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EEA A= OB FIE1 (FA=2%2270 v 795 EIRFERIND)
EEA A=Y QR FIHE2 (F A=2%270 v 795 EIRERIND)
EEAA—OHE: FIEH3 (A A—C27 U w095 EHRERIND)
VCR ® 7 L3 —% —DHEHFIH S RCA 7 —7 )b .

5 A DR

WERERT T N T1 > DY A ZEE .
rS2ZR—k - 2> ba—)LOffng

AF AT - LA=F DA 2T —ZITDNT

AF4 7] AZa—- Ry .

ROy - Ry NENXZRHT 1 —IVR

—HDA A=V DR 17 > 7L — MEBRD AT

ANETH - NTA=FDER . .
E5 4 AJ1/8F A—2%4 (Video Input Parameters)] H% >

AF 4T « T7ANOEERITLDL—E— "+ T 71 )L DIERR

[ A—2 « Y1 X (Image Size)] Y >

M A=« A X (Image Size)] V1 > RID [ANA A=YDrOy T
(Crop Input Image)] &7 3>

[ A—2 « Y1 X (Image Size)] RY > .
7L —U4 « A X (Frame Size)] A=a2— - Hh¥ > DfEH
'EF 4 AJ1/8F A—% (Video Input Parameters)] % >
TE5 % - )N A—% (Video Parameters)] 1% > .

'Ew b - L— bk (BitRate)] A=a— - RFOffifH
MPEG Effs & AT IA XT DT 1> R .

JEMED T L— L+ IXE — > Df
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[FEfE#R (DETAILED INFORMATION) t+ 7 > 3 > %#H<. 81
B O A7 0—)V EFE

(A A=&7Y Yy 7T BHEIRERIND). .95
B O BIR (A A=V v I T2 EPRFRIND) . 96
EH O : J1v b EX—Z b

(A A=&7Y Y I TBHEIRERIND). .97
B ORI 71 BV EEROIER

(T A=&7Y Y79 BHEIRERIND). .98
] DFEST - SR 7 1 V& Diedn

(f A=DEZ v I T B EMAREREND). .99
HEANHADL—E—+ JL—LNO/NIRYAL NV - 70w . . 104
AL AT A=Y DEEFHLUTIHARS > FEZRETD . . 110
L—E—2RDEBRDZER 113
2y T OEHDER 113
2w TENT YT 118
EOF v A2 ETFvRIROH 120
Movie Maker TIERL L 724 1 )L DH 122
Movie Maker TER U 7=1ER OB . 123
A NIV XLy hER 124
THE] 71 VIR OH 130
NEMmL) 74 VIEROH . 131
5@l 714 IVIROH . 131
FEHLL 7 IVIBROH 132
[Ty POBE] 71 IVIROH . 132
I ZENL] T4V HROH . 133
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Movie Maker ® b5 > ZR—hk « T2 hO—)b

Movie Maker D1 > ¥ 72— « 17T I A

Media Player DAL (7 1) v 79 % EHIERFEIR)
BME:FE1 A A=V&I) I BEIERFRINET,)
BE:FEH2 (A=Y w I EIRFRINET.)
WE:FIEH3 A A—2IYw I EIRFRINET.)
WE:FH4 A=) I 5 EIRFRINET.)
Sound Track D v T v 7 &7 U T .

N> ZHR—k - a2 bo—)LOfff

Sound Track A > ¥ 7 = —R - AT I

cowvr -arbo—)b e N—
F—F1F - T AIIVDOHEE

F—F 4% - LX)V NRIVEHOWEEYY R - TL—P—

CDPlayer DM (A1 A= &7 w792 ERRERRTEEXT.)

CDPlayer ® k7 > AR—Fh - 2> ba—)b
DAT Player DIME (1 A—=2Z7 U v 795 EIRFRSND)
DAT Player ® b Z > ZR—b - 3> bO—)LOEH
CD Manager DA > = T > R .
CD Manager #LiET + A7 LA oy rEHKX .
Record CD to...] U+ > F7 .
CD Manager #E3E7 1+ A7 LA
DAT Manager DA > - ¢ > KT
[Select "Record to "File] 7 > K7 .
DAT Manager ®HLIET + A7 LA
T—=J AT — a2 MIDL 781 A Z&3HET %
SEEMIDI N1 AWM DEET—I AT — 3> L THEET S
[Graphics Examiner] &7 >ICL7ziREOF—HR— K
lrain] 77 A& YUK T54%8) TERR
FHR (New)) ZBNL LS ITRRSNZYATHT - Ky TR
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166
183
184
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216
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236
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331
332

374
375

007-2275-010aJP



007-2275-010aJP

Digital Media Tools Guide (HZAFERR) ICD\T

IRIX V7 b2 72E. A—F 14, EFF. @A A= - 77 IIVOERAH, FwE. &
T, B, EfE. BHEAREICT S, TOR - —HHFTIVIIN - AT T VIS ENT
WET, ZTNHOT OV T AT, Web R—=DIZHBET 2T 5 - AF 17 - 771 I)VORFER
WE, INTFAT A T7OT LY TF—2 3 VHOBROIER. LA—E—< CD O&FSHEAEREI
FHTEEXT. 251> XZa7IVTE, ZOV I RIT 7 DFEHHHEICDOWTHIALET,

INEDAT AT = V—=VEMMLIET A by T« A—E—0DHIEIZDW T, Big Picture
NR=PZZMLUTLZE W, 23, Digital Media Tools Guide & EHIZA > A b—)LENT
W5 Web R—=IA\DY > TY,

13 A5 47 - Ld—4] Tld. Media Recorder 707 I LZEAL T, A—F14, E
FTA AN, FRIEE R ETRIGT 5 AFEICONTHAL £7,

% 2 % Media Convert] Tid. Media Convert ZfifiL T, F—F«F - 77 A1), E5FF -
Ty A AAXA=2 - Ty A NDB, EMAF—LIBRED/NNTA—=F ZBET L IHECDONT
AL ET.

% 3% [Movie Maker] Ti3. A—E—Z{EKRT 572D D Movie Maker Offi H HiEIZDWTEHE
BIL £9. Movie Maker 1213, 1B L7=L—E—IZ¥ 1 MLZIHATEZY A ML« XL w o
3D VA WO T S 71 NG ENTVWET,

%4 % [Media Player] Tid. A—E—&F—F 14 - 77 ()L ZFHET % Media Player Offf
HHBETDOWTHIL £,

% 53 [Sound Track] Tl&, 7> RO&EE, BLUIF T v 7 - F—F 1 FEFOIEH,
2175 Sound Track ICDWTEHBL £7,

% 6 & [Sound Player] Tid, F—F 174 + 77 AV EHET 570D Sound Player Offi 177
EICDWTHBIL £,
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%7 % [CD Player] Tid, CD#—7 1 A DA, £, BfFZ175 CD Player O i A
DWTHIAL XT,

% 8 & [DAT Player] Tid. 78I - F—F 144 - T—T DA —F 1« T DOHEE, £R, BEE
75 DAT Player DfEHGIEICDWTHBIL £,

%9 % [CD Manager] Tid. BHFENDT—Z X5 —2 32D SCSI h— MMIHEHRINTWD O
SINU BT AR - RIA TS OEE, #EZ1TD CD Manager Y — )L O HIEIC DN T
FHLET,

%10 % [DAT Manager] Tld, BffLDT—7 25— 3> SCSI A— McERIN TV D
DAT K Z A1 7%\ DAT 77— 7 O£ £ 7213 DAT 7 — 7'~ 0§k %175 DAT Manager Y —
JVIZDWTEHIAL £,

%11 mIMIDI F—HR— R TR YT > RERHDY 57 1 J1)b - —)L TH % MIDI Keyboard
IZDWTHHL £,

% 12 % [Synthesizer Panell Ti&. MIDI > >t F £ 7213508 MIDI 57 /N1 Z1Z& > THE
RENDBZYT L REEZYTEZEN, VU ROF—FT 12 a ERBITOIIEDTES
Synthesizer Panel YV —)LIZDWTHBAL £7

B3R VIR -IF4%] TR 200V vIvT - F—=F1F - T7AIVOIEREH
£ @ Sound Editor »V —JLIZDWTEHAL £9,

ZDORZa7IVITIE, 8k A TVideo Panell. {18k B I —5F 14 - )XF%JV). {8k C [General
MIDIYD >R -ty hEN=Twvar -TvT) BIERINTNET,

ABZHOCHE>TE IRIX PAT L VT by, BRUOHEMAGRZEAEL THD I an
FifeE SNTVETY, IRIX AT L VT bY o7 280 THBHNICRLHE13. £9 [Desktop
User's Guide] * >4 > + X a7 IVICRBEEIN TS T AT AOMHEICET 2 — 07
HESEL T<ZI W,

AETOTIIVITHAOTIEIN - AT 4T VT RTZTIEDNTIE, 251 > D TIRIS
Digital Media Programming Guide) ZZHL T 7ZE W,
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F1E

AFa47 - LOA—4

AF47  LA=FEFHLT, 5147 - ESF AN BEORER. F—F 4. LU T
BEIATL - TAATIRETHIENTEET, ZORIF, ROERHELSHERINTNT,
AF 47 - LAY OFAAENHHIN THET,

(AF47 « LO—FOME] 1 X—=2)

(AF47 - LO—F DS 5X—2)

(AF 47 « LIA—FIZLBEH GR—=)
L7227y TOMRAER (18 R—2)

(520 T EICRERREZRR 22 XR—2)
[FUEREREDHAF XA X (23 X—2)

[GLERFRER DBIEDFEE ] (32 R—)

(54 A7 HHITDONWT] B3 R—)

[hF > ZAR—b « 3> hO=)VOMEREZE B3 =)
(AF4 7« LIA—=FDAH T T—AIZDNT] (34 X—)
(AF4 7« LA—=F DT TN a—T127] (44 RX=2)

[F—hR—RKR-a—bhv b @5R=)

record.overview

AF4T7 - LaA—-FDHE
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o TREMAE W) B X—2)

o [ANITDERRE GR=)

record2.description

AT47 - LA—F DHEE

AF4Y - LA=FF, Lh—E— A A=Y, YU REEHRTL00707 5 LTY, Hl
MOHHIZAT 47 « 77 AV EERTES XD ICHKFI SN TVET., TV —L A X, A A—
POE, U TIIVE ERAF—LBEE. AT 4T - 77 AIVEMESEEICEDE THEN
AT a BRETEDANY—h - A bO—)LaHEHRL THD, TR 2UNENDH S
DIZHZMZEDT 7 1) & ESMENEWNET TS, B THIEIL 2ZWIHEIR, BERE Z e
THIEMTEET,

AT 47 - LA=FINERDO K D 7sienH D £9

o AF4 T LOA—F OEERHHEEHENL T, 3D EFIRED A—E—{EkSY 7 bz
Y IO S ADFESA L= 2 P HTEET,

e EFF Ity bh-LI—%(VCR)SRETH - HAFTZEMHHL TCET A EHEL, L—E—-
Ty AIZI Uy TekfFLET., £id, BEECERTOMOT Y > Rex1 /07 + >~
RV =V AT = a VTR LE VCR 2L TREL XY, RIT, TNH5DAT 17 -
771 )% Movie Maker ICRT w7 «- 72K ROy 7L THRECHKZT>TLA—E—
ZERL T, 51T, I E WebMagic % CosmoCreate (2 K0 7'L T, Web R—2
% IRIS Showcase IZ:EMUL. > 51> - L ¥ T—2a L THERTEET,

o HHLOBEEBBRDAST YT ay bEHE>TAA—J2ERLED, TV XF7— 3>
WCHER L ET A EBEN S AV ERBET S5 ENTEET,

AE:CD-ROM RI14T7TCD noH U Y RERGIZHEE. A7 47 - LA—5DORDHYD
IZ CD Player ZfiHHL T</Z& W, DAT RIA T TT—7 6T U2 RERETL5E1FE. A
T47 - LaA—=5DOHRDDIT DAT Player ZfH L T ZE W,

record.visual
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AF 47 - LO—5 ORE

ERAE : EEOH

ROBEHEZ. AT 47 - LIA—FOFALEERTHENGH T, 1 A-222Uvy7 LT,
DT 1 2 ROTIERFRL LT,

BEEA A— DS : 6l

FE 1: AA—P - Aza— - KSVELUSHLT,
IHREENTD (ZC2TiE, Ry - U7 (Window Area.)] ) .

3 o

BHINTO3 Y0 601 A=V dndy L35 b+ €54 » |
AF) v b A

TUTERRLTHS
U T ER..

T4 UEY e x|
Te AT N,
B RBLIEWD A EDELSZUYLTEE, ZOUL 2 EUHE
HHCERENET,

FrIF—iay @ HUTLEES AT E
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BIE: AFT4T - LaA—F

BEEA A— DS : 6l

FE 2: 19 x&(Task)l @ T4 A—(Image)]->
[R&U—22 3w F(Screen Snapshot)]
EZERLTEAEA A—VERB TS,

537 @] AFvav © ~bs

EEER0) "o —# @

FAPRERRT |® 27)vguh
CEFL At Piaw b
< Web g
O HAY BRE..

E1-2 B A A= QRS FIH2 (1 A=T% 7 v IT 5 EIRERETND)

BEEA A— DS : 6l

FEE 3: 3@l A LERMUT, XFv T
v hERUET. [TE4E] RIVERLT,
gALERAFyTrgy FERRLET,

BYE
@ﬁﬂ RUah- 2545
=it &/

E1-3 BEHA A= ORE: FIH3 (A7 Vv 0T D ERERERINDG)

record2.conventions
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AF 47T - LA—F DOiELH

ANIVTDRERE

ZORZa7IVE. ROEXEIEIKE > TEMTNET,

BBRTRINZEMNEL, AEOMORE, i, MEZSHEOERNDY >V Z2RET, &
ZE T7b—L - L—b) 22Uy I LET,

RTEREINDLFR TRBY V) RLETT, INerUvr$5&, TOAFTDY —
WINEBLET, A3 AT «7 - LaA—F&r )y I LET,

AZa—#HEAZ 2 —HEHOMO I->] OREBIEAZ 2 —BRANONAZEZEKLET., &
ZWE. 1774 (File)] -> BI< (Open)) 1& 77 AV AZa—%HE B 2&R
T2HENDIEKRTT, %2y b7 —2 (Network)] -> a2 > hO—)l (Control)] -> &1k
(Stop)) & Txy b= AZa—%p& a2 bo—Jb) Z2#RL. a2 bo—)b]
O—)bFA—=/N—+ AZa—n5 Mgk ZERTDENDIEKRTT,

AF 47 - LaA—FDicEY

AF 47 - LA—FZREHT HI2E. RO 3EOOHERH D £T,

REBICE#HTZITNE. AF47 - LaA—F&r Uy LET,
TA4aArEI) v LTEFHLET.

1. FAZ by T O IY—)F X b (Toolchest)] N5, M#E (Find)) > AT 17 -V —
)V (Media Tool)) %iERL £7,

2. Imediarecorder] 71 A2 &F TN U w2 LET,
a2 RN SEEIT 5I213. mediarecorder Z AL T,

record.recording

AF47 - LaA—-FICkBHNE

Z O, ROENSHRENTNET,
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BIE: AFT4T - LaA—F

EFFDEE

L—E—DitR

ZD

M2 5 Ofcdk) 11 X—2)
[F—F 1 FDFFE] 13 X—2)

Mg kWG ORE) (15 XR—2)

record2.vid

HE, ROEED SR EINTHWET,
[L—E—DftHk (6 X—2)

MR D B A 2D S Rcik 3 2 %l (8 R—2)
[L—E—REDF—F 1 F AN (9 R—=2)

AF47 - LA=FZEHFHLTET A &Rkl L—E— - Ty MI)LELTRETEXT, 20
HTIE, BEANRFIIIOWTHMAL X, SMNFLEENSLET 25813, 8 XR—20 SHED
E T A LEE N SRE T D HE ) 2 RIS BEHA < TES W,

AEL—E— - Ty AIVEIEBEIRESBLDEANDZ DT, L—E—ZiHI DA, 33
R=2D [F4 ZATERICDONT) 2FETBHRALLZIN,

1.

[Lh—E—] AZa—-HR¥> (M19&H) 27 Uw I L TAZ2—%2KRL. ROFJEIC
WD TLES W,

o EFINTVDY—ZAMS5DLA—E—: <video hardware> (Movie from Connected
Source: <video hardware>) | Z##IR LU E£T, T I T. <video hardware> \IFLERITMH T
HETH « N—RUTTY, YATLDOHEKICE > Tid, BROETH - N\—RUx
T EENTEET,

o HHTRHETA - V—R% MHEHINTNDY —AN5DL—E— <video
hardware>(Movie from <video hardware>) ] O —)LF—/)N—+ A2 —NHERL £7,
el AE. NRAEY —A (Composite Source) | ZERL £9,
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AF 47 - LaA—FIT X DHE
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WED VCR 2L I—F—Z2EHHEAE. V—ARF@EEI>RY Yy h T, Z—/)8—
VHS % Hi-8 #@& 2O A, BZFHY—RALS- EFTHTT,

B2 b RERIINBEBZMESHE. E0FMTOEEEHHATINDNSRNEE
3 EEO TH4E] RY 2L, O—I)lF—N— - AZa—n5RE%Y — X% #R
L5 AT 47 - LOA—FORREHERET, L—E—0NE> &0 BATENHE
WCHZ AU, IELWY —ZAEREN TV ET,

Indy Video £7213 Galileo Video Option Z T %571213. Video Panel 2 L TS5 %
LT,

¥9, [+ 3> (Options)] -> TEFF - )S%)L ... (Video Panel...)] ZERL T,

Video Panel IZ VIR 20w 7 (Lock to VITR) | * (€ — K (Synchronize Mode)l 7%
FREINTVRRHER, NS OERENHEMAREICE > TWA I 2L £, Frv s
X = BN TOWRUIE A RET T

(73 3>) VideoPanel 13, "TA b + NTF AR EDFDMOTEEIZHMH A FT, £/
13 Video Panel ® \)L7 (Help)l Z2ZRL TS0,

(5% X7 (Task)] -> [h—E— Movie)l ZHE. TA—E—] AZa—NSFRTZ2END
—DERL XTI,

7ZEZE Web R=Im 5271 y7°’é§ﬂﬁ'§‘%>fa/“\ [Web {2 (Web Document)| % 3R
LET, AF47 - La—Fd, BRINEZYZAVICREICRD I ICRERREEZFHEL £
¥ [Lh—E— Movie)] A=Za—DFHEIZDWTOFML TTA—E—] AZa—] (38
R—=2) B#ZRBL TSI N,

AE AT DT T 4V bEREORDVICE % DFEREEF S HEIT, THRAY L - bL—
E—#&E (Custom Movie Settings)] ¥ 707 « Ry 7 ZAzMHL £9. i3 MRk
FEDHATIA R 23 R=2) 2L T3 N,

BWERDUEHNTE TSI EZMHAL £,

ATFAT - LA—F ORRFEHICERINTNDHONEEHRINET, EBEEEZFEHL T
LT AR, TORBEDOI S bO—)LEMEHL T, ET 260 EmEDAMEICEEL
TETAZRHIE LT,

reEkE B HI1Tid. [RdEk) RY > (K172 22Uy L £,



BIE: AFT4T - LaA—F

B b RCERBRAARTICHRFELRIE 2 T 25513, [HRSE (Bdit)) > TRCEkICT « L1 2%E
(Set Delay to Record)] ZEIRL £9. FFMllE [ReERHOBEDRE] G2R—2) &5
HBLT7ZI W,

eEkEAE R HITid, M2k RY > (K178 22Uy 7 LET,

AF 47 - LA—=FZIX > RS EFHLAZGEZRE, L—E—IZZFT 7 1)V NN S
AN, R—L T4 L7 MNIIRESNET, IY 2 RThSEELAEGEIL. gD v
TR AT 47 - LaA—FERELET LI MJCREINET, KIS, AF17 - L
A—F%T7A4AERT1 RO IV IMGEEFHTEE, 77 IIEEFDT oIV 7T
BT255 0 L7 NICRESNET, 3l (70w T7OARERE] Q=) & (77
AINREBFOLEE] 19 X—2) 2BBL TN,

L—E—ZR2I123 THE RY> (®1-728) 220y 7 LET,

NBOETHEENSTLET 5%

AF47 « LA=F AL TEFTAHT—7 (VCR. ETF - T AT, VIR) ONEZRUGL 72
WIBEBHDET, ZITR TOFIEZIEFICHIAL £,

1.

ELWT—=7)V &ML T ETAEEEZT -V AT — 3 VITHE/mLET.

TFED VCR 0 L= — %25 BEITII RCA 7 — 7 IV ETY, RCA 7r—7)VIdHK
EESARPIE 2= RO ETHATEET., M14ICRCA TF—7 IV ERLET,
T—7)Vid & BFEUTY,

1-4 VCR /1 50 —% — DHEAEITHE S RCA 7 —7 )
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AF 47 - LaA—FIT X DHE

AE: AT L F VCR Offniz 02 255513, T A8 RCA 2+ v 7 DWWz r—
TR 2 AMBETY, Indy EXT LA VCR 2 585513, —UICH AR RCA P v v 70
2 Dff&E (VCR OELADOF =T 4 FAHEAR—NTHEF) . O WM AT - Pv v
7 (T—=DRAT—=a>DT4 » ANR— MNIER) DWW —7IIVnETT,

A —/)N—VHS ® Hi-8 T v F 2O FEICE. T F 2T I AT —2 3 JITHERT 2720
IZS-ESTHHTr—7INNRNETY, EOFr—JIIleFEHTEInwrbihsangEald
[ —TFINDERICONT] Z2BRLTLEEN,

T—T)NEHRLET,
J—2A5—33>® [Owner's Guidel L5 T, EFFE@EZERL T EI N,
FOwner’s Guide] 1Z Web ICHHEINTVET,

http:/ /techpubs.sgi.com

EVh 720N TVWOHRE, VCROEF A AWZET—I A5 =2 a > ODEFHAhR— M
#lL., VCRODA—F 4 AHNE2T =PI AT—23a>DI14 > ANR—MTHEHRLET.

ESHEBOIA v FNF UICHES>TNWEIEE, T—THWASDTNDZEEHERELET,
FEEBIATIEIC DWW TIE TESF A& (6RX—2) 2ZRLTLLEI N,

LA—E—RBEOF—T 1 FANHIEH
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F—F 4 F AT OHIENIE 3 DOMENH D £9,

F—F 4 F L TL—E—%iEkT 5 HE

1. [H A7 (Tasks)l -> TL—E— (Movie)l -> TR % LFRE ...(Custom Settings...)] &
BEIRLUET,

2. [F—=F 14 (Audio)) #7221 v LT, [F—F 1 F8E (Audio Settings)] /¥%)b
WEHF T

3. F—F14-rFv T2k L7 (Do not record audio track) | Z2F v 7 LET,
[OK] 27Uy L, ¥4 7072 T7TLTHREEZEHALET,



BIE: AFT4T - LaA—F

o INLSMZHF—F 1A - /\~l\'717’éﬁ)ﬂ'§‘%iﬁ/\i FIAINNDOF—F 1 F AN %
ZHEL XY, IndyCam ®° O2Cam Z i L Ttk I 2B/ EITIE A5+ 7 - LaA—%d 57
THIVMIRORA BT+ AN F—T 1« F 2 G bi? SR E T A S 2 A
LTCRHETHIERIE. AFT47 - LA—FRBIA2 A VFR— NS A>T S5 —F 1%
ERAELET, LERERET DS, [ —F 14 - )XR)L (Audio Panel)] ZfEHAL T, 5
THN DA =T A AANZEERTHIENTEEXT,

AE: Sound Track 72 EDHIDT TV r— 3 > WA —F 4 A AN ZBEAEEBICHEHRL T
HEEIE. TTIHEAFO LI —F 1+ AANERIRTZ 2 EIFTEER A,

[F—5 14 - )3%)L (Audio Panel)] TANZRET 2ITiF. 47 3 > (Options)] ->
F—F ¢ # - )XV ...(Audio Panel...)] ZZRLET, [T 74 FDANER/NA &
BR/NADRE] TRBEIN TS [F—F 14 « X)L OB TSES W,

e [F¥>*)l (Channels)]. > 7 )L - L — b (sample rate)). [ > 7 IVIE (sample width))
REDF—F ¢ FBHINT A — & Z il 2 ITNTROFIMEITHE > T IZE W,

1. r&Xﬁ (Tasks)] -> [F—F 1 F (Audio)] -> THAHF LFKE ...(Custom Settings...)]
ZERL £,

2. F=F1F (Audio)) ¥ 7%&27 Y v LT, F—7F 1 Fi&E (Audio Settings)) /3 1)L
ICHEAET,

3. AZa—-RFZEFEHLT, [Fv %)V (channel)) . Y >7)V - L—h (sample
rate)l. F7zid U2 7IVIE (sample width)] 12, RR2EEZERL £9. 0Kl %
Ty L, 47U &K T LUTEREERETLET,

AR ATAT - LOA—FD L Tﬁﬁ)@&tﬂ) WZHDZR) 2—5 - AT 51E, iLERFEH
DL—E— - T7AIVDRY a—L « LNVIZIZFEL A

record2.screen
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EE D 5 DELER

007-2275-010aJP

AF47 - LA=FZ2FHLTIA a1 —YDHEHEZLEHEL. L—E— Ty 1IN ELTRET
EFEY, AVFE2—YHEEORLFEIL D EFNEHF>ZL—E—V T MTTDODTFTES A B
L—2a iEIBIbEd, ZOHTIIEANSFIEEZFALET,

1.

(Lh—E—] AZza—-FR¥> @198 27Uy rL, VI I T7EHHLERY
J =25 D L—E— (Movie from Screen Using software) | £7213 [N TS —
AMBEDL—E—: THEHADI AT L - EFF (Movie from Connected Source: <video
hardware>) ZERLET, 72 a>OEFH - R— B HENL X TLEEHLT
WBHHEIR, RBERICETS - R—REHEHTESLDICEMDAZ 2 —HENER RTINS Z
EHHDET,

=& ZE T02Video N— Rz 7 &#FHLEZZAT U =25 D L—E— (Movie from
Screen Using O2 Video Hardware)] Ti&, O2EFH - N— R 7 2L £7.

VIR 72ERALEZAZY) =25 DLA—E— (Movie from Screen) | ZiEAZHE.

KROBIRNAEETT

e [TV 7K ... (Select Area..)] : NTADERY V2L TERTYINIA 2RIy
U, iilizWwiline<s—r7 L7,

o 4Ry .TU7 ... (Window Area..)] :HE D71 > Ry &R L Tiedk L £T,
CDOAZa—THHZBEIRLZEE, H—VNDBHASTORICENLET, itET 21
RUBEBERTSHICE. U o RUORNMIESZ Y v LET,

Movie from Screen Using <video hardware>] ZEIRL7=HE, FHL TWHETH - R—

R ORI X 0B ZEH O £9, [Full Screen) &7 3 VIdEHE K ERLE L T30,
NTSC ® PALD 7 L —ARXEI LDV A XELHEL £,

WRDOT T b IA CDEEICEREIN, 7RI 2 ONMOEENERGESNET,

o DT INIALEYAXELETEEY, WHEHERTT ST O 30 X—2)
EBERLUTLIEIN,

o BREZRMEITICE. I—VILZBIRTY IR IA OGBS, XTADERY > 27D Yy
7 LUET,

o HUHLRICHUEIRZ1T D123, THHE (Edit)) > EIR 7 L — LA % EKR (Show Selection
Frame)] Z#ERL £,

11
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12

AR AT a OR—-RELRICHESHEITE, BRY I FIA 2O XAHITEE
AN BUHLZOBE LD TEH L3 TEERT,

(5 X7 (Tasks)) -> [A—E— (Movie)] Z#RL, TA—E—] O—)LF—/N—+ AZa—
MBI AT EENM—DBIRLET,

AF AT LA—FILEIRI NS A7 IChl/s okt @I HBFE L £9. i 42
o T ETRERREERIN Q2 X—) 2B T30,

YA DT T 4) b EE TR < EHNCEESEETIHEL. WA L - L—E—FE
(Custom Movie Settings)] #1707 - Ry 7 AZEAL £, FHllE [REERED A
FIA4RX] 23R=) 2BRBL T LI,

N TEES sk vy > ®1788) 227Uy s L., iiBREMBLET,
FigkEEIEd 2iIcid MEIE) Ry (1788 2270w LET,

AF4T - LA—F &I RIFNSEELEZGEERE. L—E—IZIZT 7 1)V NN E
AN, R—L T4 L7 MNIIRESNET, I RThSEELEGEIL. iU v
TR AT 47 - LaA—FEREELET LI MJCREINET, KIS, AF17 - L

A—F%ET7AA2FRT4 > RUDT )V INSEETDE, Ty INIZDT o)L 71T
HI 5571 L7 MIRESINET,

AL T2 v TOLRETE] Q0X—) & [Ty A IREBHOLETE] (19 R—) &
ZRLTLEE N,

L—E—ZR 2123 THE K72 W1-788) 220y 7 LET,

B b HEEDSERT ST, GUEBBRTNCR R EZRET D LERTT, INERET D
IZiE, TRk Ry > &7 U v 7T 5T L (Bdit)) AZa—05 FEERICT « L1 2RE
(Set Delay to Record)) Z#ERL 9. #fflid [RLERHOEBEDRE) B2 X—2) 2ZML
TLEENn,

record2.audio
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AF47 - LA=F TR F—FT14F - Ty MV eHETEEd, =544 - 7717 —
DAT—2ar THALTA—E-IZEMLED, 25102 - TLEYFT— 3 2% Web X—
DITEMT S EMTEET,

AE :CD-ROM KZA4T7TCD oYY RERGTZHEE. AF 147 - LO—FDRHD
\Z CD Player 2L T</Z&W, DAT RS54 T TT—7InoH 0> RERGET 25513, A
T4 7+ La—=4% DR DIZ DAT Player ZfH L T 7ZE W,

1. TAF 47 L d—% (MediaRecorder) ] 7+ > RY (K192 OLEFAD F—F«
Fl AZa— R EIVYILET,

(F—FA4F] AZa—DoF—F1+F - V—RERERLET, #i:

o O2ZfH55HEITIE. [Camera Mic 705 DA —F 1 7 (Audio from Camera Mic)] %i&
KU, O2Cam KNI NTWBYA 707+ >mbicdklL £,

o T—7FvFP VCR BREQEEMNSLERT DHEIE. PATLDSA Y ANKR—HIZ
BHRLET,

A A —FTAAEBET VAT a VIIHERTIICE T A—T>3>D
IrOwner’s Guidel Z2ZHL TLZEZI WV, YATARF T a>OhR—RRFHINTVWDS

Hid. B— ROFHBIZERHIN TS EHHIEE SR L TLZ 3, TOwner’s Guidel
DiWeb WCHHESINTNET,

http:/ /techpubs.sgi.com

2. METHNL. F—F 1 F - )X2)V (Audio Panel)] ZHEHL TANL NV EHFHEL TS
SV, [F—=F1F - X)) Z2H<IE F72 3> (Options)l -> H—F 14 - )%
)V ...(Audio Panel...)] ZERL E£T,

BV b R#EGA T A ANV NVBBENR DL < 5D ESITRESNEITN, FR
IR Uy TOEEIMTRTURESNDDITTEDH U £E A

13
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14

AE T IUIINANEFATDHE, ANV RINTHETEEZE A,

(%27 (Tasks)] -> [F—F 1 F (Audio)] ZFRL. F—F 1A O—)LF—/)N— -+ A
Za—hoFATEENNT DEIRLET,

72EZIE Web R—=VRICA—F 144 - 71U v T E2EET 2HEI1TIE TWeb XE (Web
Document) ] ZERNL XTI, AF47 - LI—F3. BRINZY A7 ICEBERIUSHEZ
HEIWICRELET, AZ2a—DKEBIDWTE, MF—F1F - FZAT) AZa—] 40
R=2) #BBLTLEI N,

ZAU DT 7+ hEETEHRL, FEICREZEZT O LG REHEON AT A
X @3 R=2) Z2BRLTIIZS 0,

reERE B HI1TId. [RcEk) RY > (K172 22Uy L £,
LKL TWD YT 2 RERTEBNFREMICE RENET,
RLEREAE IR 2I1TiE, Mgk Ry 222Uy LK,

AF 4T + LOA—FEIAIYRITNSEBLESEERE, F—F 1« FIEFT 7 )V MR
52580, v—L4L T L7 MIIREESINET, a2 R0 SEBLZESIE. iy
Dy 7E AT a7 - LaA—FaRE LT« L7 MJIRESINET, FKIC, A547 -
Ld—F%7A42KRT 1> RUDT IV INSEETTEE, T7MIMEZEDT IV T
BET 271 LI MUICRESINET,

X TV TOAFEE] 20 X—) & [Ty AIVMREBFOALE] 19 R—) %
ZRLTLSEE N,

kLt —7 « A 2M<ITid THEl Ry 222Uy LET,

MESER) RYDERDDORY 2a—L4A - ATAFIL. BREADA—F 14« 77 1ILITIZ

HELEE .

record2.image

007-2275-010aJP



AF 47 - LaA—FIT X DHE

AL ER OIS

ZDHENE. ROEMNSHERINTNET,
o AT - EFTFDOAF v T ay heHmdHEl (15 X—=)

o [HEODAFv T ay heimdhE (16 R—)

547 - ETFADRFy T ay bEBRDFE

007-2275-010aJP

AT LIZET A ERE (IndyCam % 02Cam 72 E) AR INTWSHFAILT, AF 17 - Ld—
FEEFTAEREEMFHLTIAMT - ETADAF v T ay 2D, HilLWf A= Ty
WVEMERTEET,

AEEFFEBEEZTY VAT a VITERTHIZE. TV X =5 a>® [Owner's
Guidel 2L TLEZI N, YATALRT T 3 > DR—ERHFHINTVWBEAIL. R—F
OFHBIZRHE IN TV ERHEESRL TL/EI N,

FAT EFTFDRF v T ay NERDHIE

1. M A= (Image)) AZa— - -RF> (M19ZH) 27Uy I L, AZa—2F&RLTK
DFIFZHENET,

HEHRENTNDY —AMS DA A= ¢ <video hardware> (Image from Connected
Source:<video hardware>) | ZiZIRL £9., Z ZT. <video hardware> 1. 1 XA—I%
B2OIHHITZETE - N— R 7TY,

HEHREINTNDY — A5 DA A= ¢ <video hardware> (Image from Connected
Source:<video hardware>) | O—)VF—/)N—+ AZa—n5, FHTLIETH -V —X
DIATEERLET, AL HREAEY —AX (Composite Source) | ZERL £9,
HiEOD VCR AL I—=F =25 5513 V—ARd@® IRy hTT, A—=/N—
VHS % Hi-8 #£#E #5545, £V —A3Y/C S-EFH) TY.

15
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EVh A A=—DEHL-DIHNHEEELFSESG. EORBEOESEMHHAT DN
S5RNEZITI, BEO HE] Ry &L, O—)ld—N—- AZa-—-0568k5
V—RAEBIRLUEBNS AF 47 - LA—FOERREEERET, L—E—2EF-oZ0 R
A TENHBCH Z ZIULTEL WY —ZANEIRENTHET,

(5 X7 (Tasks)l -> 1 A—2 (Image)l ZERL, M A=) O—)bFA—/N—+ AZa—
MHEZ A ZERLUET,

EZIE, Web R=PHIZA A=Y - 7 Uy TEBETHHEITIE TWeb XX#E (Web
Document) ] ##EIRL FT, AT 47 - LI—FI BRSNS AT ICRESEISRE Z
HEIICRELET, AZ2—0OREBRICDOWTIE, [ TM A=) AZa—] 39 X—)
22U TLZE 0,

H 2T DF T +)V FFRETIE L, EHICRREREZTOIHREE. REEREDODNAI 1
X 23 R—=) 2L TLZI N,

AT 4T« LA—=F OERREBNITHGAENEL <EESNTND I EZ2MHREL XY,
FOREIRICIG SN A A=V NERINKT,

g Ry > (M1-728) 220 v /7 LTEEZED £,

AFw T ay bEHLDETSIT. ZUyTHIA A= - 77 IIVEDBONET,

AFA4T - LA=F 2O RINOEELEGEERE., 1 A= FT 74V MNE
A6, R—L T4 LI NIREEINET, a7 RrnsEsL 513, ik U v
TE AF 47 - LA—FERELET 1 LI NIIRESNET, KIS, AF517 - b
A= %T7AAEKRT4 RUDT IV INGEETZE 7y IMEEDOT IV 712
W55 L7 MIREINET,

AT T2 v TOLARETE] Q0 X—) & [Ty A IREBHTOLETE] (19 R—) &
ZRLTLEE N,

AA=DERZIE HE) Ry er) v LET,

BEEORFyTay bR AE

16
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M A= (Image)] AZa—- Ry (K19 28 227Uy /LT, [R7Y=h60
A1 A—2 (Image from Screen) ] ZERL £7,

(A7) =206 DA A= (Image from Screen) | O—)LF—/N—+ AZa—n5RDWN
TNNEBERNLET,

o [TTUTER .. (SelectArea...)] : XTADLERY D EMLUTERLZT I IA %R
Fw L, LV EGZEY -V LET,

o [TV 7ZEFEIRL TiE (Select Area and Record] : ZDF 72 3 id T 7&K &
FEAERUTTARTADRY > 28T EFFICA Ty 7> gy MR INET,

e 42k -TUY .. (Window Area..) | : HIHIDOY 1 > R ZEATLEL £
CDAZa—HHZRBEALRE, NT—VIVINIAT ORI L £, T HT 1>
RUZERT DI, V1 > RUOARMZEIY v I LET,

o 7))+ AZU—> .. (FullScreen..)] : ZDOF T 3 Z2ERTDE, FLEHT D720
EaEXENA = B[] “Tﬂéﬂi@“

BT O b IA CHOEMEICERENET. 7T I > ONUOEENBGEINET, ZD
TIORIA BT ARXELETEEY, il MEEERY T b5 > 0F% 30 X—2)
EZRLTLZSI N,

TBRRZEGETIKE, I—VIEBRRT T 51 > OWICEEBEL, YXUADLERY > %
70w LET, BUHLRICHWERRZT 51213, THHE (BEdit)) > HBER I L —LAZ2ER
(Show Selection Frame)| Z3#RL £

(5 X7 (Tasks)l -> 1 A—=2 (Image)l ZERL, M A=) O—)bFA—/N—+ AZa—
MEY 27 EENN1 DR ET,

72EZIE, Web R—=VHIZA A=Y 2HUE9 2551213 TWeb XE (Web Document) | %
BIRLET, AT 7 - LO—FE BRSNS AT ICEERBUSRE = HEIFNCEREL
FTAZ2—DFEHIZDODVWTIL. [TA A= AZ 2= BIR=D) E2HHL T ZI W,

HAT DT T A hEE TS, EHICREREEZT O LG REEEEO N AT <A
R 23R=2) Z2BRLTIIES N,

fEEERELES. [k R > (M1-788) 270y L%,
AFwvTay bemdEd<ice 7y THIZA A=Y - Ty IVARBDNET,

17
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AF 47 - LA—=F &I RFNSESHLAZGEZRE, 1 A-JIKIET 74V NN S
A6, R—L T4 L7 MNIIRESNET, I RThSEELAEGEIL. iV v
TE AT 7 LA—FEEHLET LT NIIRESINE T, KIS, AF5107 - L
A—F%T7A4AERT1 RO IV IMGE#FHTEE, 77 IIEEFDL oIV 7T
W55 L7 M)IREINET,

FE (27U Y TOAFEE] Q0R—) & [Ty AIVREBRFOEE] 19 X—) %
ZRLTLZES W,

AA=VERZIE THE R (K178 22097 LFT,

B2 b HEENSRERT DT, KRNI EREZZET D EEMNTYT, INERET D
IZid. TECEk) R &7V v U501 THRE (Bdit)) AZa—05 [RRICT 1 L1 2RE
(Set Delay to Record)] ZZERL £9. F#MllE [RCERROBEDRE] 32 X—) 2SHL
TLIZE W,

record.working

mMBLEOIY Y TDERAE

Z O, ROEN SR ENTHET,

18

L7277 1IVORES] 19 XR—2)

(7w THOT 7 A DER] (19 R—)

(70w 7 DHARTZEE] (20 R—2)

(70w T ORMEEITIEW 20 X—)

(Vw72 @E N7 T)r—2a ilBE#T 5] (21 =)
() T&2@3N05F 4L MIIRETI Yy T T%) 21 X—=2)
(7w 7 DHlkR 22 RX—2)

(70w THEROBE] 22 X—=)

record2.stored
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WELEs Uy T O/MMT ik

LR LET 7 MIVORFEHR

7 7 4 VORISR

LU= 7 M IIVEAT AT - LO—=F D7)y TN T 78 ATELZTHN, EEIZIZT 7+
WERREIZEODER—L T4 LI NIIREINET,
gL

o AFq 7 - LO—FZEIXURITNOEBLESGS. 77 MIIEAT 7 - L O—% ZiLH
LT L7 MUIRESINET,

o AF T LA—FETAALERT 1 > RUDT IV IhoEHLEZEE. 771 ME> =
WIICEET BT 14 L7 MIIREINET,

771 IWVRFSBFROEE
Ty AIVERRERT DRI, 77 ANV ERETLHMERRTEET, 20201 JloFa L

Z7RY 74 EZYyTHOROY T - Ry MRSV T LET, TORTRREITE 77
AIMETRTZDFT 4 L7 MU IRESNET,

record.view

OV THDI 74 IVDERR

Uy TROI Uy TEBmELZORRLEDTZIE. 7y T2 1EZY v 7 UTERL (G
HEREND), THAE Ry (M1728) 22Uy 7 LET,

AF 4T T L—F— VL TH Uy TEEET B, 71 v T2 L. T (Bdit)) ->
7L —v—0OfH ..(Launch Player...)] Z#ERL £

a—-bhAy b VY TERRL, SURODERY D ELAENS, [T —V—0iLH)
...(Launch Player...)] Z#RL £7

record2.name
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2V TDRMER

2V TDREEIIER

20

ERLIEAT 47 « 77 1I)VICHIDAFT 2T 2121, XTRADERY &L T, 727U v 75
DIV TDFTHIVE - TyAINAERTIy I LU TGERL, iLWEmZEY T T LET,

AFAT - LOA—=FEF T4 T, ROKDITT 7 A IVEICET 2T THART 2T £,

L—E—

FTIHIV DT 74 IV Al moviel . < IR T > ERVDFET, 2O <BEF> 3771
ODEXZRTHDT, movoenv RETY, DD, RIHPDL—E— - 77 1)V ELEHT
&, TDT 74 IN4IE movie2 . mov DEDITED ET,

o A=

FIAI DT 7 A I AIE imagel . < ERTF > ERODET, 20O <LEF> @F77 1)
DOERERTHDT, rgb® jpg BETT, DFEO, RIZHDA A= « 77 A )L 2508
T2E, ZOT71IV£AIE image2 . rgb DL D IRV ET,

A—=TaF Ty

FIHIV DT 74 IVEIT audiol . < HEET > ERR0VDFET, 2D <BETF> 771
DX ZERTHDT, aifc ®Pwav BRETT, DFOD., RIZHOF—F 14 - 771 %
LT B E. T T 7y A IVAIT audio2.aifc DEDITRDET,

record.edit

AF 47 A= THLWERICERT ZI2E,. 77Uy TE&R L. HE (Edit)) > TA

T4 7+ A2)N— bk OEEE) (Launch Media Convert...)] ZERL E£97,

ya—bhy b U TEERL, XURDERY EMLANS AT Y « AXN—1hO

By (Launch Media Convert...)] ZZERL £7,

record2.otherapps
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WS L7es ) 7 O %

OV TEEDPOTTIT—2a v ICBHTS

AF 47 « LA=FTHRELEAT 7207 TV r—2a  2EALUTRELZD., BlOY
U TOIERRIZHED ZEMH 0 FI 2. 2T Movie Maker TITAE T, £z, Web R—TIC
BIL 201X Cosmo Create 2 L. 'L ¥ T — a 2Tz WEATT Showcase %
HALET,

ZZTIE 2 D0HEEZEDBICI DR T CTHBAL £,
o [AF— 72K :R=ZAL:1D207 v TOHEEFITEDHENGE Q1 R—)

o [A2ER—=F: AT 47 « LI=FRFEVTOARVESE] 21 R—)

AE—-FYER - R=XM: 1202V v TDBEICHRHENSE

AF47 - LA=FTE, 7V v 7 2a—=LTHOTY 71U 5 — 3> (Movie Maker 72 &) 12
R=ZA R THZENTEET, 2L, 77 MINEERLEZTSRIZHOY FUr—2 3 > TH
BHEALZWERICERTT, 72Uy THOZ U v TE2BIRL A EZY v 755 EHHARRS
N%). lw% (BEdit)) -> O — (Copy)l Z#RLET. HlOY TV r—2a>T, 1L A
DT =4 %EE L, THE (Edit)] -> [R—Z b (Paste)] #ERTDE, JU Y THYA L -
AT 4 r—FICERRINET,

AVR=bF: AF 47 - LA=FDBREVTWGEWNMES

AT T U TENOTY TV r—2a ICBEITS 2 DHOAIKIL. BEEXEOT T r—
2a DIy A AZa—n6A VIR—FTDHETY, ZHUI. AT+ 7 - LI—=FNHN
TWiRWEEITHEFTY,

record.drag

IV T&#EPDT4 VI MIICRSYITS

BEORIYY - 72K ROy T2 FHLT, ZUyTHOZY Y T2ROF4 L7 ~NJIca
BP—92ZENTEET, VU TE2RBIRL, A7 by T THWTWRRHOY A 3 ERT 1
CRIICRI T LET,

record.delete
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2 Uy T ORI

)y TEHIBRT 21213, TNEERL. THE (Edit)) > 17 7 1)V OHIER (Delete File)) %%
RUET.

a—-bhyb: 27Uy TEERL, <Delete> ¥ —Z#L X7,

a=bhy b Uy TEERL. XURDERY &2 LIBAS. [T 7 1)L DHIER (Delete
File)] Z#RL X7

record.info

o)y TEROBRER

—EZV v THREHREIND &, THUTDWTOFMREREMATEET, 2&AE Lo—E—-
)y FIZODNTELNDERICIE. 7L—L - L—F ({ A=Y L—FEBIFIND) RL—
E—RBHOET., INZTITET Yy 7B R, [HHHE (Edit)) > (A5« VEHROEUS ...
(Get Media Info...)] Z#ERL £,

record.assign

G R T EICTRERTE ZER

FLEREE 2 BINT 2T 2 DO HENH U £

. CORITE BEEMETDROENHEEFIILET, AL (¥R (Tasks)) A= 1—
MOTET DY AT Z2RINT B0 TY, ZEAE, Web R—=VHIZA—E—- 271w
TEET 258, [A—E— (Movie)] -> [Web (& (Web Document)] ##IRL £,
AF 47« LA=FE, L—E—DTL—L -1 X TR A A-VOFE, E
fEAF— L% Web ODNFICHRIEIC/2 D XD ITHBIWITHHEL 9,

o REZMITTEFIICERET 2 HEDH VLT, ZNUL [ A7 (Tasks)] A= 2 —DBED—
WA =N= AZa—=n5 [HAL LGE ...(Custom Settings...)] ZERTLHDTY., Z
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REREDHAY A X

K0y 707 - Ry ZAMEE, FRATDOF T 4)L hFREDRD D IZEF DK E % 5
WTEXBLEHITRDET, ZOHEDFHMIIONWTIE TRMEBREDOHI AT A X 23 R—
D) B2ZRL TN,

ZOHITE, ¥R OF T al - FRAI TETRET 2 IEEHHAL £,

1. [# A2 (Tasks)] A=a—%FE, HIS5ITRINTNEEII, 1 A-VRE, BELE
WHAERICEET A A= 2 —2BRL £,

5327 D] A7vav © -~
. ;,:: @,}4} » ﬂ T t
e 5 g > L fusr /peoplefguest .‘
1A= @ "o @ =

FATREEFT. [® 257 1)vigyh
CEFL e AT Fan b
< Web g

O HAF BT

E1-5 5 A DER

2. FlE1 TERLEZI AT - AZa—=056, AT 17 - 771 )VIRERARTZZERL £ (&
EXT Web X&E, TLEYT—2 a3 EFA-I - Avtk—I70 ).

BER R EN HEMNICHEYL SNE T, ¥ A7 (Tasks)] AZ2—DOFEBICET 5
(MZ A7) AZa—] B8R—) #BRBLTLEI N,

3. (AT a2) AFAT - LA—FHERINTWDENERSIZIE. 152 (Tasks)) -> [
A7 §REZ KR ...(Show Task Settings...)] Z#ERL £9,

record.customize

RHEREDHRAITAX

FLERRE & BINT DI 2 O HENH D X7

o  ZOHITIIFMZMNT THICREZFTET 2 HEEHPILET, ZNE [ A7 (Tasks)]
AZa—@QBEO— )L A —/N—+ AZa—n5 [IRAY LGRIE ...(Custom Settings...)] % j#

007-2275-010aJP 23
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ZD

RI2HDTY, ZNICEDT 1 > RUMNHE. F27DF 74 OO DIl % DFLE
MMERDELDITRDET,

REZEO S EHEITOHEBHVET., ZHUL. [ X T (Tasks)] A= —OR#EO— )L F—
N— AZa—05, HETHRBY AT EBERTHHDTT, LEAE, Web R—THIC
L—E—- 27Uy T 2EETHOTHIUL, [LH—E— Movie)] -> Web XE (Web
Document) ] ZERLEXT. AF 47 - LI—FE. A—E—DTL—L -1 X, T71
W, A A=V ORE, EfAF—L% Web ONEIZRBEIC/ES XD ICHERIZHTHEL
£, ZOFT T alOFMIIOVTIE YR TEICHBHREEZRER 2 R=) 25
HBLTLZSN,

fild, KON SHERENTNET,

(L—E—FRESEDH AT IA X 24 R—2)
(MA—VBEREDHNAI A X (31 RX—=2)
4 —F 1 FRBREDH AT YA X (31 R—)

record2.customvid

A—E—REREDHRAIIAX

ZD

LA—E—EHRF—LDER

24

L, ROBEHMSHERINTHWET,
(Lh—E—FEfAF—LDRER] (24 X—2)

EMET > bO—)LICK DA A—E O] (28 R—)
EF sk ~HE (FL—L4 - 1 X)) Oi%E] 28 X—)
ek 7L —A - L—bhOEE] 29 R—2)

MEEERY T N T1 > O] 30 R—2)

X Advisor IZDWT] (31 R—73)

T 74N F T A—E—I3 QuickTime EFFEMAF—L 2@ AL TEMINET, kAT
ICH DA F— L& RIRT 2I121F. ROFIEIENET,

007-2275-010aJP
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(% 27 (Tasks)l -> [L—E— (Movie)l -> A% LAFKE ...(Custom Settings...)] %R
LET,

(771 IV DK (File Format)) A=a— HKY W6 T 7))L T+—<v haEnMh1>D
BEIRLET,

[VE#E (Compression)] A=a2— « RY OMSIEMAF— L& ENMN 1 DERLET,

o ZORYVEBBUEMHTESEMAGIELTEZRRLET., X111 & RITHAT
EDLHEMAF—LEZORBERL TWEY, ZORZHRTEEDY « > RO THICERR
THITE, HWY A MLVEZY Y I LET,

o [JENEMFIEE (Finer Compression Control)) %21 w7 LT, BIRUEHBHETHMT
EHEMIL b= VAL XY, EMI S bO—ILITED A1 A= EDH
B Q8R=) 2BRLTIZS W,

=11 L—E—EMAF—LU Ak

AF47 - ba— RRERE (A— E#EERD L—
YTHATEDE BEOERZEZE BBIHLEHE E—-I70—AC EHEE (EE E-—-0fREN
WRAE—A 3ICIF ... a9/ % & DHLERRER) IC > 2B R) =Y
RLE24 T ZA— T A= 3 [ R FEHITE
D= > ETHE K (lossless)
i DFLEk fE/hEWn 5
(SGI =0 17 -EFH
(1A RE N
RLES TA— TZA—3 [=5ed =35 JEFITE N
D= > E I ;K (lossless)
i DFLEk 8 fE/hEWn
(SGI =0
Apple Web & 771 Bl AN =0 fE FNGE
Compact CD-ROM I —HDER (A g vy
Video DN IHHEITEKD fe). 77
(CinePak) 17 £ 5 30 AWK E
NS <780 WIF E R
£7, FELRD
97,
007-2275-010aJP 25
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x11 L—E—JEMAF—LU A K
AF47 - ba— BREE (L— EfEtRDL—
JTHRATEIE BEOERES8 BEELLEHE E— - 70—-A4C EREE (B E-—-0fEH
WRAF¥—A 3ICE ... 297 EDHLERRER) I B B5 ) mE
MVC1 Es4 771 IEK i3 [i=3e =1
(SGI =0 5fE/ha <7z
DET,
MVC2 b 77 A IVIEHK =328 S S
(SGI 1) 20 fE/hNE <72
DET,
VI7huxYy ff 1E 5 EIRTHHEIC 95 %5 NS
JPEG X0 16 50 (FA vl 6E
5 75 f5/NE (lossy)
<IBEVET,
N—Roxy TP X, BEIRTHHIC =3 328 RS
JPEG TIE— K0, 16 &5 (FA A HE)
MEPARS 5 75 fE/NE
FF {0 %ET,
pOXT Ty TP X, BT DHEIC [ [ NS
N7 4 —LA T E— £ 0. 16 fE5h (FAH P 6E)
JPEG Tayv-E 575 {EAE
(JPEG-A) T3, <0 ET,
UNIX List
DT Z v b
74 —5AhE
@D
QuickTime
& H kD
HOET,
Apple Es4 FEIRT HHIC =t R i
QuickTime KOS5 NS
Video 25 fE/hE <7
DET,

26
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=11 L—E—FEMfAF—LU R b

AF47 - ba— BREE (L— EfERDL—
JTHRATEIE BEOERE2S8 BEEHEEHE E— 70—-AC EREE (EE E-0fREH
WRAF¥—A 3ICE ... 297 & DALIEEERE) I B B5 ) mE
Apple T ZA— T A—3 R 5B JEFIZE N
QuickTime EPZAL] > LT - K (lossless)
Animation T Dtk 8 fiF/h&E<7x
DET, T4
TEFA 14
[ENE <720
£7,
Indeo Web W% FEIRT HHIC = i & (FAs]
K0 25 fiEm fie)
5 30 fE/hE
<0 %ET,
EAERD |

o FELTWDLA—E—ZERMMNSEM L BRWESICE HRERET A
(Uncompressed Video)] #ERL 7,

e Indy ® Indigo2 V=27 A5 — 3 >/ 5HEIE. AT AT Silicon Graphics #£D
Cosmo Compress ETFFHR— K&+ 7> 3 DHKL TWAHEITRO, N—Ruzy
JPEG 7RI T £ 7,

* Octane V=7 AT — 3 > &M 25813, 2 AF AT Silicon Graphics #:® Octane
Compression R— R&F 7> 3 DHEHL TWAHEICERD ., N— R =7 JPEG HFIH
TEEY,

4. TOK) 27Uy L THLOWREZBEHL, #1707 - Ry 7 XAk TLET,

EvbiA—E— Ty EREEL TREL S, Media Convert L T7 71 L &R D
FBRDREMAF—LICEW L0, 70y TRT7 L —L « L—bh2/NEILTHREDREEZITD
ZEMTEET, L. BXERPEHICLOENRTIDZENHDHDT, HANS. A
THRXTRERT 2 HNEANTT,
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A EMAF—LARBL-—E—OHEEREISEEL T, EMAF LTI TR Dm0
NERELTZH0HHD, HRELTL-E—DMEWTL—L4 - L—FTHAINDS I EITR
DEY,

EH# bO-IVICKBA A - REDHE

T7ANDT 4 A7 HBEAREE DB TH0M AV OREZEREL TRk LIzWiEa,
W, T4 AV ERED bREEBEIETERED A A—P 2R L 2VnEanH D X7,

1. L—YE—%i&HT 2HIC. [ X7 (Tasks)|->[ L —E —(Movie)] ->[ 11 X ¥ LFRE ...(Custom
Settings...)) ZERL X7,

2. [JE#EMFH# (Finer Compression Control)] DORED/NS72REY > 27 1) v 7 LET,

3. BEASAFEMEI D EE [F— - 7 L— LK (Key Frame)] 7 1 —)b R &5 d 5,
BB NEZ O S EFVET,

AEIFHETEZEMI > FO—)UE, AL THDEMAF—LAICK O RO £,

—RIZIE. EMENEVIEET 7 AN TR0 EIH, REIIMETLEY, EMRENME
WIEET 7 AIIVEBRESBD XTI, REREEDVET. F— TV —LOHENGVIEFEE,
JEME EBHARED LNV EL<E5 I EE2ERL £,

4. TOKI 227U v I L THLWEREZBEAL, #1707 &K TLEY,

EFAEDFE (FL—4L - Y14 X) OFRTE
FIFIVETIE, AF47 « LA—FIIEED NTSC EFF + U1 > RIDESG DY A XD L—
E—%Z L EITH, JloYv A XEEIRNTHIEHTEET,

1. LA—YE—%Zi&HT 2RI, [¥ X7 (Tasks)|->[L—E —(Movie)l->[ 11 2 ¥ LFRE ...(Custom
Settings...)] ZERL £7

2. 7L —L4+HA X (FrameSize)] A=a— 1 ¥ > %&MHAL T NTSC £72i PAL ZZR L.
P4 X E7RIVEAD) Z2RIRULET, HD0WE. BEE» ST 284103 ThRAY A -
YA XDFRIE ...(Specify Custom Size...)] ZERL., HLWI1 Xz ANLET,

3. TOKI 227U w I L THLWEREZBEAL, #1707 &K TLEY,
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REIV—L - L—PORE
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TJL—AhL—hMI 1BBICERTETIL—LA (T A=) OKZEHEELET. ZHTL—E—
OEAEEZRELET, 2E2E JL—4 - L—1F301F 1BRBIC3007 L —ANERS
NBHZEEBWRLET, ESFDEEOT L —A - L— M S FLIEMELSBETEET,

1. L—YE—%E&HT 2HIC. [ X7 (Tasks)|->[L—E —(Movie)] > 11 X ¥ LFRE ...(Custom
Settings...)] ZERL £7.

2. [7L—Ah+L—h (FrameRate)] A= a2 —-HR¥ > EFHLTIL—L L —FEERLET,

TL—L L—b2ELTEHEANA=—DRRBOENRBROETE, A—E—: T71)LOY
AAMKELRBRVET, Jb—L - =R TDET 1+ AVHEEEHDD2ENDIRLIR
DEF, NTSC A—E—IIFETEZHRADOL — M1 BHIZ30 7L —A X T, PAL Ti
1RRIC25 7L —AFETTY, HEZELHRTDHE. VI AT7—2a>0FROU T Ly
Pa-L—hM3IEE 72 £213 76 NEETT,

3. TOKI 27Uy LU THLWREZBEHL., #1707 Z2&TLET,

D=0 AT —2a>OEBEOFRENULICT V=4 L—RE<BEINZEEG AT 17 -
La—%i3 ROy 7SNk 7 L—LanEA LR T ORMETE 7L —LADORS ZIEEL £,
ZOEEEREZNCT SI2IE. TEF A « 7L —A0 ROy TS Z 1L (Abort recording if
video frames are dropped) | F v 7Ry 7 A&/ Uy LET, ZOF v IRy 7 AT
Frwl X=UBBZ2EHE. AF47 - LA=FREIL—Ln ROy FaIns Eaekzdikl
EN

EVb I ATLATER, B2V TN T HEHORKEERERETEET, VU AT —
a OBERNUEDOTL—4L - L—FEERTSHE, A—E—ZHETHEEICTL—LN
ROy 7INBZENHVET, BEVWOIATFALATINZTANTSIZE, AN A—E—
5 WHEREL TAET, EWTF AN - A—E—2RBRI D EICED, AT LNNERL —
NCT7L—LZRUSTEDNDDOND LT,

Eb EWL—FTI7L—LZRETHEEICE, NS TL—4A -1 RZ2EIRL, VAT
LATEFTHFOENOTO A ZEIELET,
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BEHEZRT U b S1 2 ORE

BEICHEBTERINDTIRTIA T, AF 47 - LOA—FNEUET 2880 (RO E-
BEEDO A >y Favh) Z2RULET, M1-6 28RLTL/Z3 N,

TriN@E® HFEO®
e

B 1-6 BRI & b 51 > O A XEH

RO 3FEHOFEETAIT,
BB OB A XEE

1. A=YN2E7I I 2 OEPAICES KT,

K 1-6 DX DITH—V IV L £7,

2. XURADLERY EMLENS. YU MIA COMEBNERT v 7 L THA XEEHL
E

YA REBATIRI Iy 2B E)
T RIA THAERPCA—VIVEEE, XUAORRY ML TRI v I LET,
A X ORI E

A—=VINETTRIA 2 OmRPHICEE, XTADLERY 2 LENS, RAIF—Z2HEFRAL T
DLEDTI R TA > OACHEENL £,
£z ..

o ERULAEHDZEUHTICE. A—VINETTFIA P OUICEVWTIYTADERY > &0
Uy 27 LET,

o EELZTYRIAEBECETICR. e (Edi) -> GERTL—A%2%&% (Show
Selection Frame)] Z#ERL £,
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REREDHAY A X

X Advisor [CDW\T

(% 27 (Tasks)l -> [L—E— (Movie)l -> A% LAFKE ...(Custom Settings...)] Z#IRT %
& TR = VRO RHEILDZ0IZ X 7 BNA F 2/ (Use X advisor to optimize screen
recordings) | EWDF v IRy VAMERENET . AT 47 - LIA—FDEHEDSRLERT S
B, EETEBICEMLL TWASEHRE X U= N\NS5AFTEET, ZOHEET X Advisor &
ENET., XD, AELT—F DLk Z#IT T« AV HBZHTELDT, U1 >
R, RE 0 AZa—Z2iB I 25 ICHENTY., 2EL. VI 71y I EiRioLEe
TL—Lb  L—FEROESRETDHEEREIL. TL—4 - L— MIEHEREZK TSI E20
T X Advisor IEALAVEINENVTL LS. AF 17 - LIA=F TR Ut 2Ry, RS
2 AZa—QRERTIE X Advisor WF 2 I T7 14w IR L Y U TRETIEA 71220
E9IM, Fzv IRy IRy I L TH I ERFFTICTEHIEBTEET,

record2.custom.image

A A—CMBREDHRIIA X

AA=VHUGREENAI A XTI, [ A7 (Tasks)] -> [4 A—2 (Image)] -> X
% LREGE ...(Custom Settings)] ZZRL 9, ZDF¥ (70T KRy 7 AT, [7 71 )VER (File
Format)] A=a— Ry EFEHALTT 7 AR EZERL, TE5F - 7L —LDYA X (Video
Frame size)] ™ > ZFHAL TR, ¥50, 45D 1 OHAXDTL—LaEIRLET (KUt
JVHALD) .

record2.custom.audio

F—T4 FEEREDHNRAITAX

007-2275-010aJP

F—5F 1 ARBREEENAY YA XT DI, [ 27 (Tasks)] > [F—F 1 F (Audio)) > [
AZ LFEIE ...(Custom Settings...)] ZERL £T ., [HAY L - F—F 1 FHE (Custom Audio
Settings)] ¥ 1 7O/ MFE/RINZDT, AZa— - KRy EFHLTRKOEHZMREL £7,

[F+ > %)l (Channels)]
CDAZa— - RYTH=TAFDF v I OEEREL£T.

> 7)b - L— b (Sample Rate)]
IDAZa— - RY L TEH=FAFDOHF>T) - L= ERELET,

31



BIE: AFT4T - LaA—F

[ > 7 )V (Sample Width)]
ZDAZa—REYTYHT) - B XEHFELET, 2T - B X3
F—=FAF - TF=FD1DOOY > TINERITOIFHINDE Y MET, Tl
X8 EY OB (8. 16, 24728) T, YA ANKREWVWIZFE, F—F 14
DWEICHET I FIv D - LD EEHIITENET,

record.delay

RCERERF ] DBIEDERE

32

AF 47 - LOA=FIZF, BEOHATICAREND TR T <—) ERU KD InRREITE
BENH D XY, T, TREEk RNY 2L ERICADLBRZBWThSREZRBEIEL XD
29 %bDTY, ZOHEREIL. B OFEEDHIET BRI AT ¢ 7 - L O—4 (Media Recorder))
T4 RIEBRBMELIZNWEED, VT RNT I T DA A=V 2RET AW AZ1—%
WOTZNEEREITENLEET,

FLERIRETH] DR IE DR E S 1k

1. THR% (Edit)) -> [RCERICT 1 L1 Z3E (Set Delay to Record)) ZEIRL £,

2. TWHT DEERMZEINL 7

INTEENZESNE L, 2T 0B 2FIRTDE AF07 - La—Fid, TEEky

RN &) w7 Uz 10 BRICESRERIBELET, AT 7 - L O—F DR ERKT S 10
ANCE—=7ENB0 £,

AE D ERLU BRI OBEL, BED AT 17 - LaA—F Dty a2 Z2R& 717350 HlO
BIERE 2 ERT 5 ETHR SNET,

record.monitor
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F 4 AT HERIC DN T

T4 RVFEEICDNT

L—E— Ty A IVEERWITRELBDIENHVET., JL—L4 - L— b REFNLDEREICLD
TiE FROL—E—DF A A7 ORERZEEDDZENBVET, AT, 15 fps TiokS
N7z 15 DEX O CinePak [£4E QuickTime A—E =725, 13 AHNA hDF 4 XA fEE &2
ZEBHHDET,

AT AT - LOA—FIERIRERENH D, GEEPICE I AT LADT + AV fEICHE, FIAR]
HERFEERFR ORI 2 58 T<NE T, I, AT 7 - Ry D LIZH D TFIH T HERFR
(Available:)] DFEROBLZEZY—L TLEI W, T3 RBHBRIHEHL TWDF 1 A7)0
—WRIZ78 2 E TIZENZ T OREREHINFE> TWEMhERLET,

MWERBLA—E— - T7ANEERTEHEEDTENAR

o JEMEO hO—ILEHFHET B,

JEREE 7 7 AL - A XM/ D2 ETY, EfAF—LEZREINTIRICITE 1-1 255
LT EZSW, [REsk) Ry > &2 ) v 7§ 501, T4 X7 (Tasks)) -> [ L—E—(Movie))
-> [HAE LFE ...(Cutome Settings...)] Z1ER L. KT [EHEHFA%E (Finer Compression
Control)] ™"¥ > %7V v I LET, MBEATAFEFESI M. £2F F— - 7L —LMRE
(Key Frame)] 7« —)V RZ#{HHET 2, H2VWIEZOWAEITHET., ZHIHFHL TV
JEHES A TICEXDFATEET, JEMENRE<SBE2EET 7 AINPNISLRODET, £,
F— T L —LDHENGLRZIFZET A - A XH/NS LBV ET,

o INEBIL—L - HAZXRTL—L - L—FEEIRT S,
TL—LH A AR T L —5L « L—FDVNEILBBITZE. 7710V A AN SILIEDET,
o HEDFEIC X Advisor #fHT B,

X Advisor IZDWT] B1R—=2) Z2BRL T ZI W,

record.review

FSURR—bF - a2 bO-IOERAE

007-2275-010aJP

DOHITIE. FA Bl Rk R a—L  ATAYDYAT T I LERLET, [HE] RS
ST ATAT - LAY OU Yy THICBEEREN TS 7 7 1V ERRL £,

y
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BYE
@ﬁﬂ RUah- 2545

=it #@

E1-7 RS ZAR—F - 3> hO—)LOfFNE

AT EBHEOHMIIONWTIE, AF 47 - LO—FIZLBHE GRX—=) 25U TL
20,

R a—4L X545 8> (W17 2 2HHALT HELTWSA-—E—PAF—F 1
T T ANVOERERHL LT, ZORYE2I Uy I LT YURADRY > &M LRA5 A
FAFE L PSR THEREZHML LT,

AE R a—h - BYVRAEFBFOANTY 1—4 - LAVREEL EE A, Lno T
FEBEADL—E— - T 7R EELEE L. ALV, TA—E—RHOT—F 1+ F A
T (9 X—=2) THHINTNWS LD [F—F 1 F - /3%J) (Audio Panel)] THlfHIL £

record.interface

AF4 7 - LA=FDAL 2971 —RICDNT

34
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AF 47 - LA=F DA H T T —AITDNT

007-2275-010aJP

R |

AT4T
Ala—

He

E1-8 AF 47 LA=F DA 2F T T —AIXDNT

KIZ, KROBHEEEIZDOWTHBICHBEL £ 97,

IFoRE] (36 X—2)

(70w 75/ (36 R—2)

M7 74 A=a—] 36 R—2)

(MR A=a—) 37 X—2)

My27) Az=a—) B8R—=2)
MA72a>) AZa—) @1 X=2)
[TAF A7) AZa—- Ry 43RX—=)
MEFEOF R 43 R—2)
hS>AR—b--a>bO—)l) (44 —=2)

R a—LA Ry (44 R=2)

record.click.view
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RS

vAIRMA

2741 A=a—

36

ERERIZIZ 2 DOEMND D ET,
o FLERINDBBHD, L TNBEHDERLET,

EANSEGT 250, MPEFEENTELX0I1T, RREBITERY D b1 2N EXR
FTREINET, W=V INZEEFHNT & H—VINTHRBIEWEGNEREE &722 XD ITERR
WEHENET, =T 1 FZiLEHEL THDHEE. RREHICERERPOBRENEREN
9, HATIMOETALEBNS L—E— BT 285G, TRk Ay &7y 0 T
&, FREHICERENTVDNENEEREINET,

o AFAT - Ty AIERBLEBICERRLET.,

record.click.clipbin

7w TR BEOT AL NINDOAFT AT - 77NV ERRLET, 774V MTIE B
EDOF 4 L7 MJIRE—L T4 LZ MITT, ZEL, AF47 - LO=FZ2I7 2 RfFhS
EELZSE, HEOT AL MR, AF 47 - La—FzEEHLET LI MJITRDET,
FREIZ, AT 7 - LAY 2T AA2FKRT 1 > ROz I7heRBLESS. 77 1))
3ED N TICEET ST« LY NIIRESNET, 27U v THOI Y v TORAERE. 7
Uy TROFENCOWTIE TBELAEZZ Yy TOMAGE 18 R—) 28BLTLEI N,

record.click.file

7574 (File)] A=Za—IZid. AF 47« LIA—F&KTTH2DD KT (Exit)) A7 R
NH0ET,

record.click.edit

007-2275-010aJP



AF 4T« LA=F DA F T —AIDNT

MmEEl A=a—
MR (BEdit)) AZa2—IZXROIX > KBS0 ET,

3 — (Copy).
HEERIN TS 2 w7 2aE—L, JIOo7 75— 3 2 ICR—ZA KT
XBHEOICLET,

[7 7 1)V DHIFR (Delete File))
BIREINZD Yy TEABRL ET,

NERT L — L% &R /BT (Show/Hide Selection Frame))
BIRT TR T4 > OREBICKVRRTEI2NPRITDLOEE SNV ET, REIR
TURIA HEEICEESINZHETHIHINZEGEE. 20a3 > RIZED
HLICRT ZENTEET, EBIRTY U T4 M LIZH 255G EIRY
L — A %F& 9 (Hide Selection Frame)| a< > RZEMHL TRT I ENTEE
ERDS

[FLEkICT 1 LA 23 (Set Delay to Record)]
[FUERRF OBIEDRE] B2 R—) 2B T /ZI W,

Eoék (Record) )

FLEROBRLE (TERE) Ry > EFEUHEETT),
[F4 (Play))

BBBRINTWE 7y 1V EFRR (THE] Ry > ERUHERETT),
[ 1= (Stop).

FedkDfEl (MEik) R > ERUHEETY).

7L —¥—0D##) ...(Launch Player...)]
FUTEHT LV —2EBLET, ERLALZY Y THRL—-E—725 Media
Player. f A—725 Image View. F—F 1 AR5 H T K - T L —F =N
EEHINET,

[T5 ¢ % OiELH) ...(Launch Editor...))
WYL+ 2 EEHLET, ERLEZZY v T HNL—E—7125 Movie
Maker.  A—2725 Image View. T —F 4 TSP T2 R« T5 1 ¥ A%
gaInxd,
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[#RO] A=a—

Th—E—] A=a-—

38

[AF 47 « 22/)N— hDiEEH) ...(Launch Media Convert...)]
AT 4T« A2N=bZEFHLET, AT 07 - A2N—bE A A=, Lh—
E— BERUOA—FT1F - Ty AN eET Y- T,

(AT 1 7 IEROHUS ...(Get Media Info...)]
BHERBRSINTVWDIAT 17 - 77 AV OFME#RZRT T 1 > RUZ2ERL
E

record.click.tasks

FRICOWTIE 27 ZTEICREHREERER] 2 R=) 2L TLZI W, [F27] A
Za—E MA—E—] AZa—] G8XR=), [TM A=) A=a—] (9R—=), [TH—
FAF - FA7] AZa—] A0R—=), [FAVBEDHER] A1 R—) BHDET,

[A—E— (Movie)] H—)LA—/N—+ A=a—hb5, ROEHZBRCEET,

[—#% (General)]
AFAT » LA—FDL—E—BEOT 7 4 )b M #E

[EM (Annotation)
B I27L—A YA X T7AMBR A A—CDORE. EfAF—L%,
ENPOLEOEREL THAINDLA—E—ICHRERDDITHELET.

BT A—JL + Avt—2 (Email Message)]
HiFT27 =4 A1 X Ty AIVER A A=V ORE, EMAF—L7%Z,
BFA—I - Ayt —PICHRNT2L—E—ITRBEZRDDICTHEL £,

7L+ >5—3 a > (Presentation))
WETHTL—L - HA X, TR A A-—ORE, EfAF—L0%,
T T—2a - T0r I LACHAD LA—E—ICRESDDICHHEL 7,

'Es#4pk (JPEG) (Video Production (JPEG)]
BfFT27L—L -1 X T70IVBER A A=V ORE, EAF—L%,
EFFHIEICHE D L —E—ITRi#R® DITHHEEL £9., IRIX DLARTO/N— 5
CTHAT 2R, INEBIRL T Z3 W,

007-2275-010aJP



AF 4T« LA=F DA F T —AIDNT

[M A=) AZa—

007-2275-010aJP

Nes44pk (FOox 75w ~74—A4]JPEG) (Video Production (Cross-platform JPEG))]
BET27 =LA X Ty AIVBER A AP ORE, EMfAF—L%Z,
EFFHIEICHED LA —E—ITRERDDICHEL £9. UNIXPHDT T v b
74— ETO QuickTime THEAT 51213, IHEBIRL T 230,

Web 3 (Web Document) |
BETHTL—L - HA X, T7AVER A A—DORE, EMMAF—L0%,
Web X—INA 5 L—E—ICHR#ER D DITHHEL £7°,

X7V —2ihk (71 > B, R¥ >, A= a—) (Screen Recording(Windows,Button,Menu))]
RETZT7L—L AKX T7AIIBR A AV OE, [EAF—L%,
FENOT T =23 DFEA ML —2a v ERETIDICHERELDDIC
FEL £,

(A7) =gk (V57492 A, L&Y 7)) (Screen Recording(Graphics,Rendering))
PETHTL—L YA X Ty IV A A-DOREA, JEfAF— L%,
DY T 7 1 w7 ALY 2 DICE#ERD DICHEL £,

[ A5 LFRIE ...(Custom Settings...)
MEHICREFHETELEIICLET., TA—E—RBEREDHAI A X (24
N—=2) 2ZRLTIES 0N,

[f A—2 (Image)] O—)bF—/N—+ A2 —n5ROEHEERTEET,

[—f#i% (General)
AF AT+ LA=F DA A=VEFOFT 7 4 )V FRETT .

A7) —23 3wy b (Screen Snapshot))
BfSdT27 7 AN ERETL—L4L - A X%, BHRORAT YT ay Mok
RODITHEBL £,

'Es+4 +« 2+ w7 3 v b (Video Snapshot)]
BET277ANVERET L —L - A X%, U=V AT — 3 VITHRHEN
AT THRE T HAFT v T3y MCRERDDITHEL £,

[Web 3(Z (Web Document)]
BfFd 27 v AR ET L —L - 31 X%, Web X—IZBINT 5 AT v 7
Tay MIRERDDOIZHAEL £,
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(71 X5 LFRIE ...(Custom Settings...)]
Ty ANMVBAETL—L - A XERBIRTESLDICLET,

[FA—=Fa4F 9RO AZa—

[ —5 1 7 (Audio)] H—IbF—/N— + A= 2 —/n5ROEH RN TEET,

[—fi% (General)
AFAT + LA—FDOF—F 1 FTHEDT 7 +)V hRETT,

[ER (Annotation)
BfFT27 7K. Froxib, 27 - L—h, B2 TI)EE, En
ONEITHTHEREL TRERDDITHEL £,

T A=)l + Avt—2 (Email Message))
BfET257 71K Froxb, 527 L—b, BT IViEE,
A=) Ay =PRI 2 F —F « FITEREZR D DITHEL £,

i
+H

)
[

A

£ (Music)]
BET2 77140, Frorb, 327 - L—b, 2T )iEZ,
DOHARIC REZ B DICHEL £,

mg
i

7L ¥ >5—3 a’ (Presentation)]
BET57 7 IWIER. Frox. Y27 - L=k YT NVIEE. T
Yir—al - 7O ACBRADF =T 14 A « 77 AIVITRIER S DITH
BLET,

[ —5 ¢ #ER% (Audio Production)]
BFT27 7K. Froxib, 27 - L—h, BT I)igE, F—
T 1 FHIEIC R B DL £7,

[¥ 7 (Speech)]
BEdT27 710 ER Frox,. BT L—b, BT IVIEE,
ORI HGEE & OIZHHEL £,

m
h:

Web & (Web Document) |
BEdI27 710 ER. Frowl. 527 - L—b, 27 IViEZE. Web
R=VIGEMT 5F —F 1 FIHHS D DITHEL £7,

(71 X5 LFRIE ...(Custom Settings...)]
MEOHRENHETESHLIICLET,
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YAV BEDRT

F7var] »*=a—

TRTDI VY TE=RE

BEDOY AU BEZLRRLET,

record.click.options

[F73 32 (Options)] AZa—n5RODIAN Y RERRTEET,
o [TRTDVY YT ZLEHE 41 RXR—=2)

o RUTFYF +FTAATDERE ...] U1 RX=2)

o IF—FqF - NR).) @2R=2)

o TEFHF « NRJV..0 42R—2)

T 7 AN TR ITXTDZ Y v T &fRfF (Save All Clips...)] E— RPERITR> TWET,
L, IXRTOTY y THEFEIND ZEEZBERLET, 7V v 73, BESNLIEICES 2R/
AT SNET, 7Z& A moviel .mov. movie2.mov R ETT, ZDE— RHAER)
B> TWad &, 77Uy TRIIEFICESIENT, HLWI Uy TRmOI Yy T L#EE
LEd., 2EAE, image.rgb 3#H LWV image.rgb iICL D EEEINET, Frvr - —
IBNTOWIULZ DE— RPF B> TWET,

ROS9F - T4 RV DRE ...

007-2275-010aJP

ATy F T4 MR BRLEAT AT - T—%%, HiLWwIy )V ELTRET DRI
WM RET B85 T, T 74 b TR BEWIZ /usr/tmp T+« L7 MUIRES N
F9., EFHF - T—FET 4 AV EBEREL EDHEMRH DD T, EEFOETAHEMITEM
DIATIL - TAAVEEATEIEHHETL LD, ZOXIBRERE. TOF 1A ATITAY
TyFFAL I MIERBEL, /usr/tmp T4 L7 MUTRELSZOTF 1 L7 MU, 1R
FOETFATF—INREINDEIICLET, it T 5ETATRHICERDI AT L - T AT %
HAET2HEG. (R7TvF - F 4 XJ DEE ...(Set Scratch Disks...)) ZFHL T, WAHDT 1
ARSI DI EDHTEET, JHTXD, TL—4 - L— bidiaEasRigicmE k-
LET,
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F=FaF - KR ...

EF# - k%)

42

(20 TyF « T4 ATORE] 14707 DFENE

1.

HLWAZ FvF « 54 L7 Y (New Scratch Directory)] 7« —JL RiZ, HiLWF 1 L
NI ERRBTARXIONALEANLET, £ 4L RN) -T2 &2 ROy T -
BTy MCRI T LET,

DEM (Add)) 227Uy 27 LT, UAMIZEDT« L7 MY ZBMLET,

DZEMETF 4 L7 M) EAIBRTSI2IE T4 L7 MU EBIRLT IfER  (Remove)] &7
Uy LET,

JFEMET A 2L LD, N— KU =7 JPEG EfEZ2 AT 2551213, [5 X7 (Tasks)!
-> [LA—E— (Movie)] -> (71 A% LFIE ...(Custom Settings...)] ZERL. [MJRERIHE
I L—E— 7 71 VICERERCE (Record directly to movie file when possible) | F x v
IRy IALTF 2wl - =M TORNWI EE2RL T LIV, FEMET A T
L ON—RT Y JPEG EfiZHHT2HGICE. AT 47 - LOA—F3F 74 i
0259 F - Fo LI MNIZEMLEVWOT, ZOF v 7Ry 7 AZMHRT Z0HE
HDEE A

AR EHROT AL I NIRRT AR ERI Ty F - TA LI MIELTHD ZENTEET,

[+ —5 1 + )X%)L (Audio Panel)] ZHE £, H—F 14 - )X%)b) OFEHITDON T
[F—=F 4 - X)) O INVT (Help)) 250, 8B, TF—F 14 - X)), 2SR
LTL7IZE W,

Video Panel 2B & £9, Video Panel DFf#lllc DWW Tid, Video Panel @ NV~ (Help)l %
57, 18k A, [Video Panell, ZZHEL T /ZI Y,

record.click.mediabuttons
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AF 4T« LA=F DA F T —AIDNT

[AF471 A=a—- K>

LB DBEADOFIEL, AT 17 AZa— - R CEFHLT BELEZVWAT YOI AT L
BfG92Y —A&HERTZHILETYT, K191, EORY > 2 EOHMIHEAT 20 ERLET,
IR EZHL T ZE 0,

o TEFTADRSER 6X—)
o THENSDEER (11 R—2)
o [F—F 1 FDEET] (13R—)

o TERIEE{ROEGT) (15 X—)

F—F1 7
A—E— | A A=
“*--.._m @ _/

[ATAT] AZa— - KRIVEEST,
ATAT - FATEERT B,

E1-9 AFA4 7] AZa—-RK¥ >

record.click.time

B O&RTR

L—E—RF—F 4 FEEEL TVWDH, TAF 7] AZa— - F¥ >0 EIC 2 FEDERHA
FRINET,

o RIEFCERREHE, FLERICMN S TWBRHZRID Z &M TEET,

o TR LOREFRERIZVK, 1571 AV EBITDONT] B3 R—) 22RL TS
W,

record.click.transport
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rSORAR—=F-a>bO-

[N ZAR—b - a2 bhO—=)VOFEFAELE B3R—=) 2HRLTLZI N,

record.click.volume

RKUa—AL-KRE>

RYa—L AT Ry EFAL T, BEFOL—E—F—F 14 - T IOFEE
FABLET, ZORYEIVYY I L, XUADRKRY DML BNEATA 5 E ETFICRI v T
LTHEEZRAELET, RUa—L - A54FF. AF 47 - LA—FZHHLTERLTNS
FLNWA—E—--T7M VOFREITIE. BELBEVWIELITEEL T EI Y,

record.troubleshoot

AF4T7 - LA=FDISTNa—-FTa 5
ZOHEITIE, AFT47 « LO—FOFHPIZKEZID D ZMEEZFOMUGEZZHHL £9,
o LA—E—ZHBHLIDELTVNDEE, AF 47 - LO—INRMHERLERN,

FTAT ETFERBLEIDELTH AT 4T - LIO—FNAIHA A—TEFRRLEBEVWES
3. AATDOL X - Fr T 2N LENEINERLTLEE W, £ (AF47 - L
J—% (Media Recorder)] 7+« > RUDFNOXFEF v Z LET., 'V —2 :(Source:)] D
BEICY —AAMBERENTVRIFZTTY., AT —IDREAITERRL 2V — 22K,
T—=0AF—=2a>DhHAT4, L THHETAEBOESS. T3 MHE OV
NMTBROET, V—ADNELKBWEEIE %4 T2 AF 7] AZa—--FRF > ([TXA
TAT) AZa—RY ) @BR=) 25 AL TELWY —XZZERLET.
HAZTR VCR 72 EDQHEY — AN SRET 2HEIE. V—ANIATLOELWER—KZ
BRINTVWL ZE2HAL T LTV, 7= X7 —2 3 >® [Owner's Guidel %%
LT /E3 0,

e CD DAT MHSHEUSFTERWN,

CD-ROM RZ14 7D CD oA —F 4 FZ2BfFT 213 A5+ 7 - LaA—FORbvIC
CD Player 2L T<7Z& W, DAT R4 T DT =T M5+ —F 1 FZ2HET 21213, A
FA4T7 - LA—FORODVELIE A5 17 -
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F—AR—RK->a—brhvhk

AZa—+7R¥ ) IZDAT Player L TS 723,
fERRL7=d —F 1A - 771 IIVITEDNAD TWRN,

RAOT A+ 20F—F 4 F -V —ANPELLEREINTOEINHERLETET—I X T—
2 a > ® [Owner's Guide] 2B L TL<7Z3W, £/, [AF 17 - L I—% (Media
Recorder)] U1 > RUDTOXFEF v LET, IV —2Z :(Source:)] DIEICY —Z 4
MERINTVZRTTY, 2RI —FAREHEHITERLEY —ZITXD,
Microphone]. [Camera Mic/. [Line InJ. [Digital In] ®WFNNIT/LDET, V—2R
MIELKBWEHE, #4525 (AF 17 Ana—-hy> ((IAF147) AZa—-h%
v @3 R=) #5H) EHEHLTELWY —XZ2RIRLET, [F—F 1 F0&FE 13
R=2) BZRLTLEZI N, IHIT, YATLDEFENELVWLNVIZE>TNSZ L%
AL TLZE W, ZHE, AF 47 - La—F 0D [IF72 3> (Options)] -> [F—F 1
Z X%V ...(Audio Panel...)] Z#EIRL E£T, [F—F 174 - )3%JL (Audio Panel)] 1%, >
ATLDTF T AN EOFREL NIV ERFEL ET,

ERRUIZL—E— « 77 A IVITEN A D TR,

(Lh—Y—fHOF—F 1+ A AT 9 R—=2) 2BRLTEIWV, £k, PZXTLD

FERNMETRL NVITES>TND I EEERAL TS LIV, ZhE, AF+47 - La—%
D [+ 3 > (Options)) -> [F—F 1 # + )SR)) ...(Audio Panel...)] ZZIRLET, [F—
TAF N BF ATLDT T AN FOEEL NV ERHEL XY,

[% 277 (Tasks)] A= a1—@QIEHEIERN,
B2 BFRTDHC, AT 47 AZa— K> (K19 B ZHHL TIELWA
FTAT I TERBRIRTDZ2BENH D ET,

record.keys

F—K—K-2a—thyb

007-2275-010aJP

AFA4T - LA=F DA ROELLIZEF—R—KR- - Ta— bty bnd0ET, £121Z
a—Mhy bOUXMERLET,

BEOF—HR—R-2a—b Iy FEESINI AZ 20O ROMIZUZ FINTWDEF—
EMUET, LEAX, AT 7 - LOA—FEHKTT 5113, <Shift> F—& <Ctrl> F—& <Q>
ZRFFICH L 95
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ROFZ, F—HR—K-+-2a—bIy bOUZXANTY, ZORZHRMAREZMD T 1 > R UITE
RIBITE, FWIAMLEZY w7 LTSN,

=12 AF 4T - LA=FDF—KR—K+a—rhvh

avwrk F¥—HR—K->a—-bAhvt
FLfk (Record) Shift+Ctrl+R
JE— (Copy) Shift+Ctrl+C
#&7 (Exit) Shift+Ctrl+Q
HikR (Delete) Delete
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Media Convert

Media Convert 13, AT 147 (F—F 13, 1 A=, £LiZL—E—) 77 VOB
AF—LEEETHEHDOY—)LTT,

ZOEIF, ROHNSBERLEINTNET,

Media Convert D% ] (48 X—2)

Media Convert DFLE] (49 X—3)

Media Convert IZ X 228D EKI] (49 R—2)

(Lh—E— - 774 O%&EH (51 X—)

(F—F 17« 77N DLEH) (55 X—2)

MA=2 - T 7 AV DOEH (56 X—2)

IAF4Y « 774N OfEE] (60 X—2)

[A=E—= "+ T7AINNEDAT 1T « 77 )V Ofitt] (61 X—2)
A= « A XDEHE] (62 X—2)

TEFHF - NI A—=F DHE] (65 X—2)

(F—F 17« RTA=FDIRE] (71 RX—=)

NEMERE DAY XA X (74 X—2)

AN 7 AVERE N7 7 VGBI (81 X—2)
Media Convert D1 > % 7 = — Ak (82 XR—2)

Media Convert DF—HR—K -« > a— kv k) (90 R—2)

Media Convert ® b7 )V > a—F4 271 (90 R—2)

mediac_overview
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Media Convert D=

Media Convert D#EE

NIV T DRECE

48

ZDHENE. ROEMNSHERINTNET,

48 X—2 D Media Convert DHERE]

48 R—T D [N TDEIE]

Media Convert Tld. I EIERY A TOLMIEEETOI ZENTEET GO R—=TD [HR—
rENTWBHBR] 25H ). Media Convert THEITHRE/REIRDFI %2 KITRL £,

IHIT, ROZENTEET,

L—E— "+ T 7 1)L DB EIEMEA F— L DL
FT—F1F - T 7 AN DR EIEM DL

L—E—+ Ty A5 —HOESMEA A—I DL
—HOBEMEA A—INEL—E— - Ty 1L DEH

LA—E—+ T7ANNEDF—FT1F - 771 ETH « 77 AL Ol
JEMERRE DAY A X

TL—LL=hoH 2T L—=RRED, EFFRT—FT 1 FDINT A—F DIFE
EFAHEMA—E—+ 77 A\DYT >R - T DEHN

Evb:is)l - AP UT TS RFY =)l dmconvert Z2fHT 2 &, EROLHIEEZE
FRFIZETT S EDBTEET, 20AX Y RMTY—ILDOFFIC DV TIE. dmconvert(1) ¥ > -
R=UZHRLTLZI N,

ZORZa7IVIE. ROEXREZFEHL TWET,
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Media Convert D2 Bl

o HHRTERINLZHEDZ. AFEOMOE, i, MELBHEOERNDY > 7 2RLET, &
EAE THEME 227U v 7 LET,

o RSERINTWEZXFE, TEH) >V Z2RLET. ZhEIYvITDE ZTOARETD
V=)VIEBLET, EXE AT4T - LIA—FEZY I LTATLSEE N,

o AZa—HEAZI-HHOMICHAINZES I>) 3. AZ2—0@IRNZZERLET,
&z 17 74) (File)l -> BI< (Open)l] ERFLENTWBHFEIE [T 71 A
Za—0 TH<] ZERT DLV EEEZRLET,

Media Convert Di2E)

49 < Media Convert ZEHHT 2HE AL, RTERINZEE > 2. Media Convert 245 7
WoUw o LET,

WEIZ. ROWTHNNDSET Media Convert ZLETEET,

o Y1412 -71%10% (Icon Catalog)l] @ [AF 17 - V—) (Media Tools)] R—IZH5
Imediaconvert] 71 2225 TNI Uy I LET, [AF47 - V=) R=I%2HI
1. TAY by IO IY—)LF = X I (Toolchest)] -> MR (Find)l > AT« 7 - V=)l
(MediaTools)) Z#ERL £,

e IR R{TH 5 Media Convert B9 58513, mediaconvert EANLET,

mediac_summary

Media Convert IC&K 3 ZTHDEH

ZDHENL. ROEMNSHERINTNWET,
e 50X—TD IMPEG Z#:i) Z b
e 50R—=TD YR—FEINTWBEX
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MPEG Zi#Y R b

MPEG-1 [E#&

MPEG-1 f# &

MPEG-1 &1t

MPEG-1 ZE{LiZR:

BR—bPZhTLSER

50

Media Convert Tld. KD X S7x MPEG 2 fE#EfTTEE T,

PR Ty IS MPEG-1 A —F 14+ 771

L—Y— -+ T71)Vin5 MPEG-1 E5FH - 77 1))

—HDA A=/ 5 MPEG-1 EFF - 77 1)

YUY R - T7AINBRUIL—E— "+ T7A)VIn5 MPEG-1 AT L (systems) 7 71 )V
YR Ty AN BEXE—HEDOA A= N5 MPEG-1 Y AF 4L - 77 1))

L—=E—= Ty (A=T 44/ ETH )NS5 MPEG-1 AT L T71)b

MPEG-1 4 —F 1 F « T7AINVERRZIATL - TN TI >R T7 1))
MPEG-1 ETH « 77 AN ERIEI AT L - T I BLA—E— - T7 1)
MPEG-1 ETH « 77 AIVERIEZI AT L » T7 IS —HOA A—

MPEG-1 =5 4% - 77 A INBEIPETH « 77 1)VinS5 MPEG-1 A7 L - 77 1)L

MPEG-1 AT L« 7715 MPEG-1 A —F 4% - 77 1)
MPEG-1 > A5 L« 771 )VM5 MPEG-1 E5F - 77 1)L

Media Convert THHR— b INTWBHRIZ DV TIE, dmconvert(l) ¥ + R—T DY X b %
ZHR L TLZ T, Media Convert 1213, dmconvert AX¥ > ROL—H (> &7 —2 &L
TOWREDH D XTI,
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L—E— " Ty 1) DI

AEJPEGE. UAPTREAA-VHOEMBIEE L THEINTOHETA, A—E—ITBM
HATEEY, 2& XL, QuickTime. SGI Movie. OMFI 72 ED 7 7 f JLIEX T, A—E—-T ¥
AIVOHIZ JPEG EME T - T —F 2R FETH I EDURETT,

EXR AT T - T 7ANDT 7 ANVBAREMAF — LBONSIBWEER T AT by -
TAAY - AZa—ZFALTHARS I ENTEET,

1. AFA7 - IT7ANDTAa2% 1 EZ7Uy 7 U THRRAEZERITET, 7122 2HMNT.
H—V IV TEIRL ZREBICT 27210 T,

2. TAACHEMAERSNIRET, XUADLERY &ML ET, [ X2 kv T (Desktop))
AZa—PERENZET,

3. AT 7 - I7AINOEEIIERL T, TAZ by T - AZa—n5 [EHR (Get Info)] %iE
RUTHY > ROEHR. L—E—DIFEHR. EHE3AA-VEREIELET. 2077 1)
OERRPEMAF—LIREDERERT T 1+ > RUNKRINET,

mediac_movie

A—E— - 774 ID%KH

A—E-FXDEE

007-2275-010aJP

Media Convert 29 % &, QuickTime. SGIL. F£7z1& MPEG BEXXDL—Y— - 77 1)L %}
ORI AETEET, £z, L—E—&2—HOBEBHEAA—2 - Ty A IVITAEWHTEHI LD
TEET, ZOHIE. ROEMNSHEERKINTNWET,

o 51X—=YD Th—E—HDOLEHE]

o S3R=VD [A—E—75—HOBSMES A—T DL

Media Convert 29 % &. SGL. QuickTime. E7zid& MPEG O ALA—E— - 7 71 )LD
ERAETDHIEMTEET, £k L—E—DEMPMHEBFRRFICETTEET, & X, SGI
L—E—M»n5 MPEG-1 L—E—&ER LD, EfEINTHRW SGI A—E—M»5 JPEG [
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SGI L—E—IZZE#TE£9, Media Convert Tid. ZHOEREHNSDXT @I R—ID
Media Convert IZ & 2 A OEL] | 250 ),

Media Convert 2 L TA—E—DOERXEZETE T 21213, ROFIEIHE> T ZI W,

1. £#TB5ETH (Video to Convert)] /SA& 71—V R (FOFRLESR) 1T, 273
Lh—E—2E0D 77 )V E2EELET,
e TIyAIN-TAAERDIT, ROy 7 - Rry McRkoy S LUET,
o HDHDWIE. WAL T 4 —IVRIZT 7 AIVDINZA%4E AN LTHS, <Enter> F—7ZH

L&ET,
INZ#T 4=V RIZL—E—DIINWNZAANFERINET, LA, /usr/tmp T 1 LY
FUIZH D eddiemv EWVWIEZFTD T 7y A IV EEWRMTDEEIE. AL T 1 —ILRIC
/usr/tmp/eddie.mv EXRRINET, YUK b IvIMFEOL—E—-DHHFIF, £
#4954 —5 1 4 (Audio to Convert)] ROy 7 « Ry hENXZELT 4 =)V RIZBFRLC£
AIFEREINET,
AE K212 ROy T - KTy hENRAT 1 =)V ROFIZRLET,
FOwS -iRorv b NRAEZs—IE
!

B 2-1 ROw 7 - w7y NEXREBT 1 =)V R

2. HWHAF 1 7OMBEZEIRLET,
YU+ 2 RUDEEIZHD [HIFJAF 1+ 7 (Output Media)l &7 >3 iz, #5177 1)L - A
FATDOF T a NERINET, ANT7AIVOREIZE> TIE, FHTEARWEES
HOET, HHEOAT A 7OREEZ U 7 LET, BIRLUZAT 1 72 NS =fA
FEOHINERENET,

3. 75714 WVEK (File Format)) AZa— Ry, A7 71BN ERIRL £7,

ANT 7 A INVOEHEIZE> TIE. TORY > TERAGERA TS a3 >0 1 DUBVWESD
HDET,
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L—E— " Ty 1) DI

4. REIRLTCHN T 7 ANDF =T A FRETFTDONITA I AR TLHLILHTEXT,

FHIZDVWTIE, 68 R—TYD TEFAHANTA—FDIFE) L 71 R=PD [F—F 1% -
INTA—=F DIFE] 2B T ZI W,

5. HHhAh—E— A XZ2HBETZHER, 62X—=ID [ A= - 1 ZOLEE | 251
TLEZE W, 774 b TR BENREAEY A X SIF 91 X)) NHBNIGERSNET,

6. N7 744 ERET > T L —k (Output File Name or Template)] 7 —)V FiZ, {E
KT DL—E—DNAH (GFALI M) ET7AIH) ZANLET,

HMLWLA—E—ZIERT 25513 L VT 71V HZANLET, TD7 7N EFEEZT
LHa1. FUCARTZ AN LET,

7. TBUA (Start)) RY &ML T, A—E—&ZMLET.,

T4 R, BMETETOROEMNERINET, BMNETTSE, U 2 RUN
HAET. MPEG ® CinePak 72 E. —EOEHESY 1 T3, BRI LR O NN 5 H O
NHDET,

ZHT, Media Player V=)L TH LWA—E—- 7 7 A L2 FKRTEEXT, 59 < Media Player
ZH<IZIE RTERESNTHDEEY >V Media Player 227 ) v 7 LET,

LA—E—DS—EDBEEFMEAA—IADEHR
Media Convert Zffifl§5 &, L—E—+ T 7NN —BOBEMNEAS A= - T 7 A IVITEM
T&EE9,
Media Convert ZHifL TA—E— - 77 M) Z—HDB SN EA XA—DITEHT DL, KD
FIEITHE- T EE W0,

1. T[E¥d 5 EFH (Video to Convert)] /SZA% 7 1 —)b RIZ, ROWTNHDHETERITTO
L—E—ZHEELET,

o L—FE—-T7MINDTAALERDITT, Favy 7 - Ryvy McRoy7FLET,

o HDWNWIE. NALT A — IV RICTA—E—DINAZ%EANTLTMS, <Enter> F—%#
LE9,
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NX%74~»F”A-E~®7»N1%ﬁ§?éhi? ZEZWE, Jusr/tmp T LY
IHD jammv EVWDHAFDOT 7 AN EEHBTLIHEF. XX T 1 —IVRIZ
/usr/tmp/jam.mv EFRRINFET,

HHAF 47 ELT 4 A=« 7 7 1) (Image File(s))] MWERINT WD Z L EMEEL X
ER

T4 RUDELITHD I AT 17 (Output Media)l &7 a iz, Hihx72a>
MERINET, TLBRINTOWARVWEEIE 1A= - 77’fJI/(Imagerle(s))J &7
w7 LET, BIRSNAZEHBITE, NERBREZAFBOHNFERINET,

WEIZIRCT, A7 7AMIVDETF « NG A—FELEHLET,
68 R—=TD TEFTHHNNT A= DIgE] 2B T 7230,
BTV —4A « DA XE2BHTHEEHE. 2X=JD M A= - Y4 XOEH | 251

TLEEW, FIHIETIE A7V —4L - HAZX@FANT L —L - A XEFUIRD
E

M7 7 A V% %7137 > 7L — b (Output File Name or Template)] 7 —)L FiZ, fE
oA A=Y DNALERELET. 77 I AHOREKIT, # 2BINMLET.

B HLWVWA—E—ZERTIHEEEIFHF LV T vy A NVELEZANLET, TOT 7 1ILIC EHE
T HHEE. RULRTZANTLET,

F 74N T, outfile EVWDEZHINT 4 —)V RIKEREINET., ZOLHTEZD
FEHEMATDE, outfile EVDAFDT 7V 1 DEFHHEASINETOT, &7
#EEERAICEMLTL/EEI W, &AL, outfiled. outfilel. outfile2 7%
EEWS AHTEMMT HHEEE. outfile# EANLET,

m  <Enter> ¥—ZML E£9, IPltA (Start)l 71—V & TXF w7 (Step)) 71—V K
T, HHTHEBMIHEEERLET, T 74T, 0 06IEEFIC 1 TORERE
ST ENET, K22 2SR TSN,
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F—F4F - T 7 1IVDEH

Wh7y A hgEids o P L—F:

m [0 5

n\x
i

B 2-2 —EDA A—=TDER: T > 7L — MERD AT

6.

IBALA (Start)) RE>Z2I7V v LT, Ty A2 —HOBRSHEAN A-DITEHBRL £,

U4 2RI, BHE TR TOROGHENERINET, BENETITDHE Ur 2 RURN
HAET.

mediac_audio

F—T4aF - 7714 INDEH

Media Convert 2T 5 &, F—F 14 - 77 A INOBRELEHTEET,

F—=F4F - Ty AIVEEWT HITE. ROFIEITHE> T EE W,

1.

007-2275-010aJP

(5489 % 4 —F 1 4 (Audio to Convert)] /NA% T 1 =)V RiZ, BT 54 —F1F T 7
1INV ERELET,

o [EHT 24 —F 14 (Audio to Convert)] NAHT =)V RIZA—F1+F - T7 1)V
DEHFZATTL TS, <Enter> F—2#HL £T,
e HDWE Ty T4 EREDIFIT, Koy T - R®Rry Mckoy FUET,

(#1954 —F 1 4 (Audio to Convert)] /NA% T 1+ =)V RIZ. 77 AIVDTIISZALAMN
ERENET. 2EAE, /usr/tmp T4 L7 bUIZH D jam.aiff EWIHHETOT 7 1)
EEMWTDEET. AL T =)V RIZ /usr/tmp/jam.aiff ERRINET,

AEIEDF =T AF T - T ANEEMRT HHEE. 2 =YD EOF—F 1
T T ANNTA-FDIRE] 2BRL TSN,
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17 57 4 WIBK (File Format)) A=a—-1R&>&270 vy 27 LUT, 774 IVEREERL
E

HAT7 7 ANDF—F 1 F - INTA=FEEFTIHHL. 71 R—=PD [F—F 14 - )NF
A—F DIFE) DHHZSIRL T30,

MH7 7 A4 ERIFZT > 7L — b (Output File Name or Template)] 7 1 —)L FiZ. 1E
R 2F—=F 1A« T7ANDONA% (T4 L7 b ETyAIVH) ZANLEKT,

LA =T T2 ERTDEETH LW Ty AIIVAEANLET., T T 7 AV EEE
ToHEER. FACAHTZANLET,

BA%A (Start)) RE &2V v LT, Ty A IVeEHLET,

U4 2 RO, BHE TR TOROKENERSNET. BENETIDE, Uq 2 RUR
HAET.

YILR - TL—=V =0V =) THLWG T K - T7 A )VE2B/ETEET, ZOYV—ILERHS
IZid, RTEREINTWDEEY >V, YU R - TL—V—%227U v I LET,

mediac_image

A= - T 7L IVDEH

H—o A—DDE

56

ROPNEEHDE A T Z2BRL TS ES W,

56 R—T D TH—of A= DA

58 RX—=Y D T—HOBFESHEA AT S5 A—E—~DOLH

Media Convert Z#fd 5 &, B—A A= - 7y M VOB ELHBTEET,

HoA A= - 77 ANV ORRELHET 511 ROFIEICHES> TIEE W,
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ARA=T - Ty 1)L DIEH

007-2275-010aJP

[#19 5 E5F (Video to Convert)] /NA# 7 1+ —)V RiZ, BT 2ETH - 77 1) %45
ELET,

o (M3 2154 (Video to Convert)] /NAZT 1 =L RIZA A=Y « Ty A V& ZE AN
LTHM5, <Enter> F—Z2HL £,

o HHZWE TN - TAALERDITT, Favy S - Ryy McRoyFLET,

(4549 % B4 (Video to Convert)| /NA %7 4 —)V RIZT 7 1 IV D T IVISA B WERS N
i@‘ &AW Jusr/tmp T4 L7 FUICH S eddiergb EWDARTD T 7 A ) &AM
&l NZX#A 7 1 —I)VRIZ Jusr/tmp/eddie.rgb EERRINET,

[B—DA A—2 (Single Image)] ZERUIEEICLEY, ERENHEZERI /NS R=
A OHINPRRINET,

TAT) (Input)) T, TEFTH « )NT A—2% (Video Parameter)] DREIZH Z/NIIRIELFH DR
>y LUEd (K2-35H),

57 # AN/NT A—% (Video Input Parameters)] 7 1 > RUMMELRENET, AN/NT
A—=FPRELNWZ EZ2ERLET, 3OV TIE. 66 XR—=2D TEFTHANNTA—=-FD
) 2BHRLTES W,

CoEwI I LT TEFAAANTA—F
{Video Input Parameters)] . 2 RFUZE<.

| ernmssns [

2-3 ANEFTH - IXTA—F DER

AT 1T - A TZ2ERL £,

T4 RUDOELITHD THITAT 17 (Output Media)l &7 3 >, HHAT AT D
T alRRRINET, ATT7 7 AIVOREEIZE > T, @Jﬂf%fgmﬁﬁ%ﬂwi?
HAORDAT 1 7OREEI Y v 7 LET, BIRLEAT ¢ 723, NS BREZABOEINE
IRESNET,

774K (File Format)] A=a— - K& >h6. Hh7 7 NVIBERXERIRL £

INT A= ZBETHHEE. TEFTHHI1/NT A —% (Video Output Parameters)] 7 1 >
RUZFHLET, FMICDONTIE. 68 X—YD TEFTFHH NI A—FY DIFE] 22 L
TLIZE W,

57
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AA=Y - T7ANOYA ZEERETLHET. 62R—=ID [ A= - A TOELHE| %
BRLUTLKEIV, FI74ITE MM A=« A ZEANA A= - Y1 WL
RKEIIZRVET,

M7 7 A V% %7137 > 7L — b (Output File Name or Template)] 7 —)L FiZ, fE
T 2A A=« T7AINDNAE (T4 L7 M) ETy V) 2 ATILET,

LW T 7 AN EERT 2583 LW T vy IVABEANLET, TO 77 ILIZ EEET
55513, MUARTEATLET,

TBMG (Start)) R5 > &2 w2 LT, 77 AV EEHBUET.

T4 2RI, B TR TOROEENERENET. BENETIDE TUq 2 RO
HAET,

—EDESHEAA-HOLA—E—- DL

58

Media Convert 2T 5 &, BEEMEAA—DF 4 L7 NUMNSLLA—E—ZERTELT,

—HOEFESMNEAA=D » Ty AV EEMT 51203, ROFIEICH> TSN,

1.

(#1795 E5F (Video to Convert)] /NZ£ 7 1 —)L RIZ, BT 5 F B EA A—T0E
HINTWETF LI M) EREELET,

o A A=—VUMREINTNWETA LT NIOHFHMNS T IIY - TAA2Z2EDTT, ROy
7Ry McRoy T LET,

o HDWVEE, NRATA—=IVRIZTA L7 MDA EASTILTHMS, <Enter> F—
=ML ET,

INAZT 4 —IVRIZTF A4 L7 PUENERINET, ZEXE, /usr/tmp EVWHF 1 LY
M@ eddiedir EWIF 4 L7 FUIEFESINTVE A A=V 2L WT 58513, NA4
74 =)V RIT /usr/tmp/eddie.dir &EFRINZET,

[FEFTEDA A—2 (Numbered Images)] ZiERLET. ERSNLHEEZRT/NS/R=FMA
FBOHNERENET,

[774) 7 >7L—F (File Template)] 71—V RIiZ, BT 27 v 1)L OHHFITE AT
LET.
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ARA=T - Ty 1)L DIEH

feEZX imglrgh ~ img20.rgb EWS ZRIOERD 7 7 1IN 258, D71 —))
RIZ img#.rgb EAHL T, img000.rgb~ imgl00.rgb EWD ARTOEED 7 7 1
Wi HGEE. 2D 7 4 =)V RIZ img###.rgb EANLET,

4. TBA4A (Start)). [# 7 (End)l. TAT w7 (Step)] 74— IV REMHHL T, BBRAA—-2D
i ERELET.

7’:&%’_ 1. imgl.rgb ~ img30.rgb EVWIHED A A= DD E, HFEHID 5 DDA A—
BT 551, TBE (Start)) 7« —JV RIZ 1. T#7 (End)) 7 1+ —J)V RiC [z
T/7(Step)J T4 =)V RIC1LEANLET, B0BEDA A—AHD, 1DOBE _’f?ﬁ'd_é
&1d. TH%E (Start)] 7« —JV RiZ 1, T#7T (End)] 7«1 —J)V FiZ 30. (X5 v 7 (Step)!
7’1’_)1/]\ 2 EANLET, 74—V RIZANT ST, <Enter> F—2#HL TL
I,

5 ®51EIT771)b-7>7L—b (File Template)] 7 « —)V KiZ/1—Y )L Z & X, <Enter>
F—2H LU TANNEZHERL 9. AT 17 (Output Media)l &7 a »INEHS
NnE9J,

6. [AFI (Input)] BT, TEFH « )]XT A—% (Video Parameters)) DRETHZ/NSIZIESFD
RNEYEIU I LET (K2-4 Z2H).

'e54 A1/ A—4% (Video Input Parameters)] 7« > RUMNERINET, AN/NT
A—=FMMELWZ EZMRLET, I ONTIE, 66 XR—=20D TETFFHANIINTA—=FD
) 2BHRLTES W,

CLEs Uy LT TEFAANNGTA—F
{Video Input Parameters)] .o EU#E<.

| ernmssns [

24 M'E5 4+ A71/8F A —% (Video Input Parameters)] H% >

7. WHAF 4 7&ELT, [h—E—- 77 1)L (EFFDH) (Movie File (Video Only))] 73i#R
ENTVBZEEHRLET,

U4 2 RUDEEICHD THI AT 17 (Output Media)l £ 273 3z, Hhx7 3>
MFERINET, TLERRINTOWARVWESE, TA—E—- 771 (l:Tﬂ‘O)J}) ( Movie
File (Video Only)) %227V v 7 LT, BRI NI L E2RI/NSR=ABOHINKRSINE
ER
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10.

11.

12.

(7 714 VB (File Format)] AZa— -« RY N5, T7AIIBREERL 7,

INT A= ZETT L5, TEFFHT1/NT A—4 (Video Output Parameters)] 7 1 >
RyzfALEd, FicONTIE, 68 X—2Y0 TEFFHNIINT A—F OiFiE] 251
TLZEW,

HHL—E—DT V=L - A X2EETLHEE 62 XK= D [f A= -1 XDOEH|
EZZRLTLEEWN, 7 74)VFTiE, BENGHEEY 1 X SIF Y1 X) AHHEITER
aNnY,

MH 7 7 A4 ERIZT > 7L — b (Output File Name or Template)] 7 1 —)L FiZ, E
REBDL—E—DNAH (FTALIMIET7ANH) ZANLET,

HMLWLA—E—ZIERT 25513 L T 71V #HZANLET, TD7 7N EEHET
L5613, FUARZANLET,

BA%A (Start)) RE &2V v LT, Ty A IVeEHLET,

T4 2RI, B TR TOROFENERENET. BEPNETIDE TUq 2 RUp
HA £ MPEG % CinePak 72 E. —#OIEHES 1 7123, BT O 012 H O
NHODET,

mediac_combining

ATFAT - 771IDES

60

Media Convert ZffifHlT 2 &, ROXODBEHMNDIZDIIAT 7 «- 771 )V 2H#Ee (LE

(multiplexing)) § % Z EMTEET,

ETFDHDT 7 AINANDY TR - hT v 7 OB
FF U F T AN E—HOREREA A= NEDLA—E— + 771 L OIERK

*AE I MPEG ERLSND T 7 1)L & MPEG BRO 7 7 1 Mgk ETE £ A

AFAT » Ty AINVEFET DI ROFMEIHE> TZI W,
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L—E— Ty AINEDAF 4T + 771 L Ol

1. ANT2F—F 14 T7 4% 1DRRLET,

2. EFHADHDL—E—- - T7ANELTHOBENEAA—VERINLET, X 2-5 OF
22U TLZE 0,

| 7»ve 7@ |
| A Hih
| Y5454 B 25y

ErarEer— | AN
& A d—Te Ty AN
Besa O hmEe e Ty AN (EFADA)

g &bt Tr AN (A-FrAEERA) |
7 o L | SGI Movie = 1|

E2-5 AT AT « T AINOREERITLDL—E—+ T 7 A IVDIER

| =3

3. 56 R=TD M A= Ty A)VOEH) OB > TEMLET, Zo&x, MR
T4 7 (Output Media)] ELTHT Th—E— 771 F—=F1+FEEFH) (Movie
File (Audio and Video) )] &R L T ZE W,

mediac_extracting

LA—E—-274IVDSDAT47 - 774 IVDHH

L—E— T 7AIVCHA—F 1+ FLEFTFOMANE EN TN SHEIL. Media Convert % i
LT =T+ A ELRETFEMBTEEY, ZOUMELEMREIETET, ZOBEET,
EREN=T7 71NV E2ROBRICEHTH b TEET. HHEOBRZERTSFTT, £
BPNETTEET,

7z&2E, MPEG (F—F 1+ &EL—E—) 25 SGL (EFAHDH) 7y A2 TEET,
ZOBREIT. KOLIITEIRLET,

o [HIAF 17 (Output Media)l 725 [L—E— -7 7 1)L (EFFDH) (Movie File (Video
Only))) #ZERL X7,
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o 771K (File Format)] A=a1— K& i, [SGI L—E— (SGI Movie) | %2R
LET,

mediac_size

A A= - YL XDEE

AA=D A XEEETDHHEA. 2EBVOHENRHV LT, 1 DBRANA A-T Dz 0y
T BTk B 1 DB AP REREIK / N HHETT. ROHEHOWTNNET Y Yy
LTSN,

o R2R=TO AN A=D1y T

o BAR—TD [ A=Y - P XL

AhA4 A=y 7
BT U T, AHA A= (FRE 70 —L0) Oz sy S TEET, AHMA—TZ270Oy
T B ROTFIEIZHES T ZE W,

1. /NSIRIESHED T4 A=« Y1 X (Image Size)] NY > ZRY > &7 Uy LT, 1 A—
¥ - Y1 X (ImageSize)] V1 > RUZHEET, K2-6 ZBHWL TSN,

EFA 5
AT HAR

hafialii

Vs
ZCEIV I LT A4 A=D B X
(Image Size)] P12 FO#H<.

E2-6 [ A—2 « ¥ X (Image Size)] H% >
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A= G ZOEE

2. ATAY - N—ZBEHLT, £ A L FThoroy T80V 8ERRLEY. [V
0 7lig (Cropped Width)] 7« —J)L B & 70w 7' (Cropped Height)l 7 1 —J)L KiZ,
IOy THROBEFINERINET, K27 2B TIZS 0,

3. 7L —A54 « YA X (Frame Size)] A=a—+ Ky >D [AHDO—E Match Input)] B—)
F=N—+ AZa—=n5, S YA X (Cropped Input)] ZZERL £J. THhZEERL
WE, N A=DIEANELET, FFHHICDONTIE 64 RXR—=2D [f A= - YA XD
EH] 2BRLTIZE 0,

| Mta-vrrvy7

0
(ET] e ———
Eir e iy TIEE T L
0
(T — e ]
B e Ry TIEE T L

Al W —

0
(ET] e ———
Eireraye FIEET L
0
(T — e ]
T e Ry FIEET L

it —

B 2-7 [f A= - ¥ X (Image Size)] T+ > RUD TASIA A=Y D710y (Crop Input
Image)] ¥ 3>

B> b :SGIL TIFF. £ FATHRXDOA A—2T, HTRATHELENSH DA A—-20D0
Oy 7 HEE 2 E IR U 2 WiGEIE. Image Works WV — )L TA A—=2%227 0y 7L TH 5, Media
Convert Zffif L £9, Image Works ZB<IZ1&. Image Works 227 J w7 L TL7Z&E W,
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A A= - L XDEE

WO 57 ANDA A= - A XFERE TV —L4L - 1 ADEESH, Media Convert TEITTE
EJCIN

AE B, WA A=V KRTDE, A A-—VEEMETTSEARDH D ET,

A XeZEE T 213, ROFIEITHE > TS EE W,

1. /NERIEABD T4 A= - Y1 X (Image Size)] NY 27Uy I LT, [ A= YA
X (Image Size)] V1 > RUZHEET, M2-8 2L T /ES W,

R e
AT H AR

hafialii

Vs
ZCEIV I LT A4 A=D B X
(Image Size)] P12 FO#H<.

H2-8 [ A—2 « ¥ X (Image Size)] 1% >

2. [TVl —LAh YA X (Frame Size)] A=a— Ky >E2I7Uy I LET, K29 25T

ZE,
BN 2 Y1 S .
T dn o A | SIE AT ‘4
&: S AAI AT YT v
E2-9 (7L —2L - 3o X (Frame Size)] A= a1— -+ 1R% > Offif

RDOAZa—F T a>OnTnzERRLET,
e [ANID—E Match Input)) B—)lA—/N—+ T AZa—
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EFF - IXNT A—5 DIFE

ANTL—LERUYA ZOWN 7L —LZERT HHEE. FUPFIN -1 X
(Original Size)] ZERL £, ANNAA—2r 0y T LEBE 62X—YD TAH
A A=20r0y 7] Z22R) 3. WS YA X (Cropped Size)l #ERL T, 7 Ov
TUEAA=DERUSA XM 7 7 AIVEERLET. ZOXDITHRELRNE,
TTDOYA ZWZEDETA A= RIND =D, A A—DICEANELET,

[ SIF ¥ X (SIF Size) |

SIF 1. Source Input Format (V —ZANER) OWEEETT, DA T 3 > ZERNT
&, RoEEEALIIY A X0EE SN E T, Media Convert 13, SIF FEHEIZE DN T
BIRETVET,

[IZXZ <A X« YA X (Custom Size)] O—)bF—/N— - BT A a—

T —L4® NgE (Width)] 7« —JV & TEE (Height)l 7« =)V RITH L WEZ AN
THEEITERL £, [T AXRY b LOHEFF (Maintain Aspect)] £721& (7Y —-7
ANRZ b (Free Aspect)] ZEIRL £T, @HIL, [7 AR MHLOHER) Z2EHT 5 &
SBEOLET, [T ARY FMLOHR Z2EIRT D&, &S LEO RN —EITREN
570, A A= NEOBENDD D ERA. ZOHE. —HDT 1+ —IL ROfE%E
EHETDE, B5—HDT7 =)L ROMEHHEMICHEHINE T,

TTOHHEZEAL TRPE S 2EE T 25813, [7U— - 7 ZAXT b (Free Aspect))
BN £7,

AE I MPEG EffizHHL TW2HE, 1 A= 7 L—ADiEIT 16 DEEMHE TR
THUERD F8 . 16 DEEUELNDEEZEANTTEE, o E b 16 DEEEICH
BICY T 5N ET,

mediac_videopar

ETH - RKSA—-HDIEE

ZDHENE. ROEMNSHERINTNET,

007-2275-010aJP

66 R=2D TEFFANINT A—5 DIEE]

68 R—T D [EFFHIIINT A—% DI55FE]

65
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mediac2.vidinput

EFFANNSIA-SDIRE

66

AA=2 Ty AIVTIFERT O AITBEBFRNE TN TOWRND, A A-VE2EHRT S
BEBETTANNT A=Y 2HRTD2LENHDET, L—E—TI, TEFFTANNTA—F
(Video Input Parameters)] W > RUZHH L THEREREHRELET, TEFFATIINS
A—% (Video Input Parameters)] 7« > RUZXKRT2IZE [E5F - )XT A—F (Video
Parameters)) ™7 > &7 v UET, K2-10 #2RL T 7EI W,

CLEs Uy LT TEFAANNGTA—F
{Video Input Parameters)] .o EU#E<.

| ernmssns [

2-10 M'E5 4+ AJ1/)8F A —% (Video Input Parameters)] H% >

AE  TEFF ATI/INT A—% (Video Input Parameters)] 7+ > FTIZEKREINZ/INT A —%
3. A7 7V ORFEICK > TRRD £,

o HoAA—VEAHITDEEIE. BV - 7AXRT b (Pixel Aspect )] A=a2— K%
& 14241 —X (Interlacing)] AZa—+ RY BT 1 > RURERENET,

o FHEMNEAA—VELEWMTIEAIE. [T —L4 - L—b (Frame Rate)] 71—V K&,
77X 7 ANRY b (Pixel Aspect)] AZa— Ry & [ 25 L —XZ (Interlacing)] A
Za— - R MERINET,

o A2HL—R - AA=VEBWMTDIEERE M A= - L1477 b (Image Layout)] A
Za— R CPERINET,
A A=V EEMT DB DBERICONT, KOFHAZSHEL T ZE 0,

o 7TR=TDMMANTV—=L-L—=F Ta—=IbR TEZRIV-TARZ b 425 1—
Z] ZDNnTy

o 7R=TD [TANA A= LA T TR ITDNTY
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EFF - IXNT A—5 DIFE

TARZVU—L - V=Pl Z4—=IVE TESRI - FRARO ML 429V —R] IDOWT

EFF -V —=ZAnDno TWAEEIE. TEFF ATI/NT A—% (Video Input Parameters)| ™7 ¢

S RUDENHFHBERE T, ANV —XONENDNSBVEEE. KOk > FMESEC

LT, TATIZ V=24« b—| (input frame rate) | & TEZ )L« 7AXZ b (pixel aspect)| %k

EL. 1> A 25— (non-interlaced) ). THEEA > & L —X (interlaced even)). [HFE1 >

% L —2Z (interlaced odd)] OHMNS, 1 > F L —ZXERIRL T ZI W, ZNTNOHEBEDESE

ZOWTIE, HROMIEs ) v 7 LTLIEE N,

e NTSC EFA¥EE (VIRRZE) RN—R - F1 AV + LOA—F THRLHNIZA A= DOHH,
TL—L L= M3 2997, ET BRIV T AR MRIEAE (EFF -V —ZAH CCIR 601 E
FF DA CCIR 601/525), 1 > & L—AZHHERET 5O —HIN T,

e PALETFHEBLN—R:-F4 AT - LA—FTRONIZAA-—VDOHAE, TL—L - L—
RE 25, EZ 1)V 7 AXRY MRIESTE (EFF -V =27 CCIR 601 EF F D513 CCIR
601/625). 1 > % L —X3MBEEIEET 2O TT,

o UIT4w IR -TATILATHBENZAA-2DHE, 7b—L4A - L—HM330. EZE
e FARY MIIEHH. 1 2F L —R3BLEBET 20NN TY,

AA=D ) =ADONEBVWERIE, &S EROE7 eI Bhs 7L —LL—F EZ I
TART b, A2 —AEHHAL £T.

o E /N 486 THEA 640 DEHIT. BEHLTL—L - L—FE 2997 730, EZEIL - TR
R MIIESG, A 27 L —RA@FEN2UITIRD £T,

o SN 486 THAM 720 DHFEIL. BEH T —L - L—FF 2997, €I - TARY
ME CCIR 601/525. 1 > & L —RIFHFEIT/IZD £,

o EHEM 576 TIEA 768 DIFEIL. BESTIL—L - L—HME 25, EZ BRI - TAXT b
WZIETH. A 28 L —AHEBITR D £7

o  EHEMN 576 TIHEA 720 DA, BFHLTL—L - L—hE 25 BV IV - TAXRY MM
CCIR 601/625. 1 >4 L —AZ@EEI/Z0 £7

TARA A= - VAT IR ICDWT

IDAZa— RY NI A2V —ASINFA A=V EEBRTIEFICERINET, 20k
&=, Media Convert AN T L —4L « LA T T NEimld ZEMTERWED, 1587 1+ —)b
R (Split Fields)] %71 [7)V - 71—/ (Full Frame)] Z#ERTLIMLENHD 9. EFHEITD
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WTIE, 22T 57 1+ —)V R (split fields)) & 7)) - 7 L —4 (full frame)] Z&ZNENT
Vw7 LTLEEN,

ANA A=« LA T SBORSBWEEIE, A A5 TEET, ELWSHEOHE—
WEN SR A=Y OEAE. 7))V 7L —L4 (Full Frame)] Z2BIRLET, L FiCER>
2 DODEHEL TERRESNDHEL. 5087 + —)L K (Split Fields)] ZZERL £7.

mediac2.vidoutput

EFAHRNINS A - DIEE

68

Media Convert ZfHHL TL—E— - T 7 A1 A= - 7y A VEIERT 285G, FEDOH
HETH - NIA=FZEETEEY., TEFFHII/NT A —F (Video Output Parameters)]
U1 > RUEFRRT DI TEFH - )INT A—% (Video Parameters)] 1% > %710 v 7 LET,
X 2-11 2L T E3 0,

CoEs Uy LT TEFALANRT A —F
{Video Qutput Parameters)] W 2 K7#E <,

™~

A A= HA X ]

2-11 TES+% - )NF A—% (Video Parameters)] "% >

NEFFHi71/85 A—% (Video Output Parameters)] 7 1 > R DOHNEIE. ANT 21 A—-TD
FEICIGCTRRDET, HELAEEHBICEULIBWNTI A=Y RZITXRTT L —FRIZRD, &
HTEERA. HEDNTA—F ZEBRT DRI DON TR, ROHPH 5B BT 2 % A
THHRL T ZI N,

e OR—TD MTL—L-L—Fr T1—)VR]

o 9OR—TD 32 TNFT KK

o T0R—TD [THMA] AZa—--RFy2E f2FL—X] AZa—-RF 2]
o 7IR—=VD [E5DERET(IF]
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EFF - IXNT A—5 DIFE

o 0R—=TD [Mf A=Y+ LATTR] AZa— R

o 71R—=T® IEHE HX) AZa— K5

M7v—~4L-b—~Krl Z4—-J)VF

32 TNV Y U REE

007-2275-010aJP

D74 —=)VRTE, b—E—0FETL—L- - L—b2EFLET, 7L—4A - L—NIED
FRENDTL—L (A=) ¥ZE2EITDHDOT, oA—E—OFHEFEEZBREL T, =& 213,
TJL—AL--L—FN15DHEE. 1507 L —LANEKRINET,

SGI s—E—=% QuickTime LA —E—2Z2ERT 28E, FEDTIL—L « L—hE2EETEXT
N AN 74— IV ROEENCHAB/NSIRAZa— - RYEFHTEE, I<FHEINBZTL—
L L—hEBIRTEET, MPEG 7 7 1V EERT BHEIE. AZa— - Ry 2FHLT
MPEGFEHED 7L —L - L—FZ2IEETHHLENHDET,

ZOEMN TL—L - L= ERETDIHEE RO[ITTEEL TIES 0,

o LA—E—RYTZR: bIuIBMATVWEEAEIE TL—A - L—b2EELBRWTLE
W, Jb—L - L—hEEFETEHE, ENLELET,

e VI NIITDADEEGHEREDRERZ. TV AT =23 VX0 TREDZHENDHD
£9 BENOT I AT —2 3 COBERNZBAS TV —L L—bEERTL L, L—
E—ORERICTLRIAREENECLHBENH0 £,

e TTOANTV—L L—FrEDHBEVWTL—L - L—2RETDHE, AVHEHELET,
TDITL—LDTL—Ah - L—HMIERDFEEA,

B8 30 7 L — A (30 fps) #fH) 24 7 L — L (24 fps) ICAHL L 721, 29.97 fps % 23.976 fps IT4
WMLEDT2EA, 32 TIY U UREEFHTEET., NSRRI RAZIVY Y I TDHE, 32
TNE I UREDA > | FTNEDOEY., Frvl - X—=VB3F&RLET, 714 Lb
FUVEFAHERTIE, 24fps 7L —1% 30 fps EF HITEMT 272012 132 TIVF D ) H3f
HENTnEd, ZOUREITSE T O—FNELEL £T, 32 TINY T 2 RIRE I O
DEHD Z LT, 30 fps EFF % 24 fps IR L £, Media Convert @ 3:2 7V 5 7 > KinthE
13, 30fps ETF A& 24fps ELTL>O—RTESHKSIT, ZORUBEETTNET,
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MAM] AZa—-RELETAHV—R] AZa—-KREY
7511 (Orientation)] & [f > % L —Z (Interlacing)] DEHUIL. 1ERT 2 L—E—DOEAER L
R TIRELE T, V7 by 7A@, Fhs LASICA A=Y « F—5 & {57 5014
LT, EFFEE (VCRRAAT) T ELS THERELET.
L—E—DOHAHEIBL T, ROIDITERL T ZI W,
o AT4T - TL—Y—I2EDYVT YT EHFEHTLHER. ROXDITERL 7,
Ths kA
A L=
e VCR7ZAZEDNTSC EFALEBEMHT2HEIEL. KOXSITGERL XY,
S5 TA
A I L —R
e PALEFTHEEZFEATIHEIT. ROLDITERLET,
N5 TA
B> L—2
e CCIR601/525 EFAHEZMFHTHHEIF. ROKXDITERL 7.
5 TA
A I L —R
e CCIR601/625 EFAEEZMFHTHHEIT. ROKXDITERL £7.
EMNS A
B L—2

[AA=D - VAT7I ] AZa— K>

(M A=Y« LA 7Tk (Image Layout)] A=a— R, HAHT7AI0A > & L —X&
NBHBITERRENET, 1A= - LAY TR [7) - T —5A (full frame)) E/zid 7%
7 1 —J)V K (split fields)) ZZRL £,
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F—F 4T INT A= DIEFE

BE52&RET1NS

55 D&ERET 1 )V (Flicker Filter)] D#DR Y 7 2 %7V v I §5E, T4 )FDF> [ F
TWNGEBEDLVET, Frvl - I—=JId. BHDERETAININFT o> TWBE I EERL
9, BABRET Y CEMBET S T4 v IADA L HL—A « TL—LZEHTHHEE. b
SOERERTAINIEFRTLZLICEIOMNA A—CoEENMELEST, ZHUT A >F L —
ZAHHD 1 EZZIVBOMD S 5 DENFDTEH/-0TT,

E#E AR A=a—-KRy>

ZDAZa—+ RY VICFERINDIEMAF—L1F. BIRLEHA 7 74 BERITRC TE{EL
9. & AT 7 1IVERIC T MPEG-1 & A5 A (MPEG-1 systems)| Z#4R L 2358,
JPEG \3EMED THIL (Scheme)) AZa— Ry VICERINER . oo BRLEAST 7
AR L T, JPEG. RLE. RLE24. MVC1. MVC2. QuickTime Animation. QuickTime
Video. CinePak. MPEG-1 DIEfAF—LD S5, 1 DELIFEROA T L a b PERINET,
FHEBOERIIDWTIE., HOHSEZ ) v I LTI,

EHE A F— L DEIRG, THEREET 74N NOBENSEETTIHEAIL, 74 R—20 (JEMHES
FEDHATIA X 2B T 230,

e Hi71/8F A —% (Video Output Parameters)] DEMNT 7 L7z, AL % (Close)) &
y>uEI7Uy I LET,

mediac_audiopar

F—=F4F - INSA—HYDIEF

007-2275-010aJP

ZDHENL. ROEMNSHERINTNWET,
o NR=TVD THEQF—F1F « FT—=F AT A—F DIRE]

o TBR—TD [F—F 1 FHIINTA—5 DIEE)

mediac_ainput
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B DA =T AF - T—YANNSA—H9DIEE

72

HDOF—F 4 F T =4 T 7 A NEERTDHER. [F—F « F AN/NT A—% (Audio Input
Parameters)] V1 > FUZFHL T £OF—F 4 A -7 —F - NITA—F ZHEEL £9, Media
Convert N TERWA —F 1A - Iy A IDBATEIND &, £OA—F1F -F—% - T7
ANWNEDIDEHRT DA TOUTNERINET, IOKI 27V vrd2&, TAHTE—F+1
FeNTA=F] T O RUNKRINET,

ZDUA Y RUTEH, ROKDIBEHREZEITVET,

[F+ > %)V (Channels)]
IDAZa— RY 2T, =T 4F - Fr N BERELXT,

>7)b « L'— b (Sample Rate))
ZDOAZa— - RE T A=FT4A - H2T) - L—bEFEL XTI,

> 7))V (Sample Format)
IDAZa— - RY 2T B TIVBERERELET. J 2 TN
F—T 1A - BTN EXRTEMEF T, [Unsigned integer].
[Twos-complement|. [Float). Double] DOH175ERL L9,

> 7 )i (Sample Width)]
DA a— Ry T YT INOEEZRELET, > TN OEIA—F «
T F—FOHE—H T )EEY ML WBEIZ8 Ey FOEHKLS 8. 16, 24)
TERLULET, BAALEDEFE F—FT 1 A RBIHAKRT Y FIvr - L
CUERENMEL ET,

[)NA b« F—% — (Byte Order)]
ZDAZa—+1R"¥ T, IBig Endian] 7 [Little Endian] ®/NA b » F—
Y — B ET,

[5—% « F 7+ v b (Data Offset))
F—=FaF - Ty AR EEOF—F 1 F - T —F DI v ¥ EHRO N
MENTVREDNHVET. T7—F - A7ty M. ANvFD (F—FLS
D) NA MERLET, BHT27 7 1)V Y FERBMFMENT NS5
Bl Hlnwsr—% - F 7ty FEANTLET,

007-2275-010aJP



F—F 4T INT A= DIEFE

[45—% % BOF IZ4#: (Convert all data to end of file))
Ines )y r35E, Ty AVNOTRTOT=FNERINET, TT
DOF—F ZFWETIT, WEL 2T - 7 L — LB T 2 EHRT 55813,
(8419 % 7 L — LR DFETE (Specify number of frames to convert)] 227 U v
7 LUET,

[E#E /4 2 (Compression Scheme))
IDAZa— R T, =T« AOEMIREHEL £

mediac_aoutput

F=FT 4 FAHRHANRSA—HDIEE

HWH7 74 NVOF—F 1 F - NTA=FZI/ETSHIE. £9 Media Convert] 71 > RTD
[F—5 1% - )NT A—% (Audio Parameters)) DRI H D/NIIRIEFWDREY > %271 v 7 LT,
IF—5 1 A J1)XF A —% (Audio Output Parameters)] 7« > FUZHE LT, [F—F 1 F
HAONFGA=5] T4 2 RUDOAEIZ. BERLZT 7 AIVBERICE > TRIZD KT,

AEENT TN - L= om0 2T )b - L= MIEBRLEGER. it —F5 1 F -
T—H R ENTITIEOT — Y OEENFEL £,

77 AMVBRITEC T, ROFT 2 3 > D5 3 DL ENFRENET,
[F v > )b (Channels))
CDAZa— - RI2T A=F 14 - Fr o FNVEREREL LT,
>7)b « L'— b (Sample Rate))
ZDAZa— - RF2T A=FT4F BT L—bERELEXT,
> 7K (Sample Format)
IDAZa— R T, TR ERELXT. ¥ 7IVERL
F—=T a4 - BTN ERITBUERKTY . [Unsigned interger].
[Twos-complement|. [Floatl. Double] OH17»5ERL X7,
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I > 7 )V (Sample Width)]
ZDAZa— - RY T Y TINOEEZRELET, Y > T INVOIEETA—F «
T TF—FOH YT Ety MMLT, @HIL8 Ey bOBEKME 8. 16,
24) TELET, @BNELBBIEE, A—F 1+ T HEICHERT 2 FIv -
LoD EBENMELET,

[N b« #—4 — (Byte Order)J
DA —F 4 F - T Y TEMTZEE, CDAZa— K% T, [Big
Endian) 7 TLittle Endian] ®O)NA b« A —4 —Z2 RN £,

[E#E /7 2 (Compression Scheme))
IDAZa—+RY T, =T 1 FOIEMHREREL £9 . MPEG %&R
LTWaEEIE. EMREZNAI YA X TEELT, FMICONTIE, 76 X—
20O IMPEG 7 7 1 VOIEMDH ALY XA X 2B L TS0,

IF—7 1 71X F A—% (Audio Output Parameters)] D&ZEMNE T L5, [BAC % (Close))
Ry &Iy UET,

mediac_compression

ERBREDHRITA X

e #7487 A—% (Video Output Parameters)] 7 1 > R £/=id IF—F 1 F /85
A—2% (Audio Output Parameters)] 7 1 > R @ [ (Scheme)] A= a2— + "% > THHMEA
FoLEBERTDE, g 2 RUD TEHE (Compression)] FEBIDNEIT I A5 L JFEHEDZERN
BERMIELIENTEET, BREAIIR. #FHTSEMOFEEICE > TRADET, ROH
MHE. BETEHIEI Yy I L TLEI N,

o 74 X—® TQuickTime ¥ 7213 JPEG JEfi SGI LA—E—DEMDH X ¥ XA X
o 76 X—=2® IMPEG 7 7 1 )VDJEMED I ZH <A X

QuickTime 73 JPEG E#E SGl A—E—DEHDHRI A X

74

QuickTime %7213 JPEG JE#i SGI L—E—#{ET 25, KOS5, 1 DELIFEMOEHM D
A REHATEET,
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EMEREDHAY A X

007-2275-010aJP

AE:TEFHHIINT A—% (Video Output Parameters)] 7 1 > R TRESL T 1+ —I)V K97
L —FRRINZDGEENH O ETH, THUTRIRL 2B MOBEIIFEHTERWI LERLET,

o ROWTNMEBERIRLET,

[7E # W& (Constant Quality)]
2745 % EFCEN L CTRELZGELNVICERELET., mEERD
eH, Ev b L—hEEMIETL—E—Z2FEKRL X7,

[5—% H Ol (Controlled Data Rate))
INEIRIEAHDAZa— Ry 6, FEOEY - L—hEERT S
(K 2-12 Z8) . £REBIOT7 11—V RIZFEDEY b« L—bhZEAN
LET, L—E—2EKTZDOLNIPMRENDEDIT. Ev b L—FN
I NnEd,

YEIEY D L PAEWEEETAREN LD XTI, EMRIETL T,

& F— 5 hEOHH |
By ke L= (¥ ) [ 5000000 ] vl
5 Mbis
¥ TL—L __1 PSS 10 Mbfs
20 Mbis
7| 30 Mo
40 Mbls
BRI 2 i o= T

Eg2-12 TEw b - L—h(BitRate)] A=a— KT DA

o F—-TIL—-LOFEHEEZRELEXT,

[F— - 7L —A (Key Frame)] 7+ =)V FIZHLWHEZANLET., £EAE F—-7
L—L AT az10IC&KETHE 10 7L—LBECF— - TL—LITRVET, Z
DENRKRENVIZE, EMREFEEENENDET, 2L, IEIEREHTL—E—%
FBIELTRRSZ 7L —LE2FRRTIHEEIE. F— T —L4 -T2 aOENNIWHN
FORDEIECBIB O EEIEICERTT,

o JEMiTIY2EERLEYT (X7 3 >® Cosmo Compress™ h— FZ2%HL THHHE
DH),
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Cosmo Compress " — R Z AT 5I121E, =Ko =7 -7 27+t J L —% (Hardware
Accelerate)) Z3EIRLU £, VI MUY EMEZTEHFEATZITE. VT Uo7 ERM
(Software Codec)] % #EIRL £7,

MEeF4 #1185 A —% (Video Output Parameters)] W+ > RUDHRENT T L7z, L2
(Close)] Ry &7V v I LET,

MPEG 7 7 1 VDREHDHRH A4 X

76

AF 47T - 774 )&E MPEG BRICEMT 254G, TEFAHIJ1/NT A—% (Video Output
Parameters)] 7« > RO £7id I —F 1« A1 77/8F5 A —% (Audio Output Parameters)] ™7 1
RUT, ROAZY LIEKEREEFHTEET,

e TEwh-L—h (BitRate)] (TEFFHIJI/NTF A—% (Video Output Parameters)] 71 >
R DH)

MEEw &« L— b (Low Bit Rate)l. [CD Ew  + L— b (CD Bit Rate)] (CD-ROM T i
DEY h-Lb—F) . £&Z EEY - L— b (High Bit Rate)] ZZIRL £, —#ic,
Ey b L—=hDERENMENIEZE, ERESNDT 71 - A Z3/NS<BOETH, i
R TLET, —H, BENEWIFE, Ty )b - A ZXANKRELZDETH, BEHM L
LET,

o [F—-7L—A (Key Frame)l (TEFFH1/VF5 A—% (Video Output Parameters)] ™
PRUDH)

[F—+ 7L —LA (Key Frame)] 7« =)V RIZHLWEZANL T, F—+ TL—LDFHAE
HEEZRELET, ZEAE F— - TJL—A - FT>alEBI0CHRETSHE 10 7L —
LBEZF— T —AIKRKRDET, ZOEMPIKEVIZE, EMEREFHEREN END F7,
72720, SEIERBATLA-—E—2ELLTRRDZ VL —LZ2ERTDIESE. F—- 7
=25 - T3 > DEIVNS W NZEIR DO 1B DEEICEFRITY,

e [MPEG-1 &E/S*)L (MPEG-1 Settings Panel)] ( TEFF / F—F 1 FHH/NTA—%
(Video/ Audio Output Parameters)] 1 > K)

EF 441787 A—% (Video Output Parameters)] ¥ « > R £zl [F—F ¢ AN
Z A —2% (Audio Output Parameters)] 7 1 > R D —&F T, I MPEG-1 & & /N %)V
(MPEG-1  Settings Panel)] ™% >NERENET, MPEG-1 /¥ T A —% (MPEG-1
Parameters)| 7 > R & <ITIX. NSRBREHSBORY > &2V v LEY, MPEG JE
HENTA—F BN AIRAZXTEHT 4> RUNPKRRINET, M2-13 2SR T 7Z30,
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EHREDH AT A X

E2-13 MPEG Efi & HAI XA X BT 1 > R

IMPEG -1 /%5 A—% (MPEG - 1 Parameters)] 7 > R7iZid. &£ D &ER MPEG JE#f
BEERHHT DF T a > HERINET, RIT, TNSOREIC DV THBEIZHIAL £7°,
ZOT 4 RUDORET T THUS (Close)) 227Uy 7T5E, RENKNRIEOE R
IEASINET,
TEF4Ew b« L — b (Video Bit Rate)]
100 Kb (100,000)/ ¥~ 4.5 Mb (4,500,000)/ # Qi T, $EDLETAE
WEY R L—bh2ANTELET., Ev b L—FEEWVEES AV
BamEUETH, JEMRIMETFLET,
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78

(7 7 1 )L & JLER (Prefiltering))

AZa— - RYEFEMALT, 720 (none)l. P (medium)l. F7/=iZ
[ (maximum)] 7'V 7 ¢ L UEZBRRL £, 7V T 1)L F 0%
19 &, ANBEBRNPAL—XIZRY, EfETOoeZAnEEbInEd. =
U, A A=VEHEIMEFLUET. 7Y 70 VY AEIZ. ANEBRICKE
D/AX (BERETE - 57—%) BDA->TWED, FEFITENEY k-
L—bD7 7 A IVEERTDHEITHL THWET,

(287 L — LAREEEE (Distance Between Reference Frames)

ATA T EHNTE BRI L —LMOEMNELLET, ZNT, 1
(intra)). B (bidirectional)l. TP (predicted) ] ® 7L —LAh « NI —2D
BENLT <20 ET, MPEG JEMIZ. @, &7 L —LZFEBICEM
VI, TLV—LDT N —THATIEMRL £, ZOHA. &7 L —2413.
TN—THNOTRTORIOT L —LADHHREINBEICEIHHETEE
T, IT7L—LEPTL—LEBRTL—ATY, K2-14 28R T
IV, TSI <HIET 2. AT —IVOEEIZH B /NS R KEIR S
CEIZUILUET, EEEN1 7L —LTOBEILET,

TR T I — ABOER = 4
| ZL—ARDIERE =16

I BEEBEPEEEBPFEBEERBEBPEFEBEBETI

4 4 4

VAN

16

®2-14

FEFED T L —L » INF — 2 D

T 7 L — AfEEBE (Distance Between I Frames)]

ATATEHNT L BRT L —LHOERBENELET, INT, 11
(intra)l. B (bidirectional)l. TP (predicted) ] @7 L —L « NFT—2>D
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EMEREDHAY A X

007-2275-010aJP

P 7L —LA:

P 7L —LA:

B7L—LA:

B7L—LA:

RENLDT <D ET, MPEG JEMIZ. @, &7 L —LZFEBICEM
B, JL—LDT )N —THTEMLET. ZOFE. &7 L -4
TN—THNOTRTORIOT L —LADHHREINEBEICEIHHETEE
T, BTN —=TOHREOT L —ALIE, F— T —LEREINET, 17
L—LFF— 7L —L4LTY, K2-14 2L TLZI N, I5ICHIN<
T 51213 2 =)V ORI H B/ IR RKHRY &= 0w 7 LET,
FEEES 1 7L — AT OBHLET,

N7 & @O E) (X)(P frame: Motion Vector Range (X))
CDATAFZHINT E P 7L —LBEEHNT ML DIRINJ5 R HFH A
B UET, —RIC. MBHPESKEVWEZEESFEEN M EL I 5
JEfE T O 2 HTF'EM‘%J\# DET, E5ITHIN<HIETZIZIE. A=)
OHEENCH B/NSTRRERY > a7 )y 7 UET., MRBHFHN 1 DOBEIL
3

N7 & @O E) (Y)(P frame: Motion Vector Range (Y)).
:@x54ﬁ%ﬁﬁ?a P 7L —LEHNY L OEE S AR R )
ZLUET, MBI, RBEPFASRKEVWIZEE T AEEN M EL ET 5
JEfE T O 2 HTFEJﬁ‘fJ\ﬁ\ DET, E5ITHIN<HIETZIZIE. A=)
OHEENCH B/NSTRRERY > a7 )y 7 UET, MRBHFHN 1 DOBEIL
3

N7 & @O E) (X)(B frame: Motion Vector Range (X))
:@X%{ﬁéﬁ@?t B 7 L —LEBNY NV DK R P A
ZUET. — I RBHBELPRKEVWZEEETAEENMLEL 925
EfE T O R HTFEJf)‘fJ\fP DET, E5ITHIN<HIETZIZIE. A=)
DN B/NSIRKARY > %27 1) v 7 UET, MREEN 1 DBEL
3

N7 & @O (Y)(B frame: Motion Vector Range (Y)).
;@X749%ﬁ#?& B 7 L — LEHNRT )L D S5 [ R P A
ZUET. — I, RBHEPRKEVWEEETAEENMLEL 925
JEfE T O R HTFEM‘%J\%P DET, S5ITHIN<HIETZIZIE. A=)
DN D H/NSIRKARY > 27 1) v 7 LET, MREEN 1 DOBEHL
3
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31—5+¢ > - L1V (Coding Layer)]
AZa— Ry EEMTHE RNEZEZ2HBHOI > O— REZER
TEXY. 2FHOBEOH WA —F « AWMENA LU ETH, 25 <E
ML X9

F—F14F-Ev b L—F (£/7)) (Audio Bit Rate (Mono))!
AZa— R M F—F o FEREY b - L—FERBIRTEET (£
J o F—=FaF Ty AINEERTIEE ). Ev b L—FPEVEE
TEMNA EUETH, JERRIIETLET,

(F—F1F-Ev b L=k (ZFLA) (Audio Bit Rate(Stereo))]
AZa— RIS —F A FEMEY b - L—F2BIRTEET (X
FLF A —F AT T ANEERTEHE ), Ev b - L— hAsEnL
FEEFTEMNMELUETH, EHFIIETLET,

[F+ > %)l » £— R (Channel Mode)
ATVF - F =T 4 F - T ANOEBERNTY, AZa— Ky M5,
[ZF L (stereo)) 527 )b (dual)l. £7&1E MHE (joint)) OF v > %
- L2>ad—K - E—FZBERNTEEY,

X5+ Ew b - L—b (System Bit Rate)]
150 Kb (150,000)/ #~ 5 Mb (5,000,000)/ > D#FIT, HE D> X F A
(MPEG F—F«F / ETF) 77 A IEMOE Y b - L—hrEANTE
F9., Ev b L—FNEWEES A-VEEN A EL EI, EMERIX
BKFLEY., 2B, [ AT L (systems)] DEwY k- L—FE, #ET2
F—=FT4F - T7ANVEETH - T7AIVDGEFEY b - L—hXD/AE
SEETEEHA

DN 27« 414X (Ew ) (Pack Size(Bits)).
77 )V F T, B CD-ROM A —H U > ZIR@ERE Y k- )Xy
A RACHEINTOWET, AT FEBNT &, Ny - P10
2UET,

MPEG -1 /85 A—% (MPEG - 1 Parameters)] 7 1 > R IZI3, ROBEREH =D 7 7
£ (File)] A=2—7%BHDET,

80 007-2275-010aJP



AN T 7 AIEREE T T 7 1 IVE#R O Lk

57 )b % 5E DIE I (Restore Default Settings))
MPEG - 1 /)85 A—% (MPEG - 1 Parameters)] @ %€ %, B —#E
CD-ROM 7 —HY > 7 RIZEE T T3 Media Convert OF 7 )b k
BREWCRLET,

[ —H%E DR (Save User Settings)]
MPEG -1/%5 A—% (MPEG - 1 Parameters)] /S%IVIZ, IT—FDOEE
ERELET.

[ —H R E Z1EIC (Retrieve User Settings))
REBO 11 —TRE DR (Save User Settings)] DEREFICLRAEL /=
MPEG -1 /%5 A—% (MPEG - 1 Parameters)] OF%EZHEITLE T,

mediac_comparing

ANTZ 7ANVEHRELNT 7 1 VRO LEE

ANINTG A =5 EHNINTA=F DFELWHBZERRT 21213 ROFIEITHE> T ZS W,

e [Media Convert] 7+ > RU®DEHBRICHZ/NS/RY > 22 )y LET, M2-15 %
B L TL /230, Media Convert 235K S 1. TEEHIE R (DETAILED INFORMATION) |
ENSHRY Y a UNFRINET, 2OV 2 a OFMICDONTIE, 85 X—=2 0 M5
MEHR) £y a) 2ZBRLTIIZS N,

&g Vs LT TEMEEE(Detailed Information)) 73 »#8<.,

Ty @E

[ é b
| g5 K277

—

E2-15  [##1% % (DETAILED INFORMATION)| + %3 =3 > #&BI<

| s
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mediac_controls

Media Convert DM % 7 = — Ri&i&

Media Convert 21, ROA > T —AWHD ET,
o RR=VD [MT7A)V] AZa—]

e BR—TYO TAHOa>+O—)L]

o 85 XR—TO [MTFEMEHR £V a )

e S7XR—TO MHHarhho—)b]

o 89R—TD [TRkEI. TEIE), THIE R )

Z274)I0] A=a—

Media Convert ® 7 7 )V (File)] AZa—ICid. KROBREEIBH D £,

[ANZ 740 ERL]

T7AN - TIUF - U4 P RUNST 7 AV EERTEET,

TBh7271NVER<]

WO 77 A IVERRLEZD, ZRIEMTZZENTEXT, Mh 7y IVEERET>TL—1
(Output File Name or Template)] 7 1 —JL RIGER L 4R RINET, BEEOT 7 1)L
ZBINL T THLR (Start)) R > &#TE BEOT7 7 AIVEH N7 7 AV T LEZINET,

[F—F4FANT7 74NV EEE]

(%#:9 54 —5 1 7 (Audio to Convert)] 7 —)V R&EHEL £T,

TEFFANT7 7 MIVEHE]

(#1935 E5 4 (Video to Convert)] 7 1 —J)V RZHEL £,
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TMADANT 74V EHE]

M&71

AADaresao-jv

(78419 % A —5 « 4 (Audio to Convert)] 71 —)LV K& 2419 % E5 4 (Video to Convert)]
T4 =)V REHELET,

Media Convert Z#& 7L £7,

ABrar bho—)lid, 9T [Media Convert] 7« > RUDEMIZH D ET, F£AHI> b
O—=)LIZDOWT, o > RUKRFERINDIEFTHIHELET, —SBOBAEIL. FEISC TER
ENFEY, A, B (Input Start)l « &7 (End)) « [AF v 7 (Step)) . &5l (Total))
T4 =)V RiZ. —HOBEMNEAA-DELAWMTLIGEEETERRINET,

[E|TB3F—T«+F] FAOv 7 - Ry bE TERTBETH] FOyT - Ry b

NAZ74—=JVE

ANh&47-arra—-iv

007-2275-010aJP

ROw 7« Ry M, BITCOA A—=D, F—FT4F, L—E-REDT7AINDTAA %
ANDHHTY . =T 14« 77 4IE BT DF—F 1 F (Audio to Convert)] RH v
TRy M, FRLUANDOAT 47 - T 71 INE TEHT S ESFF (Video to Convert)] RO
TR Ty MCANET, F—F 14 FELETHAEFVL—E—DT7 1% [EWMTEHETFA)
ROy 7R 7y MANS &, TE#ET 24— 14 RAy T - Rry MZBFEUT A a2n
FREIN, L—E—RFT—FT A INFTENTNWLZEERLET,

INAT 4=V RIZE, B0 7 7 A VOLRTERELET. T 74N FTIE =4 F+
L7 NUDNKZAENERINET, ROy T - Ry M7 a>z2ANnNs &, X247 14—
ROEHFICEHR I, TOT7 A1 ADNNALNERINET,

ANEZAT - a2 bO0—)VEFRAL T, BHuTofE a0 A—2 - 77 M)V ERIFESIE
AA=YDTI)N—") ZfRELET. ROy T« Ry bEEEBNALT 1+ =)V RZFEHL TH
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BHEDA A=Y (FZEZF. imgl.rgb. img2.rgb. img3.rgb) #5851 L7 FU D4
ZHIRET 21T, [BEMNEDA A—2 (Numbered images)] 271U v 27 LEY,

ANWZ274N - TTV—F

FEAssl 74—V K

M&T1] 74 —JVE

RFv71 74—=JVE

A5tl 74—V E

84

ZDT7 14—V RiF, BEEMNEDOAA—VEAMTLGEEICRREINET, ZNEMFERAL T, £
DT 7 AINVOARTERELET., 77 AIVAERETHHIE. DTHEOASMELZIEET S
EEFBELTLESW, £&2E, T4 L2 MJIZ imgl.rgb. img2.rgb. img3.rgb &
ST 7 AINIPMRESI N TVWSEEIL, img#.rgb EATTLET,

ZDT7 4=V Rid, —HOFSHNEA AT eBMWTLLERICERINET. 2071 —IVRIC
3, —EHOA A=Y ORBESEANLET, 2 A, ingl.rgb ~ img20.rgb & WD &ipH
DAA=D - Tr7ANDBHD, img2.rgb MHRBTHEHEIT. 2071 —JVRIC 2 EATL
F9, BEEANLES. BT <Enter> F—&HL T ZI W,

ZDT7 4=V Rid, —HOFSHNEA AT eBMTL2LRICERINET. 2071 —IVRIC
F, —HEOA A—VDORTEBEEANLET, 2&ZE. imgl.rgb ~ img20.rgb &\ D &ipH
DAA=D - TyANDHD. imgls5.rgb TERTTRHEAEFRX. 2071 —IVRIT 15 EANL
£, HEEEANLEZS, W7 <Enter> F—2ML T ESI W,

ZDT7 4=V RiF., —EHOBEMEAA—DEEMTIYBICERINET, 20T 1=V R%E
FHALT, 2T A—J2FELET (ZEAE IXRT, 1DOBE, 30k, E
AN LS, T <Enter> F—2IL T EE W,

2071 =)V R, —HOBFSMNESN AT EZEMT 2HEBRCERINET, 207 1=V RIC
3 AT LSESBELEAA—VORNEREINET, 1 A—TIF. T (Input Start)]
T4 =)V R, &7 (End)) 71—V R, [AF7 w7 (Step)] 71—V RIZEDWTHEMWICEE
INFET, BiEZEZASILEZS, MT <Enter> F—2FL T /Z3 W,
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TETFAANNSA—H]1 KRy >

ZDRY N, ARV BT DBEICERINET, 66 R—D [EFFANNTA=FD
f8E] Z22RLTLEI N,

ME¥dEsER) €o>ar

5 7 4V b TiE, TEEMNE ) (DETAILED INFORMATION)) &7 > a Y I3RRINEH A
Media Convert] 7« > RUDHRIZHDB/NSBRY 22200 v rT5E, FHMER w27
2arEEVWEVALEZED TS ZEMTEET (M2-152R), 2o/ a 3AETEER
o ZHUE, ANT7 7 ANV ERNT 7 AIVICET 2GR ZRHT 20D HDTT, KIT,
Media Convert] 7+ > RUICERREINDIEICE T 1+ — )V RITDWTIHBRIZHAL £7

Fv>o 2l 74—=IVE (F=F 1 F)

AN T 7 AN F =T A ANEENTNWBHE, ZOT7 1 =)V RIZEF ¥ oIV OENERIN
£9, Fyoxd, M LAEF—F A A DA RN —ATYT, 1 £REF200BRLET, &
ZE B INVBEFICRE—OF—F 1 F - FY ORIINBEFEN. AT LARFIE2D0F v
S BERE) BNEENTVWET, FroxIod, 77y 1)L - 31 ZXEBELET, A7
LA s T7ANOHA X3, /I - T 25120 £,

M4>7W-b—bFl Z4—=)VE (F—FT1F)

ANT 7 AICF—F 1 AMEENTOBEHE. 207 1 —)L RICZANEHN OB > T L—
RERINET, F2TI - L— R & A—F 14 - H2 TN ekE. BETIEET, A
VY (Hz) B CESNET, 1THZzOF> T )b - L— R, BB 19> FNEELET, HEx
B/ SNOTFOY - A —F 1 HEBE 48 FOALY (KHz) DY T - L— R TFEUS
MET B &, (EBOEHTEIZ 48000 HOFUH )L - 4> TN ERINET, $> T+ L—
RASEVIEEREERS EAD ETH, ERIND T 71 ILOTA Lo RkE B ET,

M7kl 74—V (F—F1F)

AT 7 ANCF—F A ANEENTWEIEE, ZOT7 14—V RRIEAHEHETOY > TINIER
MERINET, YOTNBERER F—F 14 - TN E2RITEEOHATT,
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> FIVE] 24 —IVE (=T 1 F)

ANT 7 ANCHF =T A FNEENTWEHE, ZOT7 1=V R T 71V - 2TV OlgH
FRENET, YOTIRER, =T 14 - T—FDH—F 2T EZERTEY MT, @HIZ
8 Ev hOEELE (8. 16, 24) THRL XY, EALVWEE, F—FT 4 ARHITHETLY 1T
Sy LT EHIENRELET

TE#HE] 74 —IVE (A—=F1F)

DT 4=V RIE. 77 MINDEMAF—LERLET,

rNFsvoRl 24—=IVE (F—=F 1 F)

[t w7 & (Track Length)l 7«4 —J)VRIZIE, B> T - JL—LBTH—F1F - ~hIv 7D
DEIMWRINET,

ZV—AME] &£ T2V—AB]1 Z4—=)VE (EFH)

D74 =)V RIZFE. ANTL—LEHMN TV —LDYA XNRE T BIVEAL TRRSNET,

Z2v—A-b—=Fk1 74=)VE (ETH)

FETHHE 0TIV R AN T ANV ERT Ty ANVDT L —L s L= ERLET,
TLl—Ah - L—1M3 BRREEELIRRINDG A A—VOKTY, 7L—4 - L—EMENIZ

ERBMWD . T4 AV HEBEPEHNTEET, REMHENIFZERHBIEZ, L—E— - T7A
WMRELIEDET,

M9 V—2R1 714—=IVE (ETH)

86

ZDT7 14 =)V Ri& 7 7 1 IIVIFEA >4 L — X (Interlaced Odd). 1Bk > % L — X (Interlaced
Even). £7/13/ > - 1 > % L — X (non-interlaced) DWW§NnERLET, 1 ¥ L—Rid. #
BIA4—IVREBE T =V RIRETH7FOL - EFHEFTTT, /21207 L —3.
7574y A TATTATHESNGA A—VOFEERLT, &7 —AIKH—7 1 —J)LR
DEINEZENE T,
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Aml 24—V & (ETF)

DT A=)V RE, A A=Y DAENTNS B ENSTAERLET., #@E, V7 hUzy
3 TS EMERA A=Y - F=F 2 REL, EFFEE (VIRPHAT) F LS FRIC
A—TEREFELET,

TEZ2®IN-7ARI M 74—V E (ETF)

Bt TAXRT ME. HEETVINOEEZERLET., FLEAEDA A—=IF, EHEOE &
IWTHRENTVWET, ZOEN. A A—TYDEFTH -V —ZM CCIR 601 EFF B (NTSC
HA4I7MHE) OEEIE. CCIR601/525 EWHE V)L« T ARY MIERDEEHHD £,

res el 74—V E (EFH)

ZO74—=)VRid. EFH - bIvro sl BELERLEY. B 0VELER V7RIV
WE (Hadrzooty M) L@zl (E54 - Iy 7 2ERT 258 IS5 RGB
YUV R EDQEBEFDE) TRINET,

E#E] 74—V F (ETF)

ZDT714—=)VRIE EFF - Ty A INVOEMAF—LERLET,

kv oR1 7Z4—IVE (EFTH)

ZO74—=)VRiE EFH - FIv I DREZTL—LETRLET,

HAharro-i

HAWRME T3> hOo—)lid. Media Convert] 71 > RUDOEMICH D £9, KiZ. ERS

NBZMECEH T PO—)VIZDWTHIAL E9, —HMOMEEIE. FBEICECTERINET,

t&x 3. TBA%E (Start)) 71—V R & TXF7 v 7 (Step)] 7« —I)V Rid, —HOFEFFEA A—
”“Tﬁ""@‘é%ﬁtb‘i\%i“éhiﬁ‘
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HAHAT 271 &R

A AF 1 7 (Output Media)l £V TRVOHETIE, 1 A=Y, F—F 1%, EFFTOH
DL—E— F—FT 4 FBIVETAMFEDL—E—TE, BRINTVDEHEEHOHNSERT
577 ANERBRLET, LA A—F14F - T7MINVEETE - TrANEYT R - b
T INEL—E—ERTIEAL. TA—E— - T71) (A—F1FEEFH) (Movie File
(Audio and Video)) | Z3EIRL £, BIREHIEX, AN 7 71 IVIIS U THEARGERIER 2107
RENET,

N7 7AW ER] Aza—-KRs>

(7 7AW (File Format)] AZa2— + R 2T 1ERT 27 7 ANV OEEZRIRTEET,
ZORY A BRULEANT 7 7 IS T, HHTEZ@REHEINERINET. /=
EAE AT 7 AIVHSGLA A=+ 7 7 1 b O, IMPEG-1 #+—5 1 4 (MPEG-1 Audio)
FFERINER A

[F=FaF - NSGA=H] KRS

F=F4F - Ty AN T R bIvINEL—E—EERTIHE. ZONSRIELAFED
RV wI$BE [F—F7 1 FHN/NF A—% (Audio Output Parameters)] 1 > R
UMERSNET . 71 R=DD [F—=F 14 - NIA-FDfEE] 2R TSN,

TETF - KSA-51 Ky >

L—E—RA A= « Ty A VBT DG, ZONIRESBORY > EIU Y ITBE,
e iJ3/X 5 A—% (Video Output Parameters)] 7« > RUNKREINET, 68 X—TD
TEFFMNINTA—F DIFE] 2B T ZI W,

[AMA=D - YA X] KY >

B A=A A=20F1 L 7 NI REMRTZEHE. ZONSBRIELSBORY &I D vy
T5&, M A= - PA X (Image Size)] 71 > RUNPEKRINET, 62 RXR—2D [{ A= -
YA ZXOEHE] 22 L T EI W,

88 007-2275-010aJP



Media Convert D > % 7 = — A ik

BAZ77ANBEERTTV—F] 74—IVE

MGkl 74—V K

RFv71 74—=JVE

M7 7 A% E72137 > 7L — b (Output File Name or Template)] 7« —)L RZHL T,
BT 27 7 A NVDONALEIEELET. T 74 TR HLWT 7 A IV outfile &\ D £
PR ENET, —HOBESHNEAA-VELZBTZHEE. 771V AI # ZEBEMUET. #
BERBICERZSNET, X 1 A—JIT outfilel. outfilel. outfile2... &5
LM 28518, outfile#t EANLET,

ZDT7 1=V RiZ, —HOBEMEAS A—DVICEBT DI ERINET, (LA (Start))
Ta—=IV R, TWh7 7 AV EEET > TV —h (Output File Name or Template)] 7 —
IWEEHEB L TEELET, H7> 7L —bAZ AL THS <Enter> F—2#H9 &, [H
Bl 74—V R& ATy 7 (Step)) 74— IV ENRRINET., TNHDT 1 —I)V RITHEET
LEICHUT, W7 7 A IVARESEMT2HEMREDET, LEE 771V & F
37> 7V —b1 71 —)V RiZ outfile#. MBASA) 71+ —JLRIZ5 %TE%?‘% &.outfiles,
outfile6..EWVWS 7y A I AIT/RD £,

(27 w7 (Step)) 74—V Ri&. TN 7 71 )4 F721d57 > 7L — b (Output File Name or
Template)] XU Btk (Start)) 71—V REEEHL TEHEL £, HhT>TL—raZEA
U THS <Enter> F—2#HT &, [BlE) 71—V RE X5y T 74—V RRERINE
T INBEDOT 14—V RIEET ZMEIIEU T, A7 71 INAICEFSZMT D HENRED F
o REARE THH7 7 A NVAEREZT > T L —F] 71—V RiToutfile#. MBI 71—
WERIZS X7y 7] 74—V RIZ2ZEETD &L, outfiles, outfile7. outfiled.. &
WS 77 AIVAITIRD £7,

MGG, TFiE). THGH] R >

007-2275-010aJP

BT E DRI > 72 6. TBA (Start)) Ry > Z2MUET, —RICEB 2 EIET 2121 TE
1k (Stop)) R >, EHZETRICEIETHEE THBUE (Cancel)] 1% > &ML £,

mediac_shortcuts

89



%5 2 ¥ : Media Convert

Media Convert DF—/R—K - 3—brhv b

Media Convert @ 77 )L (File)] A > + AZa—, BRIZOHVT A 2—1ZiF. =—F
Zwl - F—FKR—K-Ta—-bIHy EPHDET,

ALY  AZa—DF—AR—K -2 a—bhy MIROEBDTT,

7741 (File)J
<Alt+f> F—

(7574l (File)] AZa—DF—F—K- L a—hkhy MNEROEBDTT,

i AN 7 742 < (Open Input Files)|

o M7 7 1)V ZR < (Open Output Files)]

a [F—5F 4 F AH7 7 A1)V %ZiHZ (Clear Audio Input File)]
v 54 AJ17 7 1 )L &2 (Clear Video Input File))

c M 5 DAT 7 7 A )V ZiHZ (Clear Both Input Files))

x &7 (Exit))

MPEG -1 /8T A—% (MPEG -1 Parameters)] A=a21—®D> 3 —hrchy MIXROEBDTT,

d 157 4 )b h3&E DIETT (Restore Default Settings))
s [ —H%E DR (Save User Settings)]
t [ —Y%E %18 7T (Retrieve User Settings))

mediac_troubleshooting

Media Convert D NS 7)) a—F4

Z DHITIE. Media Convert ODFEHHICE Z DR[O H 2 T T I DN DMMIT DWW THEAL
£7,

o —HOFSNEDAA-—IVELMITDEE, THIHJAFT 17 (Output Media)l K% > A%ER
IR TERN,
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Media Convert ® s 7))V a—F 1 >

007-2275-010aJP

[7574) -7 >7L—h (File Template)] EHFESMITHIEEAN LK, [Ty - T
7L — b (File Template)] 7 « —)V FICH—V )V ZRL TS <Enter> F—Z#ML T, M
71 AF 47 (Output Media)] 7 a > &EHL TSN,

AT 4 =)V RICH LW T 7 A NERT LI BUKAZAN LN, Ray T - Ry v b
ICRRENZT A a2 DNEE> TWa,

INZZT 4 =)V RIZH LWARTZATLTNHhS, XA T+ =)V RIThH—VIIndHbHl L%
L. <Enters> F—Z2L TL/AZ3W, INT,. ROy 7 - Rry MAEHRINET,

MPEG 7 7 1 IVEMERL &5 & L7z & T %, Tbad video bit rate... Only 100Kbps - 4.5Mbps
supported] F7zld Tsystems bit rate... too small; total data bit rate is already...] &£WW>5 T
F— s Avt—INERIN5S,

Media Convert Ti&, Ev b - L— MNCZHIRZH O T, ZEAE, P RATL-T7 1)
3. ENEMRTIETE - Ty AINEF—F 1A - Tr7AINDEY ;- L—FUATIZIZT
EEth. TOHE. VATLEVvh-L—=—bFEEFTE - TN EF—F 1A T A
LVDOEY b L—brDOEFEIORENVE (TF5— AvE—JITRSINE [REtF—% - Ey
belb—b Bb) REETLZLENHOET, BERLAEEY b« L— b7 100 Kbps A
$7213 4.5 Mbps 2B A5 5EE. ZOHPBENTHLWEZERL TZEWn, #Flicon
TiE, 74 R=20 [EMEHREDHAZIA X 2B T 7EI W,

BEOA A=« T7AIVEIERLELD E LM 1 DUNMERI NN,

7 74 VA E7IET > 7L — b (Output File Name or Template)] &5 71 —)L R
EHFNTLIZEN, 20714 —)VRIZiF. T74)VFToutfile EVWIHAFIMNATIINE
To RO A=Y - Ty AN EAHLTEH, ZOAFZEEELBNNED outfile &
D1 D077 AIVUDMERINERA. BEDA A= - Ty AIVEIERT ST #7
EEOANEIEET 2REND D ET., AT, outfilet DXIIHHELET. #ilH

13, BHPICERICEBRZSNET,
Media Convert "5, FHIDEZI DA A=V ZBWHWTEHEND Ay —IUNERI N

1|

an

Media Convert &, [BA% (Start)l. #¢7 (End)l. [ZF v 7 (Step)] D&% 7 1 —)V K&
RTC, BRI DA A=V OREHE L £9. AL THIA) 121 # 71 12300 TA5 Yy
T2 1 2IRELEBEE. 30O A—VEERTIHO I HEINET, IFELEZT ¥
ANBT>TL—RNZ—ETBH30BDOT7 7 A NVDREBIZHEZNEINEF v 7 LER A,
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3

Movie Maker

ZOEZ. ROHNSBRINTNET,

o THEEE] (93 R—2)

e NAU®IZ) (100 R—2)

o [A—E—%ZMHE HLWVWIU YT ZEBINTS) (105 X—)
o [fRHE (109 X—2)

o A MLEFERDMERM (121 X—2)

o HNRAT7 4 FDEM (129 X—2)

o [IFHFRROBRE EFAA] (141 X—2)

o [A—E—DXRAEDHIE] (143 X—2)

o [A—E—FHEFTTa>loOlEl 147 X—=)
o [LA—E—DIFIAR—I]) (147 R—2)

o TEFHTF—T O (150 X—2)

e Movie Maker D1 >4 7 = —AKiE] (152 R—2)

mm.overview

=

Z O, ROEMNSHEREINTNET,
e 94 RXR—T® [Movie Maker DHEHE ]

o 94 R—T® [Movie Maker D 572 : i DFEST]
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%5 3 % : Movie Maker

Movie Maker D#EE

o 99 R—TD [N TDELE

mm2.what

Movie Maker i3, EFF, A A=, F—F 4 ISR INEIINF NIV T - L—E--T7
ANEREBIUORET Z7 7Y r—2 32 T9, Movie Maker 13, EARNZTFA - T5F 1
I EERN A > 72— A2 L ET, Lo T, MR, 290 A —F 1
TR ETAOREFFEEZLBEEST IS SN ZL—E—2ERTE X, £/ kit —
FAFEETFOHRADTANIE LA—E—IZT T T 14w I ETFARNEZEBMTDYA M-
Ny FEFHATEET,

Movie Maker TIERL L 7= NEIZR DO HRYIZHEHTE LT,

e Web X—2

e JlLErF—Tar

e TU—URAF—arTOHE, £FRRETFT—TREDHDERNIL—FTEZRL 2 RY
O« h—E—

mm2.how

Movie Maker DAL : BRI OB

94

#H L Movie Maker D1—H DD, ROA A—V2FHL THEZFNTLET, 1 A=
BV ITBE AA=IUNH T4 2 RTIIERLTERINET, I8 R—=D 7w
ERNT YU DFHA BRICBRTHENVNTL XS,

AR TR by T s A—E—ERO RSB DWW T, Big Picture R—P 2S5 ML TS
ZEW, Zhid. Digital Media Tools Guide & &EHIZ1 2 A b —)LEND Web XR—I DY >
7T,
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Movie Maker MDEXRIBE
AZO=-)+BE

GAh AT — FSYRAAR—bF - O FO-NEEST,
SO EL UL fEEPFOA—EF—OeRELF—HE2HET S,
TkESy5 L, A—E—

AEMRICEET S, Tl—4 Xy T w7 ma

55 e~ ) — i e 2

=4 -T7xD—F FLb

=
e
E

BRI 27 O— L EFE ( A=V EZ Uy 7T 5 EIERERIND)
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%5 3 % : Movie Maker

Movie Maker MDEXRIBE
=R

A—E— - FALASAELUYLLTRESYS L,
SV LIDRASAREERT S,

P
' &
=,
[oner ol Conovie Video ol
1
[zoner=ault.novie Audic 1

WEQL VY TELVYLLTESYSL,
FDL Uy TEITERIRT S,

[zomer=ault, wovie Yideo
[Semersoult. wovic Avdic

eyl
y

LUy THOL U TEFELSUS L1,

EDL )y TeEEERT S,
A Btk

mstudirkmv Yideo 0.000

@studio.mv Audio 0.000 w

[tudio.nv Audic I ‘
[Etodio.nv Video I

E3-2 EH ORI IR (1 A—T %2 7T 5 EPRFRIND)
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Movie Maker (DELAIRE

Ay bER=X

1. BIREITD,

2. MREEdit)) Az=a—hb, THw MCut)l
F72(E TaAE—(Copy)l £FE5,

#ZO| =Fr®

I @h

Ak @

26— ©

ALV TERBTANEES VY S LT,
MREEdit)) Az=a—d [R—X M(Paste)]
AX L FEELS,

.al
“I

DR H Y FER=ZA N (L A=V ES Y v 7T 5 EERFRIND)

=)

3-3 L]
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%5 3 % : Movie Maker

Movie Maker MDEXRIBE
A NIVEILEROER

1T [s4r0 @ #20
~ B

2. 54 M- Ny MEEST, TFEAMES
S7q4 v REEBMT S,

E3-4 B DFEST: & A DIV EFROIERL (A A= ZIU v 7T D EIREREIND)
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NIV T DRECE
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35

IO a7 IV,

& ZI3,
RTERINTWALFIT EEN > ) 2RLET, 77Uy I T5E Z204HTOY—)),
EZE, TAF 17 - L I—4% (Media Recorder)] 25E2#H L £7,

AZa—%EAZa—THHOHED [->]
7 71V (File)] -> THI< (Open)] 3.
ZEEERL XD,

Movie Maker MDEXRIBE
ERAZ 4 NS DIEM

1. ZL—A0FBHERRT S,

o

2. BREHAEBEATE T LT EELR,

L

e e e A > :ﬁ %&Jﬁ ﬁ%
(€57 7105 e
EFFe AV EFTr | ua .

)’JX&IJ.\ DA L -

& = hiziFr T

T T

BELIVEIAL..

W ORI SV 7 V5 DB (f A—S %S Uy I § 5 EBREREND)

mm2.conventions

ROKEZMEML THET,

HETERINZEDE, AEOMOE, i, MELBHEOERNDY >V 2RLET, &
V=L b—b) 22Uv I LET,

LR AZa—0BERNNZAEZRLET, &AL
[T75714)V] AZa—%BWT <] 28RTS
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%5 3 % : Movie Maker

IC®HIC

Movie Maker D#2E)

100

mm.started

ZDHENL, ROEMNSERINTNWET,
e 100 X—T® Movie Maker DiEH)]
o 101 R—=YD V=R 7w IEROHE]

e 102R—=TVD A=Y —DREA T a > O]
BEHEIEE 94 X—2 D [Movie Maker O F 512 : HE [ D #EIT]

mm.launch

Movie Maker V—JVIZT7 72X B2 3 DDHENRHD LT,
o [HIEEHT 5IZ1E. Movie Maker 27U w7 LET,
o FAOaEIYYIZLTEHLET,

1. A bwy7® W—)LF £ Xk (Toolchest)] T MR (Find)l -> A5+ 7 - V=)l
(MediaTools)] =27 U v -7 LET,

2. Imoviemaker] 712> &#F TN Uwr LET,
e UNIXx)lDax > RIFMGREEIT 51213, moviemaker £ 1 AN L TLZE N,

a—bhvy b MovieMaker TA—E— - 77 M)V 2HIZIEHTEET, 77 1)V %
Imoviemaker] 71T A VICEZEROy L TLZEIWN,

mm.source
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F oI

V=RV TR OBE

547 - EFA, EFH - F—

L—E—QHERDIAT 4T « T A IDEVEEE. BOICHEOLA—Y—+ 77 1), F—
FAF Ty FRAA=D - Ty AINVEERLET, TR EEAYV I RT 2 TITH
EINTWBY 7 by - V=V EFALTET 7 IVEERT 2 HEEFEICHAL £7.
TTIATAT « T7ANHHIERE. 109 R—2 0 HRE] KEBEEATLEI N,

7. EEBROV-VFEDLOSDL—E— - SV v TDEK

AF 47 - LaA—=FF, A a1—FHENSL—E—ZEELET, & AT, ZOHEEEME
MLT V7 Iy - AT ILDTEA ML —2 3 2ERUGETEEY. £/, IndyCam
DEIBRT =V AT =2 aVICHATERIZIVCR (EFH - kv b La—%) BiEkianT
WAEE, E5A, #IEE, £33 T T EBEELIESTTEE],

AF 4T - LA=FDFHHEICODVWTIE, B1E (A5 47 - LI—F] 2BRL TSN,

YOV RMSYODF—FT4F - o)y TDHEBL

A *A =2 DERL

007-2275-010aJP

A—E—0F—F 1 A2 ERT BT, KOV —ILEHATEET,

o A—E—THEBEA—T 1 AE2ESFT ST T3> O—)b (Control)] -> % ...(Record
Audio...)] ZEIRL ET, FBOF—F 1 FHEY — VDM NE T, 108 X—TD Th—
— A —F A A EHET D 2SHEL TSN,

o X547 LOaA—FEFEHLT, =PIV RXAT—23>DIA >« "—NMNIEHRINZ1Y
O7 4 ERIEEBENST T REFESTLET,

e CD-ROM R4 7D CDMNSH—F « A ZkET 2I121E. CD Player 2L £9. DAT
RIATOT—TIN6EET 2121, DAT Player 2 HL £9

o TWINFRIVY - F—FT 4 FERBLUHET 51T1E. Sound Track ZHHL TLET,

L—E—O#IEEBRZERT 2I12F. ROY—IVEZHFHTEET,

o AF4T - LI—FZEZHEHLT, ESFTHRAT, EFFHFT—7, £LREEHEORAF Y T ay
rSIRZERIGL E9,

* Image Works %7213 Image View ZffI L T, #fILE{RZREL X7,
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%5 3 % : Movie Maker

mm.setup

A—E—DREXF T 3 »OER

[7 74V (File)] -> TA—E—DFKE ...(Movie Setup...)] ¥ 7O &fHTHE, ROIEHE
ZITAEY.

102 R—=YD [ h—FE—+ TJL—LDRESETL—L - L—FORE]
13 R—Y0 h—E—YRADEH
104 R=JD [ >AR—=F LA A=DF 7 4 )V b OEREFR DR E )

104 R=PDIL—E—-T 74 IJVZH A BIN—=-FA MIVBEIONTIA > S EEBNT 5]

LA—E—:-TJUV—ALADKESETV—AL - V- OBRE

L—E— - TL—LDREELETL—L - L—bZ2FERTIL-—E—DORBEICES XDITHRET
S

1.

2.

[7 74V (File)] -> TA—E—@OFRE ...(Movie Setup...)] Z#ERL £9,
(5 27 (Production Task)] A=z2— + Ry 2 EFHL T, L—E— - FA1TERIRL ET,

BZ6NBDREITIEMERIIHEDEZET, JL—L L= ETL—LDREZIZHET
5i121%. ThH A% L .. (Custom..)] ZEIRL T, XRINBF1 70707 1 —)LRIZ, #H
LWz AN LET,

L—E—=ITE [Ah—E—A—T1—: &E (Movie Maker: Setup)] ¥ 7 07 TOHREY A
ZAEDBNSIBI) Yy TEFDOOENET, JU v TH, ZNEVBKRERTL—LOFITE
REINET (M3-6 22M), EIF v A2 EYF+v (Picture in Picture)] ¥ 1 71077
EZHEHALT 7L—L0HhTOZ Yy JOMEZHETEET 120 =20 [TEY F v -
1> -EIF v VIV OEH] 22R).

A TTOTL—L - L—bhLODBBEVWITL =LA L—F2RETDHE TL—LZEELTE
BLET, TOTL—LDTL—A L —h2LEF2ZEETEERA. REAL. L—E—IC
W15 7L —L (fps) DT L—L - L—bDZ Uy T & 30 fps DRIDOT Uy TiNd 255,
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F oI
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Movie Maker 3. L—E—ZEWHDTL—A - L—hTEATIEIICTOV L LETHA
15fps DIV Y TDETL—AZ2 DTV EY, A—E—DEHEMEICIIRSBFEELZEGAF
A

EFFAEREBYA M- Uy TE2EERNLA—E—DEEXT L —Ald BREAD [EH)] 71—
LELTERINET, F7HIN TR, ZORIIETTN, BETEET, ok dic, &
23 A—E—D 7Yy T T —ADRESO—HELZEHIVBRERL—E— T —
LADREIZRINLZEZICOBEHINET, 2ZEAF, K36 28T /EZIW, A2AE
T5I2IE. ROFIEIHENET,

1. 774 (File)] -> TA—E—ODFHE ...Movie Setup...)] ZZERL £,
2. T (Background Color)] DREICH H/NSIRUMADR Y 7 Z%5 TV U v LET,

3. ANAKDORY 7 ZADFICHEZA T — VR RINET, AT =)V EO/NSB=AFEs) v
JUTEHENRI T E, BENRADEIICRDET, KA —ILZ2#GL TS
W,

4. RNARORY 7 ZAOHPIIEEIT/NSBANERINET, 7y 7 L TRARDORY 7 AD
HERIYIL, HILLWEEZBRRL T ZI W, HEOE (Current Color)] DIEMADIR v
7 2O EOES I NET,

5. @EEMT 513, [B{EDE (Current Color)) O FOFHEEMZES Y v o LET, &E
INTURENEHINET. LEA Apply)) RY &2 v T5HE h—E—TOHER
EBRTEET,

6. TOKI Z27Uvw s L., tAZ@EHL TH¥ 1707 ZHUEXT,
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%5 3 % : Movie Maker

£ 3-6 ERANEADL—E— - TL—LAND/NEBREY A ML - 7Yy T

AVR=bPULEAA=DDT T )V b DRTEEDRE

A2R—=b LA A=V EL—E—ICRRT DT 7 +)) MFHZRETEXT. RET DI
ROFINNHENET

1.

2.

[7 74V (File)] -> TA—E—@FRE ...(Movie Setup...)] Z#ERL £9,

[Lh—E—A—H—: FE (Movie Maker: Setup)] #1707 T [ A—2 DFflkef] (5
7 #) ~) (Default Image Duration )] 7«1 —J)L RZfREL £7.

LA—E— - T7ANICHA PIVN— - 4 FIVELIVAEIAA Y FEENT S

L—E— T 7ANIEA N« N— - ZA4 MIBERUONEI A > FEBEINT 5i12d. ROFIE
ICHRENET,

1.

2.

104

[7 74V (File)l > [L—E—DFRE ...(Movie Setup...)] ZHERL E7,

[L—E—A—H—: #E (Movie Maker: Setup)] ¥ 7 O/ T, [5A—E—-%1 ;I (Movie
Title)] 7+ —J)VR& [A—E— -+ 3A > (Movie Comment)] 71 —J)LRIZTFZX L&A
HUET,

ZA MU=+ &A1 RV AT S & Media Player THAH, A—E—OT 1 > RUDH A
BV N=IZZDZ A MIIBERINET, A, Web R—=VFERIFTLET—T 3
L A—E—ZEBHLEBA L—E—-F AL NN -N=IZEF T7ANED
president.mv RO VIZ TKHFEHEET ORI ICERRINET,
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L—E—ZHE, HILWIY Y TE2BINT 2

[L—E— -+ A2 b (Movie Comment)] 7 —JVRIZIZ, L—E— - T 71 IIVOFREFRIC
7O EATELEREZBMTEET, 22 A—E— - 27Uy SO AHHA,. HHHE
B, ERERICHEHTEIANDAEEZMNETEET, ATDOERBETS, EREFEFRLCES
12, [h—E—A—H—: &E (Movie Maker: Setup)] ¥ 7O/ &ZZMLTAEILT /t
ATEET,

AEIIA PV A—E—ZRETLEZIINTIL T 7 AV LR THIMNERIDH D LEA.

mm.opening

LA—E—%ZRE. HLWLWO Y YTZENMT S

ZZTIE, 105 RXR—=YD Th—E— Tyl £ 105 R—=PD [h—E—=IZ7Y v 7%
BINT S ICOWTHHL £,

LA—E— 774 &RH<

Lh—E—ZHRET 51213, &I Movie Maker IZA—E—Z#HUAA F 3, Movie Maker T7 7
AINZERITIERD 2 DOHENRD D T,

e  Movie Maker 2VEE L TWRWEAIX. A—E—-- 771D T7 A 3% [moviemaker]
TA A ROy 7L EY, Movie Maker DVEFI L TLA—E— - 77y A IIMRERINET,

e  Movie Maker VB L TWABEIZ. ROFIEITHENET,
1. T77A)l (File)] -> MBA< (Open...)) ZERL X7,
2. 774 T3 UFEMHL T Movie Maker IZEUATY 7 7 1 )L &TEIRL £7,

L—E—-I[COV)yTE#EMTS
ZDHENL. ROEMNSHERINTNWET,

o 106 X—TD MBML—E—--2Z7UwTDA 2 HR—hk]
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%5 3 % : Movie Maker

o 107 R=TD [ A=D1 R —}]
o 107 X=2D [F—=F4FDA 2R—b]
e 108 R—TD [h—E—A—F1F%2EET 5]

16 R=2D (7)) THDWHE E N7 R=DD ) wT - J—hOA 27— K] 5BHL
TSN,

BMA—E—-2VyTDL K-t
1. VT EBATHMBEIITAL A 2T AT —FERELET,

VY TRBIYAL A>T 47— DRITTHAINE T, FFICDONTIE, 109 R—T D [
ARAT 2 FORE] 2R T ZI N,

2. 774 (File)] -> [ >HA—b (Import...)] ZZERLET,
3. Iy TIUTEFHL TA—E—%#RL. <Enter> F—Z2#L £,

Ebi Uy TEACR-bTDE TEIF v - 1> - Y F ¥ (Picture in Picture)] V—))
TIL—LDRESIELEETEET, 20X—=2D [TV Fv - A2 -ETF ¥ V—)LOfFH]
ST EIN,

EVMNBHEOL—E—ERBDZY TN - L —FDL—E—- T v TEAKR— T DHEE,
Movie Maker &, KAEOFHHEAREHBETH > TIL - L—hEbEET, A—F 1 FDEZT
ZELETE<SHEDITIR. AR —=FTBHNZ. AF 47 + A2N—bDOKDBEWY —)L ZFH
LT 77Uy 70927 ) L—rE2BRIEOL—E—IZEGDbEET,

23— bAh vy b Media Player 7> 5 Movie Maker IZ7 L —AZIE—9 %213, V—)LD
E— O RER=Z b - O REFHALXT,
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L—E—ZHE, HILWIY Y TE2BINT 2

A A=D1 R=-F
1. AA—DEHATIMEBEIITNL A 2T AT —FERELET,

FLWAA=DRBIAML - A T4 r—FDRIZFAINET, FEMIcDOWTIE. 109 R—
DO HEARA > FORE) 2SR LTZ3 W,

2. [774)) (File)] -> [ >HKR—h (Import...)] ZERL LT,
3. TyAN s TIUTEMALTA A—T%FIRL, <Enter> F—2FL 7,

AR=bLEAA=—NL—E—ICERRINDT 74V FOKIZ. 1 TT, A A=
A R—hLEHRIZ. 2V THOA A= - 71Uy 70 THEERRF (Duration)) 7 1 —
I REREL T, ZORRMZIEE £/ TEET,

AE T IFINIDOA A=V EREMEEET DI, 104 R—=2D [ 2R—bLIA A=
DT 7+ )V S DEREEBOFRE) 28R TLZI N,

AE A A—TVEAR—FTBHE, [EVF ¥ - 1> EZF ¥ (Picture in Picture)] V—)L' T
TLV—LDRESIZEFETEET, 20R=2D TEYVFv -4 -EVF v V—ILOMH]
ST ESN,

B> b : Image Works, ImgView. InPerson ;"7 h7Rh— K. Media Player 725 3t — L 721
A—1E, Movie Maker IKRX—ZAFTEEXT, £Y—)lOIE— - AV RER—=Z b - 3OV
> RZ/HALUET,

A—T4FDAR—-F
Movie Maker Tid. LA—E—IZH TP RE T IVRELOT TR - 7 ) v T2BMTEEXT,
/oo A—E—OREDEBZFICEZBMTEEXT,
1. YUUREHATLOMBEIIY AL A>T 47— ERELET,

LW =T 1A - IV IRIAL A 2T 1 5r—FORITFASNET, FEHITONT
3 109 R—=2 D HEARA > bOFRE] 2L TES 0,
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%5 3 % : Movie Maker

2. [774)) (File)) -> [ 2R —F (Import...)] ZERL £,
3. Iy TIUTEMFHL TLA—E—%2RIRNL. <Enter> F—Z2#ML £7°

EYb BHEOL—E—LREDZY TN - L= DF—F 1 F - Uy TEAR—- T DY
£, Movie Maker ., KAE O HEBELRTY TV - L—MNZEDEET, —F 14 DH
ETEDRETELSBEDOITE. 1 2R —=DFT BRI, AT 17T - AN—=FDXDBEWY—) %
FHLT, 27Uy TOH 7)) - L—hEBRIEOL—E—IZEDEET,

k> b : Sound Track 7" Movie Maker iZA—F 1%+ T v 7 Z2aAE—-TEET, TOHE
2O, YOI — - O RER—ZA M - OV RZHEHALET,

A—E—ICH—F1+A2HBETS
A—E—OFEEFAMLEREY =V T, A—E—ICHEA—F 1 + 2857 2123, KOFIE
CREVNET,
1. F—F 4 FEEDBMBICIAL A T r— 5 EBELET,

ZOREIE. T8 (Record)] RY > %2 U v o LTLA—E—OFEIAE DB HED
EX

2. Ta> bho—Jb (Control)] -> MEk% ...(Record Audio...)] Z#EIRL £,

ZOEET, RO —F « FBEY —IVBHEET, BF Ry 2200035,
F—F 4 FDEENEES EFRFICLA—E—DOFENREDET, 72/Z0. BENBESHI
12 3-2-1 ORFHADH OV ET, BET 24 —F 1 FDANE. Audio Panel THIFIL £7,

3. BMEDOERNTES, Hofihhiz &E Ry >&rU v LET,

4. HEZILDDIE WA MR Ry 22Uy I LET, F—FT 1 FH LW
oIy T ELTERINET,

mm.editing
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BARS Y bORE
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ZDHITIX. Movie Maker THtEd 5 FIEZHHL £T. ROBENMSHEEINTHET,
o 109 X—=TD MFARA > DFRE]

o 1IR2R=VD [Lh—E—Dtra zRIRT5)

o 14R—TYD [TA—E—DtraoHlkl

e 11I5X=2Y® Th—E—D—#zI—, v b, R=ZAFT 3]

o 16R—VD [L—E—Dtr a3 aAT7 L —LAXRLIIEFICTERZS]

o 116 R—=VD Ah—E—Dtraz N)I2FT5]

o 16 R—=YD (VY THOREEI VYT« J—bDA 27 )b— K]

o N7 R=TOD 71w T DM

o 120XR—TD MMEYF ¥ A2 -ETFv]V—ILOfFEH]

BEEHEIEH : 102 R—PD TA—E—DREAF T a3 > D]

mm.insertion

AL AT 45— &2FHALT, 1 >AR—FERRER=ZAMLAEZY) v TOEARAL > N2
BELET, ARSI RE2FEALT, A—E—DZA70—-)VbITAET, 143 R—PD [Lh—
E—02x270—=)V] ZBHEL T ZIWN,

FHARAT > POREICIZ2 DOFENH D £7,

o EVaT7)-arbO—=)LEREKRRIZENTICE. L1I0R—=—D TT74IIVAA RN v T - E—
ROEARA > FORE] 2BBL T3 WN,

o HICTIICIE NI R—PD [FLE2— - FE—ROMBARA > FOBE] 28R LTLE
S0,
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%5 3 % : Movie Maker

Z4IWLR MY YT - E— ROBEARLS Y FORE
AR —=FERRIR=ZA T2V TE, ML AT A=Y OERICHFAINET, ¥
Ah AT r—32EET 2123, ROFIEIHENET,
1. J4NVAARNY YT + E—ROL—E—2FRLET,
FAICDWTIE, 144 R—2 0 TRRE—ROEHE ] 2L TSI,

2. FTI7FINETIE. 1 >R—=hENEZ7U 0 TE #HLWL, by T - LAYDRT Y7 2ER
LET, BEOZ Yy TRIZA DR—MLE2 )y T2EATIEEE. BEO2Y vy T %
BIRLTLEE N,

FRICONTIE, 112 R=2 0 70y 7 OB &GEIRAERR) 22 T 7230,

3. AL -A2Tar—d0EmIHB=10AK (N3-728) 227y /LT 7Yy Tek
RSB DMEICRT YT LET,
ALV TRBIAL - A 2T 45— DERICERINET., HIOZY Y TIZTU Yy
TEAR-bT G, BEOS Y v TERDBIRS NIENWK DT, ZMBOLEOALEIC
HEELTLZE N,

BAL - AT T —FOERE R v,
BARSIFERET S,

*

E3-7 FAL AT =5 OREHEALTHARA > FERET D

AL AT 45— DEP a7 ) - Fa—&RIIRLET,

o HAML - ATTAT—FF FMLTA EBEFREHITTRVEBEORE L THERS
Nx9J.

o U4 YRUETNDAIZ., ZU v TBEASNDIFENERENET,
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AL AT A=Y EMPIcBHI T2, [TL—L - T74+T—R] £3 [T —
LNy 7] RE &)y LET, K320 2ZRLTLZEN, YA LA 2T 10—
FEBEET 21T, ETFHEERBF—T4F - hIvIOHLWEEZZ ) v LTLKE
Iy,

a—-bhyb:F—F—FD-> & <- DRAF—ZMHHTDE, 1 7L —LARINERZZL T
L —LBANHEAXT,

ZVEa— - E— FOBARS V bORE

007-2275-010aJP

AZR—PEEEXR=ZA LAYy TEIAL AT —YDERICEKREINET, 1
L AT =8 EiET 2123 ROFEIHENET,

1.

JLEa— - E—ROL—E—ZFERLET,
WIS 144 XR—P D [FRE—ROAHE | 28R L THERIES T3 W,
FIHIETIE A oR—bEh=27Uy 3 HilWwky 7 - LA YD Sy 7 2ERL

ET. WHEOY Uy TR Y R— R Ler Uy TEBATIHA. BEOY ) v 7 &%
WL TLZE N,

I ONTIE, 112 R=20 70y 7 OEIR &GEIRERR) 22 T 7230,

AL AT ATr—IDRMICHZ=AK (K385 Z2/Uv 7 LT, 7UyT%E
REEBMBIZRS VT LET,

BDOTY Ty TeA 2 R— T 258 HEOY ) v FRRERI NI NE ST,
ZAEOEOMBICEREL T I,

20w TRBREERINTNE T L —LDBICHASINET, -&2E JL—4A 17 &
REICEREIN TV 27Uy T2 o R—bMLEEE A R— LAYy TIE T L —
L17 DEENSIHAED XTI,

AL AT AT =3 2B HIT2I0E (VL —4L - TxT—K] Ry U F-id
[TV —=h N7 Ry ZEI7Yy I LET, K326 #28BLTL/ZE W0, 1L A

TAT =Y EHEBET HICE. ETFERRF—FTaF - Iy IOHLWIEEZS Y v Y
LTLIZE N,
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%5 3 % : Movie Maker

a—-bhyb:F—FR—FD-> & <- DRAIF—ZMHTDE, 1 7L —LARINERZIZL T
L —LBAHEAXT,

mm.selecting

L—E—DEI a3 EEIRTS
Uy T OREELIIHEBZEZBBT 2123, FTRREZTOLENHD £, ZOHIT. KD
HNSHRE N TNET,
o 12R—=VD [A—E—DREDORMICY v > T3 5]
o 12R=TD 71 w7 DR &FRERR
o 13R=VD [A—E—2/KOMEHDZER

o 113 R—=T® 7Yy T OHEEDER]

U8 R=TD 7Yy TERT Yy I DFHE] HBRL T I,

A—E—DBEOHKEIC Y75

AL AT 45— EBHTHRMEZRET 213, V1 > RUETOMITERS N D EH
ERELET, 1BV I THET 0 —)L RORETRICARDET, HrLWERZ AL T,
<Enter> ¥—&#L £7,

2V v 7T DORFER ERIRMERE

BRGEERITRUET,

o VU wTRKREBERTZIE. H—VILEIZ )y THEICBELT, BIRTB 27U v T OLHE]
#7)wILET,

oW IHEBDOI Yy TBE TN I TERTE LT,
o HEDOVY YT EERT ZHITIE <Shift> F—Z2MLANS 7 v T BRL X7,

o ITXRTOVYvT % 1EIERYTZICIE. THRE (Edit)) > [TXTEENR (Select All)) %
BIRL £7,

112 007-2275-010aJP



LA—E—2EDMEEDZER

o)y T DEEDER

007-2275-010aJP

BEIREER S 2 HEERITRLET,
o Uy TEBRMRT SITIE. <shift> F—2WLANS, BRLUET,

o 1EIZTXRTOIY v F2RINMERT 51213, THRE (Edit)) -> HER L7 (Select None)
EBIRL ET.

L=E—= - FAAZAET VYT LTREZ VI, £FFvIDRATAIAZERT L,

[Somersault. movie Yideo
[Somersault. movie Audic

___(i':?[

£ 3-8 L—E—2EORHEEOER

Lh—E—DELAVNEATA RAEEINTHITE. L—E— 1 LTADIAL AT+
=520y L TRIY I LET, M3-8E2BMLTLEIWN, h—VILZ@#hLiansk
REEERSE, A—E—DBIRL TWAEHD 2R ZENTEET,

BIRFFHZEE T DR, U > RUETORBRFFRHEZEREZREL 7. 1 ERRKEMZZ U v
795 EMmERRICRDET, HILWERZ AN L T, <Enter> F—2#ML £7,

BREQSVyFTE2o Uy LTRZYS L. 200 Uy TETEERT A,

=
[ 1

P
[Somersault. movie Yideo !’\B}
[Somersault. movie Audic

£ 3-9 27Uy T ORI OER

7w T O EERT 21T EBRT 7 ) y THEEOHD STy ZITH—VIVEREL. I—
YIVEIVyZLTRIy L, sz ERLEY., K39 2l L THRLTES N, H—
VIVEBNUEBRSFERERZERS L. A—E—DRRNL THIEHERDZENTEET,
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%5 3 % : Movie Maker

BRI 2 LTI 212N, U1 > RULEFOERGHERZREL X9, ERFHERZ 1 EY
Uy 795 EHmERRRICRD LT, HILWKME AT LT, <Enter> F—2#HL X7,

e TNV AA RN T BF—RTL—E—2FERTDHE, EVaTI) - Fa—NNHEI5~
OIZTEIRL T < ABDET, FIcONTIE, 14 R—=P0D [RRE—ROEHE] 2L T
ZE,

IR - I Z2RTE a7 IV - Fa2—2RITRLET,
o EIRLAZMTwI/OMEET B z—RIZARDET,

o UaYRUETOMIZ, BROMBREK TRERTH, JL—4A 1L I—-RFRE
~ENET,

mm.deleting

LA—E—-Dto L a3 DRI

AE I L—E—DEr T a P OHIKRIE. A—E—DIUY EIZREDET, A—E—DkI I3
PEIZYTYLULTHEATL—LEBRASEHEIR. 16 XR—2YD TA—E—D® 7 a3 %&2HT
L= L ERZEEICERA D) 25T EE 0,

1. HIBTsL—FE—DtraazBIRLET,

BIRT D HEICONTIE, 112 X—YD [A—E—Dt 73 2ERNTE] 28HLTL
ZEN,

2. T#mEE (Edit)) -> THIER (Delete)) Z#EIRL £9,

Shortcut: T##%E (Edit)] A= a1—ZffHE 71T <Backspace> ¥—THIfRT 22 &HT
=E7,

mm.copying
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LA—E—-D—8%Z3E—, hy b, R-XITH

007-2275-010aJP

aAE—, Ay b, R=ZAFDEAXYRZHEHALT, EFH, A A=, F—FaF - 7w
EUREICSUCHEB TEET,

1. a¥—, ¥R AY b TB3L—E—0tr > g ZEBIRLET,
BEICDONTIE, 112 R—PD TA—E—0Dt 73 a2 aERT 2] 28BLTLEIN,
2. THREE (BEdit)) A=zx—%2BE£7.

o MOMBIZR—ZAFTEBEIICEs Y 3> 2HIBRTBI10E. Hy b (Cut)) ZEFL
EJCIR
o HMOMBEIZAE—ZXR—ZANTELXLDCEYarzaE—9 %23, aE—
(Copy)l ZEERL T,
3. Ay hERFaE-LEtr2ai2L—E—HNOHDOMEIZR—ZX T DITIE. 14 -
A>T ar—% (109 R—=2D HHEARA > NOFRE 228 2% EL. HHE (BEdit)) >
[R—Z b (Paste)] ZERLET,

Fw hERRBIE-Letr a3 1L A 2T =Y DERITEMENET,

Ya—bhy b REEdD AZ2—0a7 > R2EHET. KOF—FR—K:-a—h
Hy NEEHTEZIEHTEET,

e IEF—T93ITIE. <Shift+Ctrl+C> F—2#HL 7,
e 1w FTBITIE. <Shift+Ctrl+X> F—Z2#H L £9°,
e RZA—FTBITIE. <Shift+Ctrl+V> F—Z2#HL £9°,

k> b :Media Player £7zi3 Sound Track 7* 5 Movie Maker {IC2E—T&E X7, /. Movie
Maker. Image Works, InPerson "7 bR — R TIE—E X=X M TEXT, 2L, Z
NEO3DOT7 TN r—2a>TIE-TEHDIE 1EIZ1 D207 L —LADAT, [FARHTHER
DIL—L%dE—95ZLRTEERFA, IE—EX—APETDIZE, ETTVTr—ar
DAL — - AV RER=Z b - AX Y MEATEET,

mm.blank
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%5 3 % : Movie Maker

L—E—DEHI>aVEZEAIV-—LFERIETICERZS
BIRLETL—L22HT L —A, £REESOF—F 1 ACBERAD I ENTEET,
1. L—E—OBEWMADHIERERLET,
FHEMZOVWTIZ M2 R=PD TA—E—0t 72 az@RT2] 28RBL TIZIN,
2. T#REE (Edit)) -> [HZ (Clear)] ZERL XY,
BRLUEEL—E—DEIPNEESNET, 74 NVAA Ry T - E—FZHHAL TWL5HE,
FREMNOZ U7 INETL—LFRABD, F—F 1 FOWHITERRT R £T,

mm.trim

L—E—DEIaVEMNIZVITS
Movie Maker 1. #IRL7ZHHOL—E—/ZF&2ZL, KO ZHIRTEET, FIHITRDED
DTY,
1. L—E—DORFFLZVERSZBINL £7,
FHHIZOWTIE TA—E—Dt 7 a > OER] 22RLTIES N,
2. I#R%E (Edit)) -> MU A (Trim to Selection)] Zi&ERL £7,
BRINTHRWT L —LNLA—E—P5HIBRINET,

mm.editclip

VUV TRDEEEOIVYT - /= DL ONV—F

oV v TADRE

IV THHICERTDEI) v T/ K327 IRTEIRERINET, 7V v T ENS R
mo [T7AINHETTE) [T7AINVEAT—FT 17 BREDEEDT 7+ "aaBEZ 5N TH
F9, TITI7AMINAE A >R—=bLZ Uy TEEERAVWZL—-E—DITD 7 71 IV T
T, BHLOPTWEDIZ, BULEZY v 724 TRAITEELNTL &5,
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1.

2.

2w THEOI)yTHEIY I LET,
ZRTT 4 =)V RIGEINT 2 EfRERIREIC/R D 75
LRI 4 =)V ROA4FTZ2#WEL T, <Enter> F—Z2#HL £7,

OUyT - /—bDALON—F

20y TDERE

007-2275-010aJP

MELEHOHWT, 7y THOIU Y FICOAAREANDELINWTL &,

1.

ZD

KFEZ ) FRA O—=)VEHHTSE HICA270—)LLTIa A2k (Comment)] 7 1 —
W RESRTEET,

IR REMFZWI Yy TD TaA2 S (Comment)] 74—V RZE1EZY 7 LT, 7
FAZEATILET,

T L7Z5 <Enter> F—2H L £7,

mm.manip

fild, ROEMNSHERINTNET,

18 R=20D 7w TERT YT DY

NIR=2D TRTyTICk2 7 v TOBEH)

NIXR=YD )y TELA-—E—D7O2 b LAVERINY Y - LA VICBET S
NIR—=DD 7Yy TE2DO007 )y TIZHETS)

120 R=2D 71w T DA

120 =20 79w TORBARA > FERSDORE)

BHEIEH : 120 =20 [TV F v A2 - EIVF v V—=ILOMEH] . 129X—=TD FhHRA
TAINZDENM BIUR121 R—TD 1541 ML EFEROIER]
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%5 3 % : Movie Maker

2V TERS YO DEER

1]

h?\‘ja T — e F 1)
= “jg 7 —pEpoce. nov Video = | [Barts. mov Yideo

— P 28 B Y S A ) o —F
= w7 3 —Mepace. mow Audic LA |[partZ. mow Audic LA

118

E43-10 gUwTENT VD

X 3-10 1¥. Movie Maker] W« > RUDI U wTERNT Yy 7 ERLTWET, 77U v Tid, A
CIR—=hEINZTrANRE LA—E—DO—HnERLET, L—E—OFELIT. JUYTD
WMEEZTDHZEITRVET, BHOHMWT, Bid2—2220 v i2hd,. SRAOAHZ M
FBZEMTEET,

LA—E—=IZA HR—=hINEF—F A FRETS - 77 AINBITRTHY v T2k, 7UvT
FICERREINET, £ F—FT 1 FEEAZL—E—% Movie Maker T/ >R —h350H
& 2207V yTELTERINET, TNENA—FT 1A - VU TEETF - VUV T
T9., BT, YA MVEREBAA=B ) TELTERRINET,

FIwPiE. A—E—DELAVDIALTAERL, IRTOL—E— - TUyTEEALT
WEJ. BLAIVOEHICHZ Ty VI BHICEREIND T v/ TYT, EXF 1k
e 72Uy TEERL T, RbhL - LAVIIBEILZRE. 71 UL W UKREzZIN—L.
FOEVLAVIZHDETE - 71Uy TIIRBEINSORAERAL, DED. LA—E—&FHEL
THYA MVERRENEE A, T—T A F DL A YORELZS TV HEIF. YT RNV
AENET,

RELIET 7 ANEKERBIZFAR- R LT 7 AIVERWZEG, 77 1V EEME2I3LE#H L
BORD, Sy &Yy TRINTIEOT B 27 FOBDEF—TTY, 72720, A—E—-
Ty ANPEMEZZEMEINTNTH, =T 1 FZ2FEXRNVLA—E-TARWVRD. Movie
Maker T34 —F 1AL ETH + b T v I AHICERINET,
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RSy FIC&d2VyTDEE
1. BEITAIZUwTE2BINLET, SICOWVTIE. 112 R—=T0 17w O8N & RINFE
Rl 22U TLEI N,
Uy TERRTLEEIANLTA EBOANE N 1 — RIZRODET A=V ET )Yy
TOLECEHBETSE, B—=VIVNNIBFORICRD, RIvTTEHIEICLD Yy T2
BETEs52 2R LET,

2. U TEIALTA CEBOFLNLEICR T v T LET,

OV TEA—E—D7OV L - VAVEERBNYY - LAYV ICEBEITS
1. 27Uy 7EBRLET. FHICOVTIE 112 X—=20 (7Y v T ORIREERER) 22
L TL<7ZIWn,
2. % (Edit)) -> (7Y w 7 Z#i#E~ (Bring to Front Layer)] Z#EIRL T, 77U v 7% L—
E—o7orb - LI YABEHLEY, T3 HHE (Edit)) > 17U v 7T 2&% (Send to
Back Layer)] Z#EIRL T, Ny 7 - LA VYABEHLET,

MOKFEELT, VU TZ2ERLT-FLONT v ZITRIy T LTT7OY k- LA VABE
T2 FhE —FTFTOMIv IS I UL TINY Y - LA VIIBEITSZENTEET,

OV TE2D200VyTICHETS
1. 77Uy 72BERLET, FHICOVTIE 112 X=20 7Y v 7 OER EEREER] 25
LT/,

i

2. FML - ATATr—FDEMICHLNEBR=ZMA (K38 27U v I L TRI VT
LA LA T A= NGEIRA > FOMEICSSETL—E—2X 70—V L £,

AR IIAL AT AT DENDAHET )y I LTLEEN, £2TRRWhE, 77Uy
TOEPEREINTL R, BEZ Y v T ORBRPMBEITRD 9,

3. Z7Uv7 (Clip)l -> [5%] (Break)] Zi#ERL £9
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%5 3 % : Movie Maker

2V TDEE
1. #MAET27V Y INELER—D Ty 7IZBWEEIR RUMT v 7ICREL XY,

2. WAIDZUwTERINL. <shift> F—2FLANSHEIADIY) v T EEETIRDY
Jw7ZBBRLUET, FHMICOVTIE. 112 X—=20 71w FOEPR & BINEER 250
LTLIEE,

3. T7U w7 (Clip)) > & (oin)l ZERLET,

2V TORBARA » FERSDIRE

M9 R=2D [RIyTICEB7 Yy TOBE)) T, 7y TE2HEET 2 1 DOHEEHMTL
Fllz ZUyTHEFERLT, 72Uy TORBRERA > NERETEET, 77U v 7O TRk
(Start)] 71—V R&EZU w7 U THREWTEIZL., HrLWKMZANILET, £/, 1 MLE
3 A=Y ORI, TREERER (Duration)) 7 1 —) REWET D EEFETEET,

AE - [Bith Start)l 74—V RZERELTH, 7 v TORIFEDD 8 A,

mm.picture

TEOFv 42 - EOFv]1V—IVDER

B 3-11 EVF v A2 - ETFvRIROH
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&4 BV EERDIERL

'E2ZF v 1> EYF ¥ (Picture inPicture)] V—IVZFHAT S &, K3-11ITRTEDIT, 2
DULDOEBDZ ) v T 2R U LA—E—NTHRICERT2REERTEET., 2L L—
E— L —A2EKIHL Ty T« TJL—AZHN ., ARBTSHIETEITTEET,

1.

fM/NEZIIHEE, H2VEZOMEETLEIY Y TEERLET,
FHICOVNTIE, 112 R—=Y0 [A—E—0t /T a z2BRT5] 28BL TSN,
[N (Effects)) -> [E2VF+ - 1 >« £ F + (Picture in Picture)] #&ERL £7°

lEZF % -1 > -V F v (Picture in Picture)] ¥ 7 O NERINET, ¥4 707N
DRy 7 AF, BRLUIEIV y TOT L — LR ERL THET,

A—=VIVCTRy ZADAEI Yy L, RIv 7 U TRERYA XITL LT,

FIHIN B TR T AR R (lBEESOL— ) BMEENET, 7 ARY M2 RS
IZH A1 AZEET 51213, <Shift> F—2H LN STVWET,

AE: RV I AEIYTATHRET 2MROVIC, REIPMEBEEMBTANLL THET 5123,
[%t& (More)] R¥ &I Vw2 LET,

L —LEBRETHITRZONMEZ Uy s L, HILWEFIC RSy 7 LET,
G (Apply)) 22 0w 28 B E BLWHA XERBE L—E—FoR S TR TE £ 7.
[OKI #2707 LTEMAL. ¥4 07 &7 LT,

AEIHEREFERIEDITE. NEINWT Yy TRKOKRENT Y TORICHDHENH D ET,
19 R—=2D [Z)yTE2A—E—070 k- LAVYEEEINY Y - LAYIBEHTS] 25
HBLTL /&N,

4 RV EEIRDIER

mm.titles

Z O, ROENSHRENTHET,

007-2275-010aJP

122 R—=2 D [F A1 MV ETROIER DHEE]
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%5 3 % : Movie Maker

o 124R=TVD IFFANET T T4 w7 ZADEITDNTY
e 125R—=TOD [FT2xr ~DOBE

o 125R—YD AT/ bOAy b, AE—, R—=Z K]
o 126 X—=T D [FF X ~DBEMEHRE]

o 127 R—T D REROHE]

o 128 RX—T0D EADHFHE]

o 129R—=TD [FTVxl DY A XL

o 129R—VD [EHTL—LITHA NVEERT B

o 129RX=2D 114271y T DRk

mm.titleoverview

4 PIVEEROERDOIE

Movie Maker 1213, K 3-12 IZRT ELDRBY A1 RMIVOEMRE, K3-13ICRTEDBRT T T 1w D
2AETFANDERZL—E—ICMINTEDZY AL ML - Ny EIEENTHET,

Ergo Software

Product Demonstration

Eq3-12 Movie Maker TIERL L 724 1 bV OH
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&4 BV EERDIERL

lighter color?

E3-13 Movie Maker TERL U 7z7EFR D Bl

HEARWBFIFIRDOEBD TY,
1. 2DQHFEOWT NN THEBEZZERL £,

o A PNVELBEREEHTSZ 7L —LAOHHEERL 9., FFHICONTIE 112 R—
PO TLA—E—DtrTalEBRTS 2SR T</Z3W, &1 N (Title)] ->
ERK ...(Create...)] ZZEIRL. ¥1 MVOXRKMZEEL £, 1 ML - XLy b
MERINET,

o Uy IZLTHA MNERRUBDIRRNIIA L A>T r—FadbbtdEd, ¥
A1 ML (Title)] -> T{ERL ...(Create...)] ZERL T, 1 MIVOXKRIFHZIREL L7,
A4 ML XLy EPHBNICEREINET,

AEINIR=DD [RIvTITLD 7Yy TOBE) THHALLEELDIZ, 14657124
THA R - 27Uy TaBETEN. 72Uy THETI Yy 7O TR (Start)) 71—V K&
WMETHILET, L—E—NIZY A MIRERRENIGHERELET ZENTEET, 7
U 7RO TFEREE (Duration)) 71 — )V REZREL T, ¥ MIOEIZEFETLI L
HTEXT,

2. ZAR - Ny bEFERALT A—E— - TL—ADERERZEFY A M. HB0VIEZD
M2 ER L £

B13-14 1251 ML« XL w bERUET,
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%5 3 % : Movie Maker

GA BNy b

BRY-— ) TEAN
EiEY - REY =
AV e gy BUDAL
MEFURZAw - Y=l BUDARL
l'Line Thic
Foa— 3
AF—ER7O0vs

A

(A—E—I[;

3-14 A ML - XLy ERR

3. I1MIOERICL—E—Z2fATLM BEELZERICTINZERLET,

T 7+ ETIE [F1 B (Title)) -> R &L TDL—E— (Movie as Background)) 7?
BIRINET, Frvr Ry I AR FzvI/INTVET, AELAZEREZHHAT I,
HEEIRLT, HRELTOLA—E— - E—REEMICLET, BROBELFETEET, 128
R=20 [BOHRE] 22RL TSN,

4. ZA M- E—REKTIDITE. by IHEBEREBZ Yy THEI Y v I LT,

mm.things

TFEFAMNEGS T4 9O RADEMICDNT
o HA N NLy NOBAFEE. BHEATFEARNEST T T v I ZAOTOT T A TN
*9.

o L—E— TV —AREBIMETFANERRBY IT74 v VAR A7y b EFTINE
kR
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&4 BV EERDIERL

AT bOBE

o FTTVI U INL—E—FERITL—ALLICHNE, TXIERHETHRIETEET., BH.
A XEE, FroA TP/ hOLICERE, AOLE, vy b, aAB— X—=ZA M2 ET
T, AT MERET BT BYIICA TS o MEBEIRTALENH D ET,

mm.moving.objects

o FTTx/ bEBEHTIICE BIRY—I (M3-14 2R TRIRITZVLENHDET, TD
BHLUWIEICRT YT LET,

o [FEFIC1IDUULEDOF TV FEBEHTSICNE. BHOA TP 7 EEIRL T, <shifts>
F—2HLAENSIFNOA T FERERLET,

FTPx U NEYA NMVORHEHEZZIERICBETHIEBTEET, ATV NOERDEA

NEEINET,

o ATV MEREICFOTS3ITIE. [#1 ML (Title)] -> MEHHZHIHE N (Bring Items to
Front)] Z#ERL 7,

o FTTxV NEBITEDITIX. TH1 ML (Title)) -> [THHZ# (Send Items to Back)] %
BIRUET,

mm.copy.object

A7z bDhy b, AE-. X=X}

007-2275-010aJP

YA RIVEERELIRET 25G. EENLRAETHY b, 8- R—=XFTEET,

1. A7Yx7 haEBERY—) (K3-14 BH) TRRLET,

2. THREE (Edit)) -> My b (Cut)) £&I1F TS (Edit)) -> 13— (Copy)) &FERL£T.
3. R=ZANTBEHFICAH—VIVEHEEL T, [FHE (BEdit)]->[X—Z  (Paste)] Z BN L £,

a—-bhAyb:iF—F—FKOTa—-bhy b2HEATEET, <Shift+Ctrl+C> F—TIE—,
<Shift+Ctrl+X> F—TH v ;. <Shift+Ctrl+V> F—TX—-ZA ML £ 7,
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%5 3 % : Movie Maker

mm.text

T4 2 hDBIN & iRE
ZOHTIE 126 =20 [FFARDOEM . 126 R—TD [FFAROHTRE] . 126 R—PD
(T3> hERZRBTFARDAOLEE] | 127 X—2D [ 2RIVDOANITDONT] IZDWTEHH
LET,

T+ X MDEM

1. TFAb V=)l (K314 BH) ZERL £,
2. L—E—+TJL—=ATH=VIDIEZI Uy L THERDT,. ANTZEHIKLET,

ZARI Ny binoT7— 70y 7 ZERLT, TFANOBEEZERL TEETDZ
EBHTEET,

AE I <Enter> F—ZHMHLTH, TFAPDHLWITZFBTE KA. HILWITZHBT 2
& A=YV EHEREL TS,

T+ hDEE
1. TFAb V=)l (K314 ZH) ZERL X,
2. TFANMTH—VIVEBRBELT, 77Uy LU GERL, WmEZHBLET.
3. WENTT LS <Enter> F—ZL X7,

742 bEEBTFRAMOEOEE

T4 bEEFETDITE. 1 ML (Title)] AZa—2fFHALET. ZOAZ 1T EIRT
FAMDT 42 M, A1), YA X2EBT 520D A_a—HBRD D £,

THFAD - FTT 2 bOEEZEET DT ROFIEITIENET,
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&4 BV EERDIERL

IVRIVOAAICDONT

FAROFEE

EHRE BRI E#H<

AFzEmAafeH<

MOKEEBEOEE

007-2275-010aJP

1. NEFY v—)b (M3-14 28 Z2ERL LT,

2. TFAMTH—VIVEBREL. 1 EZ7UvIZLUTGERL, 1 ML XLy bOFLWA
J—-JuavrerUvy I LEY,

A4 RISy M3 FEEISO XFI—REYR—MLTWET, FEflicDOWTIE. TIRIS
Showcase User’s Guide (HAFEM) I OfEk E LR ISO XFd— K] Z2&RL TL/Z3 W,

mm.annotate

AEIERBENOF TP 27 FORDITHA XEH, BENTEEXT, 125 R—JD [F72x
7 FOBE) E129 R—VD [F T2 bOYA XEH] 2L TIZS 0,

EAREZIIRENZH <23, B#RY —I)VRZRREY —)L (K 3-14 28) 28R, A—E—-
TL—LDLERCEEL TRy LET,

e HEZRMUADHBEHEITIE, THTY I BIA 21 V=IVERIF AT T RSA 2] Y —
IV (®3-1428) 227y L. b—E—- TV —ARF TP/ belEL. RTIv T L
E

e BUDKRULHFAZRBMAZMIZIE. MBEODKRLH] V—IVEkiE TEODRLMMA] Y —
IV (®3-1428) 227y L. Lb—E—-TVL—ARF TP/ belEL. RTIv T L
E

ME LA 727 bOBMOKRE BB EEETDITE. ROFIHITHENET.
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%5 3 % : Movie Maker

ERY =) (M3-14 2 2R £,

AT MTH—VIVERBEL T 1 EZ7U v 7 LU GERL, Z1 ML - XLy M5 E
LWIA 2 ANV ERIFAZERL ET,

mm.edit.color

ANy TOERBGT 7 MIA) ZEHL. Z 1 ML XLy bOBEEZEETEEXT,

BoimEE
1.
2.
3.
4.
5.
128

BRES A 7O ZHEET,

o AN NLy NOREEETDHYAA 7O EHITE. 1 MLy bOFRE
TH0E5 TNy LET,

o A NMNIERAEAETLZY A 7OV EHITIE. T4 ML (Title)) > ¥ LD
54 ...(Title Background Color...)] ZZE{RL £,

NAFDOR Y 7 ZDTIZEOHEZ 7 —)VNERINET, NIR=ZAFEZ Y v I LT,
HEETIHERIEICRT v UET, HEZX 7 —)LEHFEEL T ZEI 0,

RNAKDR Y 7 ZAOHIZIEFEITNSBHANERRINET, Uy I U TARABDERY 7 XD
HERIYITUTHLLWEZRIRL T /ZI W0, [HEDE (Current Color)] DIEMADIR v
2z ofEOaN KN ET,

BZEMEHY 2121, HEDHE (Current Color)] O FTOFAEREZEI U v I LET, &
SHTOAEAERSNET, T (Apply)) Y& v I TBE. A—E—TOHER
ZWRTEET,

OK) 227U v, @il Ty17nrz2MUxT,

B MER LI, (51 FL (Title)] > 57 4L hOAT— KLy DU R LT
(Restore Default Color Palette)] Z##ERT LT, hF— - N v MIED XTI,

mm.resize.objects
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IR T 1)V 5 DEM

AT210 bOYAXEE

1. BERY—-) (M3-1428) THT7 7 hEERL KT,

2. YAXEELTL2H T2 FOERTY I I THLZHBORS 2Ty L, R
Fw T LET, ARSI RIv T L THT PV bEIERLZD, NREIZR Ty 7 U THE
INTBHZENTEERT, FLBEEADLEVWOIBEDBTEET,

mm.blank.titles

EAZ7V—-AICYA PILVEERT S

L—E—=DI Yy TOREIZYA MIVEERTTIZ, 1 MVEZEAT L —LICERLZWES
NHDET, HAEMEBROIZ Y v T E2EATOENA—E =T, ZATL—LDENEHDIT
BOET, ZEAX,. A—FT 1 FELETH -2 Uy TORBRA > NERIICBEITHEEAT L —
LZEERTEET, 120R—=20 1710 v TORIBERA > FEEIORE 22RLTIZI N,
KIZHZA BV Sy hEFHALT, Z2ATL—LICA—TZ20 - A MVEERTZZEN
T&EXEJ,

mm.title.edit

A4 MV -2V TDEE

HA4 RMVEERLEZZIE 27Uy 7 (K327 88) OFA MVOTA A= TINVI D IT
&, A1 RMIVICESD THIRETEET,

BOHEELT, ¥4 ML+ 70w TERRUT, (541 ML (Title)) -> e ..(Edit..)] %%
Rz bTEET,

mm.filters

MERAZ 105 DEM

007-2275-010aJP

ZDHENL. ROEMNSHERINTNET,

e 1BOR—TD [FENTWVWDETH - 71 )LF DH
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%5 3 % : Movie Maker

o WB7IR—=ID F—F1F T 1)L¥ D]

o 138 R—T D kN ADFE]

o 139R—VD [A—E—IZT 1 IVFZHHT 5]

o 139 R—ID [T 4 )L7 D]

o 10OR—=VD TEFF - T4 NI D —7 > ADRTE]

e 141 XR—TD 13D 74 )VF % L—E—ITEH]

mm.filter.examples

SENTVBETH - 7140506

ZOHETIE, Bl EINMA BN SR T VY ZRALET., 70y 0hIziE, 1
TOTETLVEa— A AXA=PHIAENTNEZHDHEHDET, ZNHD T4 IILFITDNTIE
135 R=J0D (A4 7072 074V 25U T EIN,

AEINSDTAINHIET T T, /usr/lib/dmedia/plugins/premiere 51 L 7
U ZEZH L TWET, Movie Maker I3 Adobe Premiere™ 757 > &Y R—ELTNWET,
T4 L7 FUIZ Premiere 757 A > &EBINA A F—ILT 5 &, [ZR (Bffects)] A= a2—IcFk
IRINET,

BHE

E3-15 TEE] 71 VI RDH
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IR T 1)V 5 DEM

FhL

E3-16 NEnL1 74 VTR OH

E5ICIEML

E43-17 [E5IENL) 71 IVIERDH

FAINT - AETF4INT - FTUb

ZD2DODT74)0ZE, FUCEDITHIEL £T, RAICBHIZRD, ERERLZIGEHENSHN
BAA=VEERLET, BIERITRLUET,

o L—E—OERAZRIIREL THDEAIC, MNOETH - hIv I DT L —AICHRS R
WEDBRTL—LEHBHERIRL T, 51T - 1 > (Dissolve In)) ZHEIRNL F9, BN
L7770 =413, BE0SHED. BHOAA—JICRBRDEETLEVIIHS B ET,

e HOEFTH IV IDTL—LEERSIBVWYAMNL FIv I ERBIRLEGEIC 54
V)T -7 b (Dissolve Out)) 2R L 9, ¥ MLILEWICA—E—DEREICKS
TW&EEY], [F4YVIT - 1> (Dissolve In)| ZERLHAT. ¥ ML LA—E—
DOERBNSHED, LEVITIE > EDLTEET,
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%5 3 % : Movie Maker

e HOEFTH-bIvIDIL—LEERVGD 7L —LHPEAEZERL GG TV ILT
7 bk (Dissolve Out)] ##ERT B L, BRLAZTL—AIF BROGOZTL—LITLE
WIZT7 2 — RLUTEET,

AE 103 R—=ID [A—E—EFRADELEE] 2B L T EI0,

FEHL

3-18

IyPARE

£ 3-19

132

NEEHUL 71 LR OH]

[Ty OB 71IVINROH
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IR T 1)V 5 DEM

HIRIFML

£ 3-20 T ZEN L] 71 IVI O F
HOR - v—=TF

B 3-21 HIA =T « T4 IV IHRDHI
Eih

FHE TNT 7 Fr R EA AT OMEICREL XY, ZOREL. 1 A-TDORHY
DN EBEHICTHENVWIRELGZAET, ZOMRICLD, A—E—DHEREHAPL, HOET
F TV INSEBSTWETL—LNRALEDITEDET,
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%5 3 % : Movie Maker

ERL

3-22
b

3-23
134

UN—Z 74 WSRO —ED T lr—A4

UNR—Z 74 &R —EDTIP—A4

FERL] 71 )V FEROHE

[GReH) 7 1 )V & R DB

007-2275-010aJP



IR T 1)V 5 DEM

Ty JEEATS

E3-24  [ToYEHMATDI 715 HROH
ESHICHEAT S

E3-25  [SSK@ETD) 71 VI HEOH
AT7ATEHDOT 1V

RIZ, A7 A7 2/HOETH - T4 FITDOWT, ZORELEEHILET,

(h3—-NSVR]1 74IV%

TDTAINHI T, A AXA=VDR, #& HFOLNZHETEET, AOBTHERETDHIE. A
SAF BRI LTLFEE N, AORBEEZTIE, ¥4 707 DTV E2— « £ A—VNHEE
LT LU ET,
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MEELA SR 74109

AT Ry 7 L THELI P IRAMNEAEETLE, #1707 DT L Ea— - f A=
MBEZRBL TR ET,

rRykRya—-ary - -h—xl 7449

r72xz—R1 Z74)%

\l

[/55—2a

136

ZDTANFEF, A A=V IVOEEEZER (/A IlH) EMEIN D EFNRBEIS
CTEELET, ¥4 7073, 20 OBEORKEZRLET, Z0F 1707 O GIE
3. ROEBDTT,

1. B2 —HET—IVRERELET, 2071 —J)V R, EZBIOEEMEEL TWE
To ANUEIER. BRI OMEZMEICTENERUET, -999 05 +999 £ THDEZ
ANTEET,

2. RERSEEOEVEIVEEZFEL T BEZHABLEI., BEOE IV 25— -
T4—IVRODEVD7DDT 4 —)V RTEINET,

3. A=)+ T74—=)LRT, HEICEETNIE 7 LI OHEEMOEGE2E2EEREL ET
4. TF 7ty k (Offset)) TF AL - Ry 7 AT, AT — IVt EHORKRITMA 2 HEEZANLET,
5. TOKI 27Uy PV LET, JA4ININA A=D1 D1 DO INIZH#EHINET,

(7rx—R)] 7473, BRSINZT7 L —L8B EEN L2057 21— R2ERLET,
FIHIETIE, Bz —RLUETA, BASMICT— RIZEAIR. K & 5S0517
Oy &#BELT. oD 7z — REZELET,

cTIT7 - IALT] 74VF

DT INVHFET L —LOHPEIZHE > TEEMICEILT S [SEWD | RE2ERLET, 20
SAEWMOPRIE, FIFT 14T b A A=VEFHAL, £7 L —L0@EYRHEEEHICTSLZ
ET, AlENET, SERMONEDAME, SEMODOITy OO ENIZ2EETEET,

ZDTANETERERTZDE A TOTNRY T v T LET, [ A= D0 — K (Load Image)]

ZIUy I LT VIT74LZ2 b AA=DEBRLET, 7710) - 7793, 2700
TI3T4LUb - AA—DEREETH BAEBFOAA-—DZERNTHIEHTEET, 71

007-2275-010aJP



IR T 1)V 5 DEM

NWEFEFEEAEDA A=V %, BEYRT 7 AV ORBBEEMGEICHBERTEET, 1 A—T%
BRI D& ROBIEDITAET,

e [HZHIT (Black to White)] E£7/&13 THZHIZ (White to Black)) Z&RL T, HAZHO N
O HMZERELET,

o [TUA47 VT %X (Wipe Softness)] A 715 &fHL T, AfilzfEEL £9. I T
BNT Yy CERIERT S 05, EBITHEVWARZDTS 100 ETORENH D FT.

F=Fa4F - 74IVH DA

007-2275-010aJP

ROFA—=F 4 F + T4IVFE R (Effects)] -> [ —F 13 - 7 1 )L'¥ (Audio Filters)] A
Za—lTEENTVET,

[T3— .(Echo.)JBIRU/=t P a iR L T I3 R2ERLET,

[7xz—RK A2 (FadeIn)]
BIRLZEI a2 OBREDT, B2EEASLEVIIHEML THEEDR
Ja—AIZLET,

[7x—R 77k (Fade Out)]
BRLZEI7 2 a0 HODT, BELAEVICEDL TESFORY 2—4AI1IC0L
£7,

MEF{t (Normalize)]
MEHL (Normalize)) ZZEIRT 2 &, EIRL I a 08T K- L)L
NEMLT, 74 FIv 7 - LIITRDET,

[XF A KU w D « A 3514 (Parametric Equalizer...)]
3DDL P DEPEHDOEERES LRV T MITEET., NTIARY v
I3 DOWEAH VLT, 3 DOHHT LT, ¥ —Epkk. #HEiE 7
12/ WEOMEEEICERETEET, FREDFDOEEK T RILF— 2N
., FARICEER IRV F—2ED I 85 &S, RN E K E =N E
BEEEDT A MEIZEREL., FRFICHFWHIRZ KEEREADT 1 HEICER
ELET,
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EE/NNADERTE

138

DC # 71w FEHIERT 5 (Remove DC Offset))
DCH 7ty M, A—F4FEBEN0ITEZ Y T L TWRNWEEITED
DET, DCA 7y MNRIBZE, F14FIv T - L2POORITRDET,
Zoax >y RiZ, HEREFEE AU T T, DCA 71y MEHIBRL £
ER

[J))N—Z (Reverse)|
BRU=E 2308 REREEL, #HMICHEEL £

[EEFXE ...(Set Volume...)]
TA2ETIN) c A=)V TOREFEHTELY A 7OV E2HEET,

AEINSDTAINHIET T T, /usr/lib/dmedia/plugins/premiere 51 L 7
MU EZHL TWET., Movie Maker 13 Adobe Premiere 757 A > &8 R — L TWET,
51 L2 NUIZ Premiere 7571 > Z8MA A M=ILT 5 &, BhE (Effects)] A= 21—IT&
RINET,

mm.plugin

[N (Effects)] AZa2—Da< > ROKEME, EBIZIZTTZ 71 2T,
/usr/lib/dmedia/plugins/premiere 7+ L7 MU ZZHL TWE 9, Movie Maker 3.
Adobe Premiere 7' 771 > &Y HR—b L TWET, T80 E. TOF 1 L7 ~UIZ Premiere 7
SHUAVEENA YA =T D E, IR (Effects)) A= a1—ltERENET,

Movie Maker THERT2ENDT 74 > NdHH5E1E. FEDT 4 L7 M) ICRETEET
. Movie Maker 20— RT3 X DI2T3I121E. KOEDITHRELET,

1. 774V (File)) -> [FTZ74 2 - )NXDFEFE ... (Set Plug-In Path...)] ZERL £7,

2. BMIBTSTA2 - F4 LT MIDNAHEATILET,

o7 EFERALT, BT I714 2 « NAERELZIIRELET,

mm.apply.filter

007-2275-010aJP



IR T 1)V 5 DEM

LA—E—-IC74\V9ZBERTS

1.

TN EB@AT 24 =T 4 A FLEETF - T —LDHMAZERNL £9, SRS 112
R=D [h—E—0tr I a &ERTS] 22RLTIEIN,

AE: O h—E— - FMLTA P TERLBNTLEI N, 707 EFF
EF—F 4 FOWMAITHERHZIZEH TE 8 A,

BIRLEETAELTIAF—FT 1 AU T, R (Effects)) -> TEFH + 7 1)L (Video
Filters)]. 723 )& (Effects)) -> [F—F 1% - 7 1 )% (Audio Filters)] ZZERL T,
BEAZ2a—ho 71 VY ZERL £,

1BOR=TD [FENTVWDIETH - T4IILF DA BEK 136 RXR—TD [F1 70T %8
DT 4IF)] BBML TS0, [RIVF . (Multiple..)) #1707 OfFEHAEIIDNT
1. 140 R=TD [EFF - T4 IINIDL =T > ADHRE] 2BWBLTLFEI W, 3D 71 )b
& DA EIIMERDHIETDNTIE 141 X—2 0D 3D 74 V¥ & LA—E =B &5
BLTL I,

mm.edit.filter

71 IVY DIRE
ZOfIE, 139 R—TD HMEBHINTWSE T ILYDORE] £ 140 R—2D [T 1)L 5 DH|
BRI ICDWTHEHHL £

REBAINTWS 719 DiRE

REFATOATZ/HEDT 4 )VY, BLU3D 74 IILFITIE, WEMRERNTIA—INHDET,

1.
2.

007-2275-010aJP

DV THOTANIE1EIY Y I LT, 7407 ERIRLET,
%R (Bffects)] -> MHRE (Edit)) ZZEIRL £,

BIRL T4 VY OEEICLD, T4IVIDORET A 7OV NERINSD, EX builder 7
FTA MERIN, T4INYERmETEET, FXBuilder ZH L T 3D 7 1 )L ¥ ZHE
T2 HETDWTIE, [Using the FX Builder Tooll ZZHL T</ZE W,

139
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AEIRESA T OV RN T VIR RETINITA—INBNORETEEE A,
e, TAINVIDOHIARA > MR TR > &, Ay b, AE— R=Zh, AEITZHZ
L3 TEEEA,

AEIAD IANIFERET T —bERETDINE, 141 R—=PD 3D T4 V¥ EL—E—
12BN 22 LT /E3 N,

7 4 % DHIRR
1. Uy THOTANIE1EI Uy LT, T1)VYZERLET,
2. <Backspace> ¥—Z#L £,

AE TSk (Edit) > IR (Delete)) &#RLBLTLES V. 74V H I TEL,

mm.sequence

ETFH - 74N09D—T 2V ADEE
BEEIRL TWD 7 L —LHICERAT S 7 VYD —r A% A 7O TRETEET,
HHFIEIRD EHB DT,
1. 740y ZEMT 27 L —LOHMZRERL 7.
FHIZDOWTIE, 112 R—=2Y0 TA—E—0Dtra a@RT5) 28RL T<EI N,
2. %% (Effects))->EF 7+ 7 1 )L¥ (Video Filters))-> <)L F ...(Multiple...)) ZZR L £9,
[Y)VF (Multiple)] ¥ 707 &AL T, HBRT 4 IVFE—F P AEERRLET,

mm.3d.filter
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R 2R DRRE & HA &

3D 74 V& & L—E—ICIEN

1. 3D 74V Y ZEATHETAOHFZEIRNL £

FERCDOWTIE, 112 RX=2D TA—E—Dtv T azBRT5] 22RBLTIEIN,

2. [ZhR (Bffects)] -> 1A% L 3D %% ...(Custom 3D Effect...)] ZEIRL 7,

DA T7aT TR, RDELDE 4 DDBBRNTEET,

P RRDERE LBiAS

3D 74 NV EHL HERT BIC1E, Newl 227Uy 27 LET,

FX Builder W &FE RS 11F 9, FX Builder Z L THAY L 3D 714 V7 #1ERT %)
FEIZDWTIE, FX Builder @ Help A= a2 —2ZHL TS ZE W,

FENTVWDH TV 3D 74 VI ZEEHAT2IKE. ¥170707>7L—h - UZR
51 D&RIRUT, TApplyl 27V w7 LET,

EENTVWEY T 3D 74 IVY EHET DI, ¥4 7070572 TL—h - UR
NS 1DEFEIRLTC, (Edit...] 227Uy 2Z7 LET,

FX Builder V&R E N E T, FX Builder ZffH L T 3D 7> 7L — h &fRET 2 HIE
DT, FX Builder ® Help Z22H L T<ZE W,

DRNZ S AT LORIET 4 L7 MU 3D 7> 7 L— 2Bk, RELZEEE. e
T > 7 L — ER (More Templates...)) ™Y >%&27 U w0 §2E, TV RATEET,
Ty A TIUYNS 1 DEBRLE. [Apply) 220 v 79 % &, BIEDRERY

L—AIEHENET. H50WiE 77— beR%ET 2123 TEdit..) 229070
LET,

mm.time

L—E—zRETLHEIC. A—E—ORHEREN, 7L —LHA, ¥4 AT—-RELO3D
DIETERRTEET,

Z D,

ROWEN SRS NTNET,

o 142 R—TD THERIFE R OB

007-2275-010aJP
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o 142 RXR—TD THERHHALDER

FRERROERE

3-27 IZ Movie Maker 7 1 > R QRFIZRZR L £ 9. RYOBUEIZ. 1 LA > F 1 —

S OBFEDNEEZRLET., 7L —LDHIPHZRERT D &, BIROBBEATRA > b, BifE

DL D FICRRENE T,

TAL AT 47— BB LE0HUVEREHZEET 21213, RHZROR M ZmE L

£, IR TREERR] 70—V RZ2 1 EZ U v 7 U THRERRICL. B L WK Z AN

LT <Enter> ¥—Z#L £7,

FTORENDEMEIR, BEIRUZFFRBEAMIKEL £, ROKDICERRENET,

# ZORINDEMEZ. BEATHESI N ZL—E—D—HERL TVWET,

PASN FTREINDEMEL 7L — LB THIEEN L —E—D—FERL TWET,
el AE Bl 42 0BG A—E—0HhD 2 FHO T L —LEXKLET,

A LdA—R  FREINDEUEIZ. SMPTE (Society of Motion Picture and Television
Engineers) ®% A L d— REfLTHES N2 LA—E—D—HZRL TWET,
SMPTE & L d— Rid, EFFOE4 D7 L —LADBHERET S EHRE, ¥
ALAY T ERERENLIZDDT, EBHOERETHHINTHET, £&x
Ko B L —ADEDR T L EAT N LUET,
AEHA L= RERIE EBHICHEM LW IR D XA,
—RICEFHOET A KB EFHL 2L EDAYTIEIED LT,

AEHAML AT =Y ERLEREHEBH T 272010, FERRERETZILEDHT

FET, L FEE1EZY v LT 71—V RERERREICL £,

B ] BE AR OD3E4R

FORKRE D BAL 2 EIRT 51T1d. [HoR (View)) -> TRIREFE D HBAL (Time Unit for Display))
ZEIR L. ¥ (Seconds)). 7 L — I (Frames)). £7213 14 1 s 30— K (Timecode)) Z &R L £,
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L—E—DFRIRST D

mm.viewing

LA—E—DRRFEDHIEH

Z O, ROENSHRENTNET,

LA—E—0DRoO-)V

LA—E—-DFRT

007-2275-010aJP

143 X—=2® [A—E—DZA70—))]

143 R—Y D [Lh—E—DFKR]

144 XR=2 D [RRE—ROLH)

145 R=2Y D [RRT L —LBDRE ]

U5 R=TD [X=h Ty TEX—L T T

146 R—2 0 TEF AN ERIEBA—F « AT OLEHE)
mm.scroll

AL AT AT —IDRIRIHB/NISB=ZARE27)U 7 L TRV IT5E, L—E—2%
BRRNCFH TAZO—-)LTEZT,

=) IO=ZMAFO LICEERKET 2 &, BEOREREAEETICA/0—-)LTEET,

mm.preview

Movie Maker TA—E—Z2H4AT5I2E b AR—bh-a>bo—)L2EHLET, X 3-26
FSOZAR—b -2 bO0—=)LEFET P OO ERLUET, BEIKTYAL -1
CTFAT I OMENSIBEEDS T EITEFEELTLZI N,

co
[N

143
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RRE—FOEHE

BT (RE~ED)

R a—4A
CATAY

N7 (RHNRB)

Il—4L-TxD—F {EIE

& 3-26 Movie Maker ® s 5 > AR —hk - 2> ~O—)b

mm.changeview

FRE—RIZIE. 7A4IVAA R YT 44 R—=PD (T4 )VAA MY v T« E—RIZDNWT] %
ZH) &L Ea— (14 X—YD [FLEa—--E—RZDOWT] 288) O 2 BEOE—R
NHVET, FLE2—IF. TTHIBNTERINDGE—RT, [ERE (View)] > [T 1L
NU w7 (Filmstrip)] Z#RT2E, TAIVLAN) v T« BE—=ROF > / FIDFTAET,

a—bhy b [ERView)) AZa—2FHT2R00IZ, F4VLA M)y T - E— K%
I ERIEA TIZT5IiE. Movie Maker] W« > ROIZH—VILZEEL., F—F— KD
<Shift+Ctrl+F> F—2Z#HL F7,

FVEa— - E—RIIDWT

TLEa—E—Ki& FI74INFOERE—RTY, L Ea—id FREHICL-E—D1
T —LDHZFERLET, HE Ry 27Uyr35&, ERLIZLA—E—2T L E2—T
e

ZAIVLAMY T - E=FRICDWT

144

Lh—E—=ZTAI)VLAAN) YT« E=RTERTDE, L—E—ZFTANLANIwTOEDIZ
FRINET, BREHICTIL—L01 AT O—EFHO T4 INLDIDICERINET, L—

007-2275-010aJP



L—E—DFRIRST D

E—IZF =T 1 ANEETNTVWDIEEE. A Movie Maker DfRET 1 > R DT DERGFIC
FRINET, J4NVALAARNY YT - E—REHATIE, BEOEWRENTAET.

EM:TAINAARY) Yy T TREIND T L —LOHIPEZI bO—)L TEET, 145 X—TD
(BRI L —LBOBRE) 25 L TZI 0,

mm.number

KRRV —LBODBRE
L—E—ZT74I)VAA MY YT - B— RTERT DHEIC, RREHICFRRICEREINS 7L —
LEEI N O=)LTEET,
1. [#/R (Display)) -> 7L — 4% ...(Number of Frames...)] ZZRL £7,
ZORTEIRICFIRFICERT 27 L — L2 AN LET,
2. TOK) 27Uy L%ET,

mm.zoom

A=A TPYTEX—=L-FI
FREHOT A XX —L Ty TEEEFIX—L - FT2LT, ERINDTIL—LDYA X%
BB TEET, X—LDHRFEIL. HUOREEZZLET S0, Movie Maker 2 T3 5FETHEITT,
A=bL TYTEX—A - TIDIEE
FoRtEE A X —L - 7Ty TEEERYTT5I1203. ROFEITRENET,

o IR (View)] > [X—L4 + 7 v 7 (Zoom Up)l Fizid [FR] -> [X—L4L - ¥ > (Zoom
Down)] ZERL X9,

FoREHIZI A —LA c AR RERBLET, O REHRELULBIRTSZEICEKD X4 -
Ty T ERRIX—L - I TEET,
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ZX—LDEED/E

Ya—bhy bR View) AZa—Z2fFHAT 2D DIZ. Movie Maker] 7« > RIZ
A=V NEBEBNT, X—5Lh 7 v 73 <shift+Ctrl+Us> F—ZWL. X—L - FUITiX
<shift+Ctrl+D> F—2Z#HL £7.

NSRS T =L T TR T TH5R00DI1C, A—LDBREESFRTHEL T L—E—
DERE EOBERESIXLIINSKTEINERETEET, A—LAPRERET DT, X
DFMITHENET,

o IR (View)] -> [X—LA (Zoom)] ZFENL Y., BHITLZEFHRZRRNL TZI 0,

mm.output

EFARNELBF —T« AHNDOEE

146

Movie Maker TA—E—ZREL TS E XX, 7 +) b T, EF A1 Movie Maker T
EREIN (ZOLEOMNZ (75T 4y JHH] ERS), A—=T 1 ARV —=IAT—23>0
AE—HTHAINET, ZhEZEFET I3, 3> ~a—)b (Control )) -> TEFFOH T
(Output Video To)l £7id Ma> bo—)b) > IF—F 1 F DI J15% (Output Audio To)) %
RLUET.

BAZa—IZRKREINEZA T a itk FHLTWEIT—VAT—Taré, BFEDODETFTAE/
BFA—F14F - AT a2 A=V LTHINEDINEITKEFELET, 2&21F 0212
E5F - A7 a eI Tnwadgae, 7571w 2 « A7) —2 (Graphics Screen)] IZEF
FEBHL, A2 —FEMIZTETAEERRTS G774V IEE » TEFE -7 Uk
LT E (Video Out and On Screen)] D EBLENEERNTEET, BS54 - EZFZE Q2 EF
Fe7 TR R— MIERL TWBHEHEE. TEST A -7 Y b &HEE E (Video Out and On Screen))
Tl A—E—2I Fa1—YEHEEIETE - EZFYDOMAIZERLET,

mm.playback

007-2275-010aJP



Lh—E—RBEFT T a3 > ORE

LA—E—BEFT avDRE

FEAEDLA—E—FHEF T al it 12 X—=20 [A—E—0&FELT T a > O] TH
BHEINTWET, £/, 7723 0%<1EF, L—E—2IFAR—- THELEIHRETEELT,
147 R—=2 O [A—E—DITFAKR— b #2BRL T ZI WV, Movie Maker THEHW TS
Lh—E—zHNHE_Y LICERTHEE. £RB3A AN LEREDETFE - F T a -
R—REFHTZHEE 146 R—20 EFAHNERZRF—F 1+ AHIOLEHE) 258U T
<7Z3W,

FIFIETIE, A—E— - 7703 1 EETHEHAINDEIDSICRESINTNET, ZORE
3. HET—REWEINET, ZETEZHEIROEBD T,

la> ho—)Jb (Control)) -> F4E— K (Playback Mode)] ZERL. KOWTNh 1 D%

HRLUET,

e L—E—Z1EFKITEATLZISCTOSILT ST, [HETEIL (Stop at End)J.

o LA—E—RMELEELEELFETDESICTOYIATEITE. HEL (Loop)l.

o L—E—#JEHFMETHANIKEICHELFETZEDICTO7 I LT 2ITF, TR 27
(Swing)l.

mm.export

L—E—DIFRAR—-}F

007-2275-010aJP

[7 7 1)) (File)] > TTFAR— bk .(Export As...)] I REfHTS L BEHHWTVWS
L—E=D5HLWVWLA—E— T7 A NEIFAR-FTEET, TZTFZXR—b (Export)] ¥
A 7B7I3 ROKXIBELDF T andHDET,

o HLWTyAINBAELITERAF—L

o TN L—hETL—A L—bDEIBRL—E— - NTA—FEHRETS
e AA—TDIALVIarEIFAR—FTS

e L—E—DF—FAFDHEIFAR—-FT2

147
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148

AE I TZFZAR—b (Export)] IX > RZWEHITZE, A—E—F1DOEFTE - FIvr &
1D20F=T4F + bIvr F—TAFANEDL—E—DHA) TEMSINET,

IFAR—FTEFIEIROEBDTY,

1.

2.

[7 74V (File)] -> THFZXHR— b ..(Export As...)] ZZERLET,
(X244 74—V RIZH LW T 7 A IVEEEANLET,

1 A — %4 (Collecton of Images)] D ILF AMR— hZEZRLGHEIE. KRR E AL
TIZRVET, NAAT 1=V RIZ, T4 NIAEANLET, ZOF 1 LT MUIEA
A=Y REINDIT LI MIRABDET, ZEAEFE NZAAHK
/usr/people/bob/Images Z AN LEHE, TFAR— MLEZE K, A—E—-7
L — A3 /usr/people/bob/Images TA LI RUDA A=Y« 77 AL ELTERS
NET, A A-JITRECLEAMT 50, 001.rgb. 002.rgb. 003.rgb/2E &R0,
Ty AR (& Z1E. .rgb. .jpg) Lo THEEEMNTEET,

W5, B (Format)] XA=a— -« RY VZ2EHAL T, HiLWERZEIRL £

AT A—E—DF—F A FDHEIFAR—bTBINE, F—F 14 - 771 ERD 1
DERBIRLET,

FFa) FT7Ta>  (Options...)) RE &)y LT, BNDOINTA=FITT Y
TALET,

F—F A FEBFATEL—E—ERIFAR—FTHIHAITNL, A A=A —FT 1+ FDY TN
47O OFEHICEREIN, 22003 bO—)LOEELNERBIRTEET, & 213,
F—FAF - FTEIIVVITEHE, F—F 4 FRENFERINET,
AA=VRENTITIR, ROF T2 a2lidpD, A—E—HOETH - bI v VITHEAE
NnE9J,

o [JEff# (Compression)]

IDAZa— - RY E[FHTHE EMAF—LEZBINTEET, EMRBEHE Finer
Compression Control) | 227V v 279 % &, BIRL B RITHE A TR RE R OEME D > b
O—JWZY 7 A TEET,
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L—E—DITFZAR—k

Evb:—RiC, FlL—b2E<<T5E, J7IVINSLAB0DETA, BERMEFLE
T, EML— b 2R<TBDE Ty AMINMIKRELBODETN, BWEEIMELET, F—-7
L—LDHEZELTRE, EMOL NIV EFEEENSEVET, Ev - L—F2E<
T5E, EFARENAELETA, EROEEIME<L D XTI,

o [T7L—A - H¥A X (Frame Size)]

INTSC] £7213 TPAL] A1 XZZERT D [HAY L - F A XDEIE ...(Specify
Custom Size...)] ZFERL. LW X (EZRIVES) 2AHLET,

e [7L—A - L—1I (Frame Rate)]

IDAZa—DRY WS T L —A L= EERLET, £/, TPAL] » INTSCJ
PEIRTHBE513. 7L—L4 - L—R%& [PAL) £7213 INTSC) DfE#E (PAL i 25
fps. NTSC i3 29.97 fps) ICRETD2HENHVET, VT L—L4 - L— DA
LThH, ESAHREZEDDIEEFTET, JL—L2EHTBZT T,

F—F 4 FRENRIIE, ROFT > a b Ed,
e [F+% > %)V (Channels)]
IDAZa— - RYEMFHALT, A—F 1 FDF v RV EZELET,
e [Y2F)b - L—Fb (Sample Rate)]
ZDAZa— - RYEMFEHALT, 27 - L—b (kHz HifD) ZERL £,
o [H 27 )ViE (Sample Width))
ZDAZa— R EFHEHALT, 2 TFIVRERRL £7,
5. ETLAES, [OK) 22Uy LET,

HR—FLTWBER

Movie Maker Tlid. ANT7 7 1INV EL TROBEXZEZFATEET,

e L—E—®HX :SGL QuickTime™, Microsoft AVI, MPEG-1 > A7 /. DIFF
o F—5 1 AWK AIFF. AIFF-C. WAVE. NeXt/Sun. MPEG-1 Audio

« o A—t:SCI (igb). TIFE. GIF. JFIF JPEG). Photo CD
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Movie Maker 3. 77 1V ERDT 7 A )VBERICTEBTE £,

e L—E—BRK:SGL QuickTime. Microsoft AVI. MPEG-1 A5 /. DIFF
o 1 A= TIFF. JFIF JPEG). B X O JELEHE

o F—5 1 AWK AIFF. WAVE

mm.tape

EFAT—T DL
FIH) - =Y —% VHS 7— 75T 5854, Movie Maker 207 O A2 EHIC L E
T, ZOHIZ., ROBEMNSHEINTNET,
o 150 R—PD [EFAT—T Ol OUEf)

o 151 R—® [Movie Maker Zfffi L TETH 57— IZidEkT 2]

EFAT T DERDER
1L U= AF— 3 VIREFARERT N ARG 520 Oy — 7 ) ERRL £

WEDOREMD VCR 2T 25513 RCA T —7IVBMEIZ/ESTL LD, 2075 —7
g, BEAEDKEEHBPIE 2 —-FDJETHATEET.

AE: ATLF VCR & &BI02 2fFAT 285G, MHICH ZATD RCA P vy I 3H 5
2RO =T N EMET 2RENRDD XY,

Z—)N—-VHS £/-13 Hi-8 v F2FHTZEAIL. S-EFF - ¥ —T I ZHHL T, Tv
FET—IATF—2aliZEELET, RELRTF—TUBEL S R0NEEL, “r—7
JVOBRIZTONWT 7 in ik A ZBRL T ZE W,

2. =T )vEHERLET.

ZWTWOEA, VCROEFH - > R— b2 T =T AF—2a>DETH - 7 hR—h
WL, VCROF—F1F A > R—h &2 T—VRAFT—2a>DF—F14F -1 -7
U R R—RMIERELET, EFFRBETNARAZT =T AT —2 a3 VIERT 5720 D ERE
FEZDNWTIE, 7—2 X5 —3 3 >® [Owner's Guidel #ZBL TL/EI 0,
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EFt 53— 7Dt

FOwner’s Guidel 13 Web L THAFTEET, RO URL ZTHHALZI 0,
http:/ /techpubs.sgi.com /library/
EFT « FNAZANT B> THBY, VHS T—TNWAD> TWBH I EZ2MALET,

151 XR—=2® [Movie Maker ZffH L TEFTH 7 — 75k 9 %) 22 L TickzMmL
E

Movie Maker Z2{ERH LU TETAT—7ICiEET S

007-2275-010aJP

1.

EF AT NANER SN, T— 7 OEFNTEZ5 (150 R—=2 D [EFFT—T 0
FeEkDMEf) 2B, (7 71 (File)) -> €577 — 7 IZEkE ...(Print to Videotape...)
BN £7,

Movie Maker 23— E— 28T 2720 L TS, EBREA—F —NERIN
T3, ZOM. VI MIITREREELEDETIETS - INA AOFEEZEEL, 2D 5
MTUTIE A LDOFRAEITDESEHETEEZT>TNET,
LA—E—DEE[FNEESZ5, FAT7OTNERINT, EFTRETNA A LD THE
(Record)) R &ML, ¥4 7Or7Hd THIR (Print)] &% >%&7 U v 745X DITEL
£7,

LA—E—=DETHTFT—TIRFEINTVBRH, FAFICAT AT - T L—Y =0T 1 > R
bEAEINET,

AE I LA—E—DRENFD L, AMEZSHNEF VIR0 ET, BUOA T B Tar
kO —)L (Control)) -> TEFF D15 (Output Video to))] AZa—ZfHLET. TEFF

>

2§k (Print to Videotape)) @R TEF A HANEEINS 2D, EFAHNZY Y

TOBENDHD LT,

mm.interface
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Movie Maker DA % 7 x — Ri&i&

Movie Maker DA 9% 71 —R - FAT7IS A

TrANE REG FRM® VEE-A© FAVD HEO ~v7 e |
1 e LY ; E2E ] 567 s
; st diome video 3003
[:P stdlo.my &Ldlo 1003

SRR

aZD

s W X
(Fovospm )
I — \\ " o.oool
[stedio.my video \\\ |
[stodiomy Avdio *

(h??xﬁ—h-:?hu—wj_€

D |

Toses i) ]

£ 3-27 Movie Maker DA > F T 1 —A - 14T T T L

ROHTIE, A2 72— AREOWEZHAL £9,

o 153 X—T D TFE/RfEE
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Movie Maker O > % 7 = — A

Rl
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154 X—2 D
154 R—2®
154 R—2®
155 X—=2 D
155 X—= @
156 X— @
158 X—2 D
159 X—= @
160 X— @
162 X—2 D

162 R— 2D

Mt 2w 7 wEE)

(h—E— 51 L5712

(279w 75

B N el N I e
M7 7 AV AZa—]

MFSE] A= a—]

MEIR] AZa—]
Ma>hro—)b] AZa—)
MEA ML) AZa—]

M) A= a—]

MRFfE] 2R )

mm.click.view

FoRtEE, (¥ 3-27 20 OMRIIKDEBDTT,

Movie Maker] W+ > RUDL—E—%2FRLET,

E—D&R] 2B TSN,

FHICOWTIE, 143 R—2 D TA—

L—E—%T A NVLAAN) T « E—=RTERLET, FFMICOVTIE, 144 X—=P0D [#
RE—ROEE] 2L T30,

A4 RV Ny baEATLEEIT. 1 MVETFREERL XTI,

R=2D [FA1 MV EFROIER 22 L T /EE W0,

mm.click.layers

ZEANC O N TR, 121

153



%5 3 % : Movie Maker

bS5 o fElE

L—E— 914 L5(4Y

vAIRWA

154

co v rEE (K327 20 123, E54, F—F1F YA PLOZLAVERTIALTA
0 A—E—OMBIISC TR RENET, FIvrEs Uy L TRIv I L, A—E—D
REDEY > a 2ERTH0, 1ELF VY Y UTHEARS > MEREL £,

FSw ZERDOFEMIIDONTIE. 112 R—P0 [A—E—Dt 73 E2ERTS] & 109 R—
PO AR NORE] Z2BRLTLEZIWN, £/2 118 R—=VD (VY TERTID
FHE HBRLTLZS N,

mm.click.movieline

L—E— L LTA > (M327 BH) 3. L—E—2kDY A LT 2EEL. BTV IR
EENTVET, L—E— I 1 LT > OFHEMIIRDEBDTT,

o A—E—ZZXJO—-)VLET, M3 X=ID [L—E—DZA70O—)l] Z2BRL T ZI W,

o HBEDIUwTDEIZIarTh<, b—E—2KDASA ZEERLET, 113 X—2D
[LA—E—2ROHERDZER) 25 T ZI N,

mm.click.clipbin

Movie Maker ®7 U v 7 (X 3-27 Z2#8) OfHBEMITRDOEBD TT,
o 112RX—=TD 7Y w7 ORI & RRRRR)

o 16 R—=YD VY THOREEI VYT« J—bDA 2 7)b— K]
o 120R—=TD 7Yy TORIERA > b ERS DHRE]

18R=2D Yy TERTy I DFHY 25 TSN,

mm.click.transport
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Movie Maker O > % 7 = — A

rSORAR—=F-a>bO-

2741 A=a—
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FS 2 AR=b-a>bo—)ld, L—E—DFRI> bO—=)LTY, FHIZDONTIE, 143 R—
PO TA—E—0OFR 28BL TIEIN,

mm.click.file

[HH (New).
HRERWTWAELA—E—NHU T, BIiLWA—E—2RETEDLIITRDE
ER

A < (Open...)]
TyA) - TITY « ¥4 70T NEREIN. Movie Maker THIK A5« 7 -
Ty AIVEEINTEET,

[ >AR— 1 (Import...)]
Ty AN TSIV - FATOTRERSN, BEMWTWEAT (Y - T 7
AINTEBINT AT AT « Ty AIIVEBRTE LT, ALYy T &
AL AZTAT = ORICERINET (109 XR—=2 D [FARA > b O
£l 2B ).

R17 (Save)l
E¥EFDT 7 A EREFELET,

[RE7e57—% & HIkk U TR (Save and Remove Unused Data))

7 EFFIC, HIBRFEADO > ahhd, A—E—HTHSRFERATHIZED
BNF—=FZHIFRLT, A—E—% [ZU—=27 v 7)) LET, ZHiTkD,
L—E—N5E®5F 1 AV EBER/NMNILUET, BHD [{A7F (Save)) a7 >
Rig, ZoEEETVERAL. BRICESO TR, T A7 LoD 7 7 1)
SBBIND 7w T % FICZOL—E—HIZEDTVWE I ENHEINHT
o ZOXIBHEI, (REF—YDHIFR) a2 RefHT2E27 71
MHIBRENTLENVWET,

MBI#~TE ...(Save As...)]
MARTE (Save As)| A 7 0OJ « iRy 7 ANERIN, BED T 7 1 IV EH
LWARTE 3B, 2 0WIEFOM G TRETEET.
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MEEl A=a—

156

I8 7 #iPH & B 4 f~7F ...(Save Selection As...)]
L—E—D—HMBEREINTVDHEEE. Z0ax > R R (Save)) ¥ 1
TRy Ry I AZRE, BEOERZHLVWIT 7 AV ELTRETEEXT,

[TF ZR—b ..(Export As...)]
FLWLA—E—Z2BEOL—E—PS/ERTEET, JRT7 71 NVABIUE
R EMEREDNTA—FERINTEET, 47 RXR—=2D [L—E—DITFZA
A=) 2B TIZIN,

M5 47— 7&K (Print to Videotape...)]
150 R=2 @ [EFFTF—7Ofthk) 2L TS0,

[L—E—DFRIE ...(Movie Setup...)]

12 R—=2D TLA—E—DFEF T a > O 2R LT ZI N,
[T S04 2 « NADHKIE ...(Set Plug-In Path...)]

138 R—=2 D [HEFNZADRE] 2SR T LS,

&7 (Exit))
Movie Maker ## 7L £9,

mm.click.edit

B (Undo)
BERIOMREZTCICR L E T,
73 & (Cut)]
HEOBEIRE Y Z 7y BLU TNy 7 7 IREL DGR —ZX R TEXT,
3 — (Copy).
BAEOZERE Sy 2 I — L, BIOHIIIR—ZA R TEEXT,
[R—2Z I (Paste)]
Hy b FRFaAE—SNEHSEY AL A 2T 45— DALEBEITR—X b
TEET, 109 X—20 HFARA > FOFE] 2R TSI W,

{42 (Clear))
BEDEINE 222 A T L — LA TRIEESICERZ T
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[HIB% (Delete).
WIBERLTHB 27U vy T2HIBRLET,

[’k U A (Trim to Selection)]
BUEDZEIRLS DE 53 Z2 TR THIBRLET, 116 R—2 DT A—E—DE 7 T 3
CERNIIDTTE EZRLTIEI N,

(/3% (Break)|
DV TDIAL A T4 —FDOMBIZT L=V EHALET, 119 X—
PO 7YYy TE2000 0y FIZHEITS) 28R T 7230,

#&& (Join)J
BRUZZ Uy TE2EGLET, 120 =20 7 vy T OfG) 22U T
LTEEW,
(271w 7% i~ (Bring Clip to Front Layer))
BIRLEV Y wTE2LA—E—D7O2 N LA VABHLET, 118 X—=2D
()T ERTy IO Z2BRLTZI N,
[271) w7 %%\ (Send Clip to Back Layer)]
BRIV T2 Lh—E—DNY T - LA YABEHLET,
I RTZER (Select All))
TRTOIZ Yy T2 BN KT
(4R L 720 (Select None) |
TRTOY Yy TEBYRRIRL £9,
E5R A 4R (Extend Selection Right) )
WIEDERE 1 7L —L0% AIIELET.

LR /E7E IR (Extend Selection Left))
BIEOZERE 1 7L —L0 EHELET,

mm.click.view
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[&{R] A=a—

158

AE I TERR (View)] AZa—id, AT -7 Y RUNSBHIETHOY 1 > Ry ELTE
RTEET, ZHITE TR (View)] AZa2—2H&E, AZ2—0DRICERIN TV SR
(------) ZBIRL £ 9

(71 v 7Hi% &= (Clip Bin)J
7w TRERAWEZD, BACZDLET,

[7 4 VA BY w7 (Filmstrip))
TAIWLARN) T « B=—ROF L EFTEYEFRET, 144 R—=DD T4
JWAARYwT « F—RIZDNWT) Z28RLTLIES N,

[7 L — A% ...(Number of Frames...)]
145 R=2 @D [ERTV—LBORE] 2B ML TIEE N,

(A LTA1 2 LA VICEIEZRRIE ...(Set Number of Timeline Layers...)]
FRTDIMNLTA L - by IV DRERETDZY A 7O HHAEET.

(514 L5412 OFHERHE OFRIE ...(Set Timeline Duration...)]
A LT ORHRHZEZEE TEE T,

[ R REF[H D BLAL (Time Unit for Display)]
% (Seconds)). 7L —UA (Frames)). £7zid %1 L 32— R (Timecode)] 7
SERLET, INs0axr R XRKEOBMOY 1 TZ2REL XTI,
141 R—=2 D REFEROBE EFAA 2BRLTIZI N,

[FA#EET (Playback Statistics)
FEBEOTL—L - L= FBRUOAF v TEINET L —L87s EOFAIERE &
RUFET. ZOFEHERR BIfEDO L v 2 a > THLIZ Movie Maker TA—E —
EHAELZEZICETAHDTT,

(X—=L 7 v7 (ZoomUp)) & [X—L + ¥ (Zoom Down)]
INsoav >y R BERREBICERRINTNEL—E—82ZX—L 1 >,
FHRFA—L-T7TNLET,

[ X —/I (Zoom)]
A= LDEREEFHERTHETEET,
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Movie Maker O > % 7 = — A

mm.click.clip

raryera—-Jib] Az=a-—

(B4 (Play))
(A R D ERUBEELET, 4L A 2T 17— OBEIEOMBED
5, BEFOL—E—Z2HELET,

M1k (Stop).
eIk RY > EAUEEELET,. L—E—DHEZEIELET,

M1 7 L —AHRi~ (Forward One Frame)]
[TL—h-T4+T7—R] R ERUBHEELET, Y1 L A>T T5—%
Z1 7L —LaiNBELET,

M 7 L —2A,%~ (Back One Frame)|
[TV —L Nl R ERUBEELET, Y1 L A>T T7—F%1
T —LBANBEHLET.

2B (Go to Beginning) |
Ny R ERUEBEELES, 1L A>T r—F%EL—E—D%

HABHLET,

[\ (Go to End)
&7 (End)) A7 > ERICEEELET, ML A T4 r—FeLh—E—
DEENEEL T,

[F4E— K (Playback Mode)]
L—E—%1ELTHEET 2R [RETEIL Stop at End)) ZZRL £,
L—E—ZMEHHIETITIE. KL (Loop)l ZERL ET. A—E—%JH
FIAI & FH L EICHAET 5121, TR 27 (Swing)l ZEIRL £,

M5 & #iPH7=1) 2 F4E (Play Selection Only)]
L—E—D—HEZERNL THWLHEIE, BIRE»7ZT2HELES. Fov s -
R=I NN TNBEZTF 2, FNTORNEERZ T TR > TNWET,
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[k ...(Record Audio...)]
ZOHBET, MDA —F « TEEY —IIVBEE LT, [§&E (Record)) R
FoEIUYITDHE, F—T 1 ARG — I OBt LRI L —E— DA
MIRED ET . E L, BEDIREDATIC 3-2-1 OBFANDH D £, 108 X—
PO Th—E—IZF =T+ F&HETT5) 2BRLTIEI N,

(AF 47 « La—% OiLH) ...(Launch Media Recorder...)]
ZOAXRZREF. AT 7 - LA=FZEHL, EFA, BEEAA—D, F—
T 1 A ZHWS L T, Movie Maker ICIE—BIUX—Z P TEET,

e F @715 (Output Video To))
TOEFMOETHMNA T2 a b EBINTEET, LT TEFTH - TU b
&2 57 4 v 7 (Video Out and Graphics Screen)] Zi#EiRT % &, fwk
LTWaLA—E—d AT LDHEHEET =V AT —2a>DEFH T T k-
R— MTER L IAMBETH - TN ZOWMAICERRENET, TOAZa—
DAT T alid AT LAOFERRBA T a2 - R— RaeMiTThan
EDOMITXVRERBRVET,

[F—7 1 A O F15E (Output Audio To)!
WEFDL—E—HIT. ZDORNDOF—F 1+ FTHNAT 2 a > & BIRTEET,
F74)VRTiR, A—E—DF—F1Fd. 7=V RAF—=2a>DAE—=HT
BHEINET, ZZL, ZEXE V=PV AT7—2aDF—F4F T T
R MCENDAE —HINEHFEINTND EXIIE, FOAE—ATH—T 1
FEMSIENTEET, TOAZ2—DF T 303, P AT LOFEEDH:
MEF T ar s R—REMTTHENEINTLIVRBRDET,

mm.click.title

%4 bl A=a—

MERL ...(Create...))
A4 MNUMERSY A 707 &Y MLy FEEEBHLET, 121 K= ¥
A RVEERDIER] 22U T EI N,

MR ...(Edit...)]
ARV Uy TEEIRTAHE, 20O RIZEDYA ML - B— Ryt
SRR, YT ERETEET, 1 ML XLy RRERINET,
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Movie Maker O > % 7 = — A

[THH % A~ (Bring Item to Front))
ARV BE—ROELE, 2O RII BRLAEIZY v TE2YAL LDy
T LT UVANBEHLET,

[TEH %%\ (Send Item to Back)J
AN E—ROEE, ZOARIRIEF BRLEZ Y TE2Y A1 MLOR
R LI UVABEIL £,

[THH % 7212 %51 (Align Items Left))
BIRLEAT V27 M bh—E— - JL—LOLEMICBHIISEET,

[THH 2 251 (Align Items Center))
BIRLEA TV b2L—E— JL—LOHRIZBIIITET,

MEH % 412851 (Align Items Right) |
BRLEA T2 e bh—E— - TJL—LOHMITEFISE £,

72>k« 773U — (Font Family)]
ANV TFAMACTA POAZa—ZRHEL £,

7% > bk « A X (Font Size)]
ARV TFAMHCZTA D A ZDOAZ 2 —2RHLET,

[Tk« X%1)L (Font Style))
ARV TFAMTT A2 b s AFAINDAZ 2 —2H#LUET,

74k« 15—+ XLw h®DY X KT (Restore Default Color Palette)]
BERHT— Ny h2F 74 hONLy MAICERIE XY, BEOL—
E— -1 MLoERAEIR. ZELEE A

5 E L TOL—E— (Movie As Background))
T4 MVEEATHETA 7L —LA0HBZER LA BRELTOL—
E—+ E—FTiE EFFNERELTERINET, ZOE— F2ERICT
LE, HA MUERFOERIZHICRD £, [FRELTOL—E— (Movie
As Background)] IX > REZERTHE, ZOE—RFOF > /| F 7 &AL
¥9, ZOAXIRIE ¥ ML E—F] TREL TV EZICZDBHER)
T, LA—E—ITIIZEL £HA.

(%4 FL DO s .. (Title Background Color...)]
NT—BIRYA 7O NHE. Y14 MVOEREAICHLWEEERTEET,
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TR A=a—

R &R

162

mm.click.effects

[F—5F 1% + 74 )# (Audio Filters)]
LA—E—ICHATHEF—FT 14 - TAINIEBINTEET, 129 X—=TD %)
RHAT7 1 VF OB 2R TIIZE 0,

TE54 « 7 1 J)L% (Video Filters)]
L—E—IC#EMAT2ETH - T4 FEBIRNTEET, 129 R—2D [HRA
T4V F DN 2SR TS0,

'V F+ 1> EYF v (Picture in Picture...)]
7 F% - A2 -2 F % ..(Picture in Picture...)] ZHEET, 120 R—
DIMEIFY A2 - EIF v V—ILOH] 22RLTIEI N,

(7324 I 3D #h5 ...(Custom 3D Effect...)]
3D 74 NV EERTEET, 141 R—2D 13D 74 I)V¥ % L—E—IZ3BhN)
BTSN,

MR (Edit))
BIRL =74 I BRETEET,

mm_timedisplay

FrfRoR (X 3-27 Z2H) I3 1L - A 25 17— OBENLE & £ TR BN TR S
NET, Foo TL—LDTN—7DEERRINTND &, ZOEEIT £ 0@z R I R
MBORRLET, REXE TL—L305T7L—A 17 ZBRLTH2HE. 13-17] EFR
ENET.

TAL AT 47— &BEHT 50 L WEREHZEET 2L, REZRORMZHET

E2FEY, UL, K7 —ILRZ21EIUw I LT, 70—V RERETREICLET, Hil
W2 A S LT <Enter> F+—2f L £9,
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Movie Maker O > % 7 = — A

Movie Maker %% [# (Seconds)). 7 L —Z (Frames)]. £7zI% [ L J— K (Timecode)] %
ERTDEDICHRETEET, FICOVTIE, 141 R—2 D TREHIERORE LFAH] &5
L TL<7ZIWn,
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Media Player Di#gE
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Media Player

ZOFEF, ROHNSHEENTHET,

o THEZE (165 X—2)

'Media Player Oitc#)) (167 X—2)

o Th—E— F—F 14, £LIIMIDI 771 IVOEA] (167 XR—2)
o IRYa—LDFHE (169 X—2)

o [ERATTa>oiE (169 X—)

o EZIaloER 173 X—2)

o [A—E—Fk3F—F+F - - T7MNDZRIO—)V] (174 XR—2)
o ENOT7TVT—2aizatE—7%] (174 XR—2)

* [Media Player 1 >4 7 = —ZAIZDWTJ (175 X—2)

mp.overview

Z DHi T, 165 X—2 D Media Player DH#HE] . 166 X—®D Media Player D481 . 166
R=20 INVTDOERRIE] ITOWTHML £,

Media Player i VCR (E5% - v b - La—%) LEBOBET, V-V AF7—2 3>k
Th—E— Ty, F—=F1F - T7A4INVEREIMIDI 7 7 A IV 2HETESY—)LTY,

165



% 4 % : Media Player

HEAR BB DONWTIE, 167 R—P D TA—E—, F—F 1%, £/IEMIDI 7 7 1 L OHFEA)
EBERLUTLEIN,

Media Player 1213, SEEERERFT T a>nH0 169 R—TD [RKRF T a > OFRE]
=2, 77N O—H e EZnoT7 ST r—2 3 I —T&Xd 74 R—=20 NEF1rhD7
T — g icaAE—9 %] 25H),

Media Player D41

ARA=D2T Yy 7§D ERRERINET,

Media Player M &8
Trin@E wREEH F=nOW ~ 7 @D

FoRARE
AL
AT —F GALZA
I‘-..T/ ] R a—A
BRED —0.235 CATAY
E:rf ﬁrﬁﬂ U.235|— 1722 E ;ﬁ&i

I (e O B B 2 4R Nwd ik BE

4-1 Media Player D4ME (71U v 7§ % EHLRFERR)

ANIVTDRERE

ZDOXRZaT7IE, ROEXRERZHEHALTET,

o HOTERINLMIME, AFEOMOE, i, HEXLBHFEOERNOY XV ZRLET. &
EZE =L L—b] 22U 2ETL—L L—FOERNFRSNET,
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Media Player D #f

o RTERINTWDHXFT MEBHHY > 7] 2RLET, Zhz2rUwr95E ZOLFD
v —)b. =& ZIX. Media Recorder 8B S 11 £ T

o AZa—#EAZa—THHOM®D [>] @&HIE. A2 a2—DRRNNAERLET, 2&ZIT.
[7 74 )L (File)] -> [B< (Open)l &, [77A4)] AZa—ZBHWT <] 2&RT 5
ZEEEWRLET,

Media Player D#ZH)

Media Player % B < IZ1&, 30D DHENDH D X7,

o FTRUbMYTDL—E—-TAAEYTINI Yy TBHE, Media Player] 7+ > K
DLA—E—DHBMITEEHL X9,

e YA a2%ZYwZ LT MediaPlayer ZEET 21213, ROFNEITHENET,

1. FAXZ by 7D IV—)LF £ A (Toolchest)] M5 MEFK (Find)l -> [AF 47 +V—
)V (Media Tools)) Z#ERL £,

2. Imediaplayer] YA 22Z&F 7)) v I LET,

e UNIXITz)hoax> RFNSEHT 5ICIE. mediaplayer E¥ 1T TAHLET,

mp.viewing

LA—E—, =T 1 #, LB MDI 771 IDOBE

ZOHETIE 167 XR—T D [HAEME] ., 168 X—TD [T 74 )V OREDE Y 3 > DFE] B
K168 R—2 D [HLE MIDI /)N A TOEAE] ITDOWTEHBL X9,

BAXEE
1. T771) (File)] -> IB< (Open...)] ZERL £,
2. Iy TIUFEMFERLT, AT 771V ERERL. TOK) 27U v LET,
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% 4 % : Media Player

EYFIRIY T - TR ROy TIREKD, BHEXKRLTWEHDERHIDT 71 )Lz <
TEMTEET, EAR BfELA—E— A ZRRLTWDRREHRIC, L—E—B 71
aY&Roy 795, RODICA—E—BZEERLET,

3. TH&E] Ry >&r v LET (K4-12H).

¥3—bAhy b MediaPlayer TA—E—+ 77 MIIVZHITIE, A—E— -T2 %&5T
WIUw I LET, £zo h—E—%F—F 14 - T71)L - 722 %. mediaplayer] 7
A 3 2% Media Player ZREBUCEZ NS v/ - Y2 R« ROy 7952 EHTEEXT,

EVbhFREEE1IESZY Y TDE FBEEZ-FELLET. ©21E7 Uy 795 EHE
ZRfTLET.

Z771IDEBEDELYI I a > DBE
1. HETZE I a aBERLUET, IOV TIE. 173 =20 'y a3 > 0ER] %
ZRLTLEE N,

2. a>ho—)b (Control)) -> [&E#iFHD A% 4 (Play Selection Only)) ZERL 7,
3. TH4A) Ry 270w LET,

5488 MIDI /N1 R TOHBE

MIDI & > YA T D& D74 MIDI )N AT MIDI 7 7 1)V Z2BE4AT 2121, ROFJEIC
EnETg,

1. MIDITNAZRDANZET =V AT—2a>DIUT7)L - R—hZHEHELET.

TUTIN - FNAADA VA=)V HERZDWTIE, §T7—2 A5 —3 3 >D [Ower's
Guidel] ZZHRL T ZEI W,

2. MIDIFNA A% U 7))V -R— MR L 728, [ AT L - ¥ % — v (System Manager))
EHEALT By b7y IOV R 2V REETTLET,
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AU 12— LD

" —)LF = X b (Toolchest)] 215, [ AT L (System)] -> 2 X5 L+ ¥ 37— ¥ (System
Manager)] Z#ERL. [N—RK7 7 &5 /N1 X (Hardware and Devices)] #7271 v 7 L
EJCIR

3. ZNTMIDI 77 AI)VE2Y TR - TL—Y—D ROy 7 Ry hickoy 7L, MHAE]
Helb), BEUOTERLUIRY D 2FAL T AMEMIDITNA ATT 7 A IV EHETEET,

AE:JOHEELT, MIDI TNNA ADFA—F 1 AN ZET = X 57— a ik lL. v X
T L+ XF—P ¥ (System Manager) TV —27 A7 —3 3 VHICRELZHERE, V-V A7 —
2 a>DAE—=HTMIDI 7N REFHAETEET,

mp.volume

RY a—LDAE

Media Player ®7RY 2—A « A74A4 % « Ry > (K4-128) AL T, AU a—LzHEL
£9. Ry &IV I L, ATGAMFZ LRIy LTRY a—L%z kT, FICRIYZ LT
A a—LZFFET,

A€ L—E—% %71 —L%fHE (Play Every Frame)] E— R THAEL TWHHE, +—
FAFRYNA T8 B20. A—E—DF—F 1 FIA 70 ET, FMcOVWTIE 172
R=20 THEDHREOEE) 28RBL T /EI 0,

mp.viewoptions

RRFT T a v D®E
Media Player (213, ROERA T2 3 >hH 0 KT,

o 170 RX—=20D TREBZETHEREH —F « A DI DR

o 171 R=VD [X=L TwTEX—=L T ]
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171 R—=2 D THFEFERDOBRE EFA A

172 R—=2 0 THAEDHEDEH)

REBDETHEEBF—T 1 FDHNEDEER

170

ET A5

KHEDQDETH -N—FU 7 &P AT L EIA A F—)LL TV 2581, Media Player TA—
E—2ZRTHDIMEATHIETH - N— Rz 7 2EIRTZ 250DV ET., EFH - 47
2 a da> ba—)b (Control)l-> EFF D15 (Output Video to)] D FIZEKRENET,

N—= R 27 HNTERE OF 2R £

Q2ICEFTH - F T2 a rEMIFTWDEAE. 7571 v 7+ A2 Y— (Graphics Screen) )
WCESTAZHE AL, A2 —FHEICETETHE2ERTS (74 ERE) . [EF
%« 7ok LA E (Video Out and On Screen)] D EBSNZERINTEET, %HEEER
T2E A—E—ZIZEI—FEEIICERTDHEEDIT, EFF - T T - R-hIbik
ELEY.

Indy. Indigo. 7213 Indigo2 IZ Cosmo A" — K. Galileo. Indy Video. F7id. Indigo
Video ZffI} TWAFE, ESFF - N— R 7 EHE#MEDH S JPEG Efs S Nizb—E—
ZH EEITE. 17974 v - X2 1J— 2 (Graphics Screen)] 7 [Cosmo N—R7 =7
(Cosmo Hardware)] ZR#IRTEE T, [Cosmo /N\— K =7 (Cosmo Hardware)] % #ER
5L LA—E—FACE1a—FHEHEICERINDELEBIZ, EFTF - TT b - R—hiZd
EREINET,

Impact Compression /\— R = 7 2T TWAHE, €54 - N— KUz 7 EEHMEDOH
% JPEG FEfis Nz L —E—ZH< &&Eid /57« v 7B (Graphics Screen)] 7
Mmpact Compression HW (Screen and Video)] Z#ERTE£9, BEEERITDE, L—
E—3d Ea—FEEICERINDEEBIT, EFF -7 -R—hIbEFINET,

F—F 1 A

F—F 1A - Ty AINEHAETDEEICE. (32 hO—)b (Control)) > [F—F 1 FDOH A%
(Output Audio to)] ZZFERL T, F—F ¢+ TN HEEZBNTE LT, BREOBEET. (X
F—=VENTVWBIN—RT LY +F—F4F - F T2 a itk TERIBDET,
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RRA T2 a > DRE

A=bL TYTEX=A - -FI

BREIRTORE & Fid S

007-2275-010aJP

FRERE X =L« Ty TEREBZA =L - FT2TBHILECELOT, 1 A=VDYA XEREL
LEDNSSLEDTEET,

=L A 2EZRITTT2ITE. ROFIEIHENET,
[ER (View)] AZa—m56, [X—4A 7 v 7 (Zoom Up)l £/l [X—4 - ¥ > (Zoom

Down)) ZZERLET, EE50DIV 2 REERUERT 5 &, BEBEMICA—L4 -7y TER
A=A -T2 INTWEET,

a—bhy b XR(View)] AZa2—z2#HT2KHDDIZ. Media Player] 7 > RIZ
H—=VINEEE, <Ctrl+U> F—2#HTEX—4L T v, <Ctrl+D> F—2#HTELX—L - ¥
U OTEET,

A —=LEREZRET 51213, [FR (View)] AZa2—2FNWT, A=A (Zoom)] AZa1—n5
BAOROEEZERL 7. (5EOMEELEE T 50, Media Player Z# 179 % £ T Z ORENE
AInEd,

L—E—Z2ERTDHELEE LA—E—0OKHZ PEA, 7L —LA8A 1 L3 REZD3D
DIHETERRTEET,

AE I H AL A= REREEROI—FITRBILERL, FiZ. ZEHEHOESTAEBEZHEHNT 2
EEICDOHIYTIEIEDET,

FoRd HIFRHIBALZEIRNT 51213, ROFIEICHENE T,

o [FIR (View)] AZa—%BWT, REFHAL (Time Unit)) O—)bF—/N—+« AZa—»n5,
% (Seconds)). 7 L —U4 (Frames)). F7zid %1 L J— K (Timecode)] ZEIRL 9.
AZa—HEHHOEMOF v 7 - =7 M, ERINAEEAZRLET,

4-11Z. Media Player] 7 > RUDKHERIRENTWET, EOKMEL, F1L 1
STAT Y TOBEMBEERLET. Y14 A 2T 75 —F13 RRBEHICBELRRINT

171
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BEDBRENEE

172

W7 L —LDRZERLET, 7L —L0HMZRRL 256, BIREHORBRA >~ &k
THRA 2R, BIEORRDO TICRRENET,

RRSINLEMEL, BRUKFBEAIEKEL, ROLDITRRENET,

Vi L—E—DBIRINTNWDEG DB THIEIN TORINET,

TL—A LA—E—DFEREINTNWBEMN T L — LB THEIN TRENET, =&
X, BiEN 42 oBEa, A—E—0HFO L FEHDTIL —LTHDIEE2EL
ESC

A LI—R  A—E—0DERINTWSESA SMPTE (Society of Motion Picture and
Television Engineers) @4 A 53— FEMTHIE SN TRENET. SMPTE
A Ld—RiE EFAOEADT7 L —LMEER/FETHIERE. ¥ 1 LAY
ST EBEELZDBOT, EBHOEKBETHHAIN TWEY, .0 8.7
L—4) OB TIL—0% 0D RLET,

BERAWTWS 7 7y VOBADREEELET 5121, T2 ho—)b (Control)] A= 1—%H
WT, ROBDOZERRL ET,

[F4E— K (Playback Mode)]
h—E—% 1 EEFFAT 5101, TRETHEIE (Stop at End)) Z%H L £9.
L—E—ZMEHEETITE. KL (Loop)) ZERNLET. A—E—%JH
Fi EHHNZAICEAET 2121E TAA 27 (Swing)l &ZRL £,

[F4 8% (Playback Speed))
UZA S EN/HEREDO NS FAEREZERL T, 2T, 150%) 2%
RIzL TJL—L  L—bOEZOEETT 7 MIIVBHEINET,

i (Play Reverse)]
¥4 (Play Reverse)] E— Rid, 77 A I)VOBAFZHITHRELET,
DA REBRRTZ L, HHEIE—ROF > EFTBYBEDOET . F oy
7 e R=JEF>>THBHZEERLET,
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U aro@ER

[¥5E #iPH D % 2 4 (Play Selection Only) ]

[$5 7 #iBH D & %2 B4 (Play Selection Only)] £— Fid, BHIEEREINTWS
DAz HAET DK DT Media Player Z&EL £9, 2DV K2R
5L ZOE—ROFEFTNYBEDLVET, Fzvl - X—J3F>T
HBTELERUET,

%7 L — L % 4L (Play Every Frame))

MAEIRY &7y I LeeE 27 L —A%ZH4ET 5K 512 Media Player
WHRLET, 20472 arid, EMSHEEL—FXD B LA—E—DEINKY
Il e Ao BENH D HEITHAL T, A—E—DREPICTL—L%D
MEZZIENHVET, ZHL A—F1F - bIv o - L—rCZFEITS
720, £REMBHL —MNCXBEEDK T 25720 TY, HETZ Y.
LA—E—DfFESNZT V=L« L= 2HRELED LSS RHAZTTY
FIM, MHEEDORLD, £72id CPU KARBAND TED 0T, #HFFT
ERNIEBHVET, 187 L —L%HE (Play Every Frame)] Z#ERL /2
B&. AL TS EMERICE D MBI LERRFN R 5720, 7L —1I-
L—MIEELEHDTRIARDIENH D ET,

AE: &7 L —L%FH4% (Play Every Frame)] E— R TA—E—ZFH4ET 5
Ba. =T« FFEENF 7182720, h—E—DF—F 1 FbF TIT/8D
P

mp.selecting

o a3 nER

L—E—%kkEFF—FT 1A - T7AINO—HZE2IE—FLIFIHAETHITE. 72 a P EERT
LREND D ET,

1. W=V NEIALTALY (4188 ITEWT, XUAOERY > Z7Uw 7 LET,

2. RUR - RYEWLENS, I—VIIVZERT Y7L THEBZERL £T,

R U 728 I AT E T2 0 BIREH OB S/ 7 ORI, T > RO DETOMITE

RENET,
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AT HBEORERRZAET 21T, BIREFRHEEHE Y 1 —L R (4128 22Uy 2L 7T f#
ETHILHBTEXT, FLWKHERZ AT S &, BREEAERSNET,

BRI 2HRE L 7213, ROBIERITD ZEMNTEET,

o HHEOBREMBETIZ. 77ANERAZO—)LLET, 174 R—PD (A=Y —F =134 —
FAF - TrANDOAIO—)] ZBRLTLIEIN,

o EREMHpEEALET, (32 ho—)b (Control)) -> FEEHIB DS % FH4E (Play Selection
Only)] Z#RL., THAE] R¥ 2220y I LEY, Fov - =23, FEEHHO A
ZHEA] DA THDZEZRLET, A T7IUEFEZDITE. O 1EBERL T ZI N,

o SGEREHEIE—LET, 174 X—2D EHrO7 FUr— a2 icat—3%] 2811
TL7EE N,

mp.scrolling

LA—E—FERBA—T4F - 77400DRoO-)b

FALTAY (H4-1ZBH) DI LA 2T 40— DEIMIIH LN R=AREMEHT S &,
Ty AN EMEMELZIES A 70— TEEY, ZOX—H—%27 Uy L THAMERE
BIEAMIC RS w75, EwEE22 bO—)LLEBNS Ty I)VEZX 7OV TEET,

mp.copying

EPOT7TVT—2avICaAE-T5

174

TyANOtr 3 ZBERLT. 20aE—2R0Y 75— 3 >, = & X3, Movie Maker
IZR—ZX FT&E£T, Movie Maker & Media Player M@ It —&ER—Z MIMA T, Media
Player & Movie Maker 7 5. IRIS Showcase. Image Works. InPerson 87 hik— EAD 3
E—ER=AREFFALT. INHOT T VT —2a>OhG, H2HMOT L —LZ2ERT S
DT 1 ERIE-TE50F1 D207 L —AKIFTY, £/, Media Player. Movie
Maker. Sound Track [Hi CH—FT 14 + 7 Uy 7OIAE—ER-AZTDI LB TEET,
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Media Player 1 >4 7 £ —AIZDNWT

1. A¥—9377100tralz@ERLET,
BRAIECONTIE, 173 X=20 172 a > O@ER) 28U T30,

2. [H@%E (Edit)) -> [3E— (Copy)l ZEIRL LT,

3. AE—LZZUvTER=ZA+TB7 TV r—>az2HEET,

4, HLWTTUr— 320 [R—=Z |k (Paste)] IX > REEEHL £,
DV TR T L—A LT T U r—2 a3 PNTHEELERA > FMIR—X FEINET,

ya—bhyb:TaE— (Copy)) & X=X b (Paste)] AX > RORODIZ, F—H—F -
a—hhy hEFHATEET, <Ctrl+C> F—TaE—, <Ctrl+V> F—TXR—Z F 277820
E3C

mp.reference

Media Player D4 % 27 x—XICDWT

Rl

007-2275-010aJP

Media Player I21&, RDA > ¥ T = —ANHD X7,
o 175 R—T D [FKRMEEL

o 176 R—YD [AZa1—]

o 179 R—TD A LTA ]

o 179 R—T D [KFHER]

o 180NX—D [FRYa—L4 Ky )

o 180R—=TD [hTFUAR—=H-a>bO—)b]

mp.click.viewing

Media Player TA—E—%H< & A—E—D7 L —ANFRRERICERINET. [FHAE B
2w ITEHE A—E—NERERTHEINET, L—E—OFHEPICEREEZ 1

175
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72741 A=a—

MEEl A=a—

176

ErYyrTBE A—E—F—ELLET, o—E—0EREZMET BT, HAE Ry >
2w LUET, SOV TIE, 167 R—PD [A—Y—, F—F 4. £721F MIDI 7 7
AIIVOFEA] 2L T /EI N,

mp.click.menus

Media Player I21% TNV (Help)l ICMA T, RO 4DDAZa—2HD XY,
e 176 X—=2®D [TT77A)] AZa—)

o 176 X—=2 D ITHEE] AZa2—)

o 177 R—=TD [MTER] AZa—]

o 178 X—T® Marbto—)] AZa—]

[754)V (File))] AZa—Id. ROIY> RMhSHRINET,

B < (Open...)]
Ty AN TSUY - FLT707 Ry 7 Z%&EKRL T, Media Player THi <
AFAT « Ty AV ERIRTEET,

M 1RFE ...(Save As...))
MBI#1RTE (Save As)) A 707 - Ry A%&FRRLT, BEDT 7 I %&H
LWARTE 3B, 525 0VIEZFOM G TRETE T,

¥ 7 (Exit))
Media Player Z# 7L 9

MR (BEdit)) A2 —i3ROIAY > RhoRENET,
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[RFR] A=a—

007-2275-010aJP

lag— (Copy)!
BERERL TWaEsaaE—L0, JIREMIIR—Z N TEET, 173 K=
D7 aoER 174 R—20 EFro7FUr—2 324238 —19
5] 2BRLTLZI N,

T ER View)] AZa—13 L) AZa2—T. 1 ERSENOT 1 > RIELTERT
EET, UEETITE, [RR] AZa—2HE AZ2—0 ETERINTO DM (—--) 2E
RUE9,

[F£R (View)] AZz2—IZid. RO KPHDET,

[7 ZXY F Rz L £9 (Maintain Aspect Ratio)
TANRT NEER G 2 BB oL R TENEInERELET,
7 7 4 F Tid. Media Player] 7« > RUDH A XEEELTH, L—E—
DT AR MERIIEDD £ A

[(X—=I 7 w7 (Zoom Up)]
Lh—E—%2ZX—=L Ty TULET, FHIIONTIE, 171 R=PD [X—L4 -
T T EX—A - FI] ZBRLTIEIN,

[X—L + ¥ > (Zoom Down))
L—E—&BZX—AL - FTULET, FEMICONTIE 171 XR=20D [X—L4 -+
TwTEX—L F 2] Z2BRLTLIZE N,

[ X— I (Zoom)]
A= LDEREEFHERTHETEET,

[FEfEIBAL (Time Unit))
rﬂ‘ (Seconds)J. 7L —L (Frames)). £7/213 %1 L 3— K (Timecode)] »
BIRLET, 250072 Rid £RT 2REHBEMAOBEEZZREL £,
.#%H] IZDNTI 171 R—=P O TR FERORE EFA A 2B T Z3 W,

[FA#EET (Playback Statistics)]
EEOTL—L4 - L= bBIURF v TINZT L — L5z EOFEMIE#RE X
RUET, ZOfEHEI BITED Y v > 3 > THR#EIC Media Player TA—E—
EHALEEEZCETSEHDTT,
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rrra—ib] A=a—

178

[F 4 (Play)) HERWTWS 7 7y M I)VOBEADHE, £RIEIEEITVET,
M1l (Stop))  BAEZEILET, T—KEIL (pause)) EFIFRTY,

1 7 L — AHi (Forward One Frame)]
L—E—OFBEHIZT DEOT L —AITBE L X7,

M 7 L —2A,%~ (Back One Frame)|
L—E—OBERIC1I DBOT L —LICBEHL X7,

e (Go to Beginning)|
ATAT + T 7 AINDEENRD 7,

[F4E— K (Playback Mode)]
L—E—%Z 1 ELETHEET DI [RETEILL Stop at End)) ZERL £9,
L—E—ZMEBEEERTICE. R L (Loop)) ZEIRLET. L—E—%JH
il & W I AT 5101, T2 27 (Swing)) &L £7.

[ % % (Playback Speed) |
UZ b ENTHAEEEOHN S FAREZERL £7. ZEXE 150%) &%
RNIBETL—L - L—bDOYFOEETT 7 AIVHHESINET,

¥4 (Play Reverse)]
MY (Play Reverse)l £— Ri&, 7 7 1 IVOFAEFLMZFICHRELET,
DA REBERT 2 &, WA (Play Reverse)] E— RDF > &4 7 034)%F
bOET, Fzvl - X—VI3F>THHZELERLET,

M5 7€ #iPH D % % FE (Play Selection Only)]
TR € #iPH D & 2 F 4 (Play Selection Only)) E— Rid, BfEREREIN TS
DA EHET HEDIT Media Player ZEL £T. 20X REER
IT2&E ZOE—ROFEFTNPEDVET, Fzvr - X—JFF>T
HBHIELERLET,

%7 L — A % 4L (Play Every Frame))
HAE) RNy aInksE 27V —L%2HAT S LI Media
Player IZH/RL £, TOFT T 3 i3, EMHARHEL—FLKDBL—E—D
Hzstl e RO ENH 2 BEITHALET, 7L —AldL—E—FEH
ROy 7EN5ZENHVET, 23Uk —F«F - bIv T - L—hTC
FIT 27290, £3MRHL — ML SHEORTZH O /20 TY, Al
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U3 A—E—OEESNEZTL—LA - L= FEHRFFLE D EW B0 275
HEITWET A, MBHE DD, 7213 CPU IKARANND T EDH/2DIT,
MFRFTERNWIEDBHVET, K7L —LZHAE (Play Every Frame)] %%
UGG, #HHL TO2EMRERIC K D ERICHERRRSRRS 20, 7
=L L—hMIBELZDBDTERIRDIENDHDET,

ME5F D715 (Output Video To))
ZOEMOETAMNA T a2 BIRTEET, L&A TESE - 7T b
&5 7 4 v ZEH (Video Out and Graphics Screen)] ZERT % &, For
FOL—E—IZ, AT LOEHEBELIMIT =V AT —a>DETFTE T I k-
A= MTER LA ETS - TNA ZADWHICERINET, ZDOAZa—
DAT T alid, AT LAOFERRBA T a2 - R—RaeiTThan
EDOMITXOREIBRVET,

[F—7 1 A O J15E (Output Audio To)!
HERWTWAE AT 4T - Ty VI, ZOENDF—FT 1 FH I+ T 3
CEBRTEEYT, TIAINETE, A—FT14FF V- AT—2a>DA
E—ATHEEINET, 2L, 2EZE VU RAT—a D —F1F -
T b s R—=BPCENDAE—INERIN TS EERIT, ZOAE—AT
F—FAFEHMLSIENTEET, TOAZ2a—DF T3 iE PATFLD
FESRN A T gy - R—=REMFTTNENEINITIDRAED ET,

mp.click.selection

FALSA Y
AL AT, b—E—Fk3F—T1F - T70NDOEr I a > 2ERLET, 173
R=20 27 a>OBIR) 28R LTLEIV, 4L AT 47— EEINES 1 L
14 > LOBRBEOMNERT, BIEHEELIZFERL TOBLRELZRL THWET,
mp.click.time
RERT

BREDOKMZRT 7L —4A, B 1 L3—-FR2RRLET. £ KREFNEREINTWS
BRETOHMEOERRINET. 71—V RERET DI, 71—V RZ227U vy 7L THLW
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Fefil2 A1 L. <Enter> F—2# L £, BHERLNL, 179 R—=2D (A LT DA L -
AT A= DMBIZHIEL TWET, 171 K= 0 HEFEROBELHFAL] BBRELT
<IN,

mp.click.volume

RKYa—A-Ky>

245 %7 )y L TCLERRI T THERY a—LBNERD, FIRRI YT IHERY 2—
LOFENRDET, FICONTIE 169 X—2 0 R 2—L0F%) 22RL T ES W,

mp.click.trans

rSORAR—=PF-a>bO-

TINwo1 RE >

Ny 2] RE>EIZVYITDHE Ty AIVOREIIRED £9. [K4-112. Media Player @ b
FPAR—b - A2 PO—)LOMEERLET,

MEiEl Ko >

MElk) Ry 2220y r32HE, BERPOT 7 AIVAMEIELET, K411, Media Player @
FIZAR=b - a2 bO—LOMEZRLET,

g4l Ko >

(e Ry2er)y 328, 77 M)VOBEEZRBEZITIHEML XY, K412, Media
Player ® h 5 > AR —h - 2> hO—)LOWEERLET,
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Sound Track

ZOEL, ROHMOSHBRINTNET,

o THEZEE] (181 R—2)

e [Sound Track DfEH] (185 X—)

o RIVFEIwr  -TOVxr NOHELEM (186 XR—)

o THHYTZE - T7AILOER] (189 XR—2)

o [Ty R—bh&ETOP T/ bOFA—T 2] (190 R—)
o T4 AVEBORIEERK] (191 R—2)

o I8 (194 R—2)

o [HREE) (196 XR—2)

o IZHRDBEMI (208 R—2)

e [Sound Track TOF—7F 1 FDFEHAE] (209 R—2)

o [IFZAR—bEMRE 10 R—)

e [Sound Track ICBTBRED N F TN a—T4 27 213 RX—=)
o [F—F—FK-Ta—rhvh QU4eR=)

e [Sound Track DA > % 7 —ZITDWTJ (215 X—2)

strack.overview

#h=

Z O, ROENSHRENTNET,
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Sound Track D#kE

182

182 R—® [Sound Track DHERE]
183 RXR—2 D MEHLE : HIT K S5

185 R— 0 T~V T DFEE

Sound Track I&. XIVF T v 7 OF—F 1« FEREIER. MET200T7OTFLTY, Z
113, Silicon Graphics #:0 7 —27 X5 —3 3 > ETHET %5 Movie Maker & Adobe
Premiere™ A @9 %Y —)V T, A—E—, IX—> %), F—F 44+ CD, I>Fa1—% -
=L Web R—=2, FLETF—2a lhiD, HROBEENOBKRINZTT R by
7 EfERT Bl DI I N TWET,

7= & Z1E. Sound Track Tl ROX DS BEERITAET.

BEDOY—ZAMNEOY TR -7 )y TS WELET, RIZ. TNH52FEEDT1LD
DA—F 4%« T7AINWVEERLET, ZOF—F 14 - 77 1ICiE, BT T -
L—bFDEIBF—FT 14 F « INTGRA—FEZEYTEHIENMTEET,

FERLUEHEO Ny b, A —, R—=ZA N EZT>T. VIR - TV ERELET,
Sound Track &. Movie Maker 72 EDDFZZ )« A5 47 « V=)L EDRTHY b, O
E— XR—=ZAFETHIEHTEET,

TJr—R A2 T7z—RKR - 7IROIIREZEMLET,

TENT YT DOFEOEE. WMEZITTVWET,

TOT I L = =R —N—A—FT1F - 70T MFALET, F—F 1
F 7Oy ME. T8 DAT ICTFAR—bhL., EHZERTIBEOYRAY — -« T—
TELUTHERTEET,

AE :CD-ROM R4 7D CD MoF—F 1 F&HET 5HEE. Sound Track Tld7< CD
Player ZffifiL T<7/Z &\, 195 XR—2 D [CD-ROM 725 DF —F 1 F DHAF) 2ZHL TS
FE0N,

strack2.how
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Bz

ERAE: RICKSHE

RDOA A=, #7212 Sound Track AT 5 1—HF D7=DIZ. Sound Track DHEE & H A
WWRLTWET, A A=D27U w2 d5E, FIOT 12 BTIAA—IAERERENET,
(7w & ThIvr) OBREEMTZITE. 22 X—=20 71Uy 7OREW] XY
203 RX—=2D [hT v 7 ORI ZRICBRTEELNTL &£ 9,

Ve GBI DR

FIE1:

ERICEODED Sy OMBEMRELTHG,

PSSy BT — I EFERELTE Sy S ICBMEMTET,
i [ E —

AU2—4 10.0

B 5-1 BE:FIH1 T A=2PZ27 Uy T2 EHRERSINETS)
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184

Ve GBI DR

Flg 2:

Uy TEBNE NSy L ICA R— PELERIBE T 3.

A &)y TER
L=WfirgE s
w & LT, HAR
A FERET S,

%

B 5-2 BE: FIH2 (A A=2Z27 Uy T2 EHRERSINET.)

Ve GBI DR

FlE 3: m&E
A A=Fa ADBEE

Uy LTEZvS L,
BREZERT D,

Pt

B. 7740NEA K- T Bin,

ERERET . \
¥

b Y (#)
1# &)
ERIE DT TR,

Bh-0
#HH... @

B. MRHEEdt)] A-a—poiREa~r B4 1 DEA
BARA L ZAE#REELT, BEOREEATEEELR,

%ﬁ%@ﬂ E ] =3

@ Ciried
&

Nk @ 5  Ctriex]
I¥—-  chC
HE

ReZ @) CirlrV

E5-3 BE: FIH3 (AT A—2Z7 Uy T2 EHRERSINET.)
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Sound Track D FCHE)

5-4

ANIVTDRERE

VERHIVE D=
EE 4: #R5E2RFELT. 7rANMCIFRR—FLT
2ys AT 5.

Al @] #2® :B|7-1r@]| #©
iR @) CirfeN iR @) CirfeN
.. (@ Ctri+O He.. @ Ctri+O
#E S . CtritS 1# &) CtrirS
A&t @ AR, ()

AvH=T.. @
IEIK b @
R

WE: FlH4 A A-DZI7U v TDERRERINET,)

ZORZa7IVIE. ROEXREZFEHL TWET,

Sound Track D#EH)

007-2275-010aJP

HETERINZEDE, AEOMOE, i, MELBHBEOERNDY >V 2RLET, &
ExE 2T Lb—bh) 22Uy I LET,

IRTERINTVD LTI EFN >V ZRUET, ZherUyrd5E, TOHARITD
V=)LOEHEL 9, =& XL, Sound Trackl] 27Uy 7 LET,

FEIE. AZa—OBRNXERLET, &
[T77A4)V] AZa—%Z2WT, <) %

AZa—#ZRAZa—THEHOMICH B [->]
ZIE. 17 74)V (File)l -> < (Open)J 3.
BEIRTHZEEERLET,

Sound Track ZEBIZEET 21213, KO X S /aEHY >~ Sound Track 24 7 )V 7 U w7
L9,

TA A %Y w7 LT Sound Track /&89 21213, ROFEITKENET,

185
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1. FAZbw7 D IW—)LF = X K (Toolchest)] > MR (Find)l > [AF 17 - V=)L
(Media Tools)] Z&ERL £,

2. Tsoundtrack] 714 d>%&F 7N 7w 7 LET,
o O R{FM5 Sound Track Z#E T 5i2ld. soundtrack E¥ 1T TANL £,

strack.building

TINFISyvo - TADII PDOBELER

Zav o bIDOWT

186

ZOHTIE 186 R—TD 7OV 7 MDWT, 187 R—TD [HHE 7O 7 S DR |
189 R—=20 7027 FOBEHEIE —] IZDWTHAL T,

strack2.about.projects

TuPx MEERTSE, 1 ECEROY YR - 7Yy TERFEHATESLDICRVET, 7
OYz7 MPRERLZS, 70227 hEITXTOZ ) vy TE2E0R1 D200 TR - Ty 1)L e
LTIZFAR—-PFTEET,

JOoYzr M3 1 DOXAY—-TJO0 b Ty1)). BEETIEROT TR - TvA
W BRUOEEOKEETOY - Ty U6 ERINET, 707 % Sound Track TH
<& . Jovzr haekz 1 BICEAELEZD, Oz ho—HZ2RRL THA, wRELEZD,
FZT7OP I FOTXRTOEFEEZ 1 DOV IR Ty )VICEEDTIFAR—NTEE
ER

JOY 7 NONAE%Z Sound Track TERTZEHE., 707 b O{ET771IViE 1 DDk
T EOMELEHTIDOIY T TEINET. 77N OHIZIE. EROF v XN ESE
DI, HEBEO NI Y7 EICEZND 7y ThoRB250HHDET, ZEXF. AT A -
T7AINZIR 2 DDOF v+ XNV EENTVWET, 1 >h— FELRFBRZFOBIZIE. 77110
BF ¥ FRINIMINE L2 N T v ZicaElan, JLIRETELLIITRDET,

TVl T 7 AINVEEHATLHEIC. T (New) . THH< ...(Open)l. if (Save)l .
MR ..(Save As...)] OFIAXYRIEZ, 7OV 27 b« LRIV TOHEEET D Z EITERL
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RIWVFEIwr - 70 7 bOREEER

MR7O0 o bOEE
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TLEEW, I 2R—=F (Import...)] & TTFAR—F . (Export..)] DAY K, {EFD
YR T7AINTH L THEEL, TOMOY TR - TOr S LEDTF—FZHICEHTE
S

AEIRZAY— TPz b Ty NVADREROTOY 7 MAT, 707 M<K
BRI 2420 ET (o zy <) 288), 702/ MNTEBRINS TR
TOY TR Ty EEETOY b« 770U, FEEEICTOY 7 MEAEBITH
o, Oy MU TABRICELLT WL DI TWET,

strack2.buildnew

ZOHEITIE, 7O FEBETHIBROERWBTIEICONWTHHAL, I S5ICHEMEBERZES
T2ODOBRILEMNTLET,

1.

CGF7ea) HR7O0Y 22 b ...(New Project...)] ¥4 707 « Ry 7 ZAZEHL £,

F7xN o7 s MERIZ. 41K DY 2T - L—bT16 EY OV 2T IVIET
9, £/ FIFIERTIE, 7O MI4DD NI 2EH =L TaL 7 MY
WWHRESINET, INSDNTA—FENAYIA XTI BIE. [7710) (File)! -> TH#H
(New)] Z#EIRL T 7O =7 b ..(New Project..)| ¥4 7 OJ - Ry 7 AZHE£T,

e [FO¥xzZ b -5+4L 2 K (Project Directory)l 7 —J)V RIZ. 7BY =7 hZ&MN
L7zWF o L7 NUDONSAEEANLET,

o (FIFTar) Ib7v 7 OHIMFES (Initial Number of Tracks)] 7«1 —)l R&EfREL.
FIAINNOEBEEBLET, 203 X—TD [hTv7IZDNT] BBRL T EE
Wo FIwZITVDTHIERERLIIHIRTE £,

e (713 FOVIVMIEEFNDZIITXRTOF—FT 4 AL THEALZNWY >
Ve L—bFEBRLET,

e CFFia) HlLwryorzl bHOY T IVIEEERL £,

DA 7Y « Ry 7 A, ZNEDNNTA—F ZREYNTRET D201, I—F D
R —F A FDOREET A A7 « AR—ARETHERNEREINET. FEMICD
WTIE, 191 =20 54 27 fEOHIHER ) 2801 T 7230,

187
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188

EYRIFHTIEROY T IV - L—hEY O TIVRZEERTSZEOICL TS0, &
DENWL—FTIZFAR-FLTT 1 AV HEEZHKNTD I LENDTHTEEIAN, 7
Uy THEREINE. 237007 M 2R—hENZHTIE. Zheol—h %
FFCTHEZSET S LI TEEE A

0¥l MBI STy OFEEHE L, ZNICHEDWT R Ty VIR EMNITET,

EZI NI T I REREDF L= a BB ENEI N £ T RIENT Y
DIRBENESNREEZHML LT, LRTOMITHIIONTIE, 204 R=2D ThIv D
ZRifHT) 22RUTZI N,

DUy TEEGR Ty VI, O R—-bERRRELET,

T DNTIE, 194 R—2D M) £ 190 R—TD (774D A >R—b] ZBHEL
TL7EE N,

REZITVET,
FHICDNTIL, 196 R—P D [fRE] 2BRL TSN,
[7 7 )V (File)) -> #fF (Save)l ZERL £7,

[f#7F (Save)) E721d THIBMRTE ...(Save As...)) ZERTHE, YOz r CO&RTEAT
THEORENET,

AEIRELEZTOD I FEBEHTSIE, 189 RXR—20 [0 27 hOBE &I —)
LT3N,

BEIHECT, 702z h&2 12077 MIVELTIFAR—-T DN, TP - F—
Fa4F - F—FICAE-L£T,

TOY I b1 D077 AINVICEEDDBEARIR. OV FEIFAR— T DHEN
HVET, FHIIONTIE, 211 RXR—2D [ T7MINDIFAR— K] ZBRELTLIZEIN,

strack2.managing
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FRIT 2R - 771 IVOMER

702z hOBEEIE—

Sound Track 7OV 7 FZEFHLWEMICEE /-3 I —-L2WEAIR. Jooo 7 vl
DDORAY— 7TV b TyAINEHEETLIHT R - Ty ISR N TSI &
EHMEL TWDH I ENEETT,

Tyl SOBEELIIAE—ITE RO 2DDOHENHD T,

TAV by TREEZMHLT, YA o b s TV (R T7ANFDaE—) L
WIHFTIC RS v 7 LT,

S)VEFALT, cpIM) £21E mv(IM) X2 REANLTTF 1 L7 MU 2 EBH L
¥9, OV b T4 LI FUDHRMNS, projectname* & 1 —£3BET S &
HTEEXY, projectname 370V 27 haekfF LI EEITHEA LT DY 27 MATY., I
3. Sound Track 37O Y =7 h4Z2TRTOTOT 7 b+ 77 A )V OBEEE & LT
TB72DTY,

strack.newfile

MY R - 7740 IVDERK

007-2275-010aJP

LW TR Ty IVEERTDITE. RO3BEODOHFENHOET., INHIET T,
[7 74V (File)] -> ITFZAR—b ..(Export..)] A RZEMHHLET,

BEEIFAR—F

Sound Track ZfA L TH 7 > R&HFZ L (194 R—2 @ ISound Track TO#E | 2 &),
RIT TZF AR —b (Export...)] WREZHEHAL T I Fedt—F1F - T71I)LbELT
RELET,

A 2R—b, MR TFAR—b

F—FaF T AINEAR-FLUTHREL, TZTFZXHR—b (Export)] ZHEHL TH—
FAF - Ty AINELTRELET,

189
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Z274IWVDAL R—

Z274NVDAL R— b

190

AEIH NIV IDOF—F A - Ty AIVEER WETIHEGE. YUK I5 1
% (Sound Editor)] Y —)V D FMEFI/REENH U £9, Sound Track iZ1&. Sound Editor
DT RTOMEEITMA T, ZOMDE < DEREN D > Tnd7zd, MY —IL&iz>T
WET,

e HYULR.TyANELTTOP 2l FEIFAR—K

TP bR, FRIEHMEL 186 R—20D [RIVFRIv o - 702l L O
HEEH) 228, KIC TZTFAR—b (Export)] Z2HALTTOY 27 hakERIZZ0
—fEF—F1F - Ty ELTIZFAR—-FLET,

strack.import

be7alxzo bOF-T >

186 R—=2 D Oz MZDWT) THPAINTWDE XD, 7Oy 7 hET 71 ILdH]
DHDTT, ZDEH, 190 R—=TD [T7A4)VDA >R—F] £191 RXR—=YD [Foyzr b
ZR<) THHAL TWS XD, 251 Sound Track IZ X DA ICEIRHONE T,

strack2.importfile

Sound Track TH—F 1 # - 7 7 1 L& <IZid. [7 7 1)L (File)) -> [ > AR— b ..(Import...)]
EEIRLUET, [ > HR—b (Import)) HAEIZ. F—F 14 + 77 1)L % Sound Track IZFHAA
DHENHDEE. ZEARL, 77 ANEHLVWI Y T ELTR Iy ZILHATRHEAREI
WOTHBHHTEET, 1R —hrINEZT 7 AIVEFHEARA > MEAINET., ZOFAR
A2ME AL A>T r—4% GRWE) OBITELEICRD £9, 199 R—2 0 [HFEARA
> hORE] 2B TS0,
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T A IO HI R

Aoz bERL

Evb:iL—E— - T7MINDF—F14F - bTv I EALHR—=FTIHITE (T71IVDA >
A— b (Import File)] 77 1)L+ 7IUHFTL—E—+ 77 1)L &ERL X, Sound Track #?
Lh—E—DF—F1F - "IvIEAR—-FLET,

HE :HEOF v RN EEDL Ty A IVEA DR—NT2EAE. ORI, h—VIVEHERAL
THEUBRBEDO NIy 7 EBIRL. M RI v T L TLEIN, IRTOF v >IN EE0H5H70
2. bS w2 BN TERT ZHENELSZZEHHDET, bT v 7 OERFEICDOWTI,
204 R=TD ThT v 7 DEREHIR 28RLUTLEZI N, 2EAE, AFLAF - T7 ()%
AR=bTBHEA ATFLA - T7AINIRIE 2 DOF v > RIMEENTWED, BRI 2
DORTw I ZERTIZLENRHDET, BWUREO NS v 7NERINTWARWESITE. B/
EBRREINTVDL RSy ZITNEDESRNT v oA VR— b Ena<kn T,

strack2.openproject

BrEo7Oo0o o7 e <ITE. ROBIEICHENET,
1. T77A) (File)] -> MBA< ..(Open...)] ZZERL £7,

2. Iy AN TIUFEEHLT MELWT O M ASTWST 4 L7 MUIZBEL
E

3. JOVzV hNERELEEEICRELZAT (RXY—-JOPx b 774V 5) %
RL. <Enter> F—Z2HL £,

strack.disk

T4 A9 O HIEHER

007-2275-010aJP

TOVr 7 hEIFAR—FITD (AP h21D0F—FT1F - T70IICEEDHD) B
2o F=F4F - Ty ANVDOERBETELNE VNI LEVWEAENH D £, KT, F—F«
I T4 % Web R—I T LZWEE/RETT, Sound Track TlE. 5« A 7 fHIBIZH
THEMRET 4 > RUDAHEEIIERRLET,

191
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F—=F4F - Ty OFEE, EICROXSIBRBERITEKFLET. ZNS5OEKRI=—ZITH
DETHBTEET.

EROREHINE X

TESRDIFEMNEWZE, K0DELOF 1+ AV EENNEICRD ET,

YT L—bEY T IVE

70> =7 b .(New Project...)) #4707 « Ry 7 X3, #RU=Y T ) - L—
FESTIIRIZHEDNWT, A—F oA REET 1 A7 EBICET 2 EHRNERINE T,
YT L—hME A—F a4 - B OTINNEEIN, BEShSEETYT, 27 -
L= HEWEEF—FT 4 ARENEL BTN, 77D A XFENZITFREL K
DET, B, NOFZEZEITHITE. SkHz L TWET, +—F 14 CD I3 44.1 kHz
THEIN, A—F 14 DATI1Z 32, 44.1. £7713 48 kHz THEINET,

P IEL, F—F 4 F - FT—FD1DDOY >IN ERTOIEHTIE Y FT, W
138y hDREE (8. 160 F/21d24) TERHEINET, YO TINENKRELBRDIFES A
FIT - LOIUNKRELRD, BENETLD, A—T A DOREIZEL RO TN [
BRZT7 7 AN DA X RELIRDET,

192R=20 [T7A)DOF>T) - L—bEY 2 TIVIBROFHIMD | 22U T LS,

F v IV
F v o RINVOEEREINTHIENTEET,
o FE A

F=F4F - T7AVBIFAR- P TDLEREMTEET QU A—=2D [T7 ()LD
IFAR—b) 2B, 193 RX=2D F—F 1 FEMAF—LDU R 25RLTE
S,

Z77A4NVDY LTIV - L= bES T IVIROFRY

FWTWABIEROY T )L - L— &Y 2T IVIEIE. TSound Track) 7« > R ® Bz k
RENET,

Xy 774N OT A A S ERERGT 21T, ROFEEZTVWERT,

192
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1. A—=F14F - T7ANOT7A AL ERRLET,
2. RUZDERY EHFLTAZ2—2ERRLET,
3. o2 RER OIS (Get Sound Info)] ##IRL £7°,

TR BTN L= ET O TINIEEED L DNNTA—FNY X MFERINE
9, Y7 IVEL Data Formatl] OFICERINET,

AEUNIX 3 207> KA S, dminfodM) A7 > REANT S EHTEET,

A—TAFAEB/AF—LDYR

% 5-11&. Sound Track B3 HR— b L TWBF—F 1 FEMOFEEEZ ) A FFERLTWET, Z
DFRZEP ORI aJEEIR T « > RIICEKRT DI, FROYA MLE7 Y w7 LET,

=51 F—F 1 FEMBAF—L - VAT

BELTOEMUANIL
(16 Ev FDIEHEZ 71V
ICHTBERMZ 7 ANDY A
F—F4FEBAF—A XICEDK)
G711 Mu-law 20D 1 DYALAXDT 7
A IVICEHE
G711 A-law 29D 1 DAL XDT ¥
A IVICERE
G722 45D1DOHYALXDT 7
A IVICERE
MPEG-1 BERLZHEOL NIV

IWUCTR 25D 105 24
5D 1 OYALZXDT 7 A
VI EHE

AWARE 2D1ME3HD1OY
A XD T 7 A IVIZERE
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Sound Track TODHTH

194

strack.recording

ZOHEITIE, 194 XR—2 D [Sound Track TO#F) . 195 X—® [CD-ROM 6 DA —F «
FOHAF] . 195 R—=2D [AHY—ZADHRE] . 196 XR—T D [Lh—E—~DFE) ITDNWTHH
BHL %9,

strack2.record

1. BEFLEDELTVDEY—X, &AL 127074 >% VCR (E5H4 -ty bk L
I—4) D IN. (4 —F 14 - )X%)) (Audio Panel)] TEIRINTWDZ & EMEL
£9. FEHICOWTIE 195 X—=2D TANY —ADERE] 2B T LS,

2. H—VI)EFHLT, §&FZ2BLZWRAT > % Sound Track THREL £7,
o 1 DDFIVIIEETIHITIE. TOMTYIRNITHART O h2RELET,

o TRTDOIIVIIZHETZINE. HARAIE 217 R=PD [FA L )—F—)
NIZRREL £

FHNZDOWTIE, 199 XR—2 D THEARAT > hOEE] 2BBLTLEE N, v r7D TA

71 (Input)] A=a— R >N /2L (None)] IZRESINTHREWAEZD, BEEREIN

TVEITXRTO Ty T IZREINET,

EM i BTHETLEZVWRA D bERFEI S 32— L TBLLDIIY—h—2HT
D& IEHITERITT, I DN TIR 205 R— DI —H—Dffi ] 28R LT3N,

3. g% Ry (M5-68M) #r7Uv 7 L%ET,

AE: OV MINNT LIV bIw IRBHBEE. INEES ERBICHEINETD,
BREDEDIZHON Ty 7OBEZHETIZE. Sy rzoa>ka—)L« N—D [T 2— k]
ry 2 (K58 27w LET,
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4. BELEWEOHEAZRIKLET, 22X ROBEEZTVET,
o HAOREZEFEITIIHA/Z. XA 7074 AN CTELBEDET,

o FAY - ATR-DPIEKLLTVIETH - Iy b - LI—F—IREDTNAANS
BEITDHEE. TNAAD THE] Ry 2220w I LET,

5. #xEzfEIdaicid. MER Ay > M5-6Z0) 27Uy LET,

6. HETHIUL, BEFLIERTALERTSZHIBRLET, 197 X—Y0 IFoESE Ok %
ZRLTLES 0,

strack2.cdcapture

CD-ROM D5 DF —7 1« F DERF

ANV —ADRE

007-2275-010aJP

F—F 4 F%E2/)N7 b5 1 A7 (CD) 25 HfEY %121, CD Player 2/ L £9 . CD Player
3. &N Ty I EENOA—F 44 - T 7 AINVELTERLET.CDD NIy IV ERITEI T3
CEBIRL CaE—L. Sound Track IZR—ARTBH2EHTEET, R—ZA MLt ITa>
13, HARA > MCEbDNET,

strack2.input

e CD-ROM RZA14 TMBEEZZITIITIE 195 X— D ICD-ROM 6 O F —F 1 F DEH
ZSRLTLEI N,

o IF—F 1A+ )XRJV (Audio Panel)] ZFHL T, Y1707+ > VCRREE NS
FHLEWDNZEERLET, #EichTnay( /707>, LBV AT—3>07
A2 A R=PMIERINTVWDITNA ZANSEE TSI ROFIEICHENET,

1. Ta>hkB—Jl (Controls)] -> F—7 17 + )XF)LDiH) (Launch Audio Panel)] %
BIRL [F—F 1 7 - )3%)L (Audio Panel)] TI5 7 %)V b (Default)] -> A7 (Input)]
-> lAnalog In] ZERL £7,

2. H—=VI)E TF—F 14+ )8%)L ( Audio Panel)] @ [Analog InJ > ho—)bL - /X
R EICBEL £,

195
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Lh—E—ADFEL]

wmE

196

3. RURADERY >ZEMLEMNS, [ANY —A (Input Source)] -> Microphonel 7z
13 MineIn) Z#ERL E£T,

AE: F—F 1A - X)) (Audio Panel)] 1. [V 32 - 5& 07 (Icon Catalog)] @ 3>
ko —)b - )3%JV (Controls Panels)] DX—IIZHH D £7,

strack2.movie

BEOLA—E—HOA—F 1 A Z2ERL TWDHEEIRL. 77 1) (File)] > TA—E—%H<
...(Open Movie...)] Z&RT 5 &Ik, Ls—E—% Sound Track TH ZEMWTEET, T
ko, AfftszL—E— - T =P -2 EET., Sound Track ® &%) K¥ > %7
U279 %E, Sound Track 738 E 2RI T 5 L RIMICA—E—OEENRBINE T, BFH
CA—E—DREDOMEEZREZT DI, L—E— - TL—V—DF¥ 1 LT VIZHDRVEE
BREIUY I LU TCRI T L, Lb—E—2ZX70-)VLET, A—E—DKHERT 1 —IJV R
EMETDH LTI THLA—E—NORKREDRMICEE TE £,

b e b—E— - T —VY—2@HL TIEEEKRALS. 7 741)) (File)) > [L—E—%
BIL % ...(Close Movie...)] Z#ZE{RL £7,

strack.edit

JOY s hEEVWEE, HEVET TSR Ty ANV EESEREMOR-MLAEETIR. Z
OTOT I MRT 7 AINENS DNDHETHRETEET, ZOHITIE. ROBIEEITD Hik
EHAL £,

o 197 R—=TD TRARMHREMEDMHH
o 202R—=TD 7Y vwTOEIFKN]

e 23XR—=TD [rFv T OHKN]
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e 205XR—TD v—H—DfFH]

strack2.basicedit

BANTRESEREDSER

AE:Sound Track D S w2, Z7UwS —hH—OW&EEOTAICDONTIE, 202 R—
DYy TOEK N 203 R—=ID [T v 7iIZDWT], 206 R—=JD [R—H—IZDNWT]
EBRLTLIEE N,

Sound Track T1T D HEARMRREEXEIIRDEB D TY,
o 197 XR—2 D [FOMHEILOHIBR)

o 198 R—=TD [H—F 1 FL/ITHEE & OB ODEH
o 198 R—Y® [FOEHEDOH Y b, IE—, R—=Z ]
o 19X—=2D [RITyTIZLBV Yy T OBE]

o 199 R—=T® HFEARA > hOELE]

o 200 R—TD [FOMHEMDFEN

o 201 R—=TD [Z1wTDER]

B DD HIRR
=T AAD—% b T v IV NSHIRT 21T ROBIEEZTVET,
1. HIFRL7Z2WA—F 1 A Of 2 ER L £9

FELWIHECDWTE 200 X—2 D MEOFHEBOER] &£ 201 R—=20 71 v T DER
EZRLTLIZEI N,

2. IR (Bdit)) AZza—»5 Ty b (Cut)) ZEIRLET,

AE: TR (Edit)) -> [THZ (Clear)) Z#IRT 2 & 30 > RANERNN, BEFICBEHRISNET,
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A—T 4 FEIIET L OMBDER

TFEAN - IF 4 FTIE, HEZBRLTANZBD 2 &, BIRUZHEENAN L ZEGEICERR
AZH5NET, Sound Track DA —F 4 FIHINNYTIEEODFET., DFD., YU RO—ED
fEEAEIRL T, @&fEfT0nEd,

1. BERAZWA—F 1 O EEEERL E7,

FHLWHEIZDWTIE, 200 R—2 0 [EOEBORER 228U T /ZI W,
2. ROBEOWTNNZETOT, BRLAEF—FT 1 F2EBRAET,

o [f%E (BEdit)) -> M2 (Clear)) ZERL TH—FT 1 T2 MEITERA LT,

o 774 (File)) -> [{ >AR— I ..(Import...)] ZERL., FIRLZEHEHOF—F «
FCEMAET,

o 194 R—TD M OEHTHHEINTVDIERIIK ST, F—F 1 FZ2HLWERZIT
B ET,

BOfEENHy b, JE—. X=X}

198

TRTOAF AT « V=)V TITH A~ v b, XR=ZA NI, Z0TWOTFZ MRET 7V
F—2arTiFrohy b, OE— R=ZMEREULCLIRBDTYT, HIOEREBINL, THE
(Edit)] -> IaE— (Copy)). &% Tl > [y b (Cut)) IY¥> RefHATS &, #ERL
T = N—KC 7 Uy T Hh— RIZREINET,

1. aE¥—L7zWwAd—F 1 FTOMHEEZERL £,

FELVWHEIZDWTIE, 200 R—2Y 0 [EOMHEBOER] £/-13201 R—2D (70 v 7D
R 22RLTLEI N,

2. THR%E (Edit)) > TJE— (Copy)l. F7&id TREl > [H1v b (Cut)) ZERLET,
3. YUZRER—ZAMLEWMEIZHARS > FEERELET,

FEIZDOWTIE, 194 R—=D D [§83F) 28BL T30,
4. THREE (Edit)) > [X—2Z b (Paste)] #&RL £T,

F—F 4 ADBFARA > FOT<SRITHFAINET,
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k> b : Movie Maker & Sound Track i CTHF—F1# - 7 Uy FEIE—-L, X=X T3
TEMTEXT, 2HUTF. 7V v TEBRLTHS THRE (Edit)) -> (28— (Copy)l %ER
L. 2 —FHO7 ) —3a Vi AT IHFEE (BEdit)) > [X—Z |k (Paste)] Z#IRL £,

RSvIIC&B0V vy TDEE
1. ZUwTE2FTINIU I UTERRLET,
2. EFRIFARICRI I LTIy TORMEZNENRIEZIZBAITBEH L ET,
MO TEBATI Yy TE2BET 51013, <ctrls F—2H LRSS RT v T LET,

A VU TREBONTI Y VIZRI YT THIERTEERA. ZNETIITE. Ty b
(Cut)] & X=X K (Paste)] DI > REMHAL T EI W,

BARS Y bOEE
FARA b - F02&3 A 2R—=b Ay b - FEEEEFCKD NI v 7ITREBA
ENDIY Y TORARAL > R T,

1. HALRREWERELT —F « A THRET HI12E. THE Ry & ek Ay &AL ET
(4 5-6 ZH).

BN HARS D MEREMHICEET 27201213, 226R—20 [TX—L4) Ry > ZEH
T 5 EFERITT,

AE ARSI D R EDLIOBHETZICE. 26 R—2D [T v ML X514 (¥5-7
SHR) ZHAL TSI,

2. HART BT ERHELET,
o JUwTEIDDONI Y ZIZHATZIZIE., ROBIEETNET,

HaefBALLWMEBED LI —VIVEREL, STUADERY &Yy LET, 7~
WIEARA b - SABED Ty I BIRERRENET,
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%5 5 % : Sound Track

o JUYTEITXRTDLT v IITHATSHITIE, ROBIEEZITVET,

AL I—F— (K57 ) NO, TEHALZWKEROEICH—V )L Z2E&EL.
RIADKERY > ) I LET, RAFARA N - SANITXRTORNT YT E
ICERREINET,

FEARA > b EHEBET 223 I—VILEHLWMIEICBHL, YURDOLERY > %
BEIJUY I LET,

HOMRIBDZER

o w7 O—HOERERIRT 51213, =V I EEBOLICEE., YUADERY &L T
A=V INVERIT YT ULEY., BERLUCEENEFHRRINET,

R 7K BEROFHMTFIE

1. H=VNEZ7UyTOEIBHL, XUADERY &7y 7 LTI AET,

2. W=V ERITYTLETTEEO AR RIEET,

3. BIRLEWHHDNRAZRRINGEZS, XUXDORY &L ET,

AE ERL ORI 1 > RYDETORMERITIRENET. KHAXRROTD
INSTSRENRY >0V v 735 &, BREHORES S ZLEETEET.

(R4 (Edit)) > DRI (Select)) #ERT 2 E. KO LS HERAERIY Y REMATEET,

[ RT % ZER (Select All)J
MEDAR—ZAZED, REDOIZV v TOKDOVET, 70V 7 MafkE#
WLET,

[ipH D R T ZER (Select All In Range))

1 DEFIBEROEBIGERNREINTVWEEA, Z0ax > Rid, 3XTO
BAIWTWS ~T vy 7 THAEDER &[F U OR 2B inER L £9,

[Eif% & TR (Select To End))
BEMBBERNINTOWARWES, Z0ax > Rk, ART > hOMENSZ
DRI DORBETERERINLET,
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1)y TDER

2V TDYA XEE

007-2275-010aJP

[EeH) & T (Select To Beginning) |
BEMBER SN TOWRWES, 20av >y M, FARA > FOMEN ST
DTy DFEEETEZERLET.

AE ] DO ZFERNL 7288, <Shift> F—Z M LA ST THOEIKZRINT 5 LN TE
£9, ERLUZEEOPNS 1 DORRZMIRT 2121E. <Shift> F— 2 U722 5 EHEE 2
BEIJUY I LET,

b EHEOBRBRA D NERFKRTRA > NE2ERBICRET SI21E, 226 =D 2% k
e AS5AF] E26R—TD [TX—A] RY ] BIRITSEBET,

22Uy 73 RETDANCETERT2MLENH D £, BRI 21T 27Uy Ty TV o Uy
JUEY, BRLEZ Y Yy TI3BHERENET.

AE1 DDV Yy TEERL &, <Shift> F—Z2M LS KT THOZ U v T2 EIRTE X
T BRLZIZY v TOHNS 1 DORERZMFET 2121, <Shift> F—2M L2 5ERL
Uy TEHmEIY) I LET,

AEI VTR, FIHOBEREFUHETHRERNTEET 200 X—2 0 FOHERDOER &
ZH).

70w T DA XOEEX, 7w TOREEFIIEE. HEVIEZOMmM NS5 EZ2HERGEE
IZITWET, 7Yy TOYA X2EETLREIROEBD TT,

1. 77Uy T2 TN Uy 2 U TERLET,

BEDOU )y TOYA XEEET 21213, <Shift> F—2MLBNEET U v TEERL £
kR

201



%5 5 % : Sound Track

2. JUyTOEMERIRMEEIV I L TRI v T LET, WATRBSETEFOI Y v
T MHE] ENET, DD, BETEHBASNET.

Eb 7Yy TEYRSESES, YA XE2ERTLZ LTI 2r2ETTEET,
70w T ORI RTE R /7?‘67&6?‘“(@1

strack2.working

2y TOHK

2w 7 (5528 L3 BEINZF—FT A FOWFTY, &7V TEZFA—DRT VD
THNZDZ LW TEETA. 2L, BRb5 M5y ) THMMICERD ZENTEET, Fik.
1DODRSYZIZHZET) Y TOBDAR=AL, BFITRVET, ZOAR—A1T., HEIZ
WU THE, vy b, O — £EREBHTEET,

70y TOBRBFICONTIE, 201 =20 71y TOER 28R T30, ZO4M
DFIFCDNTIE, 197 XR—=2 D [EFEOHEBDHIFR] » 198 R—2 D [F—F 4 FELIFTEEF LD
EIHOBER] . 198 R—=T0 [FOEEO Ay b, aB—, X=X ] £, 199 R—=I D K
FwZIZ&kBI 0w TOBE) 2BRL TSN,

t?biﬁvaéMme&atﬂE~?6tﬁ‘7Uv7€EﬂbTrﬁ$@mM—>m
— (Copy)l ZZERL £7, KIZ. Movie Maker THEAMRAT > h&EFE L. MEE (Edit)) >
F/\—X b (Paste)] ZERL L7
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FZwi

FZwi 2

FZw& 3

FSy O DEERN

FSvOICDNWT

007-2275-010aJP

|a’irish’usn’peoplefjbuild 44100 KHz 16-¥w S A7

B 5-5 Sound Track D kS w27 &7 w7

strack2.tracks

ZOHEITIE, 203 X—YD [T wZiIZDWTY., 204 RX—2D [hF w7 OL4FIHT] . 204 R—
OO ) TEROIEERI, 204 R—=2D [hT v 7 OIEREHIFR] . 206 XR—=TD N2 &
Fow o o RY 2—LOHIE IZDOWTHBEL £,

rZw 7 (K55 28) 3. 1 DELFIERTI2ERO I U Yy TE2FATHWET, bTy T &fH
AdBHZ LIk, YU RE2HERDZIENTEEY, £ bIv 37Oy r/ boyot
AZEEREDDY—INITHIRDET,

oy I EHERTLIEBICE ROKIBDNRHDET,

o BEOIYVvyTaliE Ll TRIEHEZITD 20

o KFEDRTwIDEZMPEFEFIFHAEL T, SEIERFTOMHEDLEZERL. INH2H
WIZHIT 5729

o OV MOEPDEHDINRONT T « R a—LEBEETBHED, &AL Ny
7757 REEEZFEIDHENRY 2 — LA THEITIHERETT,

203



%5 5 % : Sound Track

bS5y o DRI

9V y TRRDIERT

bS5y o DYER LHEIRR

204

o ZXFLAR, 4 Sy - T—F - FuFREDOINTFF v RN - V—ADXEDIT, BifE
BThRWA—F s FIZBITEF v > RNV ERFEFT DI Ty VBN ER-D

o HBIDKNTw I ERLD)—ZAMEFEETTHIIICHREL T, EEOY A0S DEF %]
HEICT B0

ZOHITIE 204 X—=2D TR T v 7 OEARIT] . 204 X—=2D 7)) w TERROIELR] . 204
R—=20O ThSy 7 OEREHIER] . 206 R—2D X ERTw Y - RY 2—AOHIHE 12D
THBALET,

@D~ Z w7 OFEZEGIET 2 AHEICEL TR, 210 X—=2 0 BERLZFT v 7 O/FE] . b
SvZearbo—)b - N—OREFINTEAL TE, 223 X—=2D ThFy 7 -a>bo—)b -
N—] ZBRL TS0,

TRTOM T ZIZEZTFT 74V ML TEE n EWSEmBIHTFeNET, 22T nid b
Sy OFEZERLET, bI v I IEEOCLETIEMITBITIE. ROFIEICHNET,

1. ~Iv 7 k@ TEE (Untitled)] EFERRINTWDHHEY TN U w7 LET,
NFDOEDICHRER Y 7 AMFERINET,
2. MEE) %= I/F) BEOBKRDODDLHTEMRA. <Enter> F—%2#L £7,

AR HERON Sy I L TR AT ZFEHATEET.

BRIV IDOIY Yy TERE FIwvroa  hO—)b - N—D FIZERINET, VU v TE
REFRFRICTBZITE. FITvIDIA MIVOERCHDNEREZAREI) v I LET, Z0O=
ABEBREZ v 728, Uy TRRNERENET,

[hZ w7 (Tracks)] AZa2—TI& b7 OERCHIBRNTEET,
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e [T v (Tracks)] -> kT v 7 DERK (CreateTrack)] Z#EIRT 2 &, FHLWET v IN
T4 RUNTEMICERLEZN Ty 7O FIGEMSNE T H RN N TR WEGEEID.
HLWEIy 73T 2 FYNOEREBDO LTy 7O TFIEASNET,

e [FJ w7 (Tracks)] > [bT v 7 DHIER (Delete Tracks)] ZZERT 2 &, BIEEIRINT
Wb Moy I DHIBRENET,

NERS YD - RY 2—LOFIHE

I—h—0DER

I—HA—ICDNWT

007-2275-010aJP

ZRIw2i2id, M58 ITRTELIIT, NERTY Y - R a—LZ2HHTEZDDATAY
NHDET, ZN5DHFEIF. Sound Track TOF—F 4 FDFAEE, TFAR—FLET7A
JWVOBEEIIKMENEIN, FEFOLNINITITEEL R A,

o N2 RATIAFE. ATLABEDEDODOELEDAE—ITDEDONST > AERELET. /=
ERE N2 ATA T EEMETBELESGS, TOR TIN50 FE. AT LVAHEE
FINAADEDAE = DA NSEHEINET,

o rIwr RYa—L - ZAFAFE BFEDONT VI DHRY 2 —L - LRIV EZRELET,
FSwZ e RYa—h - A1 EHIBEHIEDE, FOMTYvIOEEBNENDXT,

strack2.markers

ZDHEITIE, 205 R—=TD [R—H—IZDNWTJ ., 206 R—TD R—H—DERMR EHIKR « 207
R—=PD R—F—DLHFHF . 207 R—TD [R—H—DRE] . 207 XR—TD EEDIT—
H—=~"DH—V )L DOBE| . 208 R—ID [v—H—FOHEBOER | ICOWTHHEL T,

X—=N—d FEDOKRPE a2 a2 -7 L TERTERTELSLIITT 50 OENRFE
TY, X—Hh—ld. ROGFHITHATEET,

o RN
o BEDRMAAT b
o ARAHNELTHMAT S TEDMME

205



%5 5 % : Sound Track

< — 7 —DERk L HIRR

206

EZL, FOHEOHRT, EWKIEZTREZWEENHDET, ¥4 - JV—F—ITERS
NHY—N—%2FMTHE. INZERITOIZENTEET, TTRAMCENT v 7 2HAEL,
TNEMERBDSKIENBEDEZAT (R—= ) RF 27V L, RIEDKDHEZAT
BEZUYIZLUET, KIZ. 1 DO —H—%2ERL., [ —H7— (Markers) -> DRETZEZER
(Select to Next)] -> MEE (Any)) Z#ERL 9. ZHUTKD, 2 DO —H—DRHITH % HibH
DENEWITEIRESND =0, ZOHFHZRICHIBRTEET,

R—H =KD 2 DOEENH D £,

AR/ NN

07 55— —13. DAT £/21Z CD DY AY —ZER L TWAEEDIMNIHEHT S
HD T,

12T DA

A>F v X+ —H—1%. CD £/~ DAT DAY —{ERICHERLET, SOy sac
FENE, ¥RHFETY., 7OV 5L - X—h—12CD £ DAT D&y b (FO7 5 4)
OEOKIEE~Y—27 L, RBIR—H—13707 55087t a2 a237—7 LET,

R —H—ZERT BITIERD 3 EO HENH D £7,

R*—2 (Mark)] ™% > ZHHLET.
Y—2 Mark)] RF NLXKOFETHMAL £T
1. X—H—2EELZVWY—F 1 FTOEEEHEL T

2. X—=HA—ZBMLEWRA > FZEMWERRT =2 Mark)] RY 227U v79%
& X=N=F AL —F—ITEKRENET,

AE : Sound Track 27 7 f VW Z2FHAEL TWEWEETH, [v—2r (Mark)] "7 > Z2{HH
LT —H—Z{ERTEET,

[ —J1—(Markers)] -> [# Ly ¥ —J1—(New Marker) IZ#:\W T, [F0 25 A (Program))
7213 T4 >5F v 7 X (Index)) ZFRLET,

007-2275-010aJP



Y —71— (Markers)] -> iz~ —2 (Mark Range)] Z#IRT 2 &, BIFEDRREHD
S ERBRII— N —ZERTE XTI,

R—H—&HRTBHI2E. v—H—&2 21U v 7 UTGERL., KiZ *R—7HI— Markers)] > [*—
71— %HlBR (Remove Marker)] ZEIRL 9, §XTOY—H—2HIRT 22T, *—T—)
> [T RTZEHIFR (Remove All)) ZZEIRL £,

Eob:EBOREEERZEHICRET DICE, 226 R—YD [Py ML - X545 & 226
R=2D [TX=L] KT 2] DEITLBET,

I —h—0D%EIfTF

N—N—%RZMLTTHEAT S0, X—h—IZ&a1 2T 25 EERTT,

1.
2.

I—-h—-DiRE

Y —71— (Markers)] -> Y —7H—%#RE ...(Edit Markers...)] ZZERL £,

FIH)VNT MEE) Lo TWBLARTIOT 1=V RZF TNy 7 LT, RMETEDX
SICLET,

FLWEFTZ AL LT,

Y —71— (Markers)] -> Y —7H—%#RE ...(Edit Markers...)] ZERL £,
Kl 7+ =V REY TN IV v LET,

AEAREIOT s — IV RBRETEET,

FLWEZ AL ET,

BEDI—H—ADIH—YIDEE

HDHI—N—ITBEHTHIE. BIBHEOY——2 Uy 7 LET, 2L T HARAS
Sh e IAUMEDOR—H—DBEICRIREINET,
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%5 5 % : Sound Track

< — 71 — R DFEEDER

R DEN

208

Y —J1—(Markers)]-> K\ % > 7 (Jump to Next)] £ 721341\ ¥ > 7 (Jump to Previous)]
EZERL, O—)F—N— AZa—2fifL T—H—0fEZBRINTHELHTEET, X
NPT ) B BRT S E I—VINPENORBIEITH DY - —ITBEHL £, MFiNT v
T BERT D E A—VNAEMORBIESITHEZI—H—IBEHL XTI,

Evbh =22 HMEHITIEEE [Y—h—2#H%E (Edit Markers)] 7 > KU &N
FEFIILTHELE, TXRTOR—H—DY X SERRPSBRTETHENTI, ZOURAKNIHB
R—N—%%E7UvrT5EL H=IINNEDODI—H—DMNEIIEBHLET, ZOT 1 RU%
p<icid. T~v—74— (Markers)] -> 'Y —Hh—%#R%E ... (Edit Markers...)] Z&ERL £,

205 R—=TD [R—=H—IZDNTJ THHPASNTVWD XS, BTERL TREL ZOEEZHE
RLUTBLDIIY—H—Z2FHTEET,

1. A=V NERRLZWEBOEEEZIIREDOY— I —ICBEIL £7,

2. [<—7— (Markers)] -> KE T%IER (Select to Next)] F7zid [HiE T#EIER (Select to
Previous)] Z#IR L, O—)LF—/N—+ AZa—2FHL TRIRL W~ — 1 —0OfiEz %
HRLUET,

k% T#2EIR (Select to Next) | lZIHEDOY—H—DHMICH DY —Hh—FTERERL, TH]
% TZER (Select to Previous) lIHEDY —H—DLEMICH DY —H—FLTEREIRL LT

BDOHE: T —7H— Markers)] -> ¥ —7H—%&#H%E ... (Edit Markers...)] 71 > FUEHEHL
T, DAY RURZHZ 1 DO —H—%FRNL. RIT <shift> F—ZMLAENS 2HKBHDOV—
H—Z2RRLET, 2 00— H—OHOEEINERINET,

strack.effects

S (Bffects)] AZa2—I2id T7x—R + 77Uk (Fade Out)] 72EDIAR Y RNBHD., b
DAY RIGER LA —F ¢ AEBRICEATE 9., FMicONnTIE, 221 =20 [THE)
AZa—] ZBRLTLZI N,
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Sound Track TOF—F 1 F DFEE

AE  TBHE (Effects)] A=a—0a~X > RIZEBIZIZ TS 71 > T,
/usr/lib/dmedia/plugins/premiere 74 L7 RJIZEMEINTNSEHDTT, Sound
Track 1% Adobe Premiere 7571 > & HHR—FLTWET, DED, ZTOF+ L7 MJIZEMN
@ Premiere 77 A > %A A M=)V LZHEITE. b IR AZ 2T RINET,

strack.playback

Sound Track TODA—5 14 ADB4E

ZOfITIE, 209 R—D [TXRTOLT w7 OFE] E210R—2D GERLEZES Y7 OH
BT DVWTHAL XD,

strack2.play

ITRTDOFSyIDEBE

B4
A 11| e
= #F

Ed5-6 FSAR—b 3> bO—)LOMH

FI7HIVRTI, THA Ry 27U rTHE 224 R—=0 [ Iyno) Ry ) £/213 224
R=PD T2 a—F R I PEBTHERO>TVWDL Ty ZLHND, §XTORT Yy IREAES
NET, ERORYUNSEHETDICIE. B INvy) R 227w LET, F—F1F
3. HIZ217 R=PD [F AL NV—TF—] KHDHRNEEDBEDOMBNSEHAEZHBL T,

ya—-bhy b F—FR-ROAXR—ZN—ZT L, FEZEBEZIIELTEET,

strack2.selective
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%5 5 % : Sound Track

BRLEMS Y IDBE

IFRAKR—bFERTE

210

Sound Track Tld. BHAEZTOMNIC. HBELZWHEHERINTEEY, BRLEZBOZEATS
ik, hSwr-arho—=)b-N— (K58 ® 22—k K& & Vo) R¥ i
DNWTHEL TWABRERHDET, T—F 1 F1d WIZ217 X=PD [FA L - NV—F—] 1T
H DR VEREOROAED S HAEZEIBLET,

RED STy 7RI THAETDITIE, BEZRRBLEVWRS > 22U v LET,
ERBO BTy 7 &ERT 2T, <shife> F—Z2WL a6 &/ Ty V2 BRL £,

1 DOD w7 Z2HEETEHEOIERRL. TOMOITNTO T v 7 DEEHTICIE. BHE
Ty va) Ry 22y 7L Ths HEI R 220y LET (K56
S, 1 BEICERO NIy 71 LTV OEERTHIEHTEET, VOEERNTD L,
HRIv IO T2a—b) Ry > ORESITEEARIC, BRULAEDADOTRTORT v IO
BN —HICHEAET,
FowrOFEEBETIE. FIv O [Ra—b R¥ZEZUY LT RIC THAE R
HoaIUw I LEEETEDORN Ty IDRBEAEINBVWEDICLET, 1 BITEEDONT v
TOEEHTEHBTEET,

rSy 7 O—#ERRUTEETSIE. BIZZ0Enz2270y 7L, RS9 7 UTEIRL
Q00 R—=2 D [FEOHEBDER) #58), Kic THE) Ry &2V LET,

AE 225 R—YD TEREA] Ry E25 =20 [ML—TEIFN] Ry ] BT
ZE0N,

strack.export

ZOHEITIE 211 R=2D [T7AINDITFAR—F] ., 212 R=20 [FOP 7 SORE] .
22 R=VD [FIPH) «F—F14F « T—TNDIFAR—F IZDOWTHAL T,

strack2.export
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IFAR— b EfRfE

TZ77A4NDITFRAR— P

007-2275-010aJP

IFAR—b - A REFAT DL, ROWENTAET.

1 20F—F14F -+ T77A4)0ELTO, FOP 7 hEFIFTOP 27 FOEREHFO LT
ZR— b

Ty, Fyox), $2F) - L—b, B OTI)E. FRRERAF—LZELH
LW —F 1 F - INTA—FDHRE

HLWARTIEH LW ERRDINSGA—=FTD, TJ7AINERZT 7 AIVOBERE DO TF A
R—hk

IFAR—b - A RZHHTZITE ROFIEZITNET,

1.

Tyl hOBEREEIFAR-FLEWEGR. BYICZOHSZERL T, 0
PV beEEIFAR-FLIEWEEIR, FIE2 ITEARET,

FEMICOVNTIE, 200 R—P 0 RFOEBOREIR| 28| T ZIN,
[7 74V (File)) -> TFZAR—b ..(Export...)] ZERLET,

HHOIFAR-FAT 7 - TIUFEMHAL THLWT 7 1V OARTE ATIT S &,
ROF T2 a VINERTESXDITRD £,

o [TXRT (Everything)l] ZERL TT7 7ML FERFITOcr ke TFAR—FT
L, £id GERLU R O#HiFH D 7 (Selected Time Range Only)] %L £,

A NERRNL R OHEPH DA (Selected Time Range Only)) ZEAZH G, HEINL
R OEHIZ TR TO T v ZITHEHENET, FRED T v 72 TFAR—-bLR&
WEIIKT B 22— MRV 2 (M58 2L TR I v 7 DEEHL XTI,

e [77A4)-T7%—<v | (File Format)] A=a— - RF 2 EHEHLTY 71 I EBX%E
BIRL £7,

e [F7i a3 . (Options..)] Ry EERTZE, Frx, 27 L—b H
CTIVIE, ETRREMAF—LERETEET,

OK) R"Z &Yy LET,

211



%5 5 % : Sound Track

72z bOREF

AE 1193 R—TVD [F—F 4 FEMAF—LDU AN BHERL TSN,

strack2.save

BEOT7OY 27 MEREET 5I12E 17 71 (File)] > &% (Save)) ZFINL £, Kick
REIND JARTE ..(Save As)) ¥4 707 - Ry AT, RO Ty IV ERITITOD L
~D#HTE AT LET,

AT 7AINOBEFIRET LI EETEE A TFAR—FDBMHEETT,

186 R—Y O [FOY Y MIDWT) £191 R—YD [FOV s bM< BBBL T £
W,

strack2.premaster

TOON - F—T4F - T—TADIFRAKR—-}

212

FOIN e F—=F 144« F—7 (DAT) TZFAR—KTBHIEICLD. DAT DRRAY—%dH5
MUDIERTE £, DFED. Sound Track 134 —F ¢« HEM E. ZHUCHEET T XTOT O
TIh R=HN—BXUOA Ty I A« v—/—% DAT IZEAHAET,

1. DAT RIATBERINTWT, T—TBHAINTWE Z EE2MALET,
2. 774V (File)) -> IZFZAR— b ..(Export...)] ZFERL LT,

3. [774)V-74—<v b (File Format)] A=Za2— -RY > ZE2FHALT TP - F—F 1
% - 57— (Digital Audio Tape)] ZZE{RL £

4. X7 a) 7 a> (Options.)) RY &2 Uy L, [F—=F1F - NTA=%
(Audio Parameters)] ¥ 1 707 « Ry 7 AZFHL T, > ) - L — ELHETXET,

5. TZFZAR—1 (Bxport)] ¥4 707 +- Ry 7 AT [OK] 2717 LT DAT ~NDHAH
ERIBL ET,
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Sound Track IZBT2BED N TN a—F+1 27

strack.trouble

Sound Track [CB8T ABED NS TV a—FT14 0

ZOHEITI, EIDDDMEEZOMNFGEZFHHL LT,

007-2275-010aJP

CD M BDF—F 4 FDOEEN D £ Wiz,

CD-ROM R4 7D CD M54 —F 1 F & HfF9 %1213, Sound Track Tl372 < CD Player
EFEALTL/ZEIN, 195 RXR—=IJ D I[CD-ROM N5 DF—F 1 FOHR 25U TL/ZE
Uy,

Sound Track TH—F 14 F2HEL XD LT DL, ENFESE<SHIABVLD, EFEITEN
S A

HELEZWRS Y Z7OEMHEINTHRY, DD I2a—b] RYCEAERINTHARN
ZE ZLTHI v - R a—L - ATAFPELFDITETCNRNIE 223 R—=TD
(Fowr-arho—)b-N—] 288) Z2HERALTILEIV, £ YA — R a1—
L@ R=PD T AR—=h-a>bOo—)b) 288) & [ F+—F 14 )¥F%)) (Audio
Panel)] OFEOMHRAL TSI,

AR =FLET7AINTTRTD T 7 A IVDF ¥ I E TN TN,

BEOF Y AN EEV T 71 IIVEA 2 HR— T 5EICIE. H—VIVEFHL TERZED
Fow 7 ZBRL TN RS Y TR0 ENHDET, FrorN eI XRTEDDEDIT,
SHICNT Y I EERTAIHENECDHZEDBHVET Q04 X—=2D ThT v 7 OEKE
HibR) 258, 72&x1E AFLA - Iy EAHR—FT285. AFLA - T77 1))
WK 2DDF v >RINEENTNDELD, A2 DD T v 7 2RIRT 206ENH D E
o IELWED NIy INEIRSNNh 72858, BEERENTWAS NSy 7 IZINE Sz
MolFvoxIid. 1 FR—hrINFEHA.

BLTBE Mo B > TENSEEL TCLES =

HOTHIHEEDD £ A. RET DA, [FRE (BEdit)) -> [BUE (Undo)l Z#ERL TS
ZEW, L. % Ry 227U T5E, BREINTVNDZTRTO NT v 7 IS
ENDIERERLTLES W, IS EL T TAT (Input)] AZa—-RE M 7aL
(None)l KEFEINTVD FT vV ICZREShEE A,

BEORY 2 —LNETES, X3 ETE 5,
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%5 5 % : Sound Track

HEDOFTNA ANSHE L TWEHEAIT. BEEBEDDHICZOTNA ADEFEL NIV EH
Hid20ENHDET, £z, [F—5F 14 - )XF%J)L (Audio Panel)] ZHL TAHL NIV
EHREIL TSI,

o F—FAMPEFEREBUTHESNTUSES KA.,

[F—5 14 « )NF%)V (Audio Panel)] ZBWTL /X W, [F=H (Monitor)] AN/ D
TWEHEAITE. BEEEDITANEEDEZZA2139TTT, ANEEZME < BVEE
3. T84 2270w 7L THTIZLTLETI WY, B2y ] NESITAKRD E R F oy
Y= AT
o XAUOTFIMEHEEHEETEIRN,

ET. A0 4207 —TIPIELLSERIN TS ZEEHERL TSN, KIT,
[+ —5 14 - X%V (Audio Panel)] ZBWT [Microphone] ATV —A &L TERS
NTWBZEZERLTLEZIWY 195 R=20D ANV —ZADFRE) 288 . I 51T,

[F—F 17 NI 2FEHALUTAHLRUDEY R L NIVICREINTNS Z 2R L
TLEE N,

strack.keys

F—K—K-La—thyh

214

Sound Track P < > RiZid, F—FR—RK -2 a—rhy h2EDHONELHDET, ZH5
D a—hrhy MEAZ2—ICHERRINET., BEOF—F—RK-a—rhy FafHTSIC
3. AZ2—DIX Y ROBICERINTNEF—2HLET, & ZIE. Sound Track 2K T
T BT, <Ctrl> F—& <Q> F—Z2FRFICHL £7°

ROFZ, mOE<MHbLNDF—R—K - a—rhIy bOURALNTY, ZOXKZHIMAHEE
DT 4 2 RTIZERT BT, FWI1 MLes)y 7 LET,

x5-2 Sound Track DF—®HR—K - > a—krhv K

F—AK—F-
=7 3 a—-bavh
M (Record)] Ctrl+R
A4 (Play). AR—ZA)N—
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Sound Track D1 >4 7 £ —AIZDNT

x 5-2 Sound Track DF—H—K - > a—rhv b
F—HR—F -
avw Rk Ya—-btavhk
[ 1k (Stop). A R—Z)N—
raE— (Copy)l Ctrl+C
[X—Z I (Paste)] Ctrl+V
M#7 (Exit). Ctrl+Q

strack.reference

Sound Track DA %27 1 —XRICDWT

007-2275-010aJP

ZDHENE. ROEMNSHERINTNET,

216 R— D
217 R—=TD
217 R—T D
217 R—T D
223 R—=TD
225 RXR—TD
225 XR—T D
225 XR—T D
226 XR—TD
226 XN— D
226 XN— D

226 R—YD

[Sound Track D > % 71— + ¥4 T 7 5 1]
(AL —F—]

(71w 7&K

AZa—)

oy -a>bo—)b - )N—)
FS>ZAR—b-a>bo—Jb)
MHENEE] Ry )
MV—7#R Ry )

MR IR

M<—2] RF ]

v ML 2544

M =L KT )

strack.diagram
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%5 5 % : Sound Track

Sound Track DA 97 x—R - FAT7IS A

216

Uy
FR

FAh
N=Z—=

SR

Trin WE RE Avha—h  FI9¥ BB T—h— ~VT @ |
|a’irish’usn’peoplefjbuild 44100 KHz 16—t w Fo 27 {EARE 12MB F| A7 103 MB
7 =0 I T [ T 1T 1 _Zch |

THL—va AR 21— 100 o/t 00 L mmidR ASEeh

FZv& -ato—=Jb -

I T | Zch |

TEch |

R=4h
-axka-=i

s

|
S bl RSAY -‘l"_l_’

1 [T

00:00:02.800 ==
a0 ] oy | : @

| #res |[r5vrg—t-azro-n

Eg5-7 Sound Track D1 > % 71— « ¥4 T 7 T A

strack.click.ruler
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Sound Track D1 >4 7 £ —AIZDNT

AL - IV—5—

2y TRR

A=a—

007-2275-010aJP

TA L I—F—F I—FPHEDELF—F 1A - 7 Uy TORMESRT 572DICHERS
NET, FFEERICEEEEOE—RBH D, ZhUT [ER (View)) -> [—F—DH] (Ruler
Units)] Z#IRL THELET,

strack.click.views

70w TERIZ, 223 =YD [hFyr-a>ba—=)b-N—] T I IZH>B—HDOF—F 1
Fe )y FHELUETFHMITONTIZ 22 R—T D7) w 7RV 28R LT EE N,

strack.click.menus

Sound Track IZIZRDA 2 —NH D ET,

218 RXR—PD M7 7A)] AZa—]
219 R—=T D [THFE)] AZa—]

219 R—=2 D TTHRIR] AZ2—]
20— Marho—)b] AZa—)
WIR=YD [ThTFyr] AZa—|
21 R=TD TIFR] AZ2—]

222 R—=TD [T —F—] AZa2—)

217



%5 5 % : Sound Track

72741 A=a—

FHTE (New)J
Ll o2y hERERT 225G THH New)) ZFRL 9, EIRT S
EFATAT - Ry IANERSN, HLWT 7N OY>T) - L—bk, b
Ty O TIEER AT LET, HELWFIEIIDOWTIE, 191 =Y 7
OYx7 bM< 28RBLTLZEI N,

A< ...(Open...)]
BHFEOo7OY s hER<HEEE TH< L.(Open...)) Z#RL £, 190 X—
POIT7AINDAR—bETOD 2T bOF—T > 2B T EI W,

[R7F (Save)]
[##7 (Save)] ZHALTTOY o7 NMZARTEMTET,

MB#~TE ...(Save As...)]
BEOT7O2 27 FEHLWARTREL £

[ 2R —b ...(Import...)]
F—F 14« 774 )V% Sound Track IZHUAATZWIBEIT 1 2R — | L.
(Import...)] ZFERLET, 2L F—F1+F4 - T7M)er 0Py biC
BATHHEAD. 12077V ELTRETIHAICOBHEHTEET.

[TFZR—b ..(Export...)]
[TFZAR—b (Export)] ¥4 7OV - Ry IV AZHEET . 21 R—=2D [T 7
ANDIFAR—K] 2B T /ZI N,

L—E—2%H< ...(Open Movie...)]
INZEBRNTZET 7 A - TIUFNERSIN, FAMZ LD 20ITL—E—
ZERNTEET., 196 R—2Y0 [LA—E—~ORM 22| TIES W,

L—E—%2B U % ..(Close Movie...)]
L—E—%M< ..(Open Movie...)] THWEALA—E—ZMLET,

&7 (Exit))
Sound Track ##& 7L 7,
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Sound Track D1 >4 7 £ —AIZDNT

MEEl A=a—

[RR] A=a—

007-2275-010aJP

B (Undo) )
BRI T a Y REFIELET, Z2&XE Ty b (Cut)) a2 REH
AL TH—F 1« FO—HMEHIFRL 5. THUIE (Undo)) ZZEIRL TZ O
ZEILCTEET,

(AT (Redo)]
BICHHL/=ax > REHETLET,

(73 & (Cut)]
F—F 1 A O &HIBR. £7213 Sound Track NOFIDFFNHET D HEIC
(7w b (Cut)] ZBIRUET. BIR L ZEMIRED S BRN. —Mls 2
Uy 7HR—RIZEEINET, [X—Z K (Paste)] IX > REMFHTDE, &
W27 7 VO OB EE TE LT, FMRFIEICDONTIE 197 X—
DO TEOEBMOHIER 22 L T ZS 0,

faE— (Copy)
F—F 1 A0 BT HHEE. [JE— (Copy)l ZERLET, aE—
LEb0iR—RKWR 7Yy 7R—RICEBEINET, ZOET (R=2 b
(Paste)) Z#IRTHE, =0T 7 A I ORIDBFAIZR—Z FINET, 198
NR=TO IFOEHO Ay b, I8—, R=ZA K] Z2BRLTZEI N,

NHZ (Clear)]
F—F 14 FNOREIRL 20 & BMFICEW A 21213, [THZ (Clear)) ZERL
EJCIR

[R—2Z I (Paste)]
Y- /2 £330 — U@ 2 AR A > NOMEICR—ZANLUET,
[EIR (Select))
BRI RO T AZ 2 —2FKRrLET, 200 R—2 0 FOHEEHOEIR] 2
ZRLTLEE N,

[ N THERR (Deselect All)J
BEOTNTORERRZMRL LT,

DV — 5 — D HAL (Ruler Units)]
Rl D BAAL 2RI L £ 97,
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%5 5 % : Sound Track

[<v—7—%% (Marker Numbers)|
R—N—FBOFR /| FEBREUYBAET, RSN TVIHEITE Fy
7 - R—=UWENET,

[ —J1—4% (Marker Titles)]
R—N—HDER [ FRREYBEZET., BRINTVLIEHHFICT. Fov
7 - R—=UWENET,

[f4E b~ Z v 7 (Playback Tracking))
BENSYIOF Y | ATEYBFAET, FOHFTREFF vy - =0
FRENET, BENT v I BEHOHET THE Ry a2rV v T2 L,
FAL AT AT —INEESNEE 7V vy TORBNRA 70—V L%
ER

rrro—-ivl] Az=a-—
[F4 (Play))
M4 Ry > EFUBRETTS . IV O (Solo)l WA TWABAEERE,
HEINTWARW NI v I E2TRTHAELET,

[ 1= (Stop).
BAEZEEILELET, MFIL) R > ERUHKETT,

$%Z (Record)]
M%) RY D ERUMEETT, 194 R—2 0D (%] 28R T EE 0,

IE#IZRE % (Go to Beginning))
FAL AT 45— efEROEBEIIBEHL L7,

B #%IZH#E D (Go to End) )
AL AT 14— ERORBITBEL £7,

MR EiPA 2 ) — 7" (Loop Selection)]
GERIEGHAZ ) —7 | E—R2A > ERE3AT7ICUER LY, LRREGEHZ )L —
71 BE—RAF TS TWAEAIC THE) Ry 2220w o358, BIE
BIRINTWBEELEASNE T, NBREEZI)L—T ) B4 > 08BE
WKRFzy 7 - X—IDBRERINET,
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Sound Track D1 >4 7 £ —AIZDNT

rk>v91 A=a—

MR A=a—

007-2275-010aJP

MZEHUEPH 2 F5 4 (Play Selection)
DRNEHZHE] T— et E@3A 7B £, HREHEZREE
E— R RS TWRHEI THE RF 22Uy rd2E, BILER
ENTWREMYOANFESNEY, DEREEZHELE) 34 218> T
Bl Fovr - R—UNERREINET,

[F—F 13 - X%V DEH) ...(Launch Audio Panel...)]
IF—5 1 # « )X%)L (Audio Panel)] ZFE X, F—F 14 - )XRINIHER
DF—F 1« ARE. AT BROH2ERT 2 DITKREEF T,

'~ Z v 7 OfERL (Create Track))
FLWE I I ERBICERLZ STy 7 OTITEML £, BEMbRERS
NTWRBRWEEIE, HILWEI v 731 > RUNOREBED NT v 7D FIC
FlEINET,

[~ 2w 7 DHIBR (Delete Tracks)]
BEBRINTVEITXRTONS v 7 2HIBRLET.

(%% V5 ...(Set Name...)
BIRUZ b T 7 D& ZfmErTREIRIREBIZ L £9

22— b (Mute)]
BRI OFEHTN HINEBRUET, [TRTEI 22— MER
(Unmute All)] HEIRTEET, 24 RXR—=TD M a—1] RF ) Z2BHL
TL7EE W,

M/ 0 (Solo)]
BIRLAE NSy 7OV OBRAEAITY OOMRERBINL £, [TXTEY OF
B (Unsolo All)] HRBIRTEELT, 224 R—I0 TyO) Ry 28T
<7EEWn,

[TJ— (Echo)]
ER LU it KRBT IR E2MITET,
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%5 5 % : Sound Track

*R—H—1 *za-—

222

[7x—RK A2 (FadeIn)]
BIRU M OBED OB ZEENSKEICEEORY 2 —LAFTHODTHE
ES

[7x—R 77k (Fade Out)]
BN U727 OO0 OFZRBICENRLBDETK > TNEET,

MER{E (Normalize)]
ME#IME (Normalize)] ZEINT 5 &, BIRLZFHDOEDL NI T )L - FA
FIvT LD ICETEDLNET,

(XA KU w7 - A 351 (Parametric Equalizer))
A 3 DOHFDEKEEHOZVERDEDTEET, NFTAMY v IITIE3
DOFENH V., 3 DOMBITH U TEBNICH RE R, g 71> /W
FEAETEET., HAHHEOY Y ROGEEETIIVF—EZ¥ML, —
B TRABERIRINF —OBZRRIIHS LZWEEIZE, ROEHEZ & E
HCIEDT A MEICREL. FRHIHE WS Z EREKEETAaDT 1 S EIZERE
LET,

DC F 7ty ~&fEkRT % (Remove DC Offset))
DC 47ty M3, A—F 1+ AEENEOICE>F U 27 L TWRWEEICH
ALET, ZRETDE F1FIvr - LoYRBEbNET., Z0av
R BREHEEOAYUTIET. DCA Ty FEREREET,

FJ))N—X (Reverse)]
HOBRRUHGZERL, WHICHETESEIICLET,

&&= E (Set Volume))
FADETIN) « AT =)V THRETEDYA 7O « Ry 7 AZREELT,

FITDNTIE, 206 R—P D [R—H—DfFiH] 2BHLTLIEE W,

% L~ —H— (New Marker)|
X—H—%fHARA > MTEMLET,

[4ipf 2~ — 2 (Mark Range)]
X — N — 2 BAE OEREPH O JeE & RAZITER L £

007-2275-010aJP



Sound Track D1 >4 7 £ —AIZDNT

< —7—%#m&E ...(Edit Markers...)]
R—N—%mET D005 1700 - Ry 7 A%ERLET,

[ — 71— % HIF% (Remove Marker)]
BIRU Y —H—ZHIBRLET,

I XTZHIBR (Remove All)]
HEHZITNTOY—h—2HIRL £,

K E T%EIR (Select to Next))
HENZH 2 —FiENY— N —FTEERLET,

[Hij &£ T2 2R (Select to Previous)]
ERICH B —FENWI—HT—FTZERLET,

RN+ 27 (Jump to Next))

FEARA b - A 22 AAO—FENY—A—FX TPy 278X,

M4~ ¥ > 7 (Jump to Previous)]

FARA b - A 22 EMO—FINY—H—ETI vy 73T,

strack.click.controlbar

Sy -arbO—=Ib - N—
X581, bowr-a>bo—)L - N—ZRLTWVWET,
- Za—t by

- FA I -ﬂfiév*/ -f'?”/-I:l”/H:l—le
|

P n I - i g FZwa AN
s a—A Fr
-axka-=i -axka-=i

Eq5-8 cowZr ~arhro—=)b - N—

cNowrz ea>bho—)« N—=IZiE. RO LBEgERHD, Zhsidzar hao—)L

MHBBICEZICERINTVET,

007-2275-010aJP

- N—DE
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%5 5 % : Sound Track

VY TRERED=H

FTIAINETIE, 77Uy TE2a—DZMIIFAEITER>TED, 7Yy TRRNERINTNDS
ZEERRLET, 7w FRREERRITT DL, KAIZZ Y v 7 U THAZFICLET, 7 Uy
TERREMITE. HEZU v LET,

FSvo -4

ITRTOR TV IZIZETF 74N NT BEn) TR nEhTv 7 08ERLET. <)L
FhIwro7OPrl MEFETIEHRE. ST v VICARIEMNT T, TNENO ST VT
WWEDIIBBEOENEENTVRENDLNEEIITLTLEI N, 42T 2FIEIDONT
13, 204 R—=2D ThT v I OLFHNT) 28U T 7Z3 W0,

rvol K& >

vog R 23 MEFICRED T v 7 2 —IRFICHEMTHAETES LI ICTHHETY, T
DRY =7V w5 &, BN DERZFT7ITUBEDD ET, Ry N ERDOGEITHEAE
MA IO TVET, ZDRET IHE] RY>2r Uy d2E 2O Ty VREESN,
ZTOMITRTO Ty 7 OFRFHEEINET, 1 BITEEO NIy 72V OMREFHRATZILED
TEET,

ra—k1 RKE >

Ra—hRY AL REFTBEDO NS v 7 OE2—FFICE L THETE 2L 51T DA
TY, ZORY L E2I Yy ITEHE, BEENT > ERRFTIOEDLOET., Ry I nT
WBEHFIT, LB TWET, THE RY &7 0w I 358 HEINTWE NI v IIT
HEInEzEA,

bFSvo -RVa—-L-R54%

cowr e RYa—L AT EHHLT, REOF IV VDA —FT 4 A OEREMHTTE X
9. ZHUF. Sound Track TOFEA, BEUPT 7 A IVALFAR— hINHOBEIIKBEIN
9, L. BER) 2 —-AIRITEELERA.
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Sound Track D1 >4 7 £ —AIZDNT

cSvo -1V - X544

cowo - N> - A5AFZHHAL T, HED ST v I DELADF ¥ > RIVEION > ZHFHITE
£9, ZHUd. Sound Track 'C“@ﬁi BEUOT 7 AINNITFAR— TN HOFAEIIKE
NET, L. BN IIEELEE A

ANWFrvoRIV - A=a— KRy

ZDAZa—RF NI b I OREOANZHIELET. 2L (None)] #&IRLTZD
Sy IZADEFEEZITNTEILTZIED, EOF Vo RIMBESETINEERNTZZEDHT
=F7,

strack.click.transport

FSYRR—=bF-a2ba-i

RS ZR—=b a2 bO0—=)V3A—F 1 FORFLHAEICHERLET, 194 X—2D [Sound
Track TO#ZF] & 209 X—2 D [Sound Track TOF—F 1+ A OHFA] 28R T3V, ¥
612, FERTAR—F - A2 O—ILOHBRIRINTNET,

strack.click.playselect

MERBE] Ky >

DERNEE] T—R2FFREBAT7ICUELET, T 74 RTIEA I TnEd, ER
BHAE] E—REFCRE>TWBREEIC THA) Ry 2220w r35E, BEERINTNWS
HbODHNEAEINET,

strack.click.loopselect

NV—7"24R1 Ko >

V=78 R | T— RE2F 2 FRE3ATICUEAET. T 74N TR A 7o TwES, DL—
TER| E— RPN FIZRHBOTWAEEIIC THAE Ry 200w o35, BHERRINTY
LHDONELEEINET,
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%5 5 % : Sound Track

strack.click.time

R &R

BRI R RO EERI. fARA > RDOAE. £7213 Sound Track AT OB EITIZI A L -1 >
FTAT—FERLET, BEEZROTEZ. HEORBROEHEEREDORA > N2XLET, K
i HH:MM:SS:sss DIERTEREIN, HIZER, M4, SiEBzehzhnEL£7,

strack.click.mark

*—21 Ky >

AL AT A=Y OBREDMBEICY—H—Z2BMLET, 206 R—=ID [¥—H—lZDW
T Z2B8RLTLIEI N,

strack.click.shuttle

v ML RS54%

ATATZHRNESLEICRTI Y TTDE ML AT r—INEATBEHL. GITRIYy
TEDEIAL AT AT —INHCBHLET, XTI NFHRNSENDIFEAF v > D
HENESIRD £T,

strack.click.zoom

I VNI 3%
(Z—n) R CEMERALT, 20y TEREBRELGHNLET, () RE>E2Z U255

EERLEZ Uy IHE D EVEEORME TERIN, () RY &Iy rT5E, KVE
WO HALTH Y ARSI NET,

226 007-2275-010aJP



e

Sound Player

ZOEL, ROHMOSHBRINTNET,

o HIYZR-FL—Y—=lZDNT) Q27 R—2)

>R T —Pv—0DiEH) (228 X—)

e YR TL—Y—TOF—FT1F - T71IVOFHE] 229 X—2)

o YUY RDBEDHAM (230 R—)
o U R .FL—PY—DAZa—ITDNVT] (231 R—)

e [MIDI 7 7 1 )VDOFA] (233 R—2)

splayer.about

YO R - Fb—=—¥—ICD\T

YOV R - FU—vY—DHEE

IR TL—Y =DV —)VEHEATEE ROF—F1F - 7y A NVERZ S AT L THE

TEET,

e AIFF

e AIFF-C

e MIDI

e MPEG-1

¢ Sun/NeXt

e  Microsoft WAVE

007-2275-010aJP 227



% 6 % : Sound Player

YR T L =Y =DM DOV TR, 229 X—=PD [HI 2 K- FL—Y—TOH—
FAF - T AINOEE #BRLTIES N,

Eb YR Ty AINOREKXEHET HITIE. ROFIEIZHKED T EI W,

1. YU R-TyAIOT7Aa2&2 1BV LU TGERLEY, DED. Y1 I ERZRH
MW, =YL THREAERICLET,

2. TAOADEMFALRRICULIRET, SUXOAERY =M LEEFICLET,
[FZX 27 kw7 (Desktop)] AZa—MERINET,

3. [FAZ by 7 (Desktop)) A=a—7n5 M&EH (GetInfo)l ZERL £,
Ty ANERRE, FUR - Ty IVOBHREZD Y 1+ > RUNKRINET,

NIV T DRETE
ZORZaT7IVE, ROERLEEZFEALTVWET,

o HOTERINLMIME, AFEOMOE, Hil, HEXLBHFHEOERNOY XV ZRLET. &
EXRE 2T - L—bh) 22Uy I LET,

o RTERINTWBLFIT MEFY > V) #2RLET, ZNEIUwITDEE ZOHHTD
V=B L T 2 EAIE T AF 1 7 - L I—4 (Media Recorder)] 227U w7 LET,

o ATI—HRAZ2—HHORIIHS (> 2L, AT 21— OBREHAD/KZ %
LEd. 2&x1E [77 1)) (File)) > TBI< (Open)l & (7710 A=a—zHE,
MB< ) Z2IRT 2 &0 BRTT,

YO k- Tb—vY—DitE
FIUR - T X T T HOTOANE AL, KOFHTEHTE X7

o RTERINTVEIYTIZR-TL—VY—DOXFZEI) v I LET,
o 71 a2ZEIYyILTESHT DI ROFIEZITNVET,
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YUY E - T —Y—TOF—F1F - 771V DA

1. A2 bw7 D IW—)LF = Xk (Toolchest)] > MR (Find)l > [AF 17 - V=)L
(Media Tools)] Z&ERL £,

2. Tsoundplayer] 712> &5 7)Yy LET,

splayer.playing

YOUR-TV—¥V-—TOF-T4F - 7714 IVDBE

007-2275-010aJP

F—F
= 1
ST E
e F
STl
[ =R

B T
0w FLT,
BERS xS
uwsrdas,

Trin@ V-l «\)hf@

FrANLFFEEERBM. CORTOFNN
— LG TIEL, ChAiF—F
PP FANOE A LTI ERT,

B 6-1 F—F 1A TN OEE

IR T =N —=TH =T 14 - 77NV EHET DI, ROFIEZFTNET,

1.

P2 R TL—V—NEEHONTOWERWERIZ. ZhEHEET,
< HECDNTIZ 228 R—=YD YT K- FL—Y—DlEH)) 28HL T7ZI W,
F—Fa4F - TNV EERLUET,
o [77A)l(File)) -> MHI< ..(Open..)] ZERLET,
FRINZET7AI) - TIUTFEFEHALT, F—F1F - 771 IVEBRLET,

a—-bFhAyb: YIRS —VY—0ROY T - Ry MF—F 14 F - T7AINDT
A2 ROy 7 LET, K612 T/ZIN,

UK T L=V —THETELZYY R - TyIE T2 AT 47 VT U
TIZHEENTWET, & —F 14 - 7 7 1 )Lid /usr/share/data/sounds/prosonus (2.
MIDI 7 7 - JLiZ /usr/share/data/music {2 D £7,
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% 6 % : Sound Player

3. THAl Ry &7 v I LET,

BRU A —T 1A - Ty AOIVDPEESINET, HEOETITUSU T, BEED FZHD/N—
O\MABFH L. HBZHSEET. K61 Z2ZHL TSN,

4. Ty OFEEEFEILTSIE. EIL) R EZ) v I LET,
5. BRLTERANSHAETZICE. BREL] RY>&22 Uy LET,

6. YUK FL—Y—2KTTDIE (77 1)L (File)) A=a—%BWT T (Exit)
ZBRLET,

a—bAhy b fsoundplayer] 7 A2 DEICHA—F 14 - 77 AIOT A A %EHER
Oy 7 TEEY, ZHCKD, YUK - FL—Vv—2HHWICHNT, 771 IVOFEENKE
DET,

AR EENMETEDE, F—F a4 F c T AINOERB ZABRWEENH O ET, 230 R—
D Y2 RFEEDHTG LTI,

YR TV —VY—THETEEZF—FT14 - 77 1IDERXDOU X MZDOWTIE, 227 X—
O HY R L —F—I2D0WT] 28RLTLEI N,

splayer.volume

Yo FEREDRED

F—=FT 17 - URIVOFAER

WY 7 8T 27 « YA TERINDZZEOMST F—F 14 - LX) (Audio Level))
A=)V THIEIL £9. HIEHALIZT > X)) (dB) T,

F—F 1A - LNV EF#EHT 212 ROFEETNET,
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B 2 REGE DO

1. w—)l (Utilities)] -> [FAEDHI# (Playback Control)] Z#RL TH—F 1A - L X)) -
NI EHEET,

F—=FaF LR N DRERINET, 62 Z28RLTLEI N,

TrANn@E V=@ T E
A s
— 5 L%l (dB)

B 6-2 F—=Fa4F - LNV RV EROEY TR - T —Y—

A€ THAEDHI#E (Playback Control)) IZF = v 7 « X—=I BTN TWAHER, F—F «
F e LN NFNDHNTWET, ZONRIVEAL 213 THEOHIE] 2FHO07 Y v
7 LUET,

2. F—=Fa4F LNV ELEFZITE, S —IE Uy I L THIRI v LEYT, FF2IC
3. BRIy T LET,

BE, F—FT4F - LX)V OEN0dB Z2HBAD & BEEATLENET,

eEvb iRt = OEBONMAZIY Y ITDE, F—FTa4F LN O0ICREDET,

o
ol
?I
=

BREYENOF—FT 1 4 NTA—FEZHMGT L. T > BT L —Vv—D Y —)l (Utilities) |
> IF—F 174 - )3%JV (Audio Control Panel)] ZH&EET, ZONRIDAE—H + X574
FaHL CERZMEIL £,

splayer.menus
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% 6 % : Sound Player

HOVR - F=FV—DAZa2—ICDW\T

72741 A=a—

'Y—Jb] A=a—

232

ZDHENE. ROEMNSHERINTNET,
o 2R—TD MT7A)] AZa—]

o 2RR=TD [Y—)] AZa—]

[774)0 (File))] AZa2—IZiF, ROAXRPBHDET,

[FH L1 > R (Clone))
RO 9> R« 7L —¥— (Sound Player)] 7 > FU&E-7<FHU
T4 RUEBS 1 DIERLET, ZEAR, YUK TL—Y—ICBE
capture.aifc EVWIARIDO T 7 A IR HB5EE. LW 1 > RICH
DT 7 ANBEENET,

M < ...(Open...)]
FT—F14F - T7AINERRL THLS LODBEEDT 7 1)) - TIUFEERR
LY,

MB#1~TE ...(Save As...)]
HEDOT7 71 IVONEEFH LWELHEITHREFEL. O 7 71 IV E LU TERL £9°

&7 (Bxit))
YR T —Vv—%KTLET,

v —)b (Utilities)] A=z —IZid. ROAR > RBHD ET,

[F 4 Ol (Playback Control))
F—=T 1A LNV ARV EREET. FICON T 230 X—2 D TF—
FaF - LXVOEE 22RLTSES N,

[F—5 1% - )S%JV (Audio Control Panel)]
F—Ta4F -3 bO—)b - NNV ZERRLET. FFlICOWTIE, 231 R—
PO IEFEOHE] 2BRLTIEZI N,
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MIDI 7 7 A )V DEAE

MIDI 7 7 1 IV DBE

007-2275-010aJP

'MIDI /31 A (MIDI Devices)]

WY 7 b7 « > obd A& 2 AT AITHEHR S N4 MIDI 531
A EFEYEEZDO—) A —/N—« A=a—T7F, FFicONTIL 233 R—
® MIDI 7 7 1 )VOEA] 28R T /Z3 N,

splayer.midi

MIDI 7 7 1 )V &BAET 2I121E. KD 2 DDHERHD £,

WY 7 b7 « >3 AH¥TMIDI 77 1 IIVEEAETDITE, 29 R—=J0 o>
ReTVL—FY—TOA—F 1A - 77 IOEE] ITRINTWLEAEDFIEICKES>TT 7
AIVEHAELTIEIN,

S MIDI 581 X (MIDI & > 251 72 E) T MIDI 7 7 1 )V &FE4ET 2 FIEISKR O
DTY,

1. MIDITNAZRDANZEZT =V AT—2a>DIUT7) - R—hZHEHELET.

SUTI s FINAREA A R=IVTDHEIIODNTIR, &=V A5 — a3 > DA
EEBRL TSN,

2. MIDI TNARA&ET YT R—MIHERLIER. [P AT L - X% —2 ¥ (System

Manager)] ZfHAL Tty F7 v 7DV 7 by 2 7 RERTETE T LET,

" —)LF £ A b (Toolchest)] 5. [T AF A (System)) > [ AT L+ X% —T v
(System Manager)] ###RL. [)N— K> 7 &5 /N1 X (Hardware and Devices)] %
7y UET,

3. INT, Yy R FL—Y—0ROoy~7 Ry M MIDI 771 )LZ KOy 7L,

(F4 (Play)). M&1k (Stop)). TBREL (Rewind)] O&RE > 2 L THHE MIDI 5 /3
ARATT7ANEHEAETEDLLDICRDE L2 # L EHAEDTEIZ DWW TIZ, 229 X—
PO IR T L=V —TOF—F 13 - 771 IIVOFHE] ZBRL T ZI W,
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AE D EREDOFIEORD DI, MIDI TNA ADH —F « AN T =7 AT —2 3 VITHHL
T A5 L - ¥FX—2 % (System Manager)] TRET DL, V—IAT— 3 >DAE—7A
TMIDI 7 7 1)V EBHAETEET,




W7 &

CD Player

ZOFEF, ROHNSHEENTHET,

o THEE) (285 X—2)

[CD Player O#iH)| (237 X—2)

o IF—5F 14 CD DAl (238 RX—2)

o [RUa—LDHH (238 X—2)

o [CDMSDF—F 1 FDHEF] (239 X—2)
e [CD LO®H) (240 X—2)

e [ThZIwZ -URb) OffiH (241 XR—2)
o [HAFTa> ol 242 XR—2)

e ICDPlayer 1 > 7 z—RITDNT] (242 X—2)

9=

ZOfilE, ROENSHRENTNET,
e 236 X—I® [CD Player DHHE]
o 236 X—® ICD Player D4+l

o 237 R—TD [NV TDOFELE
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% 7 % : CD Player

CD Player MDH#EE

CD Player 3. SCSICD-ROM R T4 7 &L 722 AT LT L TRD 2 D DEAR IS HEE
REIELTVuET,

o J—URAF—3a3rTH—F 44 AN T4 A7 (CD) ZHETEEXT.
BIEL. o CD L —VY—&FHU T,
o F—F 1 FHUWEIZ CD #FIHT 512D OER/HEEZIZH L TWET,

CD Player 3. CD k@&~ F v 7 Z2f@R|D AIFF 77 A )V ELTRLET, 5077
A& ThZv o - UZX b (Track List)] ICERREN, AT L+ TAAVICAE—TE%
T CD EDFA—F 4 A DEEOHHZEBRIRL THL W 7y A IVICRET DI EDTEET,

CD Player D48

CD Player M54 ] bSyo - UAR
b5y RRRANE,

DT rANE, TRV,
Falo ), FOHOFTI VI —

= tpaer LAl RS yITES. =0
| 7710 ® HEG® FAM® ATvav @ | ~N7 @ |
4 0 00:08:06 00:03:39 @ﬁ%“@ Ll bt etk
b2 Bl FEERRE RDEERE CETeeee
1 2 g G 7 a g 10 I Tracs:  Title Start Duration

11 !! !! !! !! !| I Im 1 Sodium Laureth Sulfate 00z 318
e Ry &7y LT, | Nortn san Brune 321 045
bZ o EERT B, Dan't Respand 406 359
1 00:00:00.000 (e[ i [ o (D)
||“_]|-_]|_-i||_ |:l h 5 Cankehold Princacs 11-47 4-20

CD YA LZArEEST, FZAR—F -3 bO-EEST,

BREDT&F FZ v T2, A—F+A#=BETE,

E7-1 CD Player DMl (A A= &7V v U2 ERREPRTEET,)
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CD Player O Hf

NIV T DRETE
ZORZaT7IVE, ROERLEEZFEMAMLTVWET,

o HOTERINLMIME, AFEOMOE, i, HEXLBHFEOERNOY >V ZRLET. &
EZE AIFFZE27 ) w7 LET,

o RTHERINTWLXFE TEEY > 7] Z2/RLET. IhEZUYITDHE ZOLHEID
V=)V INEHLET,

o AT a—ZVAZa—THHOMIZH S [->] >2RIE. AZa—0OBRIEHAD/NA &R
LEd. 2E2E T774)b (File)) > TB< (Open)) 1. T7710)V) AZa—%RE,
A< ) ZFEINTBENDEKRTT,

CD Player Di#2&h

CD Player iZ7 7229 %1213, KD 3 DDHENHD £,
e CDPlayer ZEH5ITEEY %1213, CDPlayer 27V v 7 LY,
s YAIAXZEIYyILTEHT DL, ROFHZITVWET,

1. FAZbwT D IW—)LF = Xk (Toolchest)] > MR (Find)l > [AF 17 - V=)L
(Media Tools)] ZZERL £,

2. ledplayer] 74 a2 &¥ 7)Yy LET,
e UNIXIx)lDax > RiThoiE#id 5i2ld. cdplayer E¥ 1 T ANHLET,
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%5 7 % : CD Player

—
=714 CD DB4XE
BE

BORZwo
¢ (((p, ?RUJ_A
z\ja_ﬁlﬂlkjlﬂllilbl= e

| =1k

BID Z w7
& 7-2 CDPlayer ® b5 > ZAR—h - 2> ho—)b

RY 2 — LDRE

238

1. CD % CD-ROM K1 7iZ#fiAL. CD Player Zi#EE L £
2. CDPlayer ® 4] RF 227Uy 27 LET,

M721F I AR—b - a2 bO0—)VOWEEZRLTWET, [El] Ry 2L~
%6, CD Player [3##IERA > bZEMFFLET. DXO. [HE] RYCEHEZ Y YIS
b&, FIEL S SEENEBIN, [—RpEE) RF 2 ERUK S mREZREZLE
9, CDDBEDICREDICE, INw o) Ry 2270w LET,

FEOETENET VKT EDHEITE. 238 R—=2 D FRY 2 — LD 22U T
LSV, BED KT v 7 2BIRL THAT D HEICDONTIE, 240 XR—Y D [CD Lo
] BB TLZI N,

R a—L) RY > (W7228) Z2fHLTCD OFRZHFHEH L TI/LI W, R 2—A)
Rl Uy l$ToE ATAINEREINET, AT 5 Z LITBHTD L, FEN LN,
TIBHTLEEENTND XD,

X% :CDPlayer DE &L, [+ —F 14 - /X)L (Audio Panel)] DEFRERLZDMMDT 7'V r—
Ta DT ERE SIFRGRR<HEEEL £
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CD 6 DA —F 1 F ORfR

CD D5DH*—7 4 FDWIGF

ZOHITI 239 R=2D [F—F 1A+ b Ty IV OHG] &£ 239 X—=2 D NERL #HHOA —
TAF ORI IXDOWTHAL XTI, FEHETRESNTOUSEROEGICBL TE FHIEHE
> TL7ZE W,

F—=F4F - bS5y oOME
CD FIw7id, ROXDITHBEIZS AT L + T AZICIAE—T&EET,
1. CD % CD-ROM K Z 1 712 AL T CD Player 28 L £
2. ThowZ - UXb (TrackList)] "5 Iy 707 A 22 ZEFERLET,

o w7 OMBHIETIDONTIZ, 240 R—=2D [: T v 7 ~OBE)) 2SR L T<ZIWN, &
WUZRZy D - 743203 ThT v - UR DN (Track List)) O THFHZRINE T,

B2 b1 EBICEROY A 22 2#ERT 2121, <Shift> F—2 M LRA5EIRL TWEET,

3. Y1aAYEFAI by T, BlOTY T U= al, FRETAACERT A RTICRT Y
TUEY,

MOKiEELT, My I EFERL, RIZ [T 74)) (File)) > [ =T v U &R4ERFE ..(Save

Track As..)] ZERL TR T I Z2H LV Ty AINELTRETDHIEHTEET,
BIRUEBEOF —T « A DG

CD D—#ZHFLWT 7L ELTRET 3121F. ROFIEEITVET,

1. CD % CD-ROM R 7iZ§fiAL. CD Player ZiEE L £
2. WEBEDEERLUET,
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%5 7 % : CD Player

CD tn#EE

FSyoADEEH

240

CDZM LT (M7-1) O—faer Uy U, SMIR T v 7 U TEREITFEERL
9, BEEREIN TV SE OB [CD Player] 7 > RUDLETFITRF TERR
ENEY,

R 2 P4 (Play Selection)] 7YV %01 f;o’(%é EEWRLET, RIRNHPHZ
ﬁij ax > Rid. T+~ 3> (Options)] AZa—IiZHD £,

(A Ry >27 )y UGERL I 2MEET,

AE:1240RX—2 0D ICD LOBE)) I L<FHHINTWET, /20 N—THERE
DF T a3 VICHETBHFIZIDOWTIE, 242 R—20 THAF T a3 O] 2281
LTL7EEN,

771V (File)) -> [EIRZBIAIRTF ...(Save Selection As...)] ZFEIRL ET,

T AN T IUIFNERRENETARRT 2H LW T 7 1L DHHETE AT L. <Enter> F—
ZLET.

ZDHEITIE, 240 R=2P D - T w I ~\DOBHE) & 241 R—T D TEE DR~ E) ITDWT
HEAL £9,

RED KT v 7ITBHTZITE b Ty 7 -RY VHBIIHE Ty VBRFEORY 22Ty
7 LUET.

IRONZ w2 £ ORIy 85> (K7250) bfHTEET.

AE NIV IBEEERTDIHNOHEELT. Ty T (Track)] 7 1 — IV RICBEPED KT v
I %mE ANTLT <Enter> F—2MT2EHTELT,
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(bowo - URb) OfH

HEDRE\DBH

R E OFEICAEIT 21213, TFTE R (Absolute)) 7 1 —JV REZIE ThT v Ik 71—
WREHRELET.

o [FTEIR (Absolute)] 7 1 —Jb Rid. CD D&M 5 OfRERMER L ET, 2& 21, CD
DEE S TH S 50 &I MEIk) Ry 22 #Hd &, 100:00:50) EFRRINET. FTv
ZEsH 7 « —)V Rid. [CD Player] 7+ > RUDETIZ, KOREBHFTERINTND
T4 =)V T, BIEO T v 7 DBED NS OB ZRL £7,

o FFIE HH:MM:SS O TE/REN, HIFFRFM, M35 SIIBEXRL £,

o INBHDT7 44— )VRERETDHIT BFEIY I L. RICKEZ AT L T <Enter> F—
=ML ET,

AE:CD LORKEDOEHMERETSHAE, [8F v - U X b (Track List)) @ B4k (Start)] 7 1 —
VR & THfehef (Duration)] 7« —)V REZH T2 LMERTY, [BASH) 12 CD EObT v 7
DOtERZRL, [FrGREE] 3 h oy 7 OERESEZRLUET,

[b>yo - UR ] OfER

007-2275-010aJP

ZOYATLATECD DA =T 14+ bIv I 2T ) MEL THATEETA, CDDOLT Y
ITDIA MVERE I LR TEEEA, 2D, CDPlayer id CD D 'hF w7 - J X b (Track
List)] Z{ERRT 2 HEZBIEL TWET, ZOU R MI1ELFERT DHLENHD ET, Vo
72U A B ZEERT UL, KIENE CD Player 282D CD Z28# L. O ~F v 7 - U X M EER
LET,

CDDFI w7 - URXBMZEERTZITIE ROFIEETHET,

1. CD % CD-ROM K1 7iZ#fiAL. CD Player ZiEE L £

2. [#4 MV (Title)) & [7—F A b (Artist)) D7 1 =)V RICANZITVWET,

3. ThIwr &A1) (Track Titles)] Z AL TWEET, T v 7id, CDICREEIN T
BIEFETY A MEREINET,
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%5 7 % : CD Player

% (N5 « 54 Ml (Track Title)] 7 1 —)b RERETZIE. 71—V REZY v
L. HiLWRhS w2 - 51 FLEANLT <Enter> F— 2L £,

AE:TNTvZ - UADN (Track List)] 1Zhd [:Twv 7] 74 a20E AT LDOROEFETIC
KSwrTEET, IOV TIE, 29 X—2D [F—F 14 - bSv 7 DOHIE 288HBLT
<7EEWn,

BEATarvnER

o UJE—MHAZRETDITE [FT7 2 3 > (Options)I-> [+ 72 3 > (Repeat Options))
ZBEIRL. RiT TIE/RL (No Repeat)l. [CD %<1 (Repeat CD)J. £&id [FIv U %
%1% (Repeat Track)] DWW NMNEERL £T,

o ERLHHEHELUBET ST, H7'2 3> (Options)) -> LEREIFZ )L —7 (Loop
Selection)] ZBEINL 9, LEREEZIL—T | 2RI I8 ZOFT > 3> 2HER
RUET., ZOF T2 a >NEMNTES> TWDHAFITE, Fovr - X—INERINET,

NP 2 F 4 (Play Selection)] ® 72 3> (Options)] AZa—IZEENTHET, [#
REFHZFE) WA TWDEAEIT THE N> aer) v rd2E, BIEERINTY
LEaNEEINE T, ZOF T a nGHOHEIE. Fx vl c R—INERINET,

CD Player DA #2722 —RICDWT
ROAHITIE, CD Player O EEDOBEZFHL THWE T, K 7-1121d. CD Player D4 A
BEDEHARFHE L BITRINTVET,
e 243 X—® ICD Player ® A =1 —]
o 2USR—=TO [ThTFv T T14—IV K]

o 245 R—T® ITHF]] 714 —)V K]
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CD Player D1 > 45 7 = —AIZDWT

CD Player DAZ=a1—

72741 A=a—

007-2275-010aJP

o 245 RX—T D TFTEKH)

o 245 R—T D FO K]

o 246 R—=TD [ThTwr) KH )

o 246 RX—YD [CDHALTA ]

o 246 RXR—TD [hFy 7R &ZEIRIFRH)

o UTR—YD [hTF2AR—h - -a>bO—)l

o 2U7R=TD ML M) T4—=IVRE V=T 14X b) 71—V E)

o UTR=TD [:TFvT - UXB]

CDPlayer DAZa—IZ1F, 243 R—2D [[T7A4)] AZa—] ., 244 R—TD TTHFEHE] R
A 2AR—TD [TER] AZa—]., 24 R—TD [[F T3] AZa—] MNEEN
TWXET,

[~ Z w7 &R% R ...(Save Track As...))
N T I RBRERERINTWSHEFITIE. [ Ny 7 2344~ TF ...(Save Track
As.)] ZHEALTHRS v 7 E2H LW T 7 A IJVITHRETEET,

[ 3841 % B 44 £ 77 ...(Save Selection As...)]
HHHPHNS 246 XR—2D ICD A LTA 2] ETERINTWSE, [ER
Z B L ARTE ...(Save Selection As..)] XD ZDERZH L WT 71 VITIRTE
T&%(9,

TH Y (Eject)
CD % CD-ROM Ko 7o HBHLET,

&7 (Exit))
TOTSLEKTLUET,
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%5 7 % : CD Player

Mm%l A=a—
MR P 2 1 — (Copy Selection)]
BEER SN TV BHn 23—, JIOHNTWEY 7 r— 3 22X —
ARENBHEDITLET,
M RTZER (Select All))
BTy I EBERLUET,
(4R L 720 (Select None) |
TRTOERRZMRL £,
MEaR 4 #4R (Extend Selection Right) ]
BIEDERZ 1 AL AR £,
HEGR7E 2R (Extend Selection Left)]
BIEDERNZ 1 B EICiR U £,
[&RR] A=a—

'cZw o« JZX b (Track List))
Fowr - RN ZHELET,

F7varv] AZa—

[N\w K7 %> ..(Headphones...)]
Zoax > RiE HWN—2 3 > CD Player Z& L £9, CD-ROM FZ
A TNy BT+« R=bRH 2581, ZOR— P oF—F 1 AN
ENEY. TOKI 227Uy r92&, BED CD Player 23 7L, dn/N—
Pa PEHBHLET, CDIEZ. V=P AT—2a3> DNy KT+ - R—h%
EHL TWDOTHHES ZENTEET,

1473 a > (Repeat Options))
CD DA —F 1 F 2R L LEAET D008 F T a v 2Rt LET,

MR EiPA % ) — 7" (Loop Selection)]
DERFHZIL— T ) PWENTIRS> TWDHEIT THAE R > 2T &, Bl
BININTWEEE LHEINET, 20a~x 2 ROARIBREEITE.
Frvl - X—IDRERRINET,
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CD Player D1 > 45 7 = —AIZDWT

rd>991 74—V K

r&sll 24 —JVF

FREZRFE

%Y EE

007-2275-010aJP

MZEHUEPH 2 F5 4 (Play Selection)
DERINEEPZ L) AT /R> TWAIBAEIC THE Ry & s, BIEE
REINTVWBEHEIEEINET, 20X RPWENBREEITE Fov o -
N—UNERINEKT,

EDOFD v INBEREESNTVSN, TRRBEESNLIIORESNTNEAERLET.
D74 =)V RIE WELTHO RSy 7 ITBETEET,

KT ZDCD, 2EXIEY Y R4 T2 7 bOCD AR EZEHL TWAEEITIE. 207 1 —
JVEDBBIED NSy 7 DREFEBERLUET,

CD DIEFE 016 OB EZRLET, 2&X1E. CD OFEAZEBD THS 50 i MElR]
Ry 2T &, [00:00:50] ERRINET, TOT7 1 =)V RERET D&, HEDORMIC
BETEET, KEZ HHEMMSS O X TR RSN, HIZRKM, Mida. SEBEERLET,

BEDO Ty 712K > THLRMERLET., 2071 =)V RERETD &, FEORICHEE)
TE XY, Kflid HHMM:SS DR X TER SN, H 3K, M3, SiapzRL 7,
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%5 7 % : CD Player

rcSvo1 Ry >

[how ) RY VEHEFAISN TS CD DER Ty VIR U TEREINET . BFEDNT v
2% T BTN BELEZWN Sy &SRy P LET,

CDH#ALSA Y
BEHFAZINTNS CD DY LT 2 RLET, F—F 10 FO—EOHFH 2 EIRT 21213,
A LTA>O—EHEr2 Y7L, M RITv T LET,

;S OB & FEIRERE
kZ v 7 Wi & RIREFENE TCD Player) 71 > RUDE FICERINEKT,

Sy OB
BEDORNT v I DIEE 05 ORKEBRRZ7R L £9, FRIE HH:MM:SS.sss DR THER I .
H 3K, M3, SIIdMEERLET.

BEIREFE

BBWEDF—5 1 A ARSI NT D BAITIE, BUEDRY O PRARHE & 4 T R 275 3 340
FERATR RS NET, W HH:MM:SS.sss O TRAS N, H WM, M35, S 3Bz
HLET,
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CD Player D1 > 45 7 = —AIZDWT

rSORAR—=F-a>bO-

FI2AR—=h -2 O0=)V2FEALTr Iy 7 EFHELET, W72 28R TL7ZI N,

24 bVl 24=IVRET7=FT4AM] 74—=JVE

21 R=TD [ThZIwr - UXb] O 2B TLZE N,

>y - URb

241 R=YD [ThTwr7 « YR O] Z22RLTLZEI N,
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8w

DAT Player

ZOFEF, ROHNSHEENTHET,

o THEE (249 X—2)

DAT Player DEEH) (251 X—2)

o [F—F 1% DAT OF4| (252 X—2)

o IRYa—LDFHH (253 X—2)

o [DATM5DF—F 1 A DHAF] (253 X—2)
o [F—7ETOKE (254 X—)

o [T wr - UZXLOMEH] (255 R—)

o [HAEFTa> oM 256 X—)

e IDAT Player D1 > % 7 = —ZAIZDWTJ (256 R—2)

9=

ZOMITIRRIZDOWTHHAL ET,
o 250 X—® [DAT Player DHHE]
o 250 X—® TDAT Player D4}

o 251 R—TD [NV TDOFELE
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%5 8 % : DAT Player

DAT Player D4t

DAT Player D481

DAT Player 1213, DAT RS+ 72HERL 2P AT LT L. EITKD 3 DOEEENH D £,

J—OAF5—2a>bET, A—F 1A DAT G - F—F1F4 - 57—7) =EET S,
DAT DNED Y 07 #HEKRT 5,
F—F 1 AHIERIC, ([EF]72 DAT BUS 5L 2129 5,

DAT Player 1§, 7—7 EOZNEND ~T v 7% AIFF 7 7 1)V & L THEBMICHEG L £
T, INSDT 7L, TAAZIKAE—TES 770 ELT, bIwr - UZXMICE
REINET, £, 77 L THEEOT—FT 1 THIHZRIRL, #7771V &L THRE
THIEHTEET,

DAT Player D481

FZwZ - U

= b5 yoRRRENS,
| Tyin® HEEG FTW ATav @ | T )

3

|tov7 =

0 00:04:12 00:03:56
TERE  EBDER

F«f (ST FT—F+ AL i

Tracs:  Title Start Duration

2 |3 4I|5I|6I|?I|8I|9I|m|\

Sodiur Laureth Sulfate 0:02 3119

12|13

bFwo R EIV YT LT 2 it san Buno 321 045
FowoERRT A,

I'ri Mot Rezlly a Spring

Cankehold Princace

T FAATA L REDST,
BiREIGE RS v I T 5, A-—TFsA2BET D,

FZAR—F - FO-EEST,

250

581 DAT Player OABL (1 A=Y %20 w 7§58 LiEkFREND)
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DAT Player DH)

ANIVTDRERE

DAT Player Di#2Eh

007-2275-010aJP

ZORZaT7IVE. ROEFERLEZHEHLTET,

o HOTERINLMIME, AFEOMOE, i, HEXLBHFEOERNOY >V ZRLET. &
LA AIFF 227 w27 LET,

o MRTHERINDHFEIT EBHY > V) TT, IN&rUvrT5E TOHAFDY —IVNE
FEnxd.

o AZa—HZEAZA—THHOMOD > EWIFEHEIE. AZ2a—OEROD/SZAZRLTNE
9. e&AE 774V (File)l -> TBH< (Open)) & (774 AZa—%HWT B
<] ZBERTHENIEKTT,

DAT Player ZBi< i3, UNIX > z)bD <> BT 5EH L. datplayer ¥ 1T AHL
EE

*%E : DAT Player $3 & U DAT Manager &5 7z DAT WV —)UiE, GEOY 7 Ty - JU—
Z TR AR R— SN THER A

A%E : DAT Player 2589 %, £72id DAT K51 7iC DAT A S % &, DAT Player i3
261 R=TD [hTw7 - UX N 2FERT D7D, DAT ONEDZAF v > 2IEDET, &K
WCZAF+ 8T DAT 2EA LSS BAEIND I ONTEONENERINTVREET,
EZE 3B/BHON I v M ZAF v INBIT MEIE) R 2L, R THAE K>
EHTE, 3BHON S IR TLTABZBHO NS v I NEAINSMIC. 4 FHONS VY
DIEFEBMNE T w7 - UANMIFRINET, DAT EAEINDIZONT R T v - U X MIMER
INBHHITFTT,
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%5 8 % : DAT Player

Z—7«1 7 DAT OBX

252

BE
D bZw
- ((‘B" ;RUJ_A
A L) R e T [
| ik
BID b w7

B 8-2 DAT Player ® b > AR—1F « > hO—)LOEH

1.

DAT R I A 725 —7 %A L. DAT Player Z&H L =9

DAT ORAF v AL I LRI I A TOUTNERINET, T—T2HET DI
IV AF Y 750 EIEIH 0 ERA. AF v 8T I DAT 2HA LB, HEINhS
WONTEONENERINTVNEET, 2&21F 3FBHDORN T v INZAF ¥ N %
2 Mg RYEML, RIZ THAE RYC2LEETDHE, 3HBHDO NI v KT
LT4BHON Sy VNEEINDHENC, 4 BEHO NSy 7V OEWNA ST v - UZXMIE
IRENET, DAT WHESINZIZDONTET v T « UZXIIMERINEDHIFTT,

HE] Ry 200w LFET,

K821 I AR—h- -2 O—)VO¥REERL TWET, [EIL) Ry 27U v
9% &, DAT Player [3f# 1L L@ ZRFFT 2 I LICHFERELTLIZE W, DED, THA]
RY > ZHD1EWTE = EL) Ry 0LDI@E, FI1ELUAENS BENGTS
NEI, T—TOEREIZEZIZIE, Ny 7] RYZHLTLEE N,
TENNITELZODRETEEZDLES, 253 RX—=J0D [HRY 2—L 0] 28R L TH
BEHAGHILTLZEIW, HED T v 7 2HAT DI, 254 R—P 0D [5—F L TOBH)
ZSRLTLESI N,
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AU 12— L DOFHE

RY 2 —ADFRAE
R a—L) 87> (K82 ZHALTT—7OEREMAIL LT, R a—-L) Ry %
DIV TBHERATAINERINET, AT 5 & LTIRENT & FEND LN S7Z0 Th-o
O LXET,
X% : DAT Player DR a—Ald, [F—F 174 - /)X%)L (Audio Panel)] . 1E2 D FEHFE
EROTWAETY U —2a>ORY) a—AEIIMNITHEEEL £7,

DAT DS DFA—T 14 A DEF

ZOHTIE, 253 RX—=2D [F—=F 144« bTw ORI & 254 R—=2D [F—F 1+ FDER
FEPHDOEIS] ITDWTHBHL 9., EEHDOD A IEROFZTITIEIEMENBHINS Z EITE

BLTLEEW,

F—T14F* - FSvODME

007-2275-010aJP

DAT N v 7, AT L« T4 AZIEBIZaE—-T& £,

1. oIy U EBIRLET,
FSw I OMBEEHZHECODVWTIE, 254 R—2D BED NS v 7IZBE)] 281 T
LW, BRULE Thowr) 74 VEMARRINET,

B> b <Shift> F— 2 LANSEMOBIREITD 2 LXK, 1 BITERDOY a2 %%
WTE£T,

2. [T7A4)V (File)] -> 5T v 7 &RALRF ...(Save Track As...)] ZERL. TOLTv I %
Bl 77 1IVELTRELET,
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%5 8 % : DAT Player

F—T 14 F DEREFHA DG

57 LTOBE

BWED LSy ICHBE

254

BRUZHHZH 227 71V ELTRET 212 ROFIBEZITVWET,

1.

HHZRIRL 9

o FT—T - HALTA2 (M81 B OHhT, ZJUvIZLTHhERIVITEHIEICK
D, #iPHEZZIRE L ITHEIRL £9. BRI N TV SR OHEIPHIL. 'DAT Player] 7 «
CRUDETFTOMIIEFTERRINET,

o [ENHIPHZ A (Play Selection)) AVERFIAEIC/E > TS T EZ2HERL TS W,
NEREPA A A a2 RiE 72 3> (Options)] AZa2—0DFIZHD £,

o [ (Play)) Ry >Z2ML T, BRLULHHZHRAEL £,

AE I BRELEVWEBANDOBENICOVTIE, 254 R—2 0 [5F—7 ETOBE) SR
LTL7EaWn, £z, 256 XR—2Y0 [HEAT > a oA 123, V—TEAERED
FT T a OHANRH 0 XTI,

(774 (File)) -> TEREFILRE ...(Save Selection As...)] ZEIRL £,

Ty AN T IIFNERENETANERTDH LW T 7 IV DHHTE AT L. <Enter> F—
ZHLET.

ZDHITIE, 254 RXR—=2D RED ST v 7IZBE) & 255 R—T D TREOREICEE)) 12D
WTHHL £7,

REDK Ty 7ITBHTZITE. Moy T - RYEET (hIv &S] RYE2IU Y
JUTLEEWN,

HZWIE CROSF v 7] R THORT Y V] RY 2 E2HSTEHTEET (X882
ZH).
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row o - UX SO

1HE DRRE CTB 8

AE:HDIWE. TFFv T (Track)] 714 —IVRHPTHI v I BBERFARRI . BHED
Fv % BE AN LT <Enter> F—%#L £7,

PR EERE# (Absolute)] 7« —JV R E/F Th Iy VK] 70—V RERETDH I LITKD, #

EORICBEITE £,

o [PATENR] (Absolute)] 7 1 —J)V Rid. T—7DEHEMNS ORERMZEFRRLET, & X
W T=TRE S TS 50 BiIC MEIk) Ry &I L, T00:00:50) EFRRINE
9o b v IR T « —)U Bid. [DAT Player] 7« > RUDEFHDREBBFERRTT,
22 BIEDO N T v 7 OSEEN S OB MNZRINET,

o WifflZ. HHMM:SS EWSEXTEREINE T, T T, HIZK M35, SIIRTT,

e INHDT4 )V RERETZITE, BFEer Uy s UTHRRMZANL, <Enter> F— %4
LET,

AE: T LOMEEHSICIE. Iy IO M) & TKSE (Duration)) 7« —J)b RAEIZ
MHET, TRt 3Ty 7 OMERERL. TES) BNy I7DOESERLET,

>y - YR MDER

007-2275-010aJP

DAT Player Tid. 7—7Dhr w7 « UXMEERTEEY., bTv o - UZMOIERIZ 1 E
IO MERHVET, T7—T DU X MIMEREIND & RICEDT—T %> 72 & EIT DAT
Player 1ZU X hZF#H L. ZMUDOLTv T - UXRERRLET,

DATD b Z w7 « YR FZERT DITEROFNEZTNERT,
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%5 8 % : DAT Player

1. 7—7%DAT K51 7iZffiAL. DAT Player ZiL8 L 7

2. I&#4 BMV(Title))] & T7—F 1 AN (Artist)) 71 —IVRIZ, 14 MLEY—F 1 A bZEA
HLET,

3. howvZ %A K)) (Track Titles)] ZANLET, T—THOEHEEBVIC T v ] 7
AAPEREINET,

% kw2« A B (Track Title)] 7« =)V REfmET DI, 71—V RerJ v
LTho#HikishIy s - 14 RMVEASIL. <Enter> F—Z#L £9,

AE SV - URMDORS YT - T, SATLAHOENOEFRICRS v L TH
FTEET, 253 R—VD [F—F 1A b TV IV OHRE 28R T /E3 W,

BEAT a3 0iER

o MHMRLULHEAEZZRET 2L [F72 3> (Options)] -> [KIEA 73 3 > (Repeat Options))
ZEIRL. [1E7 L (No Repeat)). IDAT % xi& (Repeat DAT)J. [ b5 v 77 % [X1& (Repeat
Track)] OWITNNEEINL £T,

o GEIRLUZER 2R L THAT 21, TF 72 3 > (Options)] -> NEHREIF %)L — 7 (Loop
Selection)] ZFERL 9, BIRFHZIL—T) 2EILETHIE. I 1EBRLET,

DRI 2 B (Play Selection)] ®. #7232 (Options)] AZa—@DFNZHD £, [

REHZ AL NENTBo TS EEIT THE RNy 220y r§aE, BIEERINTY
LEEAFEINET.

DAT Player D4 >4 7 1 —RIZDWT

ROHEITIE. DAT Player OHREOHE 2L £9. SHEEOAMITDONTH 81 22T
7TZE W,
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DAT Player O >4 7 £ —AITDNWT

DAT Player DA =21 —

72741 A=a—
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257 R—YD
259 R—ID
259 R—TD
260 R—YD
260 R—YD
260 R—ID
260 R—YD
260 R—YD
261 R—TD
261 R—YD

261 R—T D

[ (Bject))

IDAT Player D A= a2 —|
My 271 74—V K]
MR35l 7 1 —JV K}

i SER3 R )

[5% 0 iR )

howr - K& )
A VN A

[t Z w7 IR &R IRRER)

FS 2 AR—hk-a>bo—)b)
M4 M) & [7—=F4 AL 74—V K]
'bow2 « R b

['~Z w7 %&R%RTF ...(Save Track As...)]
BER Ty INERENTND L&,
BTy AN ELTRELET,

[ EIRZ 4 RTF ...(Save Selection As...))
260 K=Y (5= - 51 551 2] ETREPSERS TS &5, i
ERIGRTE .0 1F BIERENZR 7 v AV E LU TIRELET.

DAT RSA TmE657—7Z2RHL £9,

DAT Player ® A =2 —IZid, 257 XR—=2® 774 )l] AZa—], 258 X—2 D [THHEE] A
Za—] 258 R=PVDIER) AZa—] . 258 XR=PD [FT a2 AZa—] fH DT,

IR ¥ | EA0 S N I = N O A

257



%5 8 % : DAT Player

Mm%l A=a—

¥Rl A=a—

(A7arv]l Aza—

258

&7 (Exit))

TSI LERTLET,

[E#REIPH 2 1 — (Copy Selection)]

BOBHNTNEY S r— 3 IIR—A N 52012, HEOREREHRZ 1
E—L%x9,

I RTZER (Select All))

EhTv I ZERLET,

(B L 720 (Select None))

TRTOBEREMRLET,

E5R A 4R (Extend Selection Right) )

BEDERZ 1 B AITHRL X9

LR /E7E IR (Extend Selection Left))

BEDFRZ 1 B IR L K97

'cZw o« JZ b (Track List))

261 R—2D [bTw o7« UX ] 2RL<, £&& AUET.

IDAT ® X F v > = > 7 fk#i (Continue Scanning DAT)J

DAT Player BT 5 &, DAT ONEZ 261 R—2D [Ty 7 - URA )
ICERRT 272012, DAT DRAF ¥ 0BG INET, AF v a2dikLz%.
IHICZDARREZBRIRTHZEICXIDAF v 2HATEEYT., XFv >
B9 DAT 2HAELZSHAITE. BEIND I ONTEFORBNERINT
WEEY, ZEAR 3FEHON T v I N RAF v INEFIC HEIR Ry >
L. RIC THAE] RYE2MLEETDEE, 3EBHON T v IR TLT
ABHON Ty IVHEAEINDHIC, 4 BHORN S 7 OBHNNT w7 - 1
A2 MZERINET., DAT NEEINZIIONT R T v T - U X MBMERS T
5T TY,

007-2275-010aJP



DAT Player O >4 7 £ —AITDNWT

DAT Ff A%+ > (Rescan DAT))J
RAIZAF ¥ > L21RIC DAT KEENH - 25512, DAT 2HAF v > LE
ED

1473 a > (Repeat Options))
T—7 EOF—F 1 A& KIEFHAET 20 0EREHNH D £,

MR EiPA 2 ) — 7 (Loop Selection)]
Zoav > Ricky, GERHER %)L —7 (Loop Selection)] OF >, # 7%
>ha—=)LUEd, NEREEZIL—T ) BENTR>THS &SI TRAE] R
F>aIYyrd5E BIEOERMERL THAEINET,

NEHUEIPH 2 F5 4 (Play Selection)
Zoax > RIZKD, NEREHEPFZFHE (Play Selection)] OF >, 7%
FO—)VUEd. LEREGEHZEA] DEDTR> TWD EEIT THA (Play))
R arUyr§5E, BIEORRMSEHAEINET,

rc>v21 74—JVEF

HARO Ny IR0EATFED RN T I ERLET, 20T =)L RERETDHZEITED. B
DRIV IIIBETLIENTEET,

r&sl] 74 —=JV R

R EZDOT—TE2HNWTVWD EE, ZOT7 1 =)L RIZHED T v 7 hOBEDRS[FRENE
RENET,
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%5 8 % : DAT Player

FRERFR

%Y EE

bFSvo K>

AR A N

M

b3S v & B &ERFERE

260

F—T ORENS OFERMZRLET, 2L T E - TH S 50 ki MEiE] R
& EMTE, T00:00:50) ERRENET, DT 10— IV RZREL T, BEOERICKE
TEFET, KEE HEMM:SS WS ERXTEREINET, 22T -HIZF M35, SIIHTT,

F—THROEOKMZZRL £9, KRE. HHEMM:SS EWS R TERINET, 2IT H
13, M3, SR TTY.

BHEO—-RFENTVWET—TDOENETND T v Z7IZDWT, [hIv o) RY CHPERENE
T RED Ty ZITEDITE, BELEVWI Iy I OFEFSEI Y v I LTSN,

BfEO—R3INTWS DAT DY AL LT > 2R RLET, 1L > HO—EFHE22 ) v I L
TRIWITTHIEIZED, =T+ AOHBEERBINTEET,

kZ w7 Wi & RIRFEZ. TDAT Player] 7+ > RUDE MK RENET.
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DAT Player O >4 7 £ —AITDNWT

Sy oRE
BAED Ty 7 OS5 oMM 2R U £, KX HHEMM:SS EWS B TERREIN
£9, ZIZT, HiZk M3, SIEIMWTY,

BEIR B E

F—T 4 A OHEMRR S NHEIT, BEREH O RS & REERTERRRARRINET,
FrlE. HHMM:SS EWS A TR RENET, 2T HIZF M35, SIEIH T,

rSORAR—=PF-a>bO-

Ty AINEFETHEXIC, RICAR—K-a2hO0-)LE2FALET, K82 2BBLTL
720,

%4 bVl ET7—F4RAM] Z4—JVEF

255 R—=TD [hFwr - UZFOFH] 2R T ZE 0,

F>vo - URb

255 R=2D [hFv 7 - YR FOMFH] 22U TL/ZE 0,
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o

CD Manager

ZOEIF., ROHNSMELEINTNET,

e [CD Manager IZDWTJ (263 X—2)

e [CD Manager DiEEE)] (264 X—2)

e [CD DFAE] 264 X—2)

e [CDORY a—LOFHMH (265 X—2)

e [CD LTOHBH) (265 X—)

o [HEXEANZTTDOMENT] (2656 X—2)

e [CDManager 2L T7 7 1 VITEHET 2] (267 R—2)

o [FAZTLAIZDNT] 268 R—)

CDman.overview

CD Manager [ICD W\ T

007-2275-010aJP

CDManager ZfH LTI NI bk« TA AV EBHETEET, HIO M Ty 7ITTERL<LBHL
20, BHEZEL —RHEERSEED, £ECDOAYOT ZERLIZD TEET,

CD Manager Z2ffiHILC. SCSIAZ NI b T4 A7« RSAT 15 CD Z2HAETEXT, UV—
DAF—2a EHEOTFOY /7Y% ANNFIZ CD Player Z#%#t L TW55HE1E. CD
Manager T7& <. CD Player ® 2> b O—)LHREZ AL T</Z &1, K 9-1 13 CD Manager
DAL = T4 2 RTTY,

A2EICDZRETLHLDOXOHL WY —)LiZ. CD Player TY,

263



%5 9 % : CD Manager

File_Options _Utilities Help
Progran Index Absolue Tme i  More[s
W i >
n.muil P N-xlml
- >
Stop. Play

JEEEAN [ 3
—

9-1 CD Manager DA >+ 71 > R

CD Manager D#Z&)

CD Manager ZiEET % 2 DTk
e UNIXx)lDOOXR{TM5. cdman.old &5 1 T AN LET,
e CDManager 271 v 27 LT, CDManager ZHE£7.

CDman.playingCDs

CD ODB4%E

CD Manager Zffifi L T CD #4792 FEITXDED T,
L AXNI b FTARTETAAY « RIATIHHALEXT,

CD-ROM RSA 7D IFAZ v T | 7AIAUNREDLD, F—F 14 CD Ao —Ran
Il EEIRTENNERINET,

2. CDManager ® 4] Ry &2 1) v LT,

F—F A FOEENMEED., TOT LN FPEINTWEET, TENNSTEL
DRETERZDLES, 266 X—2D ICD ORY 2 —ADFHE 28R LU TEEZHAHL T
<7EEN,

3. F—F 1 AOHAEEHNL. £i3FIET2ITiE. CD Manager @ [—RefEik | E721d %
Iy Ry 22w I LET,

HETRIUMEN S BAEZBDEWEEIT T—FEIL] 2, HEZHILL T« X7 0k
DIZERD W EEITE MEIR] 227U v 7 LTSN,
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CD OHRY 22—, DHHi

CD MRY 21— ADIRE

CD tTo#H

AU 2 —LDOFHIZIE Audio Control Panel ZfH L 9. NxINVEHITE V=)L
(Utilities)J -> [+ —5F 1 4 - 3> ~a—)L - )$3%)L (Audio Control Panel)] #3&RT D, F—
T4 - a2 ho—)b - JX%)V (Audio Control Panel)] EWHiEAEI Y w7 LET, [ZE—

J—

(Speaker)] A7 & L NICEHNL TEREZMEIL TS,

CD koo 70r o ALHERMICBEITEET,

BEHNIOIDEVS

007-2275-010aJP

CD

REDOTTT I LBET 5123, (707 4 (Program)l 7« — )V RHRTT OV T L%
BEBARRIE, BHLLLWTOTSLBZEEZANL, [Fa— (Cue)l RY>EIV v
95, <Enter> F—ZHL ET,

7075 MMZE> TE RSl (Index) THEINTWEHONHVET, TOL5KTO
FSLZH LTI, 7ar 55K BZ2ANLEZOERL L SIC. RiHFSZE 185 (Index)!
T4 =V RICANLET. [Fa1— (Cue)l RF>%2271) w75 <Enter> F— &7
&L BIRLRGNTBEL £,

CD H OFRE D FARRICEE T 51213, CD Manager A1 > + W 1 > R QOREHIZERDH
ORI ZRAE RS ¢, BHLEVEMEANLET, (F1— (Cue)l K57 <Enters
F— 2L, CDIRFESNRKHICBEL X7,

CDman.catalog

EHERANOTIREET DL, FU CD 2H4 727201, CD DY A MLEY—FT1 X b

lERDET YT e ZA BIVRERENET., CD 2 AHY AT EET LFIHIROED TY,

CDZEIINI N T4 A7 « RIATITHALET,

CD-ROM @ 27 ~wT | 7AW EDD, CD A0 —RINZI EERTEHNE
RINET,

[CD Manager] 7+ > RUDAHMZFEHAL T (K92 2H).
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%5 9 % : CD Manager

266

Y2 RO OERPEA TS HAEE. [HE More) RY> 271 v rT5E, HEOY
EEAERENET.

B 9-2 CD Manager #i3E5 « A7 LA o H & 07 EL

3. AynrsELHD ICD ®¥ 1 ML % AJ (Enter CD Title Here)] #ifisiZ& RS &, CD @
Lz AN L, <Enter> F—&MLET,

4. ICD ®O7—F 1 A K% AJ (Enter CD Artist Here)| Z#iHFERIE, 7—FT 1 A NGEA
J1L. <Enter> ¥—&{L £7,

5. ThIwr ARl 74—)VRE@HFALRIE TV VD4R Z AN L, <Enter> F—
=L ET,

6. CD Manager DA » &5 D RD b F v 7 (Next Track)) R > &2 Uy 7 L, RD Ty
D% ATTLUET,

CRD ~Z w2 (Next Track)) 177 &L, §XTONT v I EHDANEKADETRHRTE
ED

ZZTANLEERE. R—L7 1 L7 FUDTFD .cddb EVWI 71 LI BUIRESNET,
CDZAZNT b T4 AT - RIATIHAT BTN, £ DEHA CD Manager 1% 07 %
RICEREINET,

AE:CDPlayer 7 77U =33 >HTTTIZCD OF —F XN—ZZ{EHKL TWDSHEIL
cddbevt AX Y RZHWT, £DF—4FN—2% CD Manager O7 —F N—AEXY—TTEX
T, N5 2 DDF—FIXR—ZADY—IYHIEIZDNWTIE, cddbevt AX Y RO « R—=T%
ZHLTLEE 0,

CDman.recording
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CD Manager #ff L T7 7 A )VICEE T S

CD Manager ZEBALT7 7M1 IVICET TS

007-2275-010aJP

AT N FA AT « RIATNT =0 « A57—23>D SCSI ARV Z IR INTNDH
F12id. CDManager 2 HHWT, COMHF—T 44 - 77 AIIVICEHET LI ENTEET, F
TEMED & HIER DT IIIBEMIENTEH SN Z EIZEBEL T E3 W,

CD 27 7 1 IVIZEFETAFIEIROED T,

1. CDZERIATITANLET,

CD-ROM K51 7D [F22 by 7| 74 AH4bD, CD MHEASNET & 73
HHRERINET,

2. CDManager ® 77 )l (File)] -> Open Record To' file...] ZERL £7,
T7A) - TIIENRERENET,

3. BT 27 71NV #ZEANL. TT# (Accept)) 220w LET,
9-31Z"9 &£ 57 TRecord CDto...] V1 > RUNKRINEKT,

9-3 Record CD to...] W > R

L

[ 7 7 A )V§%F (File Record)) ™"y > &7y 7 LET,
WG T NEITUET,
5. CDManager A1 > - 71 > KD [fE (Play)) R¥ %20 v o LET,
CDMNHE T 7 AINANDEEDHIBEEINET,
6. BFEEITZITE (7710« X~y T (File Stop)) ™Y >%&71) v LET,

(7 7 1 V& (File Record)) & 77 A )V« A&7 (File Stop)] 2271w r T2 Lick
D, 77 AN\ DEZFEHRL TRITAZENTEET,

7. BEIMET LS. (77 1)L %BU% (Close File)) Z&RLTT 7 AL &MU LT,

267



%5 9 % : CD Manager

Ty ANEAL S I Ll T 270D 1 RUNERENET, [T71IVEHLS
(Close File)] R"F > &HD51EI Uy I THET 7 AIVHALET,

CDman.layout

TFTAARATUVALICDNWT

CD Manager D5 « A7 L 11&, 17’07 5 A (Program)] 7« —)V B, [Z5] (Index)] 71—
VR, BEIZER, TF2— (Cue)) 5 >, THE (More)] ™"y >, a2 bsO—JL - )%y RIS
RENTVWET, ZOH TR, ROERBIZOWTHHAL X7,

o 268 R—T0 TF7OFIL & THRBl] 74—V K]
o 268 R—T D [HFRIZER]
o 269 R—TD Marbko—jb-)%v K

o 269 R—TD [huy O fE]

r7as>A1 & T&511 74—V K

7’0727 5 I (Program)] 7 « —)V REBFEDO T OV I LADFFERRLET, 2> ba—)b - /X
FID DROT T Z I (Next Prog)l RY >l CROTOT I LTEAZD, THioT Oz
Z In (Prev Prog)l ™% > ML THIOT O I LARRS1Z0D TEET,

RE&RT
RefIZRIZ, BIR U ZRIZER BT, 0 B 7L —L%2FRLET, FHZROTORY >
ZHL T, RMZERBLZ BN £9, RORMEREANAETT,
7’07 Z Lk (Program time)i#ZIR U 7= 7' 017 5 L D SEEEN S ORF I,
Hak IR (Absolute time)CD O JEEE N 5 ORI,
7% D KR (Remaining time)CD Hr 5% D K¢f,
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FAATLAIDNT

T4 RIEBTINYAZERTDE, NG 3 DOMMZRICAS ZENTEET, 121 —
BHE L (Pause)) RY > D EIZ, HED 2 DI Y OT FRERICERINET,

aryekO-=Jb- Ny F
T4 AV DA, B LIZIEZ. CDManager 2> hO—)L « /)8y RORY > &2ffinEd,
4 (Play) CD Z2H4AL %9,
{81k (Stop) CD OFEZEL,. CD ®&#EICU Yy FLET,

B3£ D (Fast Fwd)
ZDORY > EFLETTWADME, CD Z2RXDLET, 5L Ry %0
Vw7955 EREDZERBLET, FIEIE2I1TE, [—FEIE (Pause)) H%
CEMUET,

HBZRL (Rewind)
ZORY EMLETTVSME, CD 28ZRLLET, H250VIE. FF %
IUw IR EEERLERBLET, #ILEE2ITE [—F#EIE (Pause)]
Ry EHLET,

ROTTT Z I (Next Prog)
ROTAT T LEAET,

A1 T 07 F I (Prev Prog)
EFO7 875 LIRD T,

U (Eject) CD ZHi L £7,
Hh %O

B4 9-4 13, CD Manager 71 > RUDAZOTEIKTY . 5 7 4 )L b T OMEBNERSI NN
EEX. ThE (More)] RY > &L THERIEET,
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%5 9 % : CD Manager

270

9-4 CD Manager #:3E5 + 2 7 LA

ZDOA&ZTTIZ, CDDYA RV, 7—FT4 A, hIwI&EANTEELET., ZOFERITT—
HNR=2EEEN. CD 2 K51 TIHAT 2 -NCERSINE T, F—F N—R Iz A
HTBHEITDNTIE. 266 R—TFD [FEAZYOTDENS] 28U TLIES N,

2%HE 3FHORRZERICKD, 707 T AR, HkER], RORER 2 FERFICR 2 2 &N T
=F9, ZNSOHMANZIE. CDOY>TIL - L—hRERINET,

1% 07 F 5, EFEERER S I — R (International Standard Recording Code) D f#i 7> T
W5 CDAHDET, ZOXDRERIZCD LICHEET SHEICLETERINET,

ZDU 14 > RUzEETICIE. CDManager DA >« T4 > RUT TKD DR (Less)) RY >~
=270y LUEY,
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#10 =

DAT Manager

ZOBEITIROHN SRS NTNET,

e [DAT Manager IZDWTJ (271 R—72)

e [DAT Manager OfH) (272 XR—2)

o [F—JOmAEl Q72X=2)

o [F—7ORY2—LOFHHE 273 X—2)

o [F—7LTOHBH 273 X—)

o DAT T—T7M5 7 71 DFE] 273 R—2)

o [F—F 1A T7A)InE DAT T—7~\OfE] 274 XR—2)

e [DAT Manager 7 1 A7 LA IZDWTJ (275 X—2)

datman.about

DAT Manager [CDWT
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DAT Manager 137 —%7 A5 —3 3 >HHD SCSI A— MR I NT PH I« F—F 1 F -
T—7 (DAT) RIA 7% hO—)IT572DDF—F 14 -V —)LTT, DAT Manager % ff
A9 27201203, F—F + FTHEEZ T R— LT3 IRIS BB ETT,

DAT Manager {3, —75 1 &Y R—b T2 RIS S AT LDEFHEZ AT LV T T LT D—
ML THBIZA > A b—Jba k9, K 10-1 13 DAT Manager D A1 > -7 4 > RUTY,

AE : DAT OF4E. BEOZDDOXIDH LY —)Lid DAT Player TY,

27



%5 10 ¥ : DAT Manager

File_Options_Utilities Help!

£ 10-1 DAT Manager DA >+ W1 > R

DAT Manager D#Z&}

T—7DB4E

272

DAT Manager ZEE9 2 HEEROMD TY,
e UNIX>z)lDIaX > R{7in5. datman EANL KT,

¢ DAT Manager %7 U v 7 L T DAT Manager Z & 7.

datman.playingtapes

DAT Manager & W TT —7 24T 25 FIEITRDED TI,
1. 7—7ZRIATITHALEXT,

RIATD [FZ7 by T TAACHEDD, T—7B0— RSN EERLET,
2. DAT Manager 2> hO—)L - )Xy B @ [Play) RF > %270 v 27 LEXT,

F—TOEENHBIN, TOVSABRBAT FEINTNWEXT, TEBNWNSTERED
REFTELZODLES, 273 R=2PD =T DR 2 —LDFHH] 22U T /Z3 N,

3. H#%EDSITIE. DAT Manager @ [Pause] F721% [Stop) H% > &ML £,

AR UV AT a  EROT IOV /578 IVEFIC DAT Player Z##i L TWAHEIC
3. DAT Manager Ti37£<. DAT Player ® 1> b O —)UHREZMAL T /EE W,
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T—=TDRY 22— LD

T—7DRY 21— ALADE

N 2 —LDHENIE TF—F «F - )XR)L (Audio Panel)] Z#EHLET, IF—F1F - /¥
)V ZB<ITIE. Utilities] -> [Audio Control Panel] Z&RT2n, F—F 1 - 3>
~o—)bL - J3%JV (Audio Control Panel)] £S5 IX)LET ) w7 LTI,
lHeadphone/Speakers] A 51 % % EFICENL T, HFREEZHFEHL TIZS W,

5—7 LTOBE

T EORBEDT OV T AERIEREIICBH TS ENTEET,

REDT Y I LAIBENT 2113, [Program] 7« —)V RHTT OV I LAFHK S ZRMAER
8, BT 0r 5 LEFEE AL, [Cue) Ry %7 v 7T D), <Enter> F—%
L £,

TOY S5 MMIES TR (ndex) THHEHINTVWEHORHVET, 7OV S LHFSE AN
TEHEDERMULDIT, KFIHEFZ Index] 71— IVRICAHNTEET, [Cuel RF %Y
w7950, <Enter> F— 2L TGEIRLZ Mndex) KBITLET.

F—7 L OKE ORRICBEIT 51213, [DATmanl W« > R ORI ZR TR 2 i8R &
RIE, BELIZWKEMEANTLET, [Cuel RY >N <Enter> F—2HL T, HHOK
EUCBEIL £9,

datman.recordingtoFile

DAT 57— MS 7 74 IADES
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DAT RIATMU =V A5 —2 3> EHOD SCSI R— MMZEFINTWD & XX, DAT
Manager Z2ffHIL T —7DoF—T 1 F + T 7 A IVITEE L K9, EEHED D DIEMHDOEEIC
FEEEENEAIND ZEITHEBELTLESI N,
T—TINS T 7 A NVIERET DI ROFIEEITTNET,
1. 7—7Z2RIATITHALET,

K

FATDTFAT by T« 7AAYPE{ LT, T—7h0—RENLILERLET,

273



%5 10 ¥ : DAT Manager

2. TOpen "Record To" file...] % [File] A= a—Mn5ERL £,
Ty A« TIUFNRERREINET,
3. fELenWT 71V OA4HTE AT L. TAccept] 227 w7 LET,
10-2 1Z/R 9 & 578, [Select "Record to "Filel W« > RUMEREINET,

10-2 [Select "Record to "File] w7+ > R

4. BF OGN TE/=5, [File Record) R > %71 v LET,
5. DAT Manager DA A > = 7« > RUHD [Play) RY > &2 v 7 LET,
T—=TMET 7 A INADFENFEBINET,
6. $kEEAFIET 212id. [File Stop) R > &ML ET,
[File Record] & TFile Stop) R"F > &2 v §2 I EITXD, #RL THETEET.
7. BEEAT Lz, [Close File) A5 > LT, 771V ZMHLCET,

Ty ANV EHUS L2l d 270D T 1 > RUMNMEKREINET, [CloseFile] 255 —&
2w LTI 7V EHUET,

datman.recordingtoTape

F=FT4F - TZ74)15 DAT T—T DEH
DAT RSIATNT =V A7 — 3 >HMED SCSI R— MiZEEHRIN TS & XIZiE. DAT
Manager ZfifIL T, 77— 712 E T2 I ENTE LT, FEHD D 2 EMOEE ITTF ML
MEAIND ZEITERL T ZI N,

F—F4F - T ANNET =T NOHRHFIROFIEEITHET,

274 007-2275-010aJP



DAT Manager 7 A7 LA IZDWT

T—7% DAT R TITHAL L7,

TI520 - TF—F, OF—FaF - F—F, EREELTHIWTF—F - TR EEFH
TEFET,

F—% « F=TEBFEIBREINE. T—T 2 RS TIHEATIENIC. EFAAFEIZ/Z S TV
BT ERMBLTLEIN, FAARREICH> TWiaEWEHEETEE8Ah. T—4 - T7—7
WET5E, T—7 ELOTRTOF—INPEEINET,

[Open "Record From" file...] % [File] AZa—7/n5EIRL £,
Ty s TIUFNRERRINET,

TALI7MIEAFY L TEHHDO T 7 M)V RO 5, TAccept] ™Y > &7V w I LE
kR

[Record] "% > ZLET,
T7AINMET—T \NOEE DB INET,
BF a7 9 BHITid. [Stop) Ry 2 EMLUET,

[Close "Record From" file...] % [File] AZa—MmoBERL TH—F 14« 771 IVEHL
EJCIN

datman.layout

DAT Manager 74 A7 LA IZDW\T
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DAT Manager 7 1 A7 L 1 1&. [Program| 7« —)V K., lIndex) 7«1 —JL R, K#ZER, [Cuel
RE >\ [More] A% >, A2 bhO—)b /Ny RPSHKSNTNET., ZOHITIE KO

(o)

WTHBAL £

276 X—® [MProgram) & Tnex] 71 —J)V K]
276 R—T D THFZFER)

276 XR—T D [TCuel HR¥ ]

277 X—Y® [MTMore] R% 2|

277 R—T@ Tarbko—)L - )Nw K}

275



%5 10 ¥ : DAT Manager

lProgram] & llnex] 74 —JL R

FrR &R

Cuel K& >

276

Program| 7 1 —)L Rid, BUEO 7DV S LK 52X RLEY. T2 ba—)b - )NV D Next
Prog) RE &IV r$HE ROTOT S AIHEHRELT . [Prev Prog) ™Y > &7y 7d
L EHHOTOT I LIRD £,

Reflid, Mg 20 B 7L —4A) EWSBATEREINET. 3BODORESLY A LT— R
DAT 57— 72tk SN E 7,

I Absolute Time]
HOEFRE, T— 7 ofHEZz YO E Lz & EDORBERITT,

Program Time]
7075 ABMIEIREDO T 0T Z LOSEENS ORI TT,

'Running Time |
ETREE, T— 7 OEHEERORR & U TEHIIL 2 @IHE T, 20
74 =)V R, SMPTE ¥ 1 L d— ROFFICE<HVWSLNET,

RERIEHRI D% A 72 BINT 21218, BRERO TORY V2L TLZI W, U1 > RuZzET7)b
YA LR T B E, 205 3 DDORFEMERZREFICRE ZENTEET. 1 DI Pausel ™%
ORI, HED2DRIAY O RREBRICERINET,

AE XA LAd— R F—FICBEEINTOARNE XF, BRIZRICE 101 Z2EDRFETIIR
L, T EWANA T UMEREINET, 1 DOV A LT—RUMREELENI ED, Fo72<
FALTA—RERLEFLBNI LRI HD £9. DAT Manager (3R 721 25k L £9.

[Cuel R ZEMEHL T, T—7HhOEEDOT O S A, Rel, £REERICBETZIEMT
XET, T—THOREDNBICEET HITTROFIEEITNVET,
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DAT Manager 7 A7 LA IZDWT

Morel K% >

m D = By AR ATV

007-2275-010aJP

1. [Program|. lIndex). F£/zid Timel OFRT 1 =)L FEZ@HAEXRIEET,
2. BELEWT O I LES, KIFS, £BHMZANLET,
3. [Cue) RE 7y I LEY., T—FI3HEESNMBEICEEHL XTI,

DAT Manager DA A >+ T4 > RUHD [More] RY 2% v 32E, BELTHWDT—
T OFMIERNK 10-3 DL I ITERINET,

10-3 DAT Manager DIE3ET + A7 LA

2 DH. 3 DOHORMERNEN., T 07 T AR, MR, 7222 VMO TR THRER
INFET. INSDEROAEBNCIE, T—TDOH>TI - L—IRERINET,

U4 > RO ZRETITIE. DAT Manager DA >+ U > RUHT, [Less) Ry 2 ZMLET,

DAT Manager D> bBa—)L « )Xy REDRY AL T, T—7OFELREL 270 E
R

RDRY >MHODET,
[Play)

T—TERAELET,
[Stop)

T—7EELELET,
Pause]

T—7 & —kREILL XS, [Play) 2#9 &, BENHERINET.
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%5 10 ¥ : DAT Manager

278

[Fast Fwd)

Rewind

[Next Prog]

[Prev Prog |

[Record]

[Eject)

R EMUETSE, MTETREDZITTVET, Fhid. R¥E20 Uy
DIBERRFEONIBED £, [Pausel £721d [Stop) Ry > g &4z
EN

RN EMLFTDE, MTETEERLEITVET, FRF. Ay 27Uy
D9 BEEESRUMNIKED £, Pausel £7213 [Stop) ZH#d L4EIEL £

F—F EOROTOT T MIHESET,

F—7 FOERIOTOZ S LICRED £9,

F—F A FANERZT 7 AN ST —TIERELET,

T ERHLET,

007-2275-010aJP
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MIDI F—7/KR—F

-
[

DEIF. ROHNSHREINTNET,

IMIDI F—3HR— RS (279 R—2)

Mla>ro—=)VAEOY 77 L 2A1 297 R—2)

MIDI F—3H— RICBIT2MEDO T TNV a—F 1 27 (304 X—2)

MIDI #—7R— FDfEWNA

ZDHENE. ROEHMMNSHERINTNWET,

007-2275-010aJP

280 XR—2D
281 R—TD
283 X— D
284 X—T D

286 R—T D
TS |

288 X—T D
289 XR—TD
290 X— D
293 X—T D

295 XR—=TD

pioEy

NIy

&R DI

Tty hEYT R - T 71OV

TMIDI 7 7 1 V&5 T 572912 MIDI F—FR— RZHEEELT /&L

(7= 25— 3 IS MIDL 781 A &34 %

A MIDI SN ANSDEET—I AT —> 3> L THEHET )
(757 4 J1)b « F—7R— R OREDFHi

[ DERIE D i

(51 THEAEIC K BIESE)

midikeys.overview

279



%11 % :MIDI F—A&— K

=

MIDI # —R— R D#kE

MIDI &1

280

O ROEEMNMSHERENTHWET,
e 280 RXR—TD [MIDI F—7H— K DHERE
e 280 R—T® IMIDI &1

o 281 R—TD [NV TDFELE

MIDI F—3Hr— R, FRE2ERT2-2ODD0Y—)LTY, Zhz2#HHAL T, I 21— —04t

HMIDI /N1 AT, WAWAREEESZODHWEZDTEHIENTEET, HEZE. ROK

ST EMTAET,

o HUTR-TyANeT ULy hOFERT ZENTEET, MIDI F—FR—RZ#HL T,
Tty RV TR Ty, F—HR—REDOHOFEL TERINZEZIZ, £D
OB ZABMRLET,

EARL THHOEEATAT - LAY 2HFALTEREL., voice.aifc &EWH P
DRI rAIIREFELZELEL &5, MIDI F—4h— K Tvoice.aifc 2 &, MIDI
F—AR—FREDF, ZEATC4 HFROC) 27y I L TAHATLIEIN, Iy
TR HOORIZEBHEIXRDET, EFLhoF—2T &, By FEEENELLLET.

o WNANARTVFTMEEERLEZD, MWEDTDHEEIC, TOEFDNMEE MIDI F—1HR— R
FTERRTEZXT,

MIDI /. Musical Instrument Digital Interface BT, Z#id, I E21—¥—LIFTZE
IRE TR, AR EZHAEICEETESEDICTA200, TOFINEFEBLUON—RTLY
HRETY, 1983 FEIXARICEAINTLNR, I 21— 2B U TH KB 2AEMNICHH S ®
HEBOTFEE LT, MIDIZAL FRFICZIFANSNTNWET,

MIDI 2B 3 23— oW DI DOV TIE. ROFMEEZSZICL T EE N,

o [ The Musician’s Guide to MIDI ] Christian Braut # (1994 4 SYBEX, Inc. ¥17)

e [ The MIDI Manual 1] David Miles Huber # (1991 4 SAMS $17)
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MIDI F—A— KD

ANIVTDRETE

[ZL®HIC

MIDI F—KR— KDL

ZOXRZaT7IVE. ROEFERLEZHEHLTET,

)

HETERINZEDE, AEOMOE, i, MELBHBEOERNDY > 2RLET, &
EAE Uy b 227Uy LTHTIES N,

RTENMNHEEL, TEEHY > V) 2RULTWET, ZhaelsUy 95L&, TOARID
V=)VINEBENET, HEAL AF4T - LOA=FEI Uy I LTHTIES N,

AZa—HEAZa—DEHHOM®D T->] EWS T 2RIE, AZa—DFERD/NNZAERL
TWEY, 2&AE 77 1)0 (File)) -> B< (Open)) & (77 1)b] AZa—%zBW
T <) Z2BIRTBHLENSEKTY,

midikeys.started

f#ild, ROEEHMNSHERENTHET,
281 R—T D MIDI F—7HR— KDEH)

281 R—=2 D BHBEBZES DDy v T v 7]

MIDI F—R— RPEZHWTWARWE SR, RTREN/MIDI F—R—KE27) v 795 L
EELET.

7213 THREK (Find)) V—IVF = A M5 TAF 17 -V —)L (Media Tools)] %#ER L. MIDI
F—7— K (MIDI Keyboard)] 74 A2 %575 1w s LTRHT S EbTEET,

NBEBEFES DO Y T VT
MIDI F—3Hh— R&2/HBMIDI 7NN A EHEHLETHAT 2550 FIEITRDOED TT,

007-2275-010aJP
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%11 % :MIDI F—A&— K

282

1. U= AF—3 3> &S MIDI /31 A %, Macintosh & A0 H 2 21 7)1 MIDI 1
ET =R T TEEHNTERLET, MIDI{ > ¥ 71— - 7HTHIE T—2
AT—=2a>PIUT) - R—=MERLET, > U T - FINA AZHERT 2 & 00w
THEENE VU XT—2a OEEEZLFTICLTLEI N,

T—=JAT—=2a>DI 7))V« R—bOLEPDNSIENEE, KBHER O ENDD
BIRNEEIE, V=7 AT — 3 POFMBAEREZSRL T 2 UYL - 731 R 28
LTLEEN,

AE DLW General MIDI 81 D% <121, U IV« R—b - AR IDBHEENTW
F9, ZOLSRGEITIE. T THYEHNTIZ, General MIDI /N1 ZAD Y 7 )L« ih—
MEEET AT =3 DU TV - R— MR TEET,

2. YUV R=HI MIDI FNARAZERLTRS, [PATL - ¥R—T ¥ (System
Manager)] 2L T, £y b7y 7OV T v 7 RERTET T LET,

Y —)LF = X b (Toolchest)] 705, T2 A5 4 (System)] -> [ A5 L« ¥ F— T ¥ (System
Manager)] Z#ERL. [)N— K x7 &5 /V1 A (Hardware and Devices)] =27V v 7 L
3

VIR LT - R—RDOREZETETTHE, T2 AT —3 3 > EE MIDI 5 /5N1 AHHEIC
WETE2XE3ICR0VET, KOEESMDHEEIZEATL I,
o 288 R—TD [T—U2AF— 3 >nEIE MIDI 5N A &2iHET 5|

e 289 XR—TD M MIDI FNA AMEDEET—I A5 —3 3> L THEHET S

EVh I EBEMEMIDIA >F T2 —R - THTHE, FHOEIIUTIV - =), H5
Fr i @iz MIDILIN & OUT i 2 HRAHF T— kb L2212y b T, @Y7 MIDI 1 > %
72 —ADHE LT, TMIDI Questl. TMIDI Strip). [Opcode MIDI Translator 11| 72 EMH D £
o U T - R— F DEFERYIN 2 DAL AATIHEE. MIDL/ 2 U 7L« XA v FHHLA
FNZMIDLA 28T 2= - TETE&WAT 2 LMERTT. AT ST —T )L O
LYW E{THT. A v FCHBICEEZURAD ZENTET.

midikeys.play
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MIDI F—A— KD

BFROESE

MIDI F—3HR— RZHEHL T, F— R —REOEDEFMETHEETEET, 7ty hoY T
ReT7AINERRL, WAWARE Yy FTEOEZHIETEEY, MIDI F—3FR— RZ2B< &,
BEDT Ly bW F 7+ b TERESNET,

FRFZEET DT ROEO T,

1.

MIDI F—R— RV TWaEh-o =56, HEET,
B < HIEIZDWTIZ 281 R—2 @ MIDI F—3R— RoilEH 28R L TL/E3 W,

MIDIL] A=a—75 [ >4 7 x—2 (Interface)] ZER L. [Software Synth] &7 1 v
7 LUET,

I3, MIDI F—AR—RiZ, V=7 ZXAF—=2a>0V T Iz « e HdAFno0H
EMETDHIEEEELET.

MIDI ¥ —R— ROEEOF—2 Uy I LET,

T HFRENEREINE T, W<ONDEFHFOETH—YNERTIYITTHIEIZLD,
[F— U147 HREEDENTEET,

MIDI F—A— RZEMHH L THEZHEET DM, ROA T 3 2hiH0 X,

007-2275-010aJP

ZEOEIRDZ Ty bR IR Iy A ZRTIENTEXT, 284 R—P0 [FY
Tty hEYTOR Ty ] ZBRLTLEI N,

MIDI 7 7 AV EFES ZEMTEET, 286 R—TD MIDI 7 7 1)V EHEAT B0
MIDI F+—hR— RZHEEELE 7 /L LTS ] 28U T3 N,

F— e TNNEF T D, F—R—ROFWERET S, £/2EF—FR—FR - Ea—%#
ETBIEMTEET, 290 R—YD 75T 14 H)L - F—R— RORFEDOHE 2BMHL
TLEEWN,

IVADROODICT = AT =2 a>OF—Fh—REFHALT. VY5971 H) - F—FK—K
BHETEET, 205 R—=20 A TEEICLDER) 28R T Z3 N,

midikeys.presets
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Tty bEYO LR

Uty bOEVE

284

Z7A4IVDENS

ZDHENE. ROEHMMNSHERINTNWET,
o 284 R—TD [Tty hDEWS]

o 285 R—TD [P I> R Ty )OS

Uty ME, BFE Ny F, 7O 54 FEEBIFEN. MIDI F—F8— RIZEIY TrlgEls
ZHEEHBETEOSIED 1 DEEEL LT, 72& 213, 013 Marimba 7' v ~ ##5% L T MIDI
F—R—ROFZHNTHDE, YU NI ZESNHEET, MIDI F—FR— RIZiZ£< 0
TUty RAHEBEINTVWET,

MIDI F—Hh—RTOF Uty b &F v > RI)VDIEEL. Synthesizer Panel TO T Uty b &

Fr XN OIEECHELET, ¥HELZFAULTT., EE50Y—ILH, AEY 7 hU T - &

TEHAFIEREEEAET,

MIDI F#—Hh—RTT Uty h2EETSFIEIKROED T,

1. MIDI F—Hh—RF®D Y2 K (Sounds)] A=a—/n5, [Presets)] 271 v 7 LET,
[Presets|] A= a—MWFERINET,

2. ROELLENERELET.

General MIDI 128 @ General MIDI Ut v b « YA 2 2E0, 74 A EKRT 1 >
RoMERETNET, Acoustic Grand Piano 70 5 Gunshot £ TOEMNE
FNTVET,

Golden Analog 1970 £ & 1980 FERID AL F ¥ Z 7 7 DL A4 - T2 K&
B YA AZERRT 4 2 RUNKREINET,

3. MIDI ¥—Hh—RKRoROy7 Ry bz, Uy b 74222 RIvT - 72K R
Ow7LET,

T7ANELT 4 2 RUNEHREINT, LWty bAREENLI LZRLET,
4. XUADQLERY > TMIDIF—HR—R&7 v 7 LT dihd2EE2MIENTEXT,

FRICDONTIL, 283 R—=D 0 [EFHFOERE) 28 TL7Z3 W,

007-2275-010aJP



MIDI F—A— KD

TVt y bEREEALETSFIHIKROED T,

BOY K- 774IVDENS

MIDI] A= a2—% [Preset Number +] 227U w7 L, RIZKERT )ty hEFIT,
HBWE Preset Number -1 227 1) w7 L TRIZNE BTty NEFICBHLET.

a—PFPhAy b i AZa—Z2F5RDDIC, F—F—FKD 4+ & -] F—2HWTTY
ty NEBEAETHIEHTEET,

midikeys.playsound

Uty bERUEDIT, MIDI F—AR—RFZ2HWT, ROFIHETH TR - 77V OEEY
TV TTBHIEDBTELT,

1.

007-2275-010aJP

MIDI F—3HR— R0V TR EEE, Ih2EET, 281 R—Y 0 IMIDI F—R—RK
O 2SR L T EI N,

M7 > K (Sounds)] AZa—%2FWNWT, KOSE0ENNERIRL £T.

General MIDI Sound Set
General MIDIV D > K-ty h-F4 L7 MN)EFDYA O - Ea—-
T4 2 RUNEKREINET, General MIDI 57 > FD Y X MZDWTIE,
f$#% C General MIDI YU > R -ty hEN—Hviar -xvT| %
BILTLZE 0,

General MIDI Percussion Map
General MIDI N\—H v > a2 - Xy 7 - T4 A 250743 Ea—-
T4 2 RUMERINET. General MIDI )S—H v a -y T DY R
MZDOWTIE, 8 C, TGeneral MIDIHY V> K-ty hEN—=Hvi 3
>Ry T EBRLTIEE N,

Cycles HFOERICE<EbND, 2T - A INDYF IR Ty )R
BT AALERRTA 2 RIERRLET,

285
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Prosonus Sampler
YO TINOEIIL O I, 4 DDHYT R - Ty ANV DT 5 )VF
EE, YAAYFRT 4 P RUERRLUET, HOBRE (ambience). %
# (instruments). X 2 —3 v 7 ¥ 7 (musictags). FRZR (special
effects) ® 4 fEFH T,

T4 YRUTHT R - Ty )VEERL, ROy T - Ry Y hETRI T LET, £k
3 MEOY TR - 77N kA Y T LET,

MIDI F¥—Hh—ROF—27 U w7 LT, MnT2E2HEET,

midikeys.player

MIDI 7 7 A V& REALT S57=8IC MIDI ¥ —KR— FZBHEREET7 / ELTHES

286

Sound Player ElEHE T, MIDI F—HR— REe7 PHINKXOBHERELY / ELTHEDS 2En
TEEY. MIDIF—R—RZ2ZOXIIMD L EDOFITKDED TY,

1.

MIDI F—®R— KAV TWER>7/7256, BEET, 281 XR—I 0 MIDI F—3R— KO
g 2L TLZI N,

MIDI A7 = A—3% 3 > (MIDI Input Animation)] &% >IZL£7.
m A7 32 (Options)] AZa—ZHEET,
s MIDI A7 = A—3 3 > (MIDI Input Animation)] Z#ERL £,

Frvl - =UNHT, TNNBRINZZENDONVET, O 1 EBRTHEH
TR0 T,

AE: MIDI A7 = A—3 3> (MIDI Input Animation)] & CPU ICEW DMNN5 70
TATY, FEMEBNATLATIE, ZOYAVBUETERWADLNEEA. F—DR
E— REFMEBEIND AL — ROREDRBVWIREENH Z 05 TY, FFICETLTNSIZ
MY TV r—andbiud, TNEKTTAHIETHEINSGZEBHDET,

MIDIL] A=a—75 [ >4 7 x—2 (Interface)] ZER L. [Software Synth] &7 1 v
7 LUET,
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ZHZE D, MIDI F¥—HR—RiZ, 7= ZXA5—>3a >HNEDPY 7 +I 7 « > 2bHv A
DEEWETHIEEIERLET,

AE DDV AT AITHNE MIDI 7N ADHEER SN TS E &3, IMIDI A =2 —
MOEAIET )T ) » R—hZRIRTE L,

4. THT 2K (Sounds)] A=a—%BMZ, MIDISongs] 227V v 27 LET,

HEINTELMIDI 77 AI)IVDTY A2 - Ea—NRREINET. HDWiE, MEHD MIDI %2
AN Z &b TEET,

5. T1—F 1 U7« (Utilities)] -> Y7 > K+ 7L —¥— (Sound Player)] Z#ERL £,
Sound Player Y — )V FRENFE T,

6. MIDI 77 A)V -7 A 22%MIDISongs 7« L7 bU/n5 KEZ w2 L. Sound Player ® R
Oy> Ry MZRkay 7 UET, [H4A (Play)) MIDI 7 7 1 I)VSEASNZITDONT,
75747 s F-—R— REESNEXT,

EY b TERR (View)] AZa—2#HLT, F— - L\ aAICLED, F—F—ROEZ
EPRHELEZOTEEY, IOV TIE 290 R—=2D (75714 H)) « F—1h— RORTEDH
fii] 2L T EE N,

T340 F—FR—RiZ. 1EIC1 DD MIDI F+ > FIDEELNERTEERAL, D
720, EEOF v ORI NFEFICHEEZIN TVWSESICIE. BEEREEYY JON—2 3 VTN
FRINET,

EF MIDIYY YR - 77 1)VIZERD MIDI Fv >R BH D, ENENDT ¥ > RI)LD
HWEZF—R—RETRZEVWESITE, ROFIEITHE> TS LS,

e [1—F U7« (Utilities)] -> MIDI F—73—F (MIDI Keyboard)] Z#ERL. #HL W
MIDI F—3H— K] U+ > RUEREET,

e Synthesizer Panel V—I)VZHWT, YU 2K - 77 A I)VNDF ¥ > RV 2R ET,
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o FRLZH LW MIDI F—H— REH|DMIDI F+ > RIVICHREL. WADT 1> RUEH
LY / £ LT, Sound Player Z AW T MIDI 7 7 TV ZHE S LT,

midikeys.playexternal

D—ORF—2arP5SE MIDI TNA RERET S

D=7 —iarinbaEl
MIDlI /51 RAEBET 2

\_ D=z AT =3l FREE MIDI T80 2

B 111 7 — 7 ZAF—3 3 254 MIDL N1 X E#HET D
MIDI F—3FR— R Z2#HL T, V=T AF— 3 >no/ED MIDI /)85 A ZEETE£T,
FIEIZKRDED T,

1. EFTMIDIFTNARAZT—Z AT —3 3 IZHEREL, BEICDVWTDY 7 "y o 7V REET
TLTWDRRERHDET, 281 R—T0 HFEEZFS 200ty Y v T 25RL
TLEE N,

2. MIDI F—R—RzEEHLET,
281 R—2® MIDI F—7HKR— ROEH) 28R L T /Z3 0,

3. IMIDI] AZa—M»5 [ 2% 7 x—X (Interface)] ZBE. S5 MIDI 57/ X & L
TWaR—hEEELET.

ZHUZE D, MIDI F—HR— RIZIHNBTNA XA EBIET DI ENfERINET,

4. 7+ >3x)l (Channel)] AZa—+RY ZEFEMLT SMHBEETHEHNITZZEMOT v >
T EfEEL XY,
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ZHUZED, MIDI F—R—RIiZ, EDO MIDI F¥ > ¥V EB LTI =V AT—a2ins
ST NA RTBEZIT O DD ESNE T,

5. XUADERY > TMIDI F—H—ROEREOF—27 Uy 7 LET,
SR NA TR D, BT B ENERSNET,

midikeys.playworkstation

5088 MIDI FINA ADPSDEET—HVRAT— a3V LTEETS

FHEE MIDI F/RA R DFZED —
GAT—artTEETS

FREE MIDI T80 2

v

V- AF—ay

L

£ 11-2 HEMMIDI FNA ANEDEET—V AT — 3> ETHERET S

D MIDL T NA AMBDEE T —7 A7 —3 3 > ETHEETDFIETROED TI,

1. T MIDI F—HR— RZEELET, 281 R—I® IMIDI F—R— ROEH) 22K L T
FE0N,

2. IMIDI) A=a—Mm6, [f 2% 72— (Interface)] ZB&E. MIDI /)N AT I3 T
WHR—hEIEELET,

MIDI F—R— RI3EES N > F T — A EFBREEITVET,

3. [F%>X%)l (Channel)] A=za— KRy > EHANT, HBEBNEGITED T+ > 1) 245
ELET.
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4. A MIDI 5N AT, B2WONERLET,

MINT HNT—I AT —=23>DY T hTxY 2 ¥ P THERS N MIDI F—1R—
R EORBDHPNET,

midikeys.keysettings

I57 47 F—KR— FOREDRE

MIDI ¥ —HR—K 7=A—-23>%&F7ICF3

F—-SRNVEFVICTS

Bl F—R—- FROB®E

290

F—HR—R:7ZA—=2 3L MIDI 5—% OUEMEL 2B I ENHVET, F—F—K-
T ZA—=2arEFTIT BT, [F 72 a3 (Options))] AZa—%E, IMIDI ALY =
A—323 2 (MIDI Input Animation)] DD F v 7 - X—2ZFTIILET, Fxzvr X —
TN TV EEE, INEH 5 —EERT DA TITRDET,

F74)V h Tl MIDI F—R— REF—D I NV a2ERLEEL. F—DITNIVEERTDIC
i3, [F72 3> (Options)] A=a—%ME, [F—- Il (Key Labels)] ZERL £, Fxv
7 =21 TRIVERPENTEOTNDZEEZRLET, [F—+ T (Key Labels)] %
HI1EI) Y ITBE, INIINERINBLBDET,

AE:[F— - TR (Key Labels)) 1. 777Xy MZX2ET J OF—&, HFO MIDI
F— - INNOM B EFRRLET,

FI7 4 E T, MIDI F—HR—KiZ, Q275 C6ETD 49 DF—2FRLET., kD ClE
C4TT, WANAREHEEIRTHZENTE, MIDI F—FR— RiZEK 128 DF—F KR TE
£9, £/2. F—OEREF VY —THMATEHEVS, BWHICE(LIEEZEHTEET,

FHEF—R—FORSZHRETDFIIROMD TY,
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1. MIDI F—4H— KD R (View)] ZBHEET,

2. TF—R—RDEZ (Keyboard Length)] A=a—ZFERL. 52056015 1 DEERL %
ER

o 49F— (275 C6ET)
o 61F— (275 CTET)
o 76F— (E1%5 G7 £T)
o 88F— (A0N5 C8ET)
o 128F— (C-175G9£T)
BIRLEF—0RIZED. 7571000 - F—F— ROEIEALL£T.

AE D RWEREZRT 21T, MIDI F—4R— K (MIDI Keyboard)] 7 > R ®H 1
ZEETBHETRTOF—NELKRBABZEIITHDET, 291 R—PD [F—R—R-Eaz—
OEAE) ZBHRLTLES 0N,

3. F—AR—ROFEEFIY—THMTET LD FFEDTHITROEIITLET,

o F— INNEFICLET, 200 R—PD [F— - SKRN)LEF TS 2BELT
<IN,

o [5RIR (View)] AZa—75. [Octave Downl| £7z1% TOctave Upl ZHEIRL £7, #
RS> THF— TP L T,

[Octave Down] 7 [Octave Upl ZERT 572N, F—DORENEMLET., F—
R— ROUHICEET 2 X TERZHRET N TEET,

o HROCHHRIZAEDT 74N FOF—AKR— REBIKETITE. F-FR—-FE
(Keyboard Length)] A= a—25. BUOF—O#HIEHZZERNL £,
F—KR—F - Ea—DigF

F—AR—=F - Ea—Z2BETDIHEPVLSDONHDET, EOHEFITH. [Graphics Examiner|
A LUTBLDBENHD XY, MIDI F—HR— KD [F7 32 (Options)] AZa—75,
[Graphics Examiner] Z#RL £, NIBRF vy - X—IRFERIN, THNBERINEZD
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& %Z/RL £, [Graphics Examiner] 24295 &, V97 4L - F—R—RFZHDT L —
LITHLWERED TR SN X T, K113 2BML T LS.

Admin  MIDI Options  Sounds  Utifities  View Help
I TR e e ey

Rot Roty I 1rm| Dolly
[l channel [[7 = | [ Sustain Pedal PitchBend @ | [T T T T Al Notes Of |

¢ B

11-3 [Graphics Examiner] %74 2 IZU/2REDQF —HR— K

*%E : [Graphics Examiner] 274 212725 TWARETIZ, 75714 H)b « F—FR— R EHET
52LETELERA. F—FR—ROMBEZZELLS, [F7 23> (Options)] AZa—75
[Graphics Examiner] 2% 5 1 EERL, F7ICL TS0,

[Graphics Examiner] [ZIZME®D NV T) HEENH D £T. NVT) 2RRTBHITE 75
T4V F—R—FRET, IURDERY &M L7235 [Functions] A=a2—75 [Help)
ZEINUET, 72720, MIDI F—3FR— RIZBEL Tid, KD 5 DOEARFIAZT 25> THhiud,
75747 F—R— REBETEET,

o X—L&FU—

[X—L4 (Zoom)] X744 & TRY—(Dolly)] &1 —IVaefHdDE V5717 F—
R—REPARLUTERTEET,

TR —) RA—IEMEHTDE ThRAT) 27577400 - F—R—RITEDTLDES
F20TEET, "M —IVE LRIy I I5EF—R—-RIINELARD, FTIREIT YT
HERELIHRVET,

[(Z—=b) ATAFBHAATOL X2 T B EITHLULET, L XDBRNRELS
L. F—R—RORESREALZDNEILBAZVLET,
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B DORE DR

007-2275-010aJP

EXbM I EBEREEZADEBGDEANELDIENHVET, TRU—) K1 —IJVEFAL T,
F—R— ALK AZZEDICLTIZI N,

ETFomEE

Rotx] A —INZERITvITEHEF—R—REEFICEETEET,
i Sl EL

Rotyl] ™A —IV&ERIv I §2EF—R—ReAICE#ITEET,
[Flzks) #BE

75740 F—R—ROELICH—VIIZ2BEHTEE, I—VININIBRFORICEDE
T, NUADRY D EHLBNE RIv T T5E, FOHESIELETF—R—RABEL
F9, WUTHMBEBTITADRY &R LET,

57 4 ) MIBEANDOEIF

WOThH, V59714« F—KR—RZ2F 73 MIBNRTZENTEET, BT,
H—=INEF—FR—ROERIIBEHL., ARY > Z2HLENS, Ry TT7 v T« XZa—Mns
[Functions] ZERL. I5ICHT - X=Za—05 [Homel ZEIRL £T

midikeys.adjustsound

RMSFRL TLIZE 0,

294 R—PD TEwF « N> ROFHI]

204 R—2 @O [EEOHHE)

294 R—=Y D [F—&F— - U U —ZHE O
205 R=2 D THAFA >« R )LDl

205 R—T D EHELY TR a2 a—)b)

293
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EvF - R KDL

Ew F - X2 R (Pitch Bend)] &1 —J)lid. %< @ MIDI > >t F—Ic A 5N 5 EHER R
EyF - RXUR] OXDIHEET, EvF - XUE] "L D. BEINLGZFOE Y
F(FEEE) ZEETEET, S —IE2FESIUI. RURORY > EHLENS RT v T LE
T, BRIV ITTHEEYF - XURREND, EICRIVITTHETNDET, ZO#EZ
TN EEHETZITE. ¥4 TERIECK D ZFEHETHLENH D ET, 295 R—=TJD [¥
ATERIEICK DR 22RLTLEIN, By F XK FRA—IVERTE 0 KRVET,

mit
o
S
b
=

[F—F 1 « )N%)V (Audio Panel)] ZHWT, V—ZZAF—33>DV T b7y - > 2tH
AP THERINAZFTOTREFETEET, FIEITXROMD T,

1. [2—5 U« (Utilities)] -> IF—F 1 + )%l (Audio Panel)] Z3E&RL £9, IF—
T 1 4« )X%)V (Audio Panel)] MWERINET,

2. TR —71 (Speaker)] FNNVDFDRATA T ZHNLET, AT7M5 & LT EHEN LA
D, FIF5EERNTNDET,

F—¢F— - VY -REEDREH
MIDI F—Hh—RDF—&F— - JY—XDHEE (NOZF 1) & F74)FT120 ITHES
NTWET, F—DFEEIR. ENFTELLEY JOF—2LEZ0MLED LENZERLET,
T/, HERZTELZTOHLIIZAEZSLIEDHTEET, Po< D EDILH EENEEIZ
20, WULSHES EEHWEEIC/RD 9, MIDI OFEEOHRIZ0MNS 127 £ TTY,
HEZAETHFIEIROBED T,
1. MIDIF—HR—R® MIDI] A=a1—%BWT, [Controllers Window...] Z#ERL 7,

[Controllers Window| MW&ERINET,

2. EE500, H2VWEMSD [F—EE (Key Velocity)l ICH7=/EEDMEZEANL LT,

3. BllsEHEOEZEATILES, U5 (Close)) Ry %270 v 7 LET,
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YRTA 2 - RYIOHIE

it
2
o
¢
g
\I

G4 TRIEICKDRE

007-2275-010aJP

AE I EZL DT AHED, BEAEONBKY 7T - oA F0T Uty M3,
F— VY —2DHEOREICIIRL FH Ao

IMIDI F—74— K (MIDI Keyboard)] W« > RUOHIRTEIZH S [Sustain Pedall %7 1 v
795E MIDIF—HR—RD H2ATA>2 - RY)) 24> /| FTTHZENTEET, Frv
e RmRyIADF Tyl - =013, YRATA 2 - RN N> TNWBIEEZRLET,

AT T 74 MIDI F—1Hh— RTidk<, @HEDOF—R—ROAR—=Z « N—2#MLFHT
L&, YATA EEEERHNE D ZENTEET,

F-axbo-=-ib

[Controllers Window...] A~X > RIiZkD, NS A, NoBREOFEERY IR - hO—
WHREZR D& 1 707 - iRy 7 ANERINET . [Controllers Window...] I~ > Kid MIDI
AZa—MMWEE T EMNTEET,

a—pkAhv b : [Controllers Window] Tit., EDQ T4 =)V ROETH, H—VILEZTD
T4V RZBEIETHhSF—FR—RD [+ & -] F—2MWTLIzLD, HEEIESZ
EMTEET,

midikeys.playkeyboard

J—2 A5 —3 a3 DF—R— RPEHER L QWERTY F—4HR— RThiud, ThzHL THK
BTEET, ZOHEITEDERDEIBFIENH O ET,

e RUTFZVVITHETHZIENTEEY, DXV, FARHIEBOEZHETEELT,

e XURZ TEYF - RUR] ® I®£Valb—Yal] OMREHET S0, FIKHC
T—=JAF—2a>0F—R—RezfAVWTEEYATA > TEEY,
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296

BRI — 7 A7 —2 3> - F—R—RIZIE, EOF—FR—ROEIITHLTHEWSD 4 4
DY —TEERTDHOIZTHREOF—NHVET, 20D, V7710 - F—FR—KROE
ETFTIAHIVRD A ITHET D E, BEBSHEINENESNET,

T—=JAF—rar - F—R—RefHLTEETZTE. F—R—-ROXFF—2ML £,
(14> 7 - 72 A—3 3 > (Typing Animation)] 24 >IZ§ % &, fEN/=F—I1THU T,
MIDI ¥ —R— ROF—NEFHEET., (¥ 27 - 72 A—2 3> (Typing Animation)] I<
> RiE TF72 3> (Options)] AZa—DTFIKHDET,

AEIHIAEDT - 72 A—232] IECPUIKRKERATRZNTET., Y1 TAHNITHT DT
74 s F— = ROKIENENIGEL, (41T T2 A= 3] 24871 TLE
SN, TSA—3 3 z2FI755&, oM PiREZEs2ETEIN, BELETOF—13F)
EEH A

TIT4H)N F—R—REMHHALT, 4375 —TOHMEHEZTEZET,

s EHD1AVH—TE T—VAT—ar - F—Fh—FROF2FDOXFF—TxinlL T
E 0

o RO 1 FVH—T1F V-V AFT—Yar - F—R—FOL2FDOXFF—ITHIGL TW
ESCIR

* <shift> F—Z2MLANGHEET DL, 2475 —Tm<RBOET,

A%E ! <Caps Lock> F—IZLoTH, 2A VI —TEWEEZHBETEETA H<DIEX
FF—ZITT, BFF—RBBE XA,

AR F—AR—REIYAMTITIHEROKBICED, F—0HAEDLEICL> TR, BFLAZEDDOE
MEBINENWI ENDDET,

midikeys.ref
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a> hao—=)VEEOY 77 LA

A2 bA=-IVFEDODVIZ7 V2R

ZDHENE. ROEHMMN SR INTNWET,

TAdmin] A=a1—

297 XR—T D
297 XR—T D
298 XR—T D
299 X—T D
300 R—=>D
302 XR—=TD
302 XR—TD
303 RXR—=2D
303 RXR—=2D
303 XR—TD

304 R— D

MAdmin] A= a2—)

MMIDI] A= a—]

M7 a>) AZa—]

My >R Aza—]

M= UF 1] AZa—]

MEFIR] AZ2—)

Mgy F « X2RJ w1 =)V
MF v )] AZa— Ry )
MA—JV - YT R-FT)] Ry
TROw 7 - Ry NENXZAHT 1=V R

lMHistory] "% 2]

midikeys.click.admin

Admin] AZa2—Z2HWTMIDI F—HR—REKTLET, ZOAZ 21T #T (EBxit)] 72
UNFEELET,

TMIDI] A=a—

(M9 T71—R] AZa—

midikeys.click.midi

[f >% 7 x—2Z (Interface)] AZa21—IZLD., VI T - 8150448 MIDI 5N
A2 %EHEL TWSHR— 28R, MIDI F—HR— R EBETINEEEL ET.

007-2275-010aJP
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lPreset Number -1 & TPreset Number+] A< kK

[Preset Number +] I > RIZKDBEDT Uy vFEF%Z 1 DS, Preset Number -] O
YRIZEODFFBIENTEET,

2> hO—3 -1 > R (Controllers Window...)] BLY IEXBXUIHYT K- a2 ho—
Z + U ¢ > R (FX and Sound Controllers Window...)] a< > Ri&, NTF X, /X2, BXV
Y =2 ED, KOEERTT RO NO—=VDEDOY A 70T « Ry 7 X EHRR
L9, IN50/8%)L EOAHEER. MIDI i TEFR SN/ MIDI 2> hO—F - Ay t—
JITHIE L TWET,

F-=N-/J=b-F2

BEAKINTVWSEIXTOE2.000000000000 (Al Sound Off)0 & D HEFEC
EHFET, ITXRTOFIRFVY —ZFPEICAD, PATA 2 - RYJNVICK D IN TS FITE
BAEZITER A
F—=IV B R e FT
BEEREN TS MIDI OB ZEBICIEDET,

yeyb--A=J)b-aba-5>

MIDI F—HhR—Roa>bto—529XTYUtvy hL, 74N MECRLET,

midikeys.click.options

A7arv] A=a—
[+ 3> (Options)] AZa—IZIEROIY Y RBHDET,
e 29 RX—T® IMIDI A7 ZA—=a) AR K]
o 209R—VQD [M¥AET - T A—=ar] AR EK]

e 299 X—® [lGraphics Examiner] I< > K]
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a> hao—=)VEEOY 77 LA

TMIDIAAZ7=A—3r] AV K

Ry ZANICF v 7« I=I 0 nTnwd e, MIDI AN ZA—=2a i F > THalt%
RUET., F208E, 1—yY)LH IMIDI F—4R— K (MIDI Keyboard)] 7 > RUNIZH
EMIDI F—3HR— ROF—=2IMIDI A v t—IZKISLET, IMIDI AN Y ZA—3 3 > (MIDI
Input Animation)] DEFIZED., >/ F 7DD £,

(4T -7=-A=-3>] a9k

Ry T ARNZF 2yl - R=I RN T0WB E, (M EL T -T2 A—2 a2 BN THBZ
LERLET, Fo0&XF. H—ILA IMIDI F—1R— F (MIDI Keyboard)] H1i2& 5 &,
V—=UAF—=ar F-—A—-—ROFATTRIEL T, F—0PHEEXT, 295 R—=20D 517
BEICKZHE) 2L T /ZE W,

lGraphics Examiner] <>k

[Graphics Examiner] 2< > Fid. [Graphics Examiner] 4 2 ICL X9, ZHICKD, 75
T4 s FoR—RERETEET. FHICOVTIE 291 X=20 [F—FK—F - Ea—0
BiE) 22U TIES 0N,

midikeys.click.sounds

Mokl AzZa—
> KR (Sounds)] AZz2—IZIZRDIAR > RABH D ET,
e 299 RX—® [TMIDISongs] I< > K]
e 300R—=TO MFYty b AZa—]
e 300R—=ID [MYTE-TyA))] AZa—)
'MIDI Songs] A<k

Sound Player Y — )L T ZA[AE/X MIDL 7 7 1 )L DF 1 L7 F U ZRIRL £
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ey bl A=a—

7ty bk (Presets)] A=a—Iic&D, 77Uy hO3EEOT A - Ea—D5BINTE
F9, INSOEDTYty hTH MIDI F—HR—RIIEETEET, 284 =20 [FUtw
FNETTDR - TyAIDENS] 2B T /Z3 W,

Y9 R-T74)b] A=a—

M2 K+ 757 4)b (Sound Files)] A=a—I2kD, KD 4 FEOTY K - 771 )Lip iR
RTxET,

General MIDI Y > K - v b
GeneralMIDIH Y > K-ty b Fo LI M EELYA O Ea—- Uy
PR EERRLUET, General MIDI 7 > RO U X MZDWTIE, {18k C
[General MIDI B > R« ty hENS—Hviar-<v S 28RLTLE
T,

General MIDI )N\—F1wa v
General MIDI )X\—H1w a2 Ry T - T7AA2EFTL, TAARRT 1
CRIEFRRLET, General MIDI /X—Hwia -y 7TDUZXRMIDON
Ti3. 8% C lGeneral MIDI ¥ > R -ty hENX—=hviar -y %
BHLTLZE 0,

Cycles BFEOAMICE<HWSND, 220 A7) - HT 2R Ty EdD
TA43AY - Ea—-Ug 2 RUERRLET,

Prosonus Sampler
R0 EEOY YR TyAM VDA 4 DOT AN EFFODT71a -
Ea— U Y RUEHESET. 74713 STOBRE. K I2—-Yv7
G, RO 4 FEOY > T) - A TIHEENTHET,

midikeys.click.utilities

A—F4VF4]1 A=a—

300

12— ¢ U5« (Utilities)] AZa2—ITIERD4DDIAX Y RBH D XT,

o 301 R—=VOD [TF—=F 1A X%V AT K]
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a> hao—=)VEEOY 77 LA

e 301 X—T® IMIDI F—Hh—FK] a2 K]
e 301 RX—=2D MYy T R TFL—Y—] a7 K]

o 301R—=TD M dAHF - )X AT K]

[FA—F4A4 - NFRN] a2 R

[F—5 1% « )X%)V (Audio Panel)] 2% > KiZ. Audio Panel #B & %9, Audio Panel #ff
LT BRBEDF—T 44 - NTA—FZRHBRTETET, 24 X—20 [HEROHE) 25
L T<7ZE W, Audio Panel O/ DFHIC DV TIE, Audio Panel @ [N\ (Help)l %
BRLTLEE 0N,

MIDI #—AR—FJ] A<k

IMIDI F—73— K (MIDI Keyboard)] I~ > K&, ©5 120 MIDIF—HR—K] 71 >R
EREET, 2T BEROF IV ESDMIDI YT 2R - 77 A)LIZDWT, MIDI F—
R—REZAEEEEY J ELTHEWEWE ZITRICHEFITY, 286 X—2 O IMIDI 7 7 1 )V &4
BT 27201 MIDI F—FR— REHBEZEEY / S LTHED ] 22RLTIEI N,

Yok -7b—v—1 a2 Rk

> K+ 7L —¥— (Sound Player)] I~ > Kid. Sound Player ¥ —)L & & £9. Sound
Player ZffHHL T, ¥ > K- 77 A )bzl BE BRLTEET, 286 X—2@ MIDI
Ty AINEETAT 572012 MIDIL F—HR— RZ2HBEELEY / ELTHD ] 2OV —)LOfin
HIZDWTIE. Sound Player @ [NV (Help)) ZZHL T 230,

o944y - XxJV] AR

> >5A 5 - )%V (Synthesizer Panel)] < > Rid. Synthesizer Panel Y —)LZH & £
ZOY=)VEEML T E2RBELEZDRHLTHAL I ENTE, £k, E0F v 2RI ETU LY
FPEZEEINTVDINEZY —FTEH5ILEDHTEXET, 2OV —IILDFEVHITDNTI
Synthesizer Panel @ [\)L 7 (Help)l ML T 7ZE W,

midikeys.click.view
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%11 % :MIDI F—A&— K

[&{R] A=a—
[£R (View)] AZa2—IZid, RO KBRHDET,
o 302R—0D A5 —T - F o) & Xy =T -F7vT)] A K]
e 302R—=TD MTF—--IX)] a2 K]

o 302RX—=Y® [MF—R—-FKE] a3v2 K]

(F045—7 - o1 & THADH—-TF-7yF] A2V R
2% —7 « 577> (Octave Down)] & 7% —7 « 77 (Octave Up)l X > Rid. 7
TG4 F—AR—RETERRINDGF—EELEAET, 290 X—2P D FHEF—F—RFED
RE] EBRL T IZE 0,

N—-5X)b] A<k
[F— - Il (Key Labels)] X > RIZ&D, V5T 14 H) - F—FR—FLOF— - FX)D
F2 ) FTEITVET, 290 R—=2D [F— - SX)NVEFITTD] 2BRLTIZIN,

—KR—FKRJ] A<k

[F—4R— K& (Keyboard Length)] 2~ > RIZ& D, MIDI F—H— RIZERENDF—DH%E
EELET. FMICONTIE 290 R=2 D [FHEF—R—-RRORE 2L T LS,

midikeys.click.pitch

TEyF - RUK] R4 —-)b

ZOMREDFEIZDOVTIE, 294 X—2 D Ty F « X2 RO 28R T30,

midikeys.click.channel
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a> b=V HEOY T 7 LA

[Fv>oxI] A=a—-

Ry

[F+ > %)V (Channel)] AZa—+&R¥ % FHL T, MIDI F—7HR— R#(EZTTD MIDI
F ¥ IV ERERLET,

midikeys.click.allnotes

A= -9 K -F71 Ky>

FIND E< Mmook EEMBRET, TFH—)V - BT R - X7 (All Sound Off)] RF 2K,
216 F V¥ oINS ERINTNEEEZHETIENTEET, A=) YT R - F 7] R
CEMLEE B AT BRERSDEBA. MIDI F—R—RZ2EHEBOMHALT
LIV, =)V ¥R -F7) K8y 3, WMBFNAANT =0 AT — 3> &@ET
ZEICHEINTVDHEIC, TOTNAARRIDERINDEEZWHTIEHTEET],

AEHOWI YA TICZ, TF—)L - YT R -+ T (All Sound Off)) (K VEEHEINS O
XRORIEBLEVWHDONH D ET, ZOHEEITE, ST ZABHEZ Uy FLTLES W,

midikeys.click.drop

rRayZ7 - Ry bFENRKREZT 4 —ILE
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Row7 « Ry MIEZELZWT ULy hOT7 A I 2EVWTBLEHTY, 7Utv b7
Aa2EADITT, ROy 7 - R oy M ROy T T57ZFTT 284 X—=2D [T Uty h&t
TR Ty AINDENE ZBR), NAZLT =)V RiE, TUtLY b Ty AIIVOINR &4
BRRLUET, ZOT 14—V RIINNRHEIATUTANTEZEHTEET, ZOHFAIE. K
Ow> « R®"7y NEEHINT, AHLET ULy hERRLET,

midikeys.click.history
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%11 % :MIDI F—A&— K

MHistoryl K% >

Historyl "% > EMINDHBORAORY > &2 v/ 25E, MIDI F—1HR—RKZHNWT
MOENZABICHNTZT 7AINDAZ 2 —NEREINET, RY > LITH—VIVEEE, YTXD
ERY LTI 7AINVDYRANERRIEET, ZOHNSRERALT 7 A )V MIDI F—
R—=RTHEZDEIITARDET,

midikeys.troubleshooting

MIDI ¥ —KR— RICEAT BMBEDO NS TN a—FTa 20

ZOHITIE, MIDI F—HR— ROMAICEEL TRID S SMEICOWTHMAL £,

304

1. 7774V MIDIF—HR—REMHL TEZHEEL LD ELTWH0, EAHRWEEE,
ROEHZMRL TEE N,

TREF—OHENMETERNIE 293 R—=T 0 [FOREDHET) 22M)
A2 T T —ADFER
IMIDI F—73— R (MIDI Keyboard)] W+ > R EIZHB I &

[Graphics Examiner] 234 712785 TWw% Z & (299 X—2® [[Graphics Examiner]
ax > Ry 220

HNEMIDI N1 A2 FHLTWS EEE. SUTIL - R—MELLS#EHRINTND
MHEHEL T XN,

A MIDI 5N A2 AL TWb &, Fr o RIVOBEIRMNEL WhEEL T/
S,

EHNRPT EERD ) HFITKORT D L&,
(A=)l « B> R« F7 (All Sound Off)) RF > &ML T, F&ILOTIZIW, ST

NAZZEHAL TWTERIEESRRNWE X, /M MIDI N1 A0&EJRZ 1 EA 712 T
MEF L TLEE N,
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MIDI F—HR— RIZBTDBED ST a—F1 27

MIDIiE, IXRTOEN TFH 2] & [FT7) Avt—Y2RBEETHLENIFERTHEET,
(FT71 A=W RA5POEBTRONTLE>ES, TOEFRBD IEAERTA, I
3 SHEMIDL FNA ZZHHL TWS EZITEIVEET, 2T F—7 )V Ok
ANTLESEEREITEIDET,
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12 =

Synthesizer Panel

ZDEIL, ROTMOSERINTNWET,
e ISynthesizer Panel DfEHITE] (307 X—2)

o a2 hO—=)VHEDYT7 LA B15RX—=)

Synthesizer Panel DfEAA X

ZDHiIE. ROENSERINTVET,

o 307 R—TD R

e 309 X—I® [Synthesizer Panel DFLH))

e 309R—TD FEETUEY bOiEE)

o 312R—=TD F—=F4F - )NTA—=F D]

o 3UR—=IVDVYTrTxY - > 2eHAMTFOEZSY 2T

spanel.overview

=
COMETIE, RICOWTHMAL £,
e 308 X—I® [Synthesizer Panel DHEAE]
o 308 X—TD MIDI &3]

o 308 R—TD NI TDOELE
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Synthesizer Panel D##E

MIDI &%

NIVTDREEE

308

Synthesizer Panel 3% & &k T 57200 Y —)LTY, FOMBEPLERZIT>20, NKD OO
0000000000 CARSNAZEEZEZYY O/ TEET . LA ROBEICHAL £9°

e HYUZR -FL—FY—-—TMIDIT—% - 771V eHEETSH L NEMIDIY 7 by -
YA P EREETE LY., TOM, Synthesizer Panel T > H A ¥FMEMAL T2
Uty he®EFTEET.

e JULY b TAAEEBYY R Ty TAAEI6DF YR T4
ROy 7« Ry Mzhkay 7L, &ORMBESCHENRICITAET,

o TUBYK NI FA4LIRN)  TFAAEERZ T AN - TAAEDDINY -
ROow> - Ry hMzRowy 7L, N2V ez E350E 282 0om 52T %
T, 31 R=20 [Tty b NV DHEHAGE 22U TLZIWN,

MIDI I3 Musical Instrument Digital Interface B§TY, MIDI |33 > 2 —4 EEMOE T
BT NA A ZHEICERETELL DT HEEDT DY INEEBLIIN— R 2 7{IHT
9. MIDI I, 1983 FEITHi—HEE L TR L TLISk, I Ea—4 2@ U TF & RBZ2AEN
WS DRI OFEE L TUAS FREIIZANSNTVET,

MIDI IZ BT 2 A28 E RO FEMIC DN TIE, ROFMEZBHRLTLIEZI N,

e [ The Musician’s Guide to MIDI ] Christian Braut & (1994 4 SYBEX, Inc. F1T)

e [ The MIDI Manual ] David Miles Huber # (1991 £ SAMS %47)

ZDOXRZa 7, ROEXRERZEHALTET,

o HOTERINLMIME, AFEOMOE, i, HEXLBHFEOERNOY >V ZRLET. &
EZE IMIDIFNA R 220y 7 LT,

o RTHEREINTWLXFL EEHY > 7] 2R_LET., INEZUYITIHE, ZOHREID
V—VEE L £9, &AL, Synthesizer Panel 27 1J v 7 LT,
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Synthesizer Panel O F 1%

e AZa—#EAZa—HHOMIZHZ [->) ORLFIE. A2 2 —ERADNNZAZRLET,
EZE, 7 71)b (File)l -> B (Open)l & (77 A4)) AZa—ZRWTH5, 5
<) ZBEINTZENDIEKRTT,

Synthesizer Panel D2}

BTV Y boEEE

B2DEFROBE
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Synthesizer Panel 1213, XD 3 D THETTY V LA TEEXT,
e Synthesizer Panel ZE 5 IZ#EIY 51213, Synthesizer Panel 25 7))V 7 U v 7 L£9,

e [YV—)VF X (Toolchest)] ® MMEF (Find)l -> A5 17 -V —JL (Media Tools)] %
R L. TSynthesizer Panel] 71 2> &5 77Uy LET,

o IO RITMHEALKICIE. synthpanel E¥ 1 TANLET,

spanel.audition

ZDHENE. ROEMNSHERINTNET,
o 309 R—TD [fElxDEFDOEAE)
o 310R—TD [FULy hEHTLR - T7 1 IVDIRE]

o 3N R—=TO [FUtw b« NV OFHGZE

Synthesizer Panel 7 1 > R @ 16 @ [F4E (Play)] RY > OENNEHL T, x0T Uty
ke  R2RERINLETEET, MIDI ofhz2EAPICE=YT52EHTEET, &
HIZOWTIR3AR=ZD VT RT T 22T TFDEZIY 2T 2B TSN,

7 7 4 )b kTl Synthesizer Panel 13V 7 h U 7 - > ¥ A FTHAEOD - RSN T Uty
FEEELET, BIHEELRWIRD. General MIDI 2M#H S 41, Acoustic Piano 7'Ut v
MIRTOF v x)hico—RENET, 2L N—=Ava> -y T THLZF v >3RIV 10
EREET, BAR2E0OFRELTF v o RIVTEM TSI, 310 R—=Y0 [FUtky hETD
YR Ty AIVOfEE] 2B TLES N,
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X% : Synthesizer Panel ® [F§4: (Play)) "% > T, TUty FEZIFZFEDC205 C5£T
DEZIEREOITHAELET. MIDI F—HR—RZfHL T, F—R—FLOERDENDE ZH
£IHILHTEXT, MIDI F—7HR— K& <IZiE MIDI Keyboard 24 7 )L 71U -7 L£T,

Ty bEYIVER - 77MIVDIERE

310

Tty MEE#E Ny T FREBIFIN. Synthesizer Panel TIRE TE 5 S OMEEIEL £
T 2&ZE Fy R 1ITKHLU T, Marimba Uty F&ZFIRU, T4 (Play)) &% > %
Uy §RE TOHFRFTY NDEICED £, Synthesizer Panel IZIZZ DTV Y b2
ABINTVWET, 7Uty hORDDITHTI R - Ty )V EFHTHILHTEET, 135
ORIy AW EZFTET, YU R Ty E0—-RTEHELE TOHYT K-
Ty ANETTINELT, —KRT Uy MBEREINET,

Synthesizer Panel T7 Uty bEZFY TR - 77 AV ZEIEET 2 FIEITKROBD TT,

1.

7> R (Sounds)! -> [Presets] £7/&id WU K] > T2 K- T71)L (Sound
Files)] ZERL L7,

AE: Y72 R (Sounds)] A= —THERTIC. BIEOY TR - Ty )T Uty
be 774NV EHERATAHIEHTEET, MIDI RBERZ2EHT IR Ty )l E2O—
K95 & (aifc v - R=POFIZEI), ZOBHRI—KWZT )y MHEHEINET,

Tty FEERT 5. ROEBOMNERELET,

General MIDI 128 @ General MIDI @7 Uty k « Y1 A2 2T A A KR T 1 >
ROMFRINET, Acoustic Grand Piano 7 5 Gunshot £ TDF Z{#
ATEET,

Golden Analog 1970 X & 1980 RO /RRITS > 2o A - H I ROT 1 3 8
EGUTAACERT 4 2 RUMKRENET,

JUty k- TFAACFERFTI R - TrAIN T AELI6DT Uy KT AL
rROow7 - Rry hOoWwWITnNic RSy sy - 7> KR Raoy 7 L£ET,

REIHRC T, @BhoF v > xicd 7 Uty hEERBY YR - Ty AV EESTET,
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Synthesizer Panel O F 1%

a—-bhAyb:EDT7 4=V ROT ULy FEBD, TOT 4 =)V RITH—V )V EESE, F—
R—RD <> F—& <> F—THETEXT, 77Uty b T =V RITH—VILEZEWVT,
LTty hBEEZANTEIEHTEET,

spanel.banks

TUty b - NODEREE
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Synthesizer Panel D1 > 7 £ — A&, FUEY b N T RNV DPRHVET A 25T 2 —
AD DGy HFRT BINE N> 7 %R (Show Banks)) KEIRY > %710 v 7 LET,

INZIZDNWT

TUty ke NV TN—=TELTHRET AT Uy FOEEDTY, £E&AT Bo&D
—f7R Ty k- N2 213 General MIDI N> 27T, 128 D7 Uty hEN—=Hy g -
Tty 50D ET, 574 T Synthesizer Panel i& [GeneralMIDI
SoundSetLevell] N> Z ZFERLET, Uty b N2T - XRIE. FHTEZN 7D
TOUERAEFERERDGITT DA T2 — AT >TWET, General MIDI N> « T4 L2
N (Z7A)V - T74IF) & SoundFont2 N> 7 « 7 7 AIIVIMBIED & Z A% T 5N ET,
Synthesizer Panel D7 Uty b« N> 7 - 272 a3 TN 70— R920d. N7 -5+
LU R (ZAF) T E2ENMEIRL, NoZ -T2 - ROy T - Rry MIRI vy
7LUET,

AEIND T4, N T4 ROy T Ry NNOMMDT A 2> BT ROy
TTBHZET, WU EJNDIN T ELMTEET,

Synthesizer Panel T7 Uty b - N INEREINTND E T, ZON 7 DT Uy b2
VIRTZT - VAT THEHAINET, NV BESEREINIVEBOTIOF - Ry %
7Uw LT, N7 Z2RRLET,
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AE I General MIDI N> 7 258G B E, ZONIHADONN—Hvial - FUty A, HES
MIZ MIDI F% >x)L 10icO0—RENFET, Frox) - 7o =)L RiZHFL WOV T LES
ZANT DN MIDI 707 SAEBA v —INZEINDEET. oMo )y FEFIZ
ZZoHi,

spanel.adjusting

F—=F4F - NS A—H DAL

Main Tune DRHH

RY 21— ADREE

312

ROEDIBF—FT4F - NTA—FORXREEHBTEET.

312 R—VD
312 R—VD
313 R—VD
313 R—VD

314 R—VD

Main Tune O i
MR 22— LD
M) N—7 D i
(30— 2 D)

IF v > FIVEABRED

I

WY 7 b7 - 2L F2FEET 51213 Main Tunel ™1 —)VZ2EHL 9, #HHRT
S HEf71L, TMain Tune] 7 1 —JV RITRENBHEDIZE b (cent) TY . £ MIFEHFED 1/100
IZHYS L., FAESKEERE Y /2T PFROFRICEDESGEEREITRICEBET,

Main Tune| 2B <213, [F72 3 > (Options)] A =2 —7%5 [Synth Runtime Parameters... |
27Uy LET, H2E<T 52 Main Tune) 1 —)IVZHICRT v I LET, K<T5
KR Ty 7 LT,

R a—L  ATAFTHNE) T TLT « ISP THERINDZIEORS ZHIEL =9, i
T BHEMIIT NIV TT, TOMEZ FTFBICEASAYZ2EIC8FH L. N33 EICBE)
LET, SOWEN0IB ZHBADE. KREBEDHMD TIIEFENEOREEND D T,
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YN—T DR

aA—-SADHEN

007-2275-010aJP

VI hTLT YA TERINSZEDKE (VN—7) Zillfid2FIHIROMD TY,
72 3 > (Options)] -> [Synth Runtime Parameters... | Z#RL £7,

[Reverberation] A= a1— + Ry EFHL TROVWTNMERELET,

[Off]
KBS 247U T,
ISmall Office]
H<UANVEBBETERINZE D BRKEGRZHL £,
'Medium Chamber |
DUBWEHRTERINZE DR ESREHLET,
[Concert Hall |
AP — b R EDREBDGETERIN LD BRESREZHEL T,
[Cavern]

REQWFECTEBR SN2 DB REZHL T,

[Reverberation] X=a1— R >ZDFDATAFZHHAL T, UN—T ORERRH., h—2>
(B3 X), HEOMINFREE, BLXUOLN)VZHEBL XD,

AEUN—=T DEBITIZZRISWIEDEN KT, [ F 0 O HERUB 2 [FRFI1T 5 HEid, U N —
TEFTICLTLIZE N,

O—J AT 2123, [F 72 a3 > (Options)) -> [Synth Runtime Parameters...] Z#RL
9, [0—F ADFEHE (Chorus Type)] A=a— Ry D &EMHAL T, —MCHEAINDI—
TADREETHD, AYF—R, J7y AL T75320, FREAO—- T DEFRLUET,
Off) ZENL T, I—FRX&A47ICT5ZEdTEET, [O—F ZDFH (Chorus Type)) *
Za— R ZDOFTDAIAF T, A—FAMREERT B2/NTA-F ZHIETEET,
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F v > RIVEIRRE DI E

JVZ2boz7 -ty

314

F ¥ > R)VEAREDHII Z1T D11, [ 2P A Y - )XV (Synthesizer Panel)] 7 1 > R
S OF A BB (More) BE 2% 1) 0o LET. W1 > KOsk, D> (Pan) 1
YL & R 2—L4 (Volume)l BET [EBL (Expression)] DEATA Y MMERINET, &
FyoxI)VEBUTERINDZED/N % N2 FAVIVTEEL, RYa—L41 & TERE)
DEATAT TEREEMEEHETEET,

a—bhAyb:TRYa—L] T10—IVRD [RE] 74—V ROfEIZ. H—VILEZD
T4 —=IVRICEE, F—FR—RD<4>F—¢& <>F—Z2HAL THEBETETET,

EXbIEEMIDI F v >RV OBFEEZHRAGT DL R 2—L) ATATOHEMHL. T&
Bl (Expression)] A 74 ¥ DEZRAD 127 KHREL XY, ERIT &8 /127 x ®H /127 1T
LLLBRDET, LENST, EbomitoiR@Esn s ifRbtrtosnn £y,

spanel.monitoring

A FDODE=SVU Y

Synthesizer Panel ZfHL T, WKV 7 ho 27 - 2 > A FOREEZEZITEHILNTE
9. YU R - TL—VY—2fHLTMIDI 7—% - 77 1)V &fAET S EE, Synthesizer
Panel ZBHW T, [F ¥ > R)V (Channel)] & 17Ut v b4 (Preset Name)l 15 L%EFH%5Z ET,
FDT7ANMWEDT Uy hEF Y RN EFAL TVWINEEZY TEET,

EVbh:BFENODYT I TICE. Z<OMIDIF—% - 77 A UDBEENTVWET, [H
> K (Sounds)] -> MIDI V >7 (MIDI Songs)] Z#RL., ¥ 7> K7L —Vv—THETE
577ANVDTF LI M) ERRLUET,

F x> x)VEBUTMIDI A X2 MWERIND =T, [F+ > %)L (Channel)] BT LD TD
LED WRKLEd, TOTILEHEAXR RIS E, [Tty FEF (Preset Number))
T4 =)V R& TFU+ty ~4 (Preset Name)] 7 14—V RBFHLWT OS5 ABFICTEDOETE
FINEY, [FUty b (Preset Name))l 71T ALICIE, BIEZOF ¥ > RIICERS TSN TV
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A bA=-IVFEDVIZ7V A

DT, ROEHBNIZY 77 L > A ERE L 7,

TAdmin] A=a1—
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270ty MEMNERINET, I (Pan)) .
(Expression)] | >3 —8 INEKREINTHLHFEIL

FTEXT,

R 2—2 (Volume)l . BLU FEH
INS OREDOELORET B HIRFICES

[Synthesizer Panel L—7 « U 7« (Synthesizer Panel Utilities)] A=a—n5, Y2 K -7
L—V—2H&EEd, YU R - TL—V—OfFAFEICDNTIE, $U R TL—F—D A
V7 (Help)l ZZHRLTLZE 0,

spanel_ref

315 X—Y® [TAdmin] A=z1—]

316 R—2® [TMIDI] A= a1—]

316 "= AT a2 AZa—)

317 R—=TD [T TR AZa—)

3I9R—=VD MA—FT 1 UF (] AZa—]

320 RX—=TD [THRY 2a—AL) ATA4 ]

320 R—T D [THEE] B )

320 R—>® [TAll Sound Off] K% |
spanel_file

TAdmin) A= 2 —IZi3. Synthesizer Panel Z# 79 %720 ® [# 7 (Exit)] A > RRH D XT,
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MIDI] A=a2—

A7>av] A=a-—

316

IMIDI] AZ=a—iZid, ROIOR > RAHDET,

lnput Interfaces]
[Software Synth] EMHIN2NEY 7 b D o7 - 2 281 ¥, S MIDI
FNAARER LU T I - R—FaED TMIDL] ANP 2kl —F %#&
RTEET,

F'All Notes Off]
HHEEAEL TWSETXTOMIDIEZ247ICLET,

[Reset All Controllers
TRTOMIDI > hO—F&F 74 )V MEIZREL £7°

[Restart Synthesizer]
VI by s YA EREHL XTI,

[Synth System Reset|
VI hULT A FeiBRoRE Iy FLET, i3 o—
RLEIRTOT Uty b= N2, TUky b BROF T - Ty 1)
PR <BRIENTENEXT,

spanel_options

F7>ar) AZa—IKE ROEHANSHD £
e 317 X—2® [Synth Startup Configuration...]
e 317 X—® [Synth Runtime Parameters...]

o 317 X—T D [General MIDI Preset Mode|

spanel.startup
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a> hao—=)VEEOY 77 LA

Synth Startup Configuration...

VIRTZT A FOEELR, BET 7 ANEEL THAIRAXTB20DT 1 2 R
VEMEELRT, JNICKD, =T FHNTF v >IN0 F—F 1 FAHHT/NA R - R— b,
A CPU &, BEUFT 7 4)L h®D General MIDL Uty b+ N2 D - NRIREDINT A—
HFENAIIARTEEY, BHEEFEELS, Lmidisynthre ~DEZ RS (Write .midisynthrc))
RNy )w I LET, TNSORERIE, VI MNTLY - oIS FNREIINDZUNE
RENET, 20T« > RUZFHALT, 57 4V MEIZU & b (Reset to Defaults)l &7V v
Il YATLADTF T AN NEREWXRT I ENTEET, RET 71 IV OHEFHEHIAH (Re-read
Configuration Files )] &7 VU v 7§ % &, mEICHA L7z midisynthre 3EICRED £9. FHMIC
DWTIE. midisynth(l) ¥ - XK= HZRL T LS,

spanel.runtime

Synth Runtime Parameters...

Run Time Parameters Panel] # &%/RL. ZZTY 7 U 27 - >t ¥ ¥ D Main Transpose.
Main Tune. Reverberation 3 & Chorus /X7 A—% DFREEITAET. TNHD/INTA—F
Z AT LHEHO MIDI A X2 MZE > THESI . S8 MIDI 5781 23 EL £8 A,
Reverberation Tid. KEZTDRMLEZ 4 DDHBRTORKENRE> I 2L — ML ET, [RERE
¢ (Reverb Decay Time)l. ['b—2 (Tone)l. BXY 7 O—/VILHRIEE L (Global Effects
Mix ratio)] & ZNZENOEEDOHLBIZDONWTELIELIENTEET, [T O0—/NIVKEL X
JV (Global Reverb Level)] 2 F A #13. TXTDO MIDI F v > RIVICEEL T, 312 XR—=I0D
(F—F 1 F - NTA—F O bSRL T EI W,

General MIDI Preset Mode

Yo Rl AzZa—
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FrvIR—=UNRHFNTWDE, VYT T LT b8 A D General MIDI HHEARIZHES T
W5l EERLET,

spanel_sounds

7> K (Sounds)] AZa—IZid. ROEHNH D £,
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MIDI Songs

lPresets] *=a1—

'Sound Files] A=a1—

318

e 318 X—® IMIDI Songs]
o 318 X—T®D [IPresets] A—z1—|

e 318 X—T® [ISound Files] A= 1—]

MIDI 77 ()« 742D 7AAFKRT 1 > RUERRLET, TNHS5D T 71 )Uid Sound
Player WV —)V THATE£Y,

ZDAZa—TI FUtyhD 3 FEOYAICERYA > RUNSREIRTEET,
Synthesizer Panel 1213, EQFED T Uty b THIETEET. dFHICOVTIE 310 XR—2
O 77Uty hEYT 2R T7AIVOEE] 2B TIZS 0,

[Sound Files] AZ=a1—Tli3. RO4EEOT TR - Ty IS EIRTEET,

[General MIDI DY > R « v )
FI74#)FD GeneralMIDI V7> KR« by kS L7 MN)EEDTI1I
FKrRT1 > RUEFRRLET,

[General MIDI Percussion Map |
General MIDI S\—H1 v a2 - Xy T - BUUR - Ty VEFOT A
KR4 2 RUEFRLET,

[Cycles) LZOERICIELEHEIND 1 BHOT I R - 7ML Z2E807 13 ER
T4 RUERRLUET,

[Prosonus Sampler |
IR Tr7AINDABEO T A NYEZOLT A AFRT 1+ > RUERR
LET, 741 BORE. B8, I2—2v 087, BREROREOY >
TNOREICKD A DICHEINTWET, 077N, 723>
DY T 2 AT I dmedia_eoe.data.prosonus 731 > A b =)L INTND EEDH,
FIET S ZEIERLTLES W,
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a> hao—=)VEEOY 77 LA

FRICONTIL, 309 R—20 [FETULy hOHEE 2L T /Z3 W,

AE :General MIDI DEZDY X M ENN—Rwv a3 -y TIZDWTIE 8 C [General
MIDIYY >Rty hEN—hyIar -xvT] 282RLTIEZEIN,

spanel_utilities

M—F4V541 A=a—
[Z—F 1 UF ¢ (Utilities)) A=z —IZid. KOAX > RAHVET,
o 319R—=TD [TF—=F 1A - )XFK)) AT K]
e 319X—T® IMIDI F—3Hh—FK] a2 K]
o 39R—=TD [T YA HY - ITF1¥] AT K]

o 3OR—TVD [TFHL K- FL—F—] I3 K]

[FA—F4A4 -] a2 R

[F—5 1% « )XF%)V (Audio Panel)] I~¥ > Rid, FEREDF—F 1A - INTA—F ZHHT
£5% [F—F 14 - )X%JV (Audio Panel))] Z2FRL ET., FMIcOVTIE, 312 X—2D R
Ja— L0 22RLTEIWV, £ F—F 14 - X%V OERFEDFMIZDN
Tid. Audio Panel @ TNV (Help)) Z2ZM L TL7ZE W,

IMIDI #—AKR—FK] a=YFk
MIDI F—HR— K] a~ > R, F2EEHICHEZ>TY > FY 27 TES MIDI F—HR— KD
V=)V EFRLET, TOV=ILOFENHIZDONWTIE MIDI F—H—RD [NV (Help)) S
LTLESN,

ryeda4Y - 5441 A9 R

OO RT, MIDIL > >80 8 - Uty b - 774V EER £E. BIUHET S
HO7 TV —3>,000000000000 (Synthesizer Editor)] ZEEL £9,
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%5 12 ¥ : Synthesizer Panel

Yo R -Fv—v¥—1 a2k
> R+ 7L —¥—(Sound Player)] 3% > K&, Sound Player V—)L&&KRL 9., ZD
V=)L D MEIE (Stop)). [F4E (Play)). BREL (Rewind)] AL TH IR 771V E
7ZIE MIDI 7 7 A )V EHIETE £ T, 20V —)LOFHAIEICDWTIE Sound Player @ A\
)V (Help)l 228 L T< 72 & W, Synthesizer Panel Z 5T MIDI 57 —% + 7 7 1 JL % Sound
Player IZ RO 79 % &, Synthesizer Panel ZffiL T, HELAZNSZDT 71 IILONEZE
EZATEET, dFlICOVWTIE 34 X—2PD VTR zT - 222 A FOEZSY Y 27 )

EZRLTLZEI N,

spanel_gain

[RKYa—ALl R54%
ZOBEDHMICONTIE, 312 X—Y0 TR 12— L0 2BBLTIEE N,

spanel_play

rg&l Ry >

(> >H14 - )X (Synthesizer Panel)] 7+ > RU®D [BAE (Play)] 7T LTHZDREY >
E7UwITHE EPNEEINET, ZOFRAITE. £D MIDI F+ > x)VIZEE TN TY
Ty MCHIELET, FMICONTIE 309 X—=20 [FETU Ly hoillE 280 T<E

Ty,

spanel_notesoff

F'All Sound Off] K% >

ENEPTHE S ZHER. TAI Sound Off) RY > &L TIXRTOEZEILLET, TAI
Sound Off) Ry > &ML TEHEEA VTR ASLEIZH D ZH A, Synthesizer Panel %%
DEFMHEL THEHATEET,
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ZOFEF, ROHNSHEENTHET,

o THEE (321 X—2)

MR- I5 45 OEEH) (322 X—2)

o [HUZER--TyAIVDOEME 322 RX—)

o [HUZR-TyAIIDOFAE] 324 XR—2)

o YUK -IF4%] T7AINANDFEDEGAH] (325 X—2)
o IR --T7A)LOfE] (329 X—2)

o NI TNTa—F+127) 335R_—)

o YR -IFA4F - FTARATLAIDNT] (37 X—=2)

e YU R -IF4HDAZa—] (339 R—)

seditor.overview

=
YT RIFA4FE A—F 1A - Ty A INOEREREDZODY =)L TT, YU K- T
T4 Y EFALT. ROBEEZETTEET,
o HLWHTZE Ty A1ILOIER
o HUXR--TrAIIOmREL FHEDCHHOA Y b, IE— X=Z b
o BEFEOHT R - Ty AIVITKT DEHRIRE DB

o a2Vl brIVvIRAFL—TaOEE

007-2275-010aJP 321



BBE: VIR IF 1%

AEFHLULBHFEINZ. K0P Y 2 RiEE Y —I)LTH S Sound Track B L <723 W,

IR - I5F49DiEE)

PR IF 4 713 ROXIRHETETTEET,
e [HYU2R-IF 1% (Sound Editor)] 227U w LT, YUK TF1 ¥ EHEET,
e YA EIUYILUTHEEXT,

1. TAZbv7 D I'V—)LF X b (Toolchest)] -> [HFK (Find)) -> A5 47 -V —
)V (Media Tools)] ZiERL £7,

2. Tsoundeditor] Y1 A>&F 7)) w7 LET,

e 1Y R{FT. soundeditor &¥ 1 FTAHLET,

seditor.manipfile

BOYU K- 77140V D#%F

YR IF 4723 77V EHTED, RELZDTS-00BENLIT Y RNHD
F9, KD2DOHEIZHTT. ZN50ax REMHHT2EANEFIEEENLET,

o 322R—=UD FEOY TR 77 1)L
o 3UR—IYD YT RITF14¥%] T71INERETS]

BHEOY IR - 774NV ERS

WGEOF—F 14 - 77 0IVEMITE (774 (File)) A=2—0 MP< ..(Open...)] IX
REMHLET.
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PR - T 7 AIVDOEE

1. TZ77A)V (File)) > [BI< ..(Open...)] A > Rz#RL X7,

T7A) « TIUTFNERINET., PROSONUS™M G R« 54750 %EA A M=)
LTHBEAEIE. /usr/lib/sounds/prosonus T4 L7 RUIZH > TILENNL D
ADTWET,

2. BAEEWT 7y AIIVAZEREIRL T, B (Open)) RE > &2y LET,

YR -IF45] TAATLAI, BBWET 7V OF —F  FRENERINET
(K 13-1 i),

S 1
o] [ ]| ETESE
e [ [ - [ E

®13-1 lrain] 77 M)V %& 92K ITF 4 %] TE=R
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YOYFR - I5F49]1 774V ERETS

77 AINVORIFREE T, [771)) (File))] AZa2—05 [RTF (Save)) £z MHISRTE ...
(Save As...)] ZERRL T ZEW, BIRLZHHZTRET 561, [HEEHFEZRTF ...(Save
Selection)] ZERL £7,

AEHTUR - IF 1 FIE TRTOT 7 1IVEEMBL D AIFF BRO 7 7 1)L & U THRTE
LET, BEDZEROT 7y A INEFAL TS, RETDEERTONT v 720 AIFF BRI
EWINET, T2 BEDZH D TIEEZHED T 7 ANV EBALESEEE. 7 7 1 IV ORERIC,
TXRTOT 7 A NOY > TIVENRBIENY > TIVIRICEDESNET,

seditor.playback

YO kK -7714)V0OBE

324

BEOY TR« Ty A INVEREHEOT TR - 771 )Ud, 28R ER3F0—ieHETE
£7,

Ty AINEEREREAETBIZE. RO2EODOHENRHDET,

o WROEHHICH—VINEBNT, [HE (Play)) R7>22Uv 7 LET.

o [ITRTEIRAI RF>E27Y I LT, [HE (Play)) R’y %71 v 7 LET,
T7AINDO—HE2EAETHEEE. £9. HETHHMOLHEMBICH VIV EBNT, IXT7X

DIRY VEML, RIv 7 LTIES N, FAETHHENT L —CRAERINESETTAD
Ry > EML. THE (Play)) K5 >%2210 92 LET,

a—-bhy b THE®PLy)) RF7>222V v 73580012, XTADERY > 2L TH
ATBHIEBTEET,
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L NV D

B&E U ANDORER
M)V (Level)] AZa—@DaX > REMHN, Y2 R - LNV ZHRHHITEET,
o [IEH#HUE (Normalize)] 1. 7 - ¥4 FIwr - L2DIRYTR - LNV E RFET,
o [HFEZE TS (Softer)] IZH UK LNV ETTET,
o [HF&E%E LTS (Louder)) W3H UK LANJVE BT ET,

o TLXRIVDFHE ...(Set Level...)] ZFIRTHE, ¥4 707 - Ry I ANWE, ATr—1U 27
laEfEETEET, FHEMITONTIE. 34 X—20 MTLNJVOH|E .0 AN R OFiA%E
ZRL TN,

seditor.record

[YOUR - ITF4%]1 7274 IVADEDEGAH

ZDHITIE. FTOEGAASEZ 3 HEHHAL £7
o 355XR—TD HLWT 71T ZEEAT
o 3NIR—=T0D BEEDOT 71 IVIZEFZHEUATY

o NIXR=ID [TF—=N=FEIVHFITE—R] a~vRE2FEHLTFHL— 3 > 2H0AE

LW 70 IICEZEGAL

PULR - IFa ¥ EHHLT LA —FT1F - Ty A NVICEZHAD I ENTEET, ¥
TR CIFqFEFEERBHLTOWRNERIE. 22T (YU K- I5F 1% (Sound Editor)]
Uy LT, YUK IF 4 ZERNTLZI N,

1. 774V (File)] AZa—05 THH ..(New..)] ZERLET,

B 132 IR KDBEAT AT - Ry JAMKRENET, ZOF¥1 70T Ry 7 ATH
TN b—=b, TR Fv O RIVBERETE LT,
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BERBE VIR -I571%

[ 78] [

132  [#Hi(New) ZBIRLAEESICERINEF17OY - Ry s 2

2. RRSNEFAT7OT Ry IV ADENTNDT 1+ —)V BT, ZOHFETHEHRTZH T -
L — b (sample rate) . 7+ > %)L (channels) £ ¥ > 7 )V (sample width) Z A7 L 9

3DD7 4 —)V RIZHERRMEE. ZNZIRDED T,

YT L—h
8000
11025
16000
22050
32000
44100
48000

F ¥ R 1
2
4

YT - Ev Mg
8

16
24

3. [F—5 17+ )X%)L (Audio Panel)] ZHEIL T, 72&ExE, T1 >« 1> - B MTHE
INETF—T - FoFREDRGY — A Ll SR AR L £,
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Y R-IF4¥] 774N ADEFDFGAH

[F—F 1%« )N%JV (Audio Panel)] ZB<I2IE. 21— ¢ U 7 ¢ (Utilities)) A=z —7H
5 [F—5F 17 « X%V (Audio Control Panel)J EWSHHHZERT 20, F—F 14 -
JNHI)V (Audio Panel)] EWS IX)VESGT U w7 L TLEIN,

o AT THIMEEET DHEIL HER (Selected)] A=z —n5 TAJ]Y —X (Input
Source)] -> [Microphone] Z#ERL £7.

o AT AOD Line-In R—hIF—7 + FvF£/&IZ VCR 2HHEL TW T, O
SEE T 2581 BEIR (Selected)] A= a—n5 TAHY —X (Input Source)] ->
Line In) Z#IRL X7,

e AT LD Digital In R—k (H2HE) ITHEZEHL TWT, ZOEENS DOEE
ST HEHE1E (57240 (Digital)] Z#ERL £9

4, =5 1% - )X%)V (Audio Panel)) ZFHL T, ANLIVEFHL ET,

U1 2 RUDEMIOMITIESILATA T2 A LT, ANLNVEHETEET. LIV
T 6 FLITT7ITRET D ERHBHERPRESNET,

5. o> KI5 1% (Sound Editor)] 7 1 > R D I§43F (Record) | R > %7V w7 LET,
6. BRETTHTOHEEEMBLET,
e HODORZEERETIESIT. XM 7073 HEMN> THELET,

* CDPlayer £7z13 DAT Player /» 5 #% & 9 %5713, CD Manager %7213 DAT Manager
D 4 (Play)) "7 >z AL X,

¢ LinelIn R—MIEHINTVET—F - FvF R EDHERBN LT T DHEIT. HiD
(E4 (Play)) A% > %=L ET,

7. BEEKTISEEE. HEIL (Stop)) RY CEMLUET.

8. I77A) (File)] AZa—Mn5 [HIALRLF ...(Save As...)] ZEIRL T, fERL7Z7 71V
Bl EAMTET,

BfFED7 71 IVICE AL

YR IF4 7 2fHLT filWwt—F+4F - Ty A IIVICEEZHAD Z ENTEEY, ¥
TR IF 4 FEEERHL TWRWESIE, Y2 R L5 1 % (Sound Editor)] 227U v
JLT, YUK - I F 0TS,
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328

BETLEEZHALLLWIEICHES 1> 2ES KT,

EAE. 77 AIVDFEBEITH L WERE ZEBNT 25813, BEOLHICHES 1 > 2ES
£, FEMICONTIE, 330 R—=2 D TRET 1 > OfHGE 22U TSN,

[F—5 1 74 - )X%)L (Audio Panel)] ZffL T, ¥+ 2707+ >% CD Player /% & Dk
V=R LT b BEREERL Y,

[F—5 1% - )3%)) (Audio Panel)) #B<12IE, [2—F 1 U T ¢ (Utilities)) A=z —n»
5 [F—F 1A - )X%)L (Audio Control Panel)] EWSIHHZRIRT 20, [H—F 14 -
NIV (Audio Panel)] EWS IX)VEST U w7 LTLEI N,

o AT TFh5EETLHHEIX HER (Selected)] A =2 —25 [AJ7Y —Z (Input
Source)] -> [Microphone) #ZERL 7,

e I ZAFAD Line- In‘]‘ MZF—7 - FwF£71E VCR Z2#Hi L TWT, ZOHS
SHE T 2BEE. HER (Selected)] A=z —n5 TAHY —X (Input Source)J >
Line InJ %% ?F\bi'?

* AT LD Digital In R— b (H2HA) ITHEZHERHL T T, TORKE =8
G 2561 15250 (Digital)) Z2#RLET,

[F—5 1 F + )N%)V (Audio Panel)) 2L T, AHLIVEFHL £,

U4 RUDEMGDOMITIE ST ATA T AL T, ANLNVEREITEEY. L)L
T 6 XTI T7ITRET D ERHBHERPREONET,

My > R+L5 1% (Sound Editor)] W 1 > R D [EF (Record) )Ry > &7y 7 LET,
BETHETOHAEEMBLET,
e HHOOEZEBEITIHAE. XA 7074 AN >THELET,

* CDPlayer %7213 DAT Player 7 5% 3 % #1313, CD Manager %7213 DAT Manager
O TEAE (Play)) &% > Z2#HALET,

e LinelIn R—hMZEHINTVET—T - Ty F R EDHBNSEFETTIHAIT. HED
[E (Play)) R > &2WLET,

BEEMKTIDEEE EIL (Stop)) REY 2L ET.
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UK 77 AV OfRE

[F—N—FEIEFE—F] AT FEERALTHV—2 3 Z20AL

TTCREEMORNT v I 0HD, ZZIHENOFZERTRETIHAEEATHET. 20K
D12 EEFITIE. TRE (Settings)] A =2 — D [F—/N—%FE > 7 §FE— K (Overdub Record
Mode)] O > REMHNET,

1.

2.

ZEBETDOA—T4F - T AINVEHEET,

[FXE (Settings)] A= a—Mmb5 [F—/N—FE 7% E— K (Overdub Record Mode)] %
BEIRL £T,

(%% (Record)) EWDREY AN [FH—N—FE T (Overdub)] AV T,
LHERE Z T 2B OMBEICRET 1 2B LT,
WET A ZDNTIL 330 X—2Y D HRET M > OFALE 2R TL/IZE N,

325 R=TD FHLWT 7 A INICHFZHTOAL) O T, #FY—ZX&8IRL. AN
LV EHRHH L ET,

[F—/IN—=FE T (Overdub)) 221U » 7 LT, &EzMEL£7,
BEEEILT B EEE, I (Stop)) KY S EILET.

seditor.edit

YOV R - 77140V DiRE

WO 2 R T 7 AINVERRBH LT 2 RERRAARE T 7 AN DYDY > REefETEET,
ZDHITIE ROBEIZDWTHAL T,

007-2275-010aJP

3B0R—TD THRET 1 > DA A%

332 R—=TD 7> RO—{%ERT 5

333 X—=D ¥ > RO EHIFRT S

333 XR—=TD 7> RO—LEBEWRA S

334 R—TD 7> RO—ffZ2I—EXR—Z b

335 R—Y0 Y ROIFI 7]
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o 335 XR—TD TEEHRENFEDM

WESA X DERAE

IR Ty AINVERET D202, FEET A AT LA L TORET 1 > OFERGIEZBEEL
THLMENDDET, M13-31F. T v 7 DEFEERPOD 2 NFTICENZRE T 1 > DOFl %
ARLTWET, RET T WL —ORTERINET,
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AV

T 7V ORRE

007-2275-010aJP

Play Pos: Bs Cursor Pos: 7.856s 44,1688 kHz

185 1s 25 3z 45 55 G5

FZyv o OEEY

ICECEENi-imE

A
Play Pos: Bs Cursor Pos: 7.856s 44,1688 kHz
IIII|IIIIIIII|IIIIIIII|IIIIIIII|IIIIIIII|IIIIIIII|IIIIIIII|III
As X 45 55 Gs

k2w DERA
ICEEZNR
i

®13-3 WET 4 AT VLA LORET A >

WETA > 2REBET 5123, BRLCH—VIVeEE, XURDOERY > 27y LET,
DEIET, WMETA DA —VIWMIBIZEHONET, MET 1 2R OBFICBL & X,

HDBFRICTH—V IV ZEBEE, BEXIAOERY > &7 v LTLIEEN,

AEIRETA L LITOBHLZVWEEIE. K134 1TRTRAIF—ORY 2 2[HHL £,
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13-4 e o1 > DI EZFET 2O DKRAIF— - R >~

YooY rO—E%EERT S
YUK RTy s O—-ERELLZD, By b aE— R=2bLED. FHRSRELGAD
T3, £T. TOHSEERT ZLENH O LT, JOHTIE KOFMIOWTHAL £,
o 3RNR—=VD [hTv oLz

o 332R—TD [T v T O—H%EEN]

bS5 v o2EkEER

RSyl Rk ERIRT 21013, TTRTERIR (A K5 2220w s 320, [k Edi)) X
Za—h5 [TRTER (Select All)) 2BIRL ET, WIHREHS L —CHBERSNET.

b3Sy o D—ER%EER

w7 O—EzRRT 2123, WEEICH—VINEZEBNTIYTADOERY 2L, h—V))

2RIy LET, BERNAEFIEILROED TI,

1. WEECH—VIEZEE, XTUADERY > EMLET,
H—=VILBIZHRE T 1 > b £,

2. RURADERY VEHLEEEN-VINERTI I LT, EEOBEBRFARRITET,
BINLU 8008, 7L —TCliE RSN xd.

3. HHOEADEmAR RTINS, XTADORY > E2HLUET,

BINGEIPH OSEEE S REIXEIE LD DGRBS (Selection Start)) & DGERAE T (End)) 7 1+ —Jb

RICEREINET, 714 —IVRIEFEZANTHZIEICKXOD NI v IV O—Z2BINTHZEHT

=2F9, 2EAE bSurE 11 THEBL, 28 TRTI 5. HEIREEME 70—V RIC

1.1, TR T] 74—V RIZT28 EANLET., ANTSH-UNC <Enter> F—Z2HHL T2
W, HPHAGEIRINET,
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PI2R T 7 1 IVORE

Eb T, T<y T>)0 o> RYDEZFRHLT, BEDOH 2N BIRTEET, 25
DRY NZDNTIE, 338 R—=I0 DGERFEFI > bO—)b) 22 T Z3I W,

YUY FO—EZHIRT S

Y2 R - 8Iv I O—HEHFRT 2HEE. 5y b (Cut)l 2 THIER (Delete)) J< > RZ&{#
HALET, —HZ2UR->T. by 7 OENOERICHATZESE. Ty b a2 Bl KA
ICHIFRL THEIWEAET THIRR) a2 RafHL T<EI N,

1. HIBRT 285 2 EIR L £9

BIRL 28007 L —TCTHRHFRRINET, FficONnTIE, 32 XR—=YD Iy 7 D—
IR 2R T EI W,

2. I#R&E (Bdit)) AZza2—»5 1y b (Cut)l » THIER (Delete)] &EIRL £7°

o ERLAZHMpEYED, [R—Z K (Paste)] I<¥ > RE2FHLTT 71 IV DIFNDOEFFH
AT 28813 Ty b (Cut)) a7 REZERLET,

o BIRUZHGZANCHIBRL THIWEGIE THIER  (Delete)) I > KZEBRTH0
<BackSpace> ¥—ZHL £7,

AEERRLEZT D ZHIBRT 272000 RELT Iy k (Cut)) & THIBR (Delete)] 233
DETH, ThUL (Trim)] I KIE, IO 2 D032 ROMIZ, BRLZH0 LS ETN
THIBRL £7

Yo FO—8BEERZS

TFAD LT TLFHNZRERL TANZHIET 2 &, EHIREBOSTTHIN, AN LT
WCERASGNET, ZNEFUBEZFICOVWTHEFTEELET, ROFIETHY T > RO~z
BIRL, HEICENOODICEIAZ D ZENTEET,
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1. EHATZWEDZERL X7,

IR U 725N T L —THFAZRRINET, FicONVTIE, 332 R=2PD [Ty T D—
2RI 22U T EE N,

2. ROWTNNOEIEITHES T, BIRL 28 2 EWMA F T,

o ERULMADZEEITT 25013, THRE (Edit)) AZa—775 HHEK (Clear)) Z1ER
LET,

o BRLAEMHERHEDT—FT 144 77N OFICEBA WS, [7 7)) (File))
AZa—hs THA (Insert..)] ZZERLET,

o BEINLAZHpZHLWEST TEBATZVWEEIL. 327 R—=20 BEFEOT7 v IVIZEZE
HOATY] 2B L TLZ3 W,

YO RO—EZ3E—&ER—-X B
P2 RO—Z2IE—9 %I, aE—LEWHSZRRL TS5, HHEE (Bdit)) AZ2—0
aE— (Copy)) IX > R& [RX—=Z |k (Paste)) XY REMHALET.
1. aE—L7eWipzERL £9,

IR U 725N T L —THFAFRRINET, FlicONVTIE, 332 R=2D [Ty T D—
2RI 2B T EE N,

2. THR%E (BEdit)) A=a—n»5 a8 — (Copy)) &ERL £,
3. AE—LAEEER—ZANLEVWIEIHRES M Z2EEET,

MHEOE BRIy CERA WG, MET M 2 Z2MEHL T BRA W 22
WUET., WMEFT IOV TI 330 R—2D HRES T > OEHAIE 23RLUTKE
Ty,

4. THR% (Bdit)) AZ=a—05 [RX—Z |k (Paste)] ZERL X7,
=L WETA > OBERIEAINSD, BRUEZTICEEZINET,
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NIV a—Ta 2T

Ya—bhy b :TdE— (Copy)l & R—Z b (Paste)) IX > REMATLI2HDDIZ, O
E—L7ZWH T2 RO—HEBIRLTHSE, XURAOHFRY 27Uy 7 LT, hTv 7N
DOEFPFIIR—=A M TBHZEHTEET, A WET 1 B TIHRL, H—VIVLBEITE
REINET,

YOURDEIFXI D
Ty 272 Mix)] AXREHFHALT TO2 00D 2#ATHIENTEET, FIHITKRD
WO TY,
1. EhOEFEIFLTTEZITRESZERRL. HRE (BEdit)) AZa2—»5 M-
(Copy)) F£721& Ty b (Cut)) ZERLET,
FR U 723 —Rriz 7 ) w 7R — RICEAENE T,
2. T77ANANORDOF—F 1« A ERIRL £,
BINLU 8T L — Tz RINET,
3. [HR%E (Bdit)] AZz2—05 (272 (Mix)] 2RIRLET,
Hw NEZIZIAE LB OENBR LTS EIFI 207 INET RIEZTIETITE
MR (Edit)) AZ=a—05 MEEOHEH (Undo)) ZFEIRL T /Z3 W,
B ROER

[N (Effects)] A= a2—IZid, BHEREHRIREGZA SOOI ERHDET, 77— K-
A7 z—R-7U N $EHROEE Td—, HEEEOHETL E2TAET, (1R (Effects) )
AZa—PDIAX Y RIZDWTI, 344 X—20 TR AZa—] 2B8RBLTLIEI N,

seditor.trouble

cSTNa—-FTa20

ZOHTE, YUK - T5 1 & OFAPIC—ICE SN D ME &2 ORI DWW TEE
WL £9
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336

T 7 AN DO—HOeREFHAEL THEIHR N,

B LEORES A N7 7 1INV ORRBIZEBPN TOWEWNFARTLSEEI W, HET T VI3H
A ORBMEERL TWETS, £k F—F 17 - )%V (Audio Panel)] ZfWNWT, &&
FEIF D44 D Headphone/Speaker | L NIV 2S EDHIZIR> TS Z &R L T2
Iy,

[F—5 1% - )XV (Audio Panel)] #B<IZIE, T2—F ¢ UF ¢ (Utilities)] A=a—n»
5 [F—F 1A« )X%)L (Audio Control Panel)] EWSIHHZRIRT 20, [H—F 14 -
JN%)V (Audio Panel)] EWD IX)VES57 U w7 L TLZIN,

TRERRNIZLTVWSDIZ, EEITNINWETHREIND,

LX)V (Level)] A= 2 — D F&E%E EF % (Louder)] i3 5. /213 NEH{E (Normalize)]
EEALT. BBWIZEEL XU T A4 F I 07 - LoD EIIZLTLEI N,

BREZRKICL TSI, EFIIREVWVETREIND,
ML X)h(Level)] A =2 —DIF &% T 5 (Soften) | 2 L TSR EFEICL T Z3I 0,
HIBR L 7238000 2 R— A R T&ERW,

TR (Delete)] % L CHIBRL 728050132 U v TR — RICEES N E A, By k-7
K- R—Z MEBEAER. 5T Hy k (Cut) ZHEALTES0,

HINEINS,

[F—F 1 « )N%JV (Audio Panel)] ZBWTLEE W, £=% (Monitor)] RY 234>
RS> TWSE, HFEFOFEVS LLICIEOBFNHMIAET, MEA<AVWERIR £=
H1 RYEFTIZLTLEIN, FT7I2T5E, FWFovI—UMNEAET,

[F—5F 1A - )N%)V (Audio Panel)] #B <23, —7 ¢ U 7 ¢ (Utilities)] -> [F—
Fa A a2 ho—)b - )3%)L (Audio Control Panel)] EWHIHHZRIRT 50, [F—
F 4% « )NFJV (Audio Panel)] EWS TNV ESGZ Y w7 LTLEEN,

A7 OT 4 NS EETERN,

FI, A0 7 5207 =T IHELEHRINTOUDDHFANTLZS WV, ZOMERER
Z7z5. IF—F 1 F - )X%)V (Audio Panel)] ZFWT, AV —Z& LT Microphone]
MBEBRENTVDNHERL TLEE W, o, HRZHEITLLELD Input Levels) 71k
DHITHESNTND I EBMRL T ZI N,
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BUZR - IFT48 - T 1 ATLAIZDONT

Audio Panel ZB < iCid. T2—7 ¢ U 7 ¢ (Utilities)] -> [ —5F « 4 - /X% )L (Audio
Control Panel)] EWSIHHZRIRT 20, [F—F 17 + J)X%)L (Audio Panel)] &5 5
NWVESGI ) w7 LTI,

seditor.display

BYOVR -IF49 - TARTUVALICDNT
ZOHTIE, KO 4DQHIHIT, $UZK L5718« T4 AT LADI> ha—)LZDW
THWALET.
o 3WR—=TO MEFarbo—)LEHETY FO—)b)
o 338R—=T0D [X—=AL a2 hO—)]
e 338 R—TD NERHFI> SO—)L)

o 338 XR—TD IJEERiEE]

g¥arbo—-iEBEarro-i
> K+ 5 1% (Sound Editor )] W1 > RU® EFICE, HEOREEY IR - T7A1))
OEERADRY >Nb D ET,

[$%3% (Record)] 855 (Record)) #7 VU v 7 L THEEMALET., WMET L MEITH LW
F—F 1 FWHNERSINET,

Ik (Stop))  TPELE (Stop)) B2V w2 LTRERKTT B0, £23F92 K- 77110
FEEEIELET,

[F4: (Play)) (H4 (Play)) 2270y 27 LT, B2 R T 72K, £23-HOHEE
PAIEL £9,

M55 U (Repeat)) TH#Z L (Repeat)) 22V v 7 LTHI 2R« Ty M)V EEELUEEL £,
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BBE: VIR IF 1%

X—A-arbo-i

(1> (n)l . T7T bk (Out)l . TR (Selection)] 7% > ZEMHAL T, EHERELEETEET,
B EMID W TERRTDEEE. 12> Un) 270y 7L TLEIWN, (7O &7
w9 dE, KREBKMES TEENERINET. HER) 27U v 795 &, BRI ZH
H—MICHERFR L £ 9

HEIRGEHE I O

BEPEHF O POV R 131 ERTEIBRY CRHVET, TNS5ORY P Z2FRL
T, EREFSRET 1 > ONEEMRBETEET,

® 131 EIREF I ho—)L

Ry ke

FULK - by s RRERRT 5,
FTRER |

PR Ty OFEE TRRHEFEZ

|_<| IRV %,

SRR DS &R B < BT B,
I - [

YR Ty OREGEE TRIRHEFEZ

] IR %,

BERR RIS

WREEREY A LTA EHIE. BBNWTWBEY YR Iy ANV 2R LET, Y1LT712DE
IZid. RDO4DDT 4 =)V RABHVET,

ME%1 (Time)l 7 7 1 VNOBHEOME % AL £7,
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YR IFA DA 21—

[ (Selection) FRIRAGE 2k L £ 9. M ZRINL TWARVEAILRET 1 > OREERTH

'L — b (Rate)l

[Position]

HOUR - IF49DA=a—

ZOHITIE, KD 7 DOHEBIHT T, YU R« IF 4 YOKBA 2 —ELI 2 RIZDNT
AL ET,

2741 A=a—

007-2275-010aJP

339 X—T D
341 R—T D
343 R—T D
344 R—T D
345 R—T D
346 R—T D

346 R—TD

F1DITHRDET,

T 7 AINVEREROY T - L—bhERLET, Y2 7)b - L— M E0nIEE,
F =T 4 FDBEENILBDKE, T4 A7 DERREIRELED £,

A LTAHNDHI—IiiEzERLUET,

M7 7)) AZa—]
MRl A=a—]
MyN)h) AZa—|
MR A=a—)
MER) AZa—)
MERE] A=a—]

Ma1—F1UF1—) AZa—]

39R—=ID TR IF 4 DA a—] bSBRL T ZI W,

[774)) (File)] AZa—@a<x>Ra#EHALT. HilWT v IIVOEK BEEOT 7LD
F—T 2 RRE FENOT 7 ANV OBUAHRIR EDBIEEITI CEMTEELET [Ty ANV AZa—
WZIROaAR > RMNHDET,

3O R—=TO TTHH ... a7 K]

340 R—2 @ ML .. a< 2 K]

MqOR—=TD TTHA ... I3 K]

339



BBE: VIR IF 1%

M#...1 A< F

< ...0 A<k

M&A..0 A<k

MMR#E] Ok

340

o 3MOR—IO [MEEFE] ax 2 K]

o 3MIR—TO [MHIARE .0 A E)

o B3I AR—=T0 MHEEHMAZRF .0 AR
o 341 R—=TD [T IZDNWT] a3 K]

o UIR—TD KT a< > K]

FLWF—F1F - Ty A IEERTZDEZIMENET, HFLWLWT 7 AIVICHEAT S > T -
L=, Fr o O TNVIEBOIREERD DY A 7O - Ry I ANFRINET, O
a2 ROBFRBRERFIEIZONTIE, 325 R=IY0 [HLWT 71 IIIZEZEGATD) 250
LTLESN,

BEOF—F 14 - 77 ANV ZHA ESITHEMRLET,

BHERNTWEF—F A - 77 A INVICHIDOF —F 1 F - 77 AV EIFAT S LEITHENET,
REAX, YUK Iy I OEBEICEREANTZWEEIL EEOEEICHRET 1 > E2EN
T A ..(Insert.)) Z#BINLET, Z0aT > REFHL T, BRESZHOFICERZ S Z
EBHTEET,

Ty AIVICMATEREEZRET HESIIHEAL £,

YU RIF 43, TXRTOT 7 AN EEMBRLD AIFF RO 7 v AV ELUTIRELET,
BRBHZEADOT7MIVEHAL TS, RETDEZITETDNT v 7 ERD AIFF ERICE#H I N
£9, £z, BR3P TNVEEF D7 v A NVEBALZEBEIR. 771 IVORERHZ, T
D77 AINDY T IVIEN, HBIENT > TIVIRIZEDESNET,
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YR IFA DA 21—

rAM&RE...l A9k

FLWT 7 MIVICEHT 2T EE, FRUEFECT7 7 MV OARTZAEET 5 EEIHALET,

MEEEEZHFEF...1 AT FK

BN 27 7 AIVICRET D EZIHNET, 1 D0F—F 14 - Ty ImsEVY T 2R
HEERERTDEZITHHAT D EMRTT,

M..IcoWTJ] a2k

AL TWE SO I LDN=2a  EREFRRLIZWVWESICHERALET,

M&Tl1 avrk

YR IF A I TOEEEKRAT, 77— a2 T32EZIHEALET., 771
NWEEBELEBERKRTHNIC. ZOEEZRET D0 T2BMETIAMWEDERH D T,

MREl A=a2—
MR (Bdit)) AZa2—0axv > RaffiAL, BRLEZHIOH Yy b, aE— X=X ET5Z
ENTEET, L] AZ2—IPROIY > KNHDET,
o 3M2XR—=TD IMEMEDOHEH / BEfT) a< K]
o 3M2R—=TO [MHhy ] a7 K]
e 3M2AR—TQ [Mar—] av K]
o 3MR—=TD [MR=Z K] AT K]
o 32R—YD M2y r7 ] AT K]
o 32— ML av 2R
o 343 RX—0 [THIER) a< > Ry
o 3M3IXR—TD [MTHhULA] OX K]

o 3M3R—=T® MYy T R—-KE2ZEZ a3 K]
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BBE: VIR IF 1%

MEFOEUH/BXR1T]1 2%

Thy bl A=k

ME—-] a<erFk

[R=ZRBFJ] aATVE

N’y X1 Ak

MEExl aevk

342

o 3B3R—TD MINTER) a7 K]

K4

BRIAT O T BEZROE T EEICHEAL £, 223 Thy b (Cut)) IXREMFEHLTY
U2 RO—EZHIBR L ZERIC HEEDTGH (Undo)l ZERT 2L, TOHIFRZEIHL T, T
WWRY ZEMTEET,

B2 RO—HEHIRT 20, £RFIEOHSET TR - bTy I OHOMBEICBEIT S EE
WAL ET, BRI NSHEAT, —RHWIZZ Y v 7 R— RICEAENZDT, [R—=2
k (Paste)] I~ > RE@HHALT. 771 IIVNDIENDOHFTICRA—Z N TEET, BANARTIEIC
DWTIE, 333 R—=0 > RO—FZHIRT 5] 22RL T LI,

U2 RO—-EHOIE—2ERT D EEIHENET, aE—F MY v 7 R— RICEAE
N5DT, [R—=Z K (Paste))] A REMHL T, 771 IVNDENDHHIIR—ZX N TEE
T FHNICDNTIE, 334 R—DD B> RO—#HZ2IE—-ER—2 ] 2BRLTIZI 0,

73 & (Cut)) £7/21& TaAE— (Copy)l AX ROBRTHEMT ST RTY, 77U v THR—
RS RERE > 25t U, S LENEERET 1 D MEITHAL £,

M3y b (Cut)) £ TOJE— (Copy)l AX > ROBTHMATZIYRTY, Ay bEkF
AE—-L7TEHERIRL TWaAEHnEIF OV TEET,

BERUEZEFICTLESITHMALET. BRI OBENR< B L IITRAXT.
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YIUR IF 4 DAZa—

MgIgg] a<> kK

N VWA = I 7

YR NI NSRBI ZHIBRTDESICHEMAL XY, +—KR— KD <Back Spaces>
ZHLUTHEEETY,

AE GBI E THIER (Delete)] <> RTHIBRL 7286, TX—Z  (Paste)] a2~ > Ridff
AER, YU RO—FZHIBRL T, 77 A IVNOE»OEFICHBEITLZHEEE. Thy b
(Cut)] O REFHALTIIZE W,

BERER LN DT X TZHIFRT 2 ESITHERL XY,

[YVy7FR—F£2IC] A< R

MAXTER] a< R

ryN] Az=a—
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Y2 RO—EEERL T, [Hy b (Cut)) £7213 TaE— (Copy)l IV RZEHHLEEA,
Hw MEZRZIAE-LETSENES5T Uy TR—RICEAENET, [RXR—Z K (Paste)] I
XRUREHEHT DN, YXTAOHRY D EHTI LTI, 2Oy TR—RONEET 71
IWNDIENDZFTICR—ZA R TEET, LD, Z7U v T R—RORNENHIFRIND Z &iF
H0ER .

Uy TR=BFEDTF—=FF, TARVEEBITIZATL - ARV ZHEHLET, 71 AT D%

BT D R VREET, KE At —F 1+ F— 5 F A — LBt Rk (Bdi) A= 2—
m5 1271w JR—RK&22Z (Empty Clipboard)] I< > RZEZERL T ZI W,

TR (Select All)l FY > ERUBEEZT AT RTT, FU2 K- kv s eked
Eo<BRTEET,

X)L (Level)] AZa2—0aX > REHHLT, Y7 EOZFEEZMAGHTTEET, LX)
(Level)] AZa—iZid. RO RPBH O ET,

343



BBE: VIR IF 1%

MNE#HEL] A< K

EE%TIF51 a< R

HEE8%LlF51 a7 F

o 34 X—T0 IMEHL) o< K]
o 3AR—TOD [THEEZ TS AT K]
o 3MAR—YD TFEZEZ LTS ax > K]

o 34 R—TD ML NRJDOBE ...] AT K]

BRUEHEDPOEDL NNV ZETI - T4 F Iy s - LD ETERY. 771V e2fkoEigEz b
o &Zid, T RTEIR (Select All)) =20 v 7 LTS TERE (Normalize)l Z3ERL TS
ZEW,

R U OERE T ET. 77 1V hkOBRE FIF53 & 213, [T TER Select All)
27Uy LThs TEEZE TS (Softer)] &FEIRL TSN,

BRUEBHOERE LFET, 77 AL 2KOERE LT 5 E X3, [T <TER (Select All))
B2 w7 LTHS [ER%E LTS (Louder)) FEIRLTLE &0,

LRI ORE...] A7 R

¥hE] A=a—

344

BERUERrOEEZERICHET T2 ESITHEALET. HiILWAT—IMEZANT 572005
A7 Ry TANEREINET, £EAF, HEZEZS0% K< THLERF. 1707 - Ry
Z A .50 EANLET, WROEmINENMTRD LT,

BN (Bffects)] AZa2—@DIa > F%ﬁ}ﬂb BRLAEYY D REIEIHICA(LIEDLZ &
MTEET, R (Effects)] A=2—I2iF, KO RBHD £,

e B45R—TD [MTxz—K-A12] OITH]

o 3U5R—=PD [MTT7x—K -7k OII2 K]
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YR IFA DA 21—

o 345 X—TYp MTad—) ax> K]
o 3USXR—TD [MTYN—Z] ax> K]

e 3USR=TOD Y FORE ...] ALK

7xz—F-a421 392Kk

BN U 7280y DS O & B2 BEREN S lH O L NVTRAZIZET TWEET,

M7xz—F-79k a9k

BRI ORBOEEZRLZITNI T, BEIZLET,

frra—J] avrk

BIRLAZICTO—2NTET,

TyYN—X1] a<w>vRk

R 72 H 2 W5 HEL 9,

EyFOEE..1] A9 K

ERUEOEBEKR, £LR3EEZERICHS T2 SITHEMLET. LA HEEERE 2
BIILT, Y2 A= a > THEDNDEIREFCTIHEE. RESn2¥1707 - Ky U7X
I22.0 EANLERT. BIROKRSIIEFITRO XT,

/K] A=a—

IR (View)] AZa—@ax > REMHL. X—AL 12 =L TT bk HEVIERED
WA TA—L - A2FTHIEICLD., FROFREEFETEET,

[F£R (View)] AZz2—IZid, RO RBNHDET,
o 3MeR—ID [MX—=L-A>] OXTR]

o 3U6R—=TD TX—=A+T7TIhr OXY2K]
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BBE: VIR IF 1%

o 346 R—T D [TENHFFHE X —L]) I K]

[R=L-A4v] AR
BREMN VRS TR RT D EEICHEALET, BEEEZESTILEIC. YU RERS
IHRETEET, 12 (In)) RY L ERUCEBEEZT 2T RTY,
[R=—A-FDr] ATV E
FREREVKES TR RTDEEICHEAL LT, LHMHOT 2RET 2 & SIHEFTT, 17
7~ (Out)) ™7 EFRUEEET SO RTY,
MERGEEHEX—A] ATV R

W —FR RIS 23k L TRAR L KT (IR (Selection)) £ > EFUBIEET 7> K
T

ME&E] A=a—

[FTE (Settings)] A= —IZid, ROIAX Y RAHD £,

o 346 R—ID [MF—N—FEITHEE—K) a7 K}
[(F—N—-FEXIEEE—F] AT F

HLWEZIDAAT, BCREFAHADOEEIF IV THEEIMEHL £, FMlIcDON T,
RIR—=TD [TF—N—FETHEE—F) A REHEHALTFL—2 3 > 2H0A8) &5
LT ZE0,

1—-F4UF4—] AZa—

[—F ¢ U F ¢ — (Utilities) ] AZz2—IZi3, ROIAX > ERHVET,

o [TF—F o))V a7 K]
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YR IFA DA 21—

F—5F44 - KXxJ] AT R

TREFABLEZD, AWV —ZXE2BELZDTHLENSDGEIHEHLET, H—F 14 - X
*JV (Audio Control Panel] OffNVHIZDNWTIE. [F—F 14 « )%V (Audio Panel)] ® A
W7 (Help)l Z2ZHRLTLZE 0,
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8% A
Video Panel

ZOEIL, KON SRS NTNET,

o i) (349 R—2)

o [EFHEEOHME (352 XR—2)

o [FT7Ta>OEFH - R— RKEHIT Video Panel 2T 5] (354 X—2)
e NEBDAASZMAT S (357 R—2)

o [VCR®EFH - hATZHEKT S (358 R—2)

e (U2 RUREFTFERRT D] (360 XR—2)

o EFFRITIT14 v I RA%EED] (360 X—)

o (VI T74 v REEFAHIIFEMEESD] (362 X—2)

o [AXZRTEFH - 7L —LZE2MALKEET S (363 X—2)
e [IProPanels)] Offif] (364 X—)

o EFHKMTBRI TN a—TF 127 (369 X—2)

Vcp.about

=

ZOHEIDONEIL. TVideo Panel DEERE] (350 R—70), TEH G #E] 350 R—), BELY
TNV T DELEE] 351 X—2) MoK EINTHET,

007-2275-010aJP 349



{18% A: Video Panel

Video Panel D#EE

ERAE : HE

350

Video Panel IZ1&, T—7 X5 —3 3 ViR L THDET I OMRENTRI N, EF A1
ROBREEZFHTEET,

Video Panel 13, 7z & 2RO XD ICHIHTEELT,

o T—URAF—3 3 IZEREINTNVEHATRDVCR NS DESZHIEIL £T
e AHMNEFTHREREORBEZHAMLET,

o EFARTITIT4 I ARBETAT—TITHEDXT,

Video Panel L T. 7—J X7 —a VIZERINTND VCR RETH - HASKRED
EFAHGNS EQOLDIBREEOESNADTLSdNE, T—URAT—2a IiBAbH I ENT
ZFET, V-V AT—3a IZVCR 2L THHHEHIE. VERMNSDANEEN -7 X
T—=2a iMfFEo TNBEFTEHTELITY A I T EINDHENDH D £7., Video Panel
ZHEALTESZHAGIL. FEHEEZOY I LTEDETIEI N,

¥7z. Video Panel I3 £ E/R [T 07w at izl RENDHD, TPHIVES. 2>
R—=%> b 7FOFES ARy b - 7IOTEEREDEEORELHALHITEET. &
BEREEORATERET LT~ AT — 3 L ERELES, (70 (Pro)] AZa—
EHEALT. FUYIEERTFOIERIIZI ORI A VIR EOEEEMAET,

AE: ZOXZaTIHTO MEE (save)l EWIERRIZ, EFARREBT ST v I ARV R
ThTAAT EDT 7 AIVICRET DT L2 BRL £, [MnzE [FEk (record)] 9% &3,
EFt, o974 v IR, £RBZOMAEET AT —TITHET S I ETY,

Video Panel Z1FNDAF 47 « 77U —2 3> EEbBTHDZEICED, F—F 1 FE
FHADOI )y T A—E—ICHAALT, V=V XA5—2a> ETHALEZD, ES5AT—7 128
WTEEXT,

EAF WZRILENTWDE AT AT « V—=IUNTRDEDITHEET,
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W

ANIVTDRERE

007-2275-010aJP

Video Panel & I —5 1 # + J3*%)L (Audio Panel)] 2> L XIZHEHAL T, EFAF4—
FAADOANEEEHFHL £7

Video Panel] ®Z )L %%~ U v 7 LT Video Panel R & £9, [F—5F 1 F - /X%
(Audio Panel)] ®ZX)V&27 1) w7 LT IF—F 1% )%)) (Audio Panel)] 2 & £97,

AF 47 - LA=FZEZHFHL T, BRAAKLETHEI AT L - T4 AVIRELET,

AEI AT T - LO—FEFHT B EE, Video Panel Z#FH L TANT/INA X Z1EIRT
DI ANT AR EDHZEZFE L2 & =272 Video Panel Z#NET, [TH
INT VR DHEFE] G57R—D) Z2BRLTLIEI N,

Movie Maker ZfEHIL T, RFLTHE2F—T 1 FLETHZMERTZOMELZD L X
kR

E5ad5—7ICA—E—2FE L WA RETO L ZDHRZIZH S 1 & Video Panel
& IF—F 1% - )X%)L (Audio Panel)] ZfHL T, VCR & DBEHAOHIESZFHEH L
TREZIWN, TETFHIT T T w7 A%%5] 360 R—) 2R TN,

Media Player 2L C. #lfEFEADOL—E—&2T—I AT —2 3> ETHALET,

ZoRZa7)NE ROKRLEZFHLTET,

FBHRTRINZEMNEL, AHEOMOE, i, MEXZBHEOERANDY >V Z2RLET. &
EZE =L L—b] 22Uy I LET,

IRTERINTVD LTI EFN) >V ZRUET, ZherUyrd5E, TOHRTD
V=)L EIL £, 7z& XL, Media Recorder 27U v 7 LET,

AZa—#HEAZ 2 —HHOMIZH S [->] DRLFIE. AZ a2 —IHENOZERNAZRL X
9o 2EZE T771)b (File)l -> [BA< (Open)l 1& (77 4)V] AZa—ZWTHE,
A< ZBIRTDHENDIEKRTT,

Vcp.menus

351



{18% A: Video Panel

EFH(ES DAL

F 72 alDEFF c R—RBA A=)V aniz 02 Z2H L TW3BHEAE, Video Panel Dff
AHEDOFHMIZDNTIE, O2video(7) U7 7L 2R (X)) R=VZEZRBLTILESI W, T
2a OEFH - R—RPA A M= INMOFEEDO L AT LAZFHL TWEEEL. 7
TarOETFA - R— R EHIT Video Panel 2T %) (354 R—2) ZHHL T /Z3W,

AZa— - N=MN5IDIAXY Y REFALT, EFFTEBEMETEET. JOHIE. KOEM
SHEINTHET,

o [IT77A4)) AZa— a2 BROfH] (352 X—2)

o [IFNARZ] AZa—0ffif] (353 R—)

e [ProPanels iIZDW T (353 R—3)

o MEFTH A2 ETETH T I I—FT1UT 1 OfFH] (B53X—2)

Vcp.file

72741 A=a—-2a%Y ROER

352

[774)) (File))] A=a2—DIax > Bz L T, Video Panel NDFHRESCHT ZREF CEXT,
[BIE DR E % R 77 (Save Current Setting)]
Video Panel > b O—)VIZMA=Hfi#RETEET, INHOHFHIED
EFFANRET AN bETINET,
MERTOFREIZRY (Restore Setting)]
Plaiic THAIEDFRE % -7 (Save Current Setting)] I~¥ > FZfH L THR#E
LEBEIEORECRLET, 20aAY RE2MAL T—RKRMICLEEL, /27T
DFBEWCRT ZENTEET,
TR D% E ICFE 9 (Restore Factory Settings) )
THHARFOREICRL X7,
&7 (Exit))
Video Panel ZFAU £7,

Vcp.device
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[FNAR] A=a—0DER

[FNNA X (Device)] AZa—Id, BFENOT—IAF— a3 iT#ERINTVWEE T a>D
EFt i D—E &K RL E7, Video Panel ¥ EZEH I /20T /NA A& BIRL T ZI 0,

Vcp.pro

ProPanels [CDW\T

70 (Pro))] AZa—IZid, JOOI—UNEFTFHEEERAGTH2OORENH D £, Pro
Panels THEAWEERA T a2 id. N— Rz 7k, SAFTLZTERCREROET, 723
COEFF « iR— R EHIZ Video Panel 2T %] (354 XR—2) &ML TL7Z3 W,

EFHEED

=

HiDOFERIZ DWTIE, [TPro Panels] D1 (364 R—) HBIL T 7230,

T

Vcp.utility

TETH 421 ETEFH 7Y A—-T 4 YT 1 DER

[1—5 ¢ U5« (Utilities)] A=a2—DaAX > REFHAL T, MORAALEETHEEEZT 1+ A2
WWRIELZD, ESF T —7 1B L0, Audio Panel &89 572007 ) r— 3%
EETEET,
[Z4 7 - E5 4 AJ7 (Live Video Input)]

ANEFHEBZE, F5971 v IR B2 EOT 1 > RUNIKERLET,
IS4 7 « ES A7 (Live Video Output)]

TI3TAYITRFZIMNS, TLERVCRIZV ST v I AEHEDET,
[F—5 1% - )X% )V (Audio Control Panel) ]

F—F 4 F AN I L= EHET 2200, [F—F 1% - )X%)) (Audio

Panel)] #RHE %9,

Vcp.optional
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{18% A: Video Panel

F7arDOETF - K— K& H#IC Video Panel ZERT %

Video Panel i3, # 7> a>DEFH - h— ROFBEICL VD REED FT,

e Indy Video. Indigo? Video %713 Galileo Video Z## L 7=> AT L% MM T 5HE.
NEOR—=RIZDOWTOFMIL, RO 3 DOHizEBFHA LT W,

o LEUADTTTarOEFFEREE LI AT LEFHAL TNWSEE, Video Panel 2B
LT 20ETH - 72 3 VITHEOHAEFZSHML T /LS, BET2Y T 7L 2R
(2) - R=2, 7z& &I, o2video(7) £7-13 octanevideo(1) HLBTE £ T,

N=RT 7 QHHAERRDONSIBNGEIL RO Web U1 M7 7 2RI HELNWTL &
Do
http:/ /techpubs.sgi.com

N—RD =7 OFFIZIE U7z Video Panel DEHIZ D1 Tid, Video Panel Update Web X —
THITELSLEE W,

http:/ /www.sgi.com /Products/SGIHelp_Hub/Videopanel. html

7 RINAL R : [TProPanels] Offifl] (364 X—2) Tk, E5A - X))V EOa> hOo—)LDn
KOMITDNT, TIL7 7Ry MEZHALTWEYT, > FO—IUITATFALEETF - R—
ROMHEICE VBT D20, ZO—ETId Video Panel > hO—)L 23N THEEL SN EE
DS, BEIZLTLEE N,

Vcp.option.device

Indy Video. Indigo?Video. 7=(3 Galileo Video & L/ AT AD [FINA R ] FaEk

[\ R (Devices)| fEIICIZ. HEDETAANZERADD IOV I NI T E2RET D

O hO—)VENH D £T,

601 A7 ar -r>avy]
ZDRY 1d. Galileo Video 1.1 ZH#E L T —V A5 —2a > THAET,
CCIRAA I T oy /EflE—REFHALTWSEEIZ, ZORY
AZF v IR—DEMTFHEEEMENMEL ET,
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F 7 aOEFHF - R— K &3IZ Video Panel Z 9 %

[FTAE - A JANEENTOINETFOTDEEENTHEIMERELET,
[FT74)V b - 7O MHAEENTIOIINETFIOTDEESNTH 2N ERELET,

AN% 4 3>V (Input Timing)|
BEIAIDITNET AR LRI EDITERL £, NTSC. PAL.
CCIR 601 2L Ty,

M (Sync))  REFAHNIHT DA77 - V—R%HBELET, EFFHNEANE
FIFEMESEZD. N= RO 7 PHSEDSY A 2 27 2 NI ETE DK
2L Y, W (internal)l . AL —7 (slave)l . 77> 0w 7 (genlock))
EHRLTLZE N,

oy 2« ) —XZ (Genlock Src)l
FAIDTEFEDOY—X&eRELET, IFHH (Sync)l 2% slave (AL —7) %
7zl genlock (7> 0w 7 ) ICRESNTND EZITLETHHTY,

Vcp.option.input

Indy Video. Indigo?Video. ¥7:I3 Galileo Video ZB#H LR TLD [AH] fals

[AJ7 (Inputs)] fEITIZ. ANEFSZHRHHETEET,

VIR i20 v 7 (Lock to VIR))
J—27 A5 —3 3212 VCR &L THHHEE. VIR ic0 v 7 (Lock to
VIR)) A& >%&7 Vw7 LT, ANMERBERENXLET, Thick> T, BE
NEELET,

MAJE— K (Synchronizer Mode))
EFRzWwosLlxiclTay L, ANV —RAZERLET, Indy Cam L7z
MOETH « HAZTZFEAL TWSEEIE, 520y /T30 EITIHD 18
oo

['AJ71°/) —Z (Input Source))
ANV —=ANSREENEERTE—RITLZET I ETERRLET,

Vcp.option.output
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Indy Video. Indigo?Video. ¥7:=I3 Galileo Video Z&& L/ XFTAD MNEH] FEEE

M) s T, HHEX2#RTEXT,

VIR 120 % (Lock to VTR))
VIR 120w 7 (Lock to VTR)) R& > &7 1) w7 LT, ANEEERELLE
9, ZRICLo> THENMEL £7,

e 7 )L O (Pixel Format))
J2R=F2 b - EFFREERIE 7 BN BERERIRL £T. BS540
SRV Y S ETFFOHE. BN BERERIRTZLEEIH 0 EE . H
FBED YUV & RGB 2L TL/E3 0,

A% : Indigo? Video Z#E# L 72> A7 L Tld, /X3)LD [ (Outputs)) 8 TE 7 LR
ERHTE 5L ST TOEEA. Indigo? Video 1013 > K—% > b+ EF A5 b X
B Ao

Vcp.singleframes

U - ZV—LDOFRE (Galileo &V Indigo?Video R— K DFIA)

HxDETARTTT v IR TV —LZELERT 5720IT, Galileo & Indigo> ETF « A — R
IR BUTANDBHAENTHET, PUTEKICIE, 7290 - R—hDF1 > ZBLTY Y
TATEXT, ZOR—hCE RO 2DDSHETHEHETEET,

e Galileo 601 ¥¥# )L - EFH « 723> - Ry 7RI, trigger-in BNC J3% 7 ¥ % i ]
LEd,

e 601 AT Tar Ry IREMHETIC, NUT - T7HTY - r—T)VEfHLT, FTI%
Ve R—hMCEEERL L. Z0r—7)Wd EFH - R—K - 3723 ViCAHENT
WET, NUN - THFTH - =TI A> TN 5EEIR. &0 OWGEENTR—
NMEYSE D S R THERD W £ T

~ U BNC %7 % %, Videomedia, Inc. ® ALIX R 7 2%, [AZ% D VLAN £721% IVAS
SHTI—RA Ry I AREDAF T —A « Ry 7 AT B0, T3, #@YSRED
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MEBDIIA S ZENT S

ChO—ZiZERELET. Hhaxs&Ii2id. @%. [GPIO) DI XIUBMHNTNWET, fRED
CRO—SOFRFIEICDONTIE. ZFOHEEI FO—JIMNEOFHEESRL T X0,

Video Panel @ [Device Control Pro Panel] Zf#H L T, ZDii&kIicxd 2 /)L 2 Mk, F45
NOH - A1 2FF BE T IV ROa>  O—)VEEIRLET,

Y—RNN—F 4 OT7 TV —2 3> 2IFHAOEEIE. )b - A< K [vidtomem -t] %
FRALT, R—RMWEI > MO—InS N HEEZ2ZR o ESICEEZHABITET,

Vcp.cam

FEONASZERTS

TB/NS 2 R] OFE

Camera Videol

007-2275-010aJP

T—=0 AT =23 VICHAATIMNEL TWDHE. ROFIET, TOHAITNSETH AN EZ
BIHLICRETEET,
1. AASHNU—=DAT—2 a3 YREICERS N TWDS Z L2 L X7,

2. Video Panel EC. 57 )l ;A (Device Default Input) | A=a1— + R"F > ZfFHL T,
(71 A « ESF (Camera Video)] ZEIRL E97,

TH/NZ > A (White Balance)) (&, HABRZREL £9. ZDO/)NT > AETHHMRHT R E G H
TID, TNTNORBICEDLDETHHILZNWI EBHVET, ANT RAEFAMHT DT H
ATOL > RIZHME T 7IRET THINT > X (White Balance)] R"¥ > %2271 w7 LET,

[Cfi: [EE)- i

NT—=FARTVLA, v v —AE—FOEHE, JU—X T —LA- 22 bO—)LOfEH,
B2 N IR NOFEREOWFAEEITSITIE. TCamera Videol I hO—)b - )XK)L %
kg, 70 Pro)] X=2—»5 [Camera Video) ZEIR L. A =a1—_E% [Camera
Video) 22 hO—)b « WRIVIZHEHAE T, Pro Panel D7 1 —JL RIZDWTIE, [Pro Panels]
Ol 364 X—) ZBBLTLEZI N,

Vcp.equip
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{18% A: Video Panel

VCRPETH - hASZEETS

F—=TIVDOFERICDINT

358

VCR. VIR, F£IZETH - AT 2T =TI A5 —3 3 ITHEHT 21203, ROFEICHE> TS
EEn,

o HYIRT—TINEFEALEY ( (=7 OBRITDONT] 358 X—) &),

*  Video Panel 2L T, EF AN S DA NBEHICHEDEZFEEITVET (IO
ftl (359 X—2) ZBE).

EF AR E T~/ AT = 3 VI B L&, YRS — TV EBIRT 50, TOET
AHEBEVEHTESOMEZH > TELENHDET, $R-—FLTWD 4 BHEOETAES
COVWTRICHIL £ 7.

ARy k- 7Foas
FEAEDHED VCR RET A - W AT RY Yy MEBZREL XY, O
CIRTYw MERRIIT— PV AT —3 3 VICRCAT—7 NV ZEFAL THERL X
ED

S-video (Y/C) EFEEAEDEFHED VCR PEFH - T AL S EFAHEEZEZELE
T, SEFAIL. BEROIIF R (WE) kol rnIF> X () finz,
YECOMERDTr—TNTERELET, SEFTADIARIFIIY/CIAXIH
EIEINET, S ESF AT, SZDIN AX 7Y Z2FHLTT—0 25—
T a iBERELTL/ZEIW, S-VHS ®© Hi 8 mm 57— 729 % VCR s
FFEAE, SSETF ORI I EEHELTVRET,

a2 R—=%> bk T7FOr
BREOETAZHIIET 22007 OAOKBICHEONET, J>FK—%>F
BEY. BNCOR I FZMHHL T —I A7 —2 3 VTR L T Z3 W,
A R—=%b - FPH)
FREOET A EFET 22007 OHOMERICHEbNET, a2R—% b
BEY. BNCOR I FZMHHL T -7 A7 —2 3 VTR L T E3 W,

BNC. 2= DIN.RCA YT —7INI AT TVEEAIZO S E 2 — Y DRFEETAFTEET,

007-2275-010aJP



VCR®ETH « WA T &H#wT 2

HIRDEE

007-2275-010aJP

VCR. VIR, EFF - AT ZHHT 2 EEE ROFIMEIHE > TS0,

1.

EFA 2T — 2 25— 3 >DIELWR— MIERRELET,

EFAgz ) —V 25— a VICERT D FRIEICOWTIE, 87— X57—2 3 > OitH
EEBHLTLEIN, YATLARETH - F 723> - R—R2E#H L TWEEAEZ. E
FAREERE AT T 3 > DR— RICERT B HEICDONVWT, FOF T a - R— ROFHE
LT3N,

Video Panel 73BT W/ WIREA, RETERIN/= Video Panel OB > 727U vl
LCHEET,

(74 k1> (Default In)] A=a—-RY E2EHALT, T 74V AN ZERERL £,

FmEZE VCR Z2H##KiL THHHEIR. 774V bAKELT 7585 -V —X (Analog
Source)] ZERL ET,

WY TANEA 20 (Input Timing)] A=a— - Ry CEFHL T, Z0OET AR
T 2513 > HEERRL £,

EDITAIITRBNONSBVERIE. FETAREOHPFELZ T LS, Xk,
NTSC. PAL. 723 CCIR 72 ED. TR EOMEZEZI U v 7 LT OMNAZRRT 5 &
HBTEXT,

FAIDTERBERTLEE, RETARBOETARBEORBICELY T DA 1— - Ry >
EHEALTIIZE N,

EFFEBEDOHIIZDONWTIE, (7 —=F IV OBIRITDONT] (358 R—2) &ML T 723 W,

VCR 7213 VIR IS TV 5HA1E. VIR E— K (VIR Mode)] Fx v 27 Rv 7 2
PERENTWD Z EERBL T,

70 (Pro)) -> [Composite Video Input] (VIR OFE#HIZ & > Tl [S-video)) -> [EF
fil# (Signal Controls)] ZERL T, VIR E— K (VTIRMode)] F v 7Ry 7 AT
TALET,

Vcp.window
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71

YRUIKETHZRTTS

EFdF—I MO ETFAEGZEZ T — VAT —2a DAY —IRERTBEDIE. T—7
T—aVICHATERIZ VCR 2#6 L TBLENHDET, [VCR ’@tTﬂ' AT %
#95] 358 R—) ZBELTLEE N,

videoin WV —IVEMHWN, ROFEICHE> TETFET 1 > RIICERITET,

1.

[1—F ¢ U7« (Utilities)] AZa—m6, 547 - EFF AT (Live Video Input)] %iE
RLUET,

RELZETAANY —AN5QEREFRRL TWDY 1 > RUNBDONET,

T4 RUDMERS LT A XEELET, <+> F—% <> F—2fHAL TX—
LTy TEREIA—L - T LT,

AEIATAT - LIS ZEHLTETAZERRTEHILDBTERT, ETADF YT F v
SURER. TOMOI—H - A 2 F T 1 =R ATV =V T,

Vcp.gfxtotape

EFAICIST714 v 0 REED

T—JAT—=2a>NoT I 74w I ARt =T 1 A2 ETAT—TIZHT 21213, RO
NHETT,

360

E5d - 5—7 - La—%—

(47332 )F—F 1 A eRETEEOOIA IO T+ > (£ DT—7 AF—3 3 2 THE
M I NT NS, )

RCA 7 72T 5 35mm AT LA - v vy
RCA-RCA T —T N 2R (=T FHEETAHICTK 1A)
Hi8mm F 7213 S-VHS I2&H T 585513, S = DIN- 2= DIN 7 —7 )V HHETT,

007-2275-010aJP



ETHTTT 1 v I ARES
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AE ZZICRTHERTIER. IRXTOUY = AT —2 3 VICENUTI2DI TS EE . T—
DATF—3a ICET ARG T 20D L WHIIE. FOU—7AF—3 3 > OFi#E
HCELSEIWN, FBHEZRD Web U1 MMZHD ET,

http:/ /techpubs.sgi.com/library/

ROFNEZHE> TS EE W,

1
2
3.
4

T—DAT—3>DI1> 77 MMIRCA35mm 75 /¥ &8k L £7,

FTA2 T NIERLETY TYIZRCA T —7 N O—dizHER L £7.
RCAT—TNDH5—HDl%E, VCRDTA > - A IZHEHLE T,

2 AH® RCA-RCA r—7I)VEMHLT, 7=V AT—2a>DEFTH -7 & VCR D
E5d - A I EEHRLET,

(A7 ar) I F—F 14 - )N%)V (Audio Panel)] Z#HL T, ROBEEEFTVET,

e XAUOTFZINOF—T 4 FZEFHET SITIE TAnalogInl NFILTIA 70T % >
ZERT 20, HER (Selected)l -> TAFY — X (Input Source)l -> Microphone]
EBIRL ET,

e TEZH (Monitor)] Frvlky ARyl LET, Frvlro—rRinaT, 2
DEZINF LB OTVWDIEERLET, TV AT—2a o0t —F AN
RAVATH 2NEDF =T AFANEI VI AEN, ETAT—TIHREINET,

Video Panel ® [ZL—5 1 U 5 1 (Utilities))] A= a2 —n5. T4 7 - EFF A (Live Video

Output)] ZERU £9, [Live Video Output] O Z IV DIWIZRE 2371 —) NN T

BHboh£9,

ZORY & EOEEOBICESET,
WO EICEWRDM WY ¢ > KRB b ET,

T RTDEEETEYTR - Ry EMLUTEDOEEICLET, kL2 WERZFED X
DITRI VI LEY. £, HEEAREZRHRLZVESRIE FIHIITHEATZEE N,

AEIETAHNT 4 2 RURYA XEETEEE Ao

WA 2R Z G L ZWEaIE. YU X% [Live Video Output) "% > D LITBEIL T, A<
TR RY EHLTEDOEHIZLET. [Send Full Screen] Z#ERL T /ZE W,
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{18% A: Video Panel

AE 12801024 DT T T 4w 7 ADDIBED 1280 x 960 AN EF HITEHEI N B2, F
D 64 RIS N T Ao

10. VCR OEEIRY > &ML £T A —T 1 FZMATZWIH AL VCR ITHER L 72X /707 +
NS CEELE T,

AE: T —LEBLEHEIL—L, YN, T—2 a3 - T—F I 77 b ERHBEAI.
T5374 v AEETFTFEENEIL TORWAREENRS D ET, ZEXRX, VI 7197
AM72Hz T EFFNBE0Hz ODBERETT, (V5T 4w 7 A EFHICRMESE 5]
@62 R—=2) ZHILTLZI W,

Vcp.framelock

I5749vOREETHICAEES

362

TI5374 v I ABRE LD, EFAET I T4 v IR - B2 LIZERRT DI ETHEE
ET T T 4w I ABEENERIU L — M TERINTVELEND D ET, EEEERMITLIEE, E
FTHET ST 4w I AETL—AOy I TBHIECKEDET, 7L—A0v7I2&D, EFHE
BET I T4 I ARBEDORBNEN TV RN EZIIRETZYNCE—2ar - T—F 777
Y2 <72DET,

Unix > o)V TROAX > Ry, 7574 v I AFREETAHESEZT7L—L0y 7 LET,

Indy. Indigo®XL. O2 ¥ A5 AT, ROAX Y RZEMENET,

e PALESH*5—7 :setmon -Fg 50
(7574 w7 A&B50Hz DY 7w a - T—RTER)

e NTSC ESAHit% : setmon -Fg 60

(7574 W X% 60Hz DU T7Lva-E—RTERR)
XL W< Indigo &3 ~TD Indige? 757 1 v 7 2Tl KOFIEHES TS &,
1. E5F-V—RETIT14v IR R—RIHERLET,

e Indigo Tid. /57«4 w7 X+ R—ROHMEIZBNC A% 7 NHD LT,
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O RTEFH - JL—L& M LEET S

e Indigo® Tid. 2= BNC-BNC 7¥ ¥ NMETT, 7¥THDI= BNC &7 Z
T4 w7 A - Rh—ROBMIFEFHLET, 7Y TXIIETE - R—K - 7 a ittt
BLTWET, 7T TINRMNTOW R 2EAE. &0 OGEENTR— MEYE
IZBEWEbELZI N,

e Galileo Video T, 74 7% ® BNC M0 %40k R v 7 Z O RIBIH 13 %7 7 1Tk
LET, TDEFENDOEIATLTIE, 7¥ 75D BNC DMz ETA -V — X Hk
Lx9.

2. HHLTWAESFARKHAOIY Y REYATANLET,
e PAL Tlid. setmon -Fi 50
e NTSC Tlid. setmon - Fi 60

PIET, ESHAANT ST 4wV AERRETAHNT 574w 2 RWCAMLET ST v I R
Z, E—3ar - 7—F I 7 ML TERTCELLDIICHEDELE,

Vcp.tools

AR KFTETH - ZV—LEHHOLRET S

DEITHHAT 2 Y —)LE, UNIX > )WY —IV %4 E9 1 T AHLTEFHL £, a<v> K -
SA 2 EFF - V=)L, ROHDNH D XTI,

y

vintovout

videoout DA NZETAHNITED LT, KO3 DDA T3 « NTA—FINHVET,

-n devicenum
FHAT2ETAEEROES, I R viinfo #AL T, £OF/NA X
D/ —REBZERDITET,

-0 outputnodenum
AT 2HN ) —ROFE, A7 Kviinfo #AL T, FOF/NA R
D/ —REBZERDITET,

-7 ARE - TA A 2F T —ARMFERHT B /) — REE E/NAEE Z
LxT.
-v FRTHIAN /) —ROFEF, AX KR viinfo AL T, TDF/INA A

D/ —REFEADITEXT,

vliinfo
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[Pro Panels] DfEA

70 (Pro))] AZa—ITid. AT EFTAKBOBEEENAMEYR— T 250U T,
RBizs707ryya ) FREBEENHEINTVET, ZOHITIE. [ProPanels] THHTE
574 =)V RRREDNSDONZE, TIVT 7 Xy MECHHLET, I JITRT 2EORENE
DTTy N T —LIZHFEADDITTIEDD FE A,

364

I VIZ viinfo EF A TANL TETF AHERICEAT B EME R RIS T ET,
videoout

EFt T4 RO EFEEZIZTIVAZ U —2 (1280 x 960) IZITWHiRZEERL £9,
[Live Video Output) "% > D EIZH—V )V EBEHL T, GXVR - Ry &L, Ry~
Ty T e AZa—RT7I7E®ALET, 2070758 T2—F 1 U5« (Utilities)] A
Za-—MhobAET,

videoin

BAAEEFH %Y 1 > RYRERLET, BAALEF 22T &b TEET. 20
V—lid T2—5 1 )5 ¢ (Utilities)] A=a—»5 bHAET,

AE I ESHDON—RT7HERICE S TE. videoin & videoout T+ > K% HE
FRTERNWIENHVET,

vidtomem
TV —LzaETHANST 4 AVIREL LT,
EOETAHBITHHAET,

memtovid

Ty ANMEET AT L —LEEAAET,

Vcp.Propanel
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AGC (Automatic Gain Control) 71 > (Gain)] ATA Y EA T4 + )N—ITH>
THIRICEN L ET, BRU @ISR C TEGIEBLLES, 1> - a2 b
O—)L&dH2M@EIcOy 7 L. TNAANHBTY (> - 2> bO—)L&f75
£2127512id. TAGC A%) (AGC Enable)] Ry 7 AIZF = v 7 —27 &4}
JET,

Anti-Dither T TIT 0w ABEENSFE L ZREERRS & EFAEEHROs 0
S AEERR S OMTOTHERELET, ZHUINVIF R/ v T -
TN 2 ANTITWET, T4 YT OMENRECEZEEICOAO/HAT
H5ZLEBEDLET, ARy MEY/CHNITETHEL £,

7 IN—F v 7 U )L (Aperture)
AYRY Y hEY/CANDIVIF P RTHT BT N—F v (R 2RI L 7.
ZOHBIIE Y F ¥ OMIEICHBELET,

HEAi# (Bandpass)
FEICHBIZICEE L LT, 20748, 707 - by TRNA RS
NizEETH, BEBDEEBITTOT I L TEET,

7527 « LX)V (Blank Level)
FRFERIAY s+ T—=TIWHTOT Z 2 7Id4T 27 28I - LRIVERE
LET,

75w« L)L (Black Level)
AAZ L - T—=TIVHTORIIHTETFIZI - LXIVEFRELET,

T 7 5 v % — (Bottom Flutter)
CCIR > T T DAEMTEET, FFEDTA > HFF TOKREALAHRS
WLZMELET,

b-Y 71 Zfli7n vy (b-Y Gain Fine)
BY O AR—=2bMATDT A D EWHELET. T 1 > 2BREICEALD,
REDOIHRICRET 2 & ZIFEFITT, Galileo Video @ Y/R-Y/B-Y ANt
LTOHEINTT,

b-Y 7 > HW (b-Y Gain Coarse)
B-Y A2HR—% 2 MANDTA 2 RENTHTHELET, 71 CE2BREICE
A0, BEOKRICHET S & EIHEFTY, Galileo Video @ Y/R-Y/B-Y
AR LU TOHEHTT,
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366

77 1< AGC (Chroma AGC)
ARy MERRBYCITHT D703 F > ZAHB,TF A > - 22 O—)LDX
E—-K,

2 O #80E (Chroma Bandwidth)
JOIFCARERERET 27 A—FHD4DDEET A NI DSE1 D%
ERLET,

27 O JE3E (Chroma Delay)
CCIRY>TY TICOIMEATEET I IF D ABIEICHEELZEZTIZ, O
SRV PEFRBY/C/OIFUAGRIEEEELET,

7 a<x - 74 > (Chroma Gain)
aA2RTy FATEY/C AT B 0% - A > OMEHE,

CLUT B— R (CLUT Load)
FIAIWE - T—=TNERIHRAI L - T—=TINEFrABET, T T4V B -
T—TIIEER L NNV EEZET, DAY L - T—TI)IVTE, T—FHE
WETIRAHALN)VE, ZONFIINOIENOI L hO—=)L TIRELZLSIZ
WETCEET,

515 — 77 bk« F)b (Color Out Kill)
HI— +N—=ZABEZOIFUREFTIILT, T2RYy MR Y/CHIhEE
J7micLET,

(anZEH %) L EWHE (dB)(Color Kill Threshold(dB))
(715 — + &— R (Color mode)] #% [HE) (Auto)] /2> TWHEEIZ, O
ROw NEERYC ANZEANT =TT HNE /70T 20 EHRDDEFR S
ELTON—Z MRIED L X)L &l 257D DFETT,

£ — R (Color mode)
ROFT > ailndbDET,
e HEj(Auto) : N—A MRS AT—EE/JOEBRHELET,

e E/ZUO(Mono): 70X« hIy I FEDE/ 7 OERHITT 7T«
TIZLUET,

e 15— (Color) : #lIICH T —IZLET, S-Video ZEINL. C AN
BRELBWZEICKD, by TRLOE/Z7OIKTEDZEIEELT
{EIW, a>RYw b &Y/LCIHLUTHERTT,
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a2 7R—% > b (Component)
NAZ LZEEFEAL T, EQTAR—F2 b T =TIV EGHHMADNEBRRL

£9,
a7 (Coring) APy h&E Y/C ANDINIFLADAT Y F « LANLERELE
ED

C 7 > (C Gain)
ARy REYCON—=ZAMEZOIF O AHAHL ) Z2RBFICHEL £
ED

74 )V% + )N )R (Filter Bypass)
FA—=FHDOINIFUAMS I OIF 2 AZNEET 2 OIS N5 HE0EE
TA NI ENANATHOIMEHTEET, ZOT 4 NFIFEE, TRy
k- EFFANTIEA >, S-Video ANTTEA 7> TWET, £/700
ARy MEBEZETDEETE. 20T YEFTICTEELNT
L&D,

&WDTZ > 7712 L) 4 > I (First Unblanked Line Out)
yFary - EFAHNITH LT 80T T2 TRIBWI 1 > &2ikE L E
ER

HF 7t v MFH% (Fine H Offset)
HA 7%y ; (HOffset) LRI CZIEDH D £ 0% LK DRNEHICHEHA I N E
T, RBEERZIE I vay 2y c X579 T T,

7> 8y 7 KAl (Genlock H-phase)
7>y 7 (genlock) BE— R T, §XTOHINITH U, KFEALHE % # A < FAHE
TEET, AL—70v 7 - B— KR Tld. HAMHEEKEEGAED® AT >
Ry bEYCHNTETBHLET AL —7-E— N TIX RGB & Y/R-Y/B-Y
BEEEZTER N, AYR7O0—2 - B—RIZIIEELEE A,

JKSEA7#E (Horizontal Position)
ANBEGDOKEALBEZFEEHLET, TI>RYy bE Y/CITHL TR, BEET
27V - ATy T TY, Y/R-Y/B-Y OffEIZ 1 EV IV - AT v T TT,

A (Hue) J2RIy FERIFZY/C DBEMEZHREL £,

JL—<#EE (Luma Delay)
IHUL NV F AL 0T ZAOMMBEINOEG N2 HIEH L L7,
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368

v 7 )L DO# (Pixel Format)
FHIENHE -7 OHORIEZFEL. Y/R-Y/B-Y ASTDY DRITHL TIE
l[setup) %7213 no setup) IZHEL £7, Beta JERUE. 714 mV/setup Zff
ML %EY. SMPTE & EBU JE13 700mV/no setup Z A L £

71U 7 1)V % (Prefilter)
BEIOVENVWAREIF Yy 2525970V EE T IVY EMHHTREICL £
T, TUTANFIZ. BEHRATLIOICMHTES &FmEEZSHL £,

&= 1k (Quantization)
BT EL NV OEZEZRELE T, RRICERET D L RIEIRICHH D EH A,

=Y 7 Al (r-Y Gain Fine)
R-Y A2HR—=RY bANOTA P EWFRBL LT, 71 2 2HE LD, FE
DORRICEET 5 & EZIZMHEFTY, Galileo Video @ Y/R-Y/B-Y AT LT
DAENTT,

r-Y 7 2 HLW (r-Y Gain Coarse)
RY AZR—=RZ NANDTA 2 RENTHREL T, 71 > 2BREITE
A0, BEOBRICHET D & EICEFTY, Galileo Video @ Y/R-Y/B-Y
AR LU TOBEE T,

r-Y/b-Y 71 > (r-Y/b-Y Gain)

HNAZ L s T—=TIHT, BICkdT7 1 MR EHRELET,

Y7 F v T JEBEL (Subcarrier Frequency)

ORIy FEYCHNNAT— - T F V) 7 REEBOMIARE. 23 +/- 450
ppme A¥ > E7O—2 - E—RTOHHNITEELXT.

A€ — K (Synchronizer Mode)
ETFANEETHENOY A I DU NEEEO Y 7SN THuRnEEIT0H
FRHLTLZZW, EFFAIDSDOTNRYAI 2T - 25 —2BRELET,
T —LDFAMEELDITHHEMATEEXT,

SC H {izfH (SC H Phase)
FEHASH 73 v U YA Z +/- 180 EOHIFATHE L £9

FEH /1 X (Vertical Noise)
MH /A AEHOT— RZEIRL £,
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EFFCMT BT TN a—T 17

VA T7Ewy bk (VOffset) & HA 7t b (H Offset)
7>y 7 (genlock) E— K &ENEB (internal) E— R THTY. I2RDy
k& Y/C Tid FEGE SN U THSRRABICH IR EGEZEE L £9,
RGB & Y/R-Y/B-Y 1 Tid. JRWHEPHD H B ROV AL AEGIEIC /2D %
9. Rl EHEGEEDELETARESRKROY A I 2T %, Foay s AN
EDWEDYA IV THBENERESTET,

K74 b - LX)l (White Level)
AAZ L - T—=TIVHORIZHTHTFIF )L - LXIVERELET,

Y/CA > (Y/CGain) A>RT Y ~ &EY/COEAL)V (R, N—Z K, IVIF>Z, 70O
IFR) RFEMICHEELET,

Vcp.troubleshooting

EFFICEATB STV a—Ta0Y

007-2275-010aJP

ZOHEITIE, V= RAT—2a > OHEHERETAZERRITLIELTND EXITET ZREIC
DWTHIHL £9,
EFdNEmRInizn,

o NATRTINARAMT—VAT—2a ITIELLERIN, TR >TWDS T EaMREL
ESCIR

o ANTNAARICHEYER—F2BEIRLTHIZE2HRALET, RU—ZXT—2 320D
FAEE CELEEI 0,

.« LI AHEARELTHBEAE. ELWr—TILEEHLTWSZ & 2MALET, 2640
3 =7 OREFUTDONT) (B58 X—2) ZZML T /EE W,
ETF OEEAEN,

e NTSC £7/21Z PAL. ARy FERIZSETHDOHREN. ANV —ADbDE—FKLTW
5T EEMRELET,

o HIMIFREZMETLL TIES W,

B L= VCR DS DF —F 1 F AFTHR N,
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{18% A: Video Panel

o F—Fa4F I —TNO—wmNET AT, O —WmNT—7 AT — 3 2D Line In
ICHEHRIN TS L2 MALET.

o [F—F 14+ )%%)l (Audio Panel)] Z#BIWT. "BE=% (Monitor)] 234 7> THOD,
FEMELSHFHFINTWT, HER (Selected)] > [AJ1V —Z (Input Source)] -> [Line
Inj 2% TH—F1F - )8%)V) ED TAnalogIn) /N1 A « INRIVAIGERESNTNWD Z
EEMRL T /Z3N,

EFABEROBE, TRy b BATERGE L LTS EF4 2R AR S D %
T

HIfE O—F FICRORABONDHG, 77U —2 a > &R T 51 NTSC %7213 PAL #
BIEAZERL TET N,

NP OBERZDOMBEITDNTIE, YU—R - /—hEITEIZIWN,
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1% B

F=Fa4F - KRI

ZOEIL, KON SRS NTNET,

o [F—F1F - XFIIOHE (371 X—2)

o [F—F1F - XX OEF 376 X—2)

o [D—PURAF—2al - AL—THOREDHE 376 X—2)

o [FIUFIMDODANEBENZXEHNERNAOEE] (377 XR—2)
o (2T - L—brDER (378 XR—2)

o TAHALRNIWEHALNNVOEZSY 7 i (381 R—2)

o BIIFNARDOIY NO—)LDFER] (383 R—2)

o [ELARYa—L - ATAY DTN —T{LfiEbk) (384 RXR—2)

o XFLFAFLEIF4Fv>RI - E—ROERL] 38 R—) !
o [F—F 1A FNAZXDFHML) (385 X—2)

o [F—F4F - XNF)N - A2 a2—I2DNT] 386 R—)

e [Presenter Audio Dffiffl] (389 XR—2)

o [F—F4F - NFNDRTTINTa—F127] (389 R—)

apanel.overview

F=F4F - RRIDEYE

Z DN, T —F 1 F - INRILVORERE] (372 R—), MEHFE: fil] G722 R—), [F—F 4
Z - IRV DOAE) B75 X—=), NIV TDERE] B75 R—2) MHERINTVWET,

apanel.what
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% B: & —F 1« A - NIV

F—F 1 F - NRIVDHEE

SERAE : B

372

F—F4F - NFNVEFALT, 2EAE RVa—4o, 2T L—bDEDR AT A
CHOAD, KB AT LN RS A =T A FDF—FT 1 F - NTA=FZHFH L £T. ¥ 1
ruadA+>, CDFL—V— ELBV—VAT— 3 VIERINIZNSA —F « FEBLD
WEZFELZDI MOV TEET,

[F—5 1 F - )%V (Audio Panel)| 1&. EEODF—T 1 FDFREDS AN OEFIEIEF] T
T, DBIMFNA 20> hO—=)LDER| (83 R—) BXU [F—F 14 « FNNA ZAD[EM
b1 (385 X—2) ZBMWL TL/Z3 W,

AEFAI YT U RDPF—FR—R - YU REI 12— MELRZENTT BT, TX
7 kT D Y—)LF X b (Toolchest)] 75 [5A 2 kv 7 (Desktop)l -> [TAZ A X
(Customize)] -> 7> K (Sounds)] Z&ERL £7,

apanel.how

T 74N ETIE [F—F 14 - )XV (Audio Panel)] 1&. Y1707 >DaART I INSF—

FAFEZE AN) L, V=25 —3 3 DA —hAhot—F 14 Z2HE HBhH) T5&

ICHRESINTVWET, PATLDTA > A2 AR FIZHFRINZ VCR 26 F—F 1 F

ZZET 21T, ROFIHITHENE T,

1. VCRZ2U—JAT—a>D3A4y A2  AXTFITHRLET,

2. [F—F 1A+ )X%)V (Audio Panel)] Z#HL T, 7T OV ANTNA XA %ET 7+ )V bAN
IGERL £,

[ 7 4 )b & (Default)] -> [AJ] (Input)] -> [AnalogIn) ZERL £,

AEZOFREF. TIAIDE c FNARXEEIN, SATLATETLTVWRIENDTY T Y
= a hBEEISNBVRD., S ATLADBANHERTIRNEA—F 14 « TN AU
2D ET,

3. F—5F 1% - )X%)V (Audio Panel)) ZfFHL T, ANWIRIFERIRLET,
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F—F 1 F - IRV DORYEE

007-2275-010aJP

o TAnalogIn] FNAZ « XNV &Es Uy 7 LCGERLEY., NRVOEADIZY T T4
UIRFREN, BRENSZZEERLET,

o [ (Selected)) -> A1V —Z (Input Source)] -> [LineIn) ZZERL X7,
B 2-1 1A =T 1 AEE/NADFZRLEXT,

AE VAT LDHA =T A FATNTNA AR, BROIXI Y EBRFTELTNTIADH
DEIN, FHRIZIZ 1 DOIRI Y EOBBENWAETT . ZDD. BHICT 7 )L D
WEATI T NA A& ZIR L. a0 5 RIS ZUNENHD £,

CDREBNAZHRELES, REZAXROIDICTFOT ANZREEZFAHT L £9,

o AHLNI (RYza—24) — TAHLNILEHEALNIVOEZS Y 27 L] (381
R—=2) 25

o YIS L—b— BT L —bDER] B78X—2) 2HMH

AT KU EERHEEIL. HEIR Selected)) -> FRE ...(Preferences...)] THAET, #Hik
DF v > FINTH—FT 1 F2HETHIHLENDDEE. FLE2DOULEOY—2DF 13
JEREMSEHHIE. SEAREEMEAL TEI W,
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% B: & —F 1« A - NIV

FLOVERTHUL Audio Panel TEHRE LA —T 1 S/ RDH

FFUsr— g A F7U4sr—i3B

_______ [ |
L FFES L FUSNL
N R -

Y

L TR

T—&AF—%3 AL

D—& AF—23 wHER

FiR—b=axss
YCR
(EFF -hts b - La—3)

B2-1 [F—5 17 « J$%)) (Audio Panel)] TH#E LA —F 1 FEENRADH (1 A= %71y
5B EPREREIND)
apanel.glance
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F—F 1 F - IRV DORYEE

F=F4F - RRIVDHNER

oA a—FELT, COAZa—FFELT,

BRI FRARDT E i
I | REERTEDSEY
Microphone Speaker/Line Out | T3,
L B LR E
AAbAN - g |
33:3_”' 2l - IR LT
ey | ZADB (FINT
i Pl = 7 oF S
-30 N =ha)
=40
CTIClE, A= soff| |- | s
HBLTHWAERICDI B0 i;;];::éiwb
THELAITHRER 11,025 kHz 11.025 kHz ~
=ha. [ 2 = Ll za-+ AFAY

ZOFRAADE TN LT,

F—=F4F - KRN DNE

B 2-2 F—=F A RRIVOHNB A A=V r )y T2 EIREREIND)

apanel.conventions

ANV T DRRE
IO a7V, ROEFREZFHLTEI,

o BHARTERINLZHMHIZ. AFOMOE, i, MELZIIHFOERANDOY IV ERLET, 2
EZAX BT L—h 2IYUv I LET,

o RTERINTWBLFI TEEN > V) ZRLET. TNEIU v ITEE, ZOHLHTO
V=)V L 9., 2 E XX AT 1+ 7 L O—% (Media Recorder)| 227U w27 LET,

o AZa—HEAZa—THHOM®D [->] &LHIF. AZa2—DBRNNRERLET, LEXT
[7 74V (File)] -> [BA< (Open)l &, (77 A4)] AZa—ZWT <] 2RSS
ZEEERLET,
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% B: & —F 1« A - NIV

F—=F47F - KNRILDEH

[F—5 1% - )X3%)V (Audio Panel)) 1Z5 227 ~vy 7 ®D I'V—)LF = X k (Toolchest)] A= 1—
MmET7 U EATEET, [FAV kv 7 (Desktop)) -> [2> hO—)b -+ —F 1 7+ (Control
Audio)] ZERL TIZEI W,

AE: O RTINS F—F 1A - XK EREIT ST, apanel EF 1 AN L TLZS W,

apanel.speaker

D—ORAT7—ar - AE—HDREDRED

ZOHENE, TR 2—LDHE] B76 X—2) . TEBEEIEORY 2 —L%E] @77 R—2)
Ra—F] B77R=) hoERINTHET,

ARY 21— ADIEE

FIHINERTIR, V=PV AF—2 3> - AE—HOHH A 51 FE. T4 —F 14 - 3%V (Audio
Panel)] 7« >R (22 Z2H) OLHMO [Analog Out] 7 /N1 X+ )XFNICHD ET. R
E—AMNIAIA45% EITRT YT T5EL XU END, TIZENTEL XV TR0 ET,

AE: L) £/ TR EX—VINEATAFIL. TNENE, AOFrvox)loa> ho—
NWERLTWET EEEDATAYE. T 7+ TR INV—FbInNThET AR 22—
I ATAT DT —TufiEkR) (384 R—2) 2L TN,

AEIFIHI - TIEDEIIT, HATNA R - a>bha—)b - NIV E> TR, RY 22—
L ATGAITVBBNSOBH D ET, [F—F 1A+ )X%)L (Audio Panel)] Tid, %)L - F
NAZDHHRY 2— A% "O—)LTERVNSTT,
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F I3 SDANEENZ EHMNET/INADH

EEEFIEDRY 2 —ARTE

1. a2 RIThSE, A== —HF &L T IF—F 12 /3% (Audio Panel) ZiEE L £
o UNIXT TNV Tsub¥ATANLTLEZN,
e <Enter> F¥—% AL T, apanel £ 1 TANLTLEI W,

2. TAnalogOut] FN\A A = )XV EZ U w7 UTEIRL £
INRIVDFEDITHRNTY T T OPREREIN, BRENZZEZRLET,

3. YFaZHAL N ASA Y EHE L THEBRERICLET,

4. TER (Selected)) -> [FZFE ...(Preferences...)] ZEIRL £,

5. [F%E (Preferences)] ¥ 707 ® [JEE)HRY 12—  (Boot Volume)] DI TZXF v
(Snap)) R >MVHVET, ZORY %27 )y LT BEORY 2 — L &EH &R
BHLUET,

6. TOKI 27V vwrZ L%,

I}

H
|

-

HHTFNAZDa > ba—)LiZid, TAnalog Out] /R EQFET &I 22—k (Mute)] Fxv
Ry IAMEENTOWET INAREI2a—FERRI 22— FEMRTZITE. Z20F v
DRI AEIV I LET TNAZANIa—rINDE, Frul -I—INERINET,

AEHANTNARIZIE, 22— FTERLTNIABHDET,

apanel.setting

T2 DANEBNREBOEB/NADRTE
BEENRZAOMEIIDONTIE, K2-1 D TF—F 14 - )¥%)V (Audio Panel)] TDAHEF/NZ
DREDOHEZML TLZI W, TIHINEDFNA N, MOT7 TV r—2 a3 0o d DIz
FEELRWED, PZAFLNMERL TWANEA—FT 14 « TINAAERDET,

FIFINNDANEEIIHEHNEBTNAZRET AT, ROFIEICHENET,
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% B: & —F 1« A - NIV

1. [F7x)Vh (Default)) A=Za—2EHALT. ANWEERZHAHEATZF 74V bOFN
A AERERL £,

2. FTIFINRDANZZREL TWT TAFHY —X (Input Source)] A=z —IHHAGERMRER

BEE TNAANT T I ETHEAT DAY —R (& A3, TlineIn)) 22N £

o [F—F 14+ )R)V (Audio Panel)] 71 > RUDANFTNAZ - )NV ETY YT L
TERLET,

o [E (Selected)) -> TAJ1V — A (Input Source)] ZERL. AV —Z) o—)LF—
N— s AZa—BY—A&ENM—DERLXT,

00 : BEVWIZESTWEIATLDF—F 1 FANTTNA ZDOHFIZIE, EEDOY — X LR@ET
ELTFNAZALHVDETH, FARKFICIE1L DDV —ADAEBENFETT, 02D, BIICT
THIVENDANTNA ZAZRIRL, RIZY —AZRIRT20ENHDET,

HATFNA ZRHERZO IR Y 2RCH N E2REET 220, FLAEDEE, HkaERIRT
LDHEIHVET A, 727ZL, Bl —F 4 F - N—RUzT7E2EHB LTI ZXT—a>
OHIZIE, HHEEBETESZH0EH D ET., ZOHEIE. [HH15% (Output Destination)] 73
IR (Selected)] A= 2 —TERATHEIC/R > TVET,

a—bhy b EGYVR - RYCEMGEHLTANEZBHENOT 740 F3GE, BEUAND
R Y DERIMTAET, BETDTNAZADTINA X « NRITH—V IV EREL. AT
Z WY EBLULBNS, REICKERAZ 1 —2FRITET,

AE AT a>0F—F 1A - F—bEEHA A =)L TWBEHET, SHEEICAREE
HIECE L TE2MAENELNET, LA, P ATALARL2DDOPCI A —F 144 - F T3
R — R A =N ENTWBEEIE. —H D ADAT ANiE TRAD 1.ADAT InJ. 5
1Z TRAD2. ADAT In) EFRINET,

apanel.sample

BT - L— FDER

378

ZDHENL. ROEMNSHERINTNET,
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BT - L— b DER

o BT )L —HKiZDWT] B79 X—2)
o YT - L—FOFRFIHIEl (379 R—)
o YT L—MNEROFTEESEIHE) (380 R—)

Y7 - L—=BFITDWT

Y2T) - L—HME TFATEENSTFIIIVERIT, £RBZOMITERTLEEDY T
Ve L—hZEREL. BETDEBERO LRERELXT.

BET A —F ¢ AR Y TN - L NEERTSE BEPOEAEHBIELET, B
1. 8kHz (FFunjLy) o8 >7) - L—hr2FHLTWET, SHFHOA—F ¢ A3
BL—FTY, AT b T4 A713, 41kHz D> 7 )L - L— b 2L, ZHUIEEA
OY T2 RIBBHERL—FTT, =514 DAT 7L —V—13 48 kHz DY >7I)L - L — |
DR TT A, 32kHz £7/213 44.1 kHz EHINTVWET,

AES 7213 ADAT R AY — - 7Oy I DEIIZ, FNAADY > T )L« L— P u]LEL— kD
FY —ZmeEINBHBE. 27 - L—NIRAMEEOSKRTEL LT, 1/1 OEH—
MICHERINE T, A2 2 —IAERRSEAHEINTVWET, & ZE. 1000/1001 1
ESHAOFIHIN - F—F 4 HHEETRITT, 147/160 13, 48 kHz L — h DRIV —ZAm 5
441kHz 9> 7 )b« L— b, 320/441 13, 44.1kHz L — b ORI —2An5 32 kHz ¥ > 7)) -
L—hk, 2/31%, 48kHz L —bORMY —ZAM532kHz > 7 ) - L—h2ELTVWET,

AR BFOREEERE. T - L—FOESDEICREDET, FEAR BEEROR
EEEEE. YT L—bF8kHZz TH B0 4kHz 1T/ D £7

Yo7 - V- bOREHE

BEDTNNAZDY T ) - L—bE2HRET 2123, ROFPIEIENET,
1. /BETEDFINAZADFENAR - NI E2Z7 w7 U TEIRLET,
FINA R < NRIVDEDIZT T ST fE, ZONFIVINERSNZZ EE2RLET,
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% B: & —F 1« A - NIV

2. DR (Selected)) -> > 7 )L - L— b (Sample Rate)] ZZERL., O—)LF—/)N—+ A
Za-—mHANERIZHIT T - L— R EBIRL ET,
AN —h BETHF—FT A FDOHF T I - L—hEBIRLET, V—Z + AT 17
ERUCH T - L—=brEBRLTLZSI WV, TP IVATTNA ZANS
BEITHEA. ANV T - =ML ZEFIYIL - F—FDL—|
ICHBMICHRESNET,

HHaL—h ATDH T ) - L—MERbEVL— M EERL TZE 0,

FHICOWTIER, T - L— NEROBFEEFIHE] (80 R—) 2L T 7ZI W,

a—bMhAYBM AYTR - RYCEEHLTH ) - L—b2HHTEET, RET DTN
AZDTFINA X« NRIVZH—=VIVEEBEL, AYTR - R VEMLUBNSAZ 1 —%2FRS
BEY., P2F)V - L—k (Sample Rate)] ZFEIRL TS,

AE YT L—ME BF—FT4F - TNAADTO—NIVRETT, BETHE, F—
FTAF - TFNAZAZFAL TVWRENDF—F 1 F - 7O AT RTIEELET, &l
FTIAINE « FNAZDY T ) - L—bEEETDE, BUET 74NN - TN X &FEHALT
NBITXRTOT7 TSI r—2a ICHEELET,

Yo7 V- EROEEEIE

380

o ANL—hETEZWROHAL—NZHLETIEI N,
ANERHDOYT T - L—R"BRE-S>TNSE, AV ROBANKELARDET,
o FUHNVI—ZADOY LTI L—hiEayrINTVET,

FOYINANZEETBHE Y27 - L—MIYT ROV —XTHRELET., &%
X, SOV vy I HEDOCD 7L —Y—13, 441 kHz THE#RZXELET, V—7
25 —a i, HEWICEOL — Moy 7 LET,

e WRODEITEEEA.
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AHL AL EHH L NVDEZS V) 227 EHf

BN >T N - L—=FTHEFLTLED & AU PFINOEBERETEEE . BFTOM
BWEEREEE, V=2« AF 4 7 ERUY 2T I - L— N TEE LT, Sound Track T
27 L— hEFFHT DN £7213 Media Convert T7 71 IIVEEHL T, T4 AY
IR L T /E3 0,

o T AU E

TN L—h @< I3 L HEOHREIRBDEIN, KRERT 1 AVHEMELEEL
E 0

Tip: T« AV HEEBZHKT 2123, KWWY T - L— b TEH—F 1 4 2HEETHL0 B,
FfEL TSN, F—F 14 « 771 IV DOJEHEIZIZ. Media Convert ZHHTEET,

apanel.levels

ANLRIERAURNIVDE=S Y > LA

Z DI, ROWEMSERINTNET,
o TAHLIVOHE (381 X—2)
o THHLXIVOHE (382 X—2)

AHN VRO

RAZOATHFRE T4 A2 « AR IITEHRINZMOEENSEHSTTIEE. T—2
AT —2a @37 IOl N T OINAF =T A FEFEERLET EREEREDT Y )
F—HIEHTHITE. BRDBAET I REELNDEIIICANL )V ZHE L XD,

AEANLNIIE, THFOTMETF O INICERINDEHICOARMENET, ZDED,
ANATATEHHGT L THDT Y IANTEEINT T

SACERBTFOTANTNAZADIA 7 AT 5>« ARTFIEREINIEN—R T 27 DA
HUNVHST 212, ROFNEIRES T EE 0,
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% B: & —F 1« A - NIV

1. TA=% (Meter)] Fxv2 - Ry X&r v LT, ERHHEEZRRIEET,

m A0 T75>OANLNIVEHET DI £ Monitor)] Fxv 27 Ry 7R
Z27Uw I LUT, JflfidsA—FT 1+ FaMEET,

A*E: [E=¥ (Monitor)]l & FTI7AIMHHTHT D RERELXT., T4
METEROZFHICDONTIE, 574 hDOANEENZ EHAEBINADHRE]
@77 R=) 2L TLEI N,

2. A—TaAZRMELXT,

B XA 7O07F2h50HREDEEIE. 2EAR IRAVDFA MR, LN)LEYAY
DOBEZEZF T L TVET, ] DEIIBAYE—I2HZFL TN,

3. A—INFLEHAEZRRTDEDICANATIAFEHE L. ROBPEICAS NI DITLE
To ATATDOITIN—TZHRL THIZICHETT 21, [EAR) a—L - A545 DT
W—TbfibR] (384 R—2) ML TL7ZI W,

. A—IVRRDAERRTDHHEE. LNVIMETEET,
n A—IPRERRTLHEE. LNLBETEERT,
. A—IPRPSFEBAERRTIHEE. LNIVPEIETTY,

BEICHEOMENADTELHAT, XM 7074 22 OICKVDIEDT AN L)L ZFHHHH L

TLEZ W, [P] BXY [B] THEDHEOHRZICEOZTNAVDTESZESIE, 1707 %
CEONGEIIT T, WMEADDOTRL, X707+ #HUICETLOICLET,

TFRENAR: FA IS ANENDTF =T A AN REBENSNEREXTDIENWY A F Iy
7 L2V T2 HER. ANV ZREBSFICEDE THEIL TS,

HA U NI DFEE
1. WHERAGT 5N R - )80, 2EAIE TAnalog Out) 5N & + NIV EHE £T

2. LI & IR} AF94% % EIkBHL THRY 2 —L% LT 50, TREHLTHR)2—-L%ETF
X
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EBMFENA 203> hO—)LOER

A& Digital Out) AKX bO—)b - XRJINE, RYa—L - XTAIDHDE
Hho [F—F 17 - )XF)V (Audio Panel)] TEHAZEI> hO—)L TERRNWNSTT,

apanel.device.display

BIMFNARDAY FO—-IVDOERFR

007-2275-010aJP

T 74N BT TF—F 1 F - )S%)L (Audio Panel)] 132 DDF/NA ZAD I > ~hO—)V&FKR
LEY,

o KIZHBANMICIE. TAnalogInl FNA X - a2 hO—)b - NFINERINET, 2D
FNAAZT =V ATF—2a>pIA 70742232 bO—)LLET,

o HIZHZHHNMITIE. TAnalog Out] F/NA X« a2 hO—)b - NRNNERRENET,
DFNARET =V AT =2 a>DAE—=H%EI> ~O—)LLET,

F—=F 4 FDN—=RT 7 ZEML THDHEITE. BIMTNA ZADTFINA A - INRIIZT 7

ATEEIN FHARERT NA RAZN— R o 7 ITKFEL £

1. TR (View)l > [5/)NA1 X « U Z & FER (Show Device List)] ZERL T ZI W,
FNAZ + UAIPERINET, PATLTHEARERTNA ZADHRY X FEINET,

2. ITFH—=F 174« F/)N1 X (Audio Devices)] D F T, £RTBF/NA AZERL £, BIRL
I RTOFINA AN [F—F 1 F - X%V (Audio Panel)] IZFE/RINET,

Fiz. [FR (View)] AZa—2z2HL T, N1 ZZ2EINGERTE LT,

AE AT a0t —F 14« R—=b2EEA A=) L TWBIFFIT, HHEEICHREE
FINECES TEMAENROGNETT, LA, PATARL2DDOPCIA—F 144 -+ T3
R — R A =L ENTWBEEIE. —H D ADAT ANE TRAD 1.ADAT InJ. 5
13 TRAD2.ADATIn| &FERINET,

U2 RMERRDTFINA Z2BIRT B EFEFIC, [H—F 14 - )S%)) (Audio Panel)) 1, ¥
XENBEEEELET., T 74N NOANEZIHNEEFTS &, ZREZITICESHINET,
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% B: & —F 1« A - NIV

F72. [574)V s A1 (Default Input)] 257 NA A+ UARTF v 7 INTWIEHEIF. =
&AL TAnalog In) 72 EDQBUEDT 7 )V b AN ZT NA A« UZX BN SERLTH, [Analog
In] 3T TRERINTNSED, MBEEINEH A,

XE: Digital Out)] AKX SN hO—)b - XRJINE, KU a—L - XTAIDHOE
HFho [F—F 14« )NFJ)V (Audio Panel)] TEFIHI - FNAZADOHHRY 2—LZ23> b
O—)L TERNWNSTY,

AE: [FTIHINRNOANEBNZAEHNEBENZDHRE] 377 X—=2) #2HHL TN,

apanel.ungroup

EARYa—A - RS54 DI —T{LhER

384

[F—5 1A - X% (Audio Panel)] &, 1 DDATAFERT v I T3 EEHDL XA FEK
CHETEDLSITHESNTNET,

ATA Y w533 TREAD L XV 2 EBICHETT 212, TN 2 -8 )bz ) w7 UTERL,
R (Selected)) -> A T4 5 D7)V —T(t (Group Sliders)] ZERL T, Frv 7 - 3—
IMATATDITN—TERLTVET, Frvl - I—=UNDNTWEWERIE, XI714
ZHEGNCERIETE XY,

a—bFhAy b GEXTRX R CEFHALTATAIT DI —T. T —TfEkziTnE
T INAR - INFINCH—=VINERBEL., X TR Ry EHLTAZ 2 —2ERIEE
Yo [XFA4 5 DT )—T1t (Group Sliders)] ZHERL T ZE W,

apanel.stereomic
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AT VA ERZ4TF v R - E— BOFHL

ATFVFAELERB4F vV - E—FOBFME

T—0 AT =2 a>WATEHITDADOMNL=F v > %)V EHR—ELTWDHEEIR [F—
517« )XF%)V (Audio Panel)] T4 F v >R - E—REFMLTEELT, £/ V=T RAFT—
YAaMATLA A 70T+ EYR—FLTWAEHAIE. ATLF - E—REAEIMELTE
E

o N—VNEZEYTEZTINAA -a>bO0=)L - NRIVICHELET., ZEXE ATLA -
XA 7 4+ AT S5 EEE TAnalogInl O LITH—YVIILZEEET,

o ARXTR-RYDEWLIENS A2 —2RKRSE, [FE ...(Preferences...)] ZHERL £,

o FKIREINJ=TFHFE (Preferences)) NIV T [XAF L F <1 7 107 + > (Stereo Microphone)]
7213 T4 F+v > %)l « £— B (Four Channel Mode)] 71U v 7 LX%7,

Frvl =T, FOFNARATHRCE>TWEE—RZRLTWET, F—F«
7« )X2JV (Audio Panel)] DY Xid, BIHDOL N - T4 ¥ EFRTEDLSIC. H
BICAEINET,

A4 F v oR) - B—REHEMLT D E, 7FHOF AL ETFOTHNFINA 2R
BEBEZET, 4 F v >3 - T—ROFEMIZONTIE, audio(IM) DX > - R—P 2B T
<73,

A% :Indy & Indigo D7 —2 AF—3 a3 VT ENE YA /707 + VIEE ) FLT
KR

apanel.sync

A—F 44 - FIA ZAOFMIE

007-2275-010aJP

FRFICEB DT INA A5 EET 211, TR — X (Sync Sources)| #aEZfHEHL T, YA
F— e LI T ERELET, YAY— - I I T EHHTRE, 8BFRFD, LEAX, L—
E—DF—F 1 F LEFTTHIOEWREROTNZIETEET,
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% B: & —F 1« A - NIV

1. FNAR-a>ba—)b - Xx)E7Y 7 L TGERLET,
2. [ER (Selected)) -> [FZFE ...(Preferences...)] ZEIRL £,

3. FREINZ TEE (Preferences)] /NRIVT, T —Z (Sync Source)] AZa—«RK¥ >
EEALT, YRAY— -1 T72ENN—DREIRLET,

ZDAZa—RY > CHEATELRREHZ. V-V A 57— a > CHEMAERN—RY o
FIKBFELTWET, AV —ZOBREAN 1 DLNBNTINA ZAHHDET, TOHE
3, AZa—DRODICTNIMERSINET,

FT7a OF—F 1A« R—b2EBA A =L L TWBEAL, BHEBICHREER
JEICEPS THMEGENRONET, XL YATARL2DDOPCLA—F 44 - F T3
o R=RYA VAR = ENTNBEEIE. —HD ADAT AS1E TRAD 1.ADAT InJ.
#1d TRAD2.ADATIn) EFERINET,

AEITNAX A bBA=)b s NRIVTREEY =205 A I 27 2FKRT 5T 723
> (Options)) -> F'OE— K (Professional Mode)] ZERL £, Frv V- =070
HE—RDPAHNTHBZZEERLUET,

apanel.menus

F=FAF NI+ AZa—ICDNT

ZOfEINE. TT7 714 AZa—] 386 X—), ITEIR] A=a—]) (387 R—2), [TFER] A
Za—] 388 RX=), T3] AZa—] @88 XR=), [[FT7x)Lb] A=a2—] (389
R—=2) THEEINTVET,

2741 A=a—

[774) (File)] AZa2—IZIZRDOIAR > RABHD ET,

A< ...(Open...)]
T7AI s TITENS, F—F 1 F - X)) (Audio Panel)] DLARGIZ R
L7iREZBEINTEXT,
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F—F4F )X s AZa—IZDNT

MER] A=a—

007-2275-010aJP

[&7F (Save))
BED I —5F 14 - )N%)V (Audio Panel)] OFFEZEHREFELET.

MBI fRTF ...(Save As...)]
BED TH—F 174 - )X%)V (Audio Panel)] O EZEIEEL 4RI THREFEL
9., %T < ..(Open..))] IX>RTHSZENTEET,

ST (Revert)
[F—F 1 F + )X%)V (Audio Panel)) % il OEEHERFEICR L £75,

&7 (Bxit))
[F—F 1% + )X%Jl (Audio Panel)] #FUC £,

[N (Selected)] A= —IZITROAR Y RBHVET, ZOAZa—iE F—F 1A - )Xx%
JV (Audio Panel)] THEBIRINTWETFNA X - NRJVITHEAINET, /N1 R - X%V
BEIRT I, TNE 7 ) v LTLKEI W, BRINZNRIVOFEDIZT T N IA T E
E

>7)b « L'— b (Sample Rate))
BT L—RNEEIRTEET,

[AJ71°/ —2Z (Input Source))
HAPRER B AT, BREINATNA RZICHHATZ2 AR Y ZRRTE
£,

(X545 D7 )—71t (Group Sliders)]
TN—=T A4 - E—ROF > EFTEYBEAET, Fvr - I—UM
ATGATMT N =TSN TNWBEIEERLET, FT7ICTHE, ATAFMN
WL T, EADL NV @IS TE £,

(57 4)V s A1 / i) 5E (Make Default Input/Output) |
BUBBIRL TWEFNA ZET 7 4V MTHEL £7.

[E%7E ...(Preferences...)]
BIRUIETNARADOREYA 7O 2HEET, [F—F 14 - 57 /)N ZDFEH
b (385 X—2) BHBRL T ZI W,
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% B: & —F 1« A - NIV

[&{R] A=a—

F72av] A=a—

388

[FOR (View)] AZa—icid, F2EFTEYBFZZ2IAT RPFENTNET, OV REE
WUTHEREFFTIRUET, Fvl - X—UN F2)] THdILeRLET,

TDAZa—I2E TIAINWPAATNAX - a2 bO—)b - NIV EFREFIZRT I &2
E9% 577 4) ~AJ] (Default Input)l & 774V AT NA X - a2 bo—)L - )b
EFRARELBRTIEEEET S 57 4)0 MJT (Default Output)] WEENTVWET, £z,
FHRERTNA AN DA 2 —ICERRINET, FHTERTNA AT AT LDN—E
VI TIKFET B0, DATLACEVDRRDET, 51T, [FR (View)] AZa—12id. 5
NA A+ J A NZEFR (Show Device List)] 230D, FINA X - UX MEAWEZDHCEZDTE
$£9, BEBMFNAZ0a> ha—)LDFKR) 383 R—) 2ZRLTIEI N,

[%F7°2 3 > (Options)] AZa—IZi&, [F—F 14 + /X% (Audio Panel)] DR REAEET %
AR RPFENTVWET, ORVREBIRLT, 42/ F720BAET, Frvd - =2
MW IFx>) THBHIEEZRLET,

(F—F 1%+ F21—+ EZ¥ (Audio Queue Monitor)]
FNWTWbFd—F 1A - R—F2UXNERTDIA—F 1A - F21—-FZ%¥
#FRRUET,

7' & — K (Professional Mode)]
Y — 2 « FINAZAEFRLET, [F—F 14 - FNNA ZOFME] (385
R—=2) 2ZRLTIEI N,

[5 X))V » 24 —)b (Decibel Scale)|
LN s ZFAF DTN« Ar—)vaRRLUET,

[Z 27 0—)V)N—% &R (Show Scrollbar)
T4 2 RUOTHNICEREIN, EROFNA A - a2 hO—)b - )XV TRAY
O—)VIZHERAT A A7 0=)VN—2FREZITEBL ET,

(74 v « NV T EEKR (Show Quick Help))
T4 Y RUDOTMICRRENDRKAFEDN T 2R RELBREBLET. 7
4w« ANIVAE TF—F 14 - )X%)V (Audio Panel)] W+ > RUDH—Y
IVDALEITHIEL THWET,
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Presenter Audio O 1 il

[F72#)Vb] A=a—

(57 #) & (Default)l] AZa2—IZiTXROAT > RNHDET,
[A77 (Input)

FHTH A =T 1 T ANTNA ZERBIRT B7-2DICHHL £7.
77 (Output))

FHT D F—F 1+ FTHITNA ZERIRT 272DIHHL £7.

AEINSIEFTIFIE c FNAREREIN, SATALATEFLTVWBENOTY T r—3 3
UOBIEEINBVRD, AT LANERTENEA—F 4 F - TN R0 ET,

apanel.presenter

Presenter Audio D{EFH

Presenter LCD 7J v b « X%V« T4 AT LA B, 7—2 X5 —3 3 >IZ Presenter 731
PAR=NENTVWRHAEII, F—F Ao bo—)VEENFERLET,

FaTIVHEHASA N, TH—F 14 - )XF%)) (Audio Panel)l D754V HHASA 5 EE
bETTIN—TbINET, [HE (Treble)) IXRT, U2 ROEIZHFH L ET,

apanel.trouble

F=TFT4F - NRIVDESTINa—TFT45

ZOHITIE, =T 4 F RNV OFERPICEZD S 2MEEFOMUFET DN THHAL £3°

J—POATF—>ar - AE—HEREAY RT3 >h b6t —F o AR haInizn,
RDOFINEIZHES TLZE W,

e [F7+)L b (Default)] -> 77 (Output)] -> lAnalog Out] ZFERL TWBH L%
R L T &,

007-2275-010aJP 389



% B: & —F 1« A - NIV

390

e [F74)lk (Default)] -> TAJ] (Input)] THEYISANIERESNTND Z L2l L
TLIZE W,

o ANFNAZX - XFI)VD [EZH (Monitor)] 27U v LT, Fxvl - Ry T AN
FvIINTNWBEZEEZERLTLZI W, EZANT T+ AT T > RE%
BLET,

o THurharhruo—)VORY2—-LEFzy L, [Ta—F Mute)] Fxv7 -
R T AMF Ty 7V INTN RN EEZHERL T ZE N,

FIOFIWANERBIRU WD, DO 5780,

77 4 )b s (Default)] -> [AJ] (Input)] -> [Digital In) Z#RL T ZE W, #iD/N—
Par® F—F 14 - 3%V (Audio Panel)| EHEEHIENRIZS>TWET, £z, O2™
ERFFEOBEIR. 723075 8N - F—F 4 F - R —FEA A=V LIEWRD,
Digital InJ 13&% 0 £t A. O2CD Player Tid, F—F 14 - )Nx)b) ZHHLTATZ
FRETHHEND D EH A,

TSN SEND XD BENT S,

TN L—hERIMY =X ( TF—=F 1A - TN ZADFRMME] (385 X—2) #=&H)
OGN, EZITEANTNAZRET TV MHIFNA A ET—HLTWBE Z & 2R
LTLESN,

F—F 4 AEROTFTERHE I NI,

l[snowflake] & Tamesh] O XSt —F A4 - FERIE BHHREN—RIT 27 DIL—T /)Ny
ZEEEEZFAL THWET, Yo TidvR—hraNThEH A,

007-2275-010aJP



% C

General MDI D2 K -2y hEN—-Nyrary -y
70

ZDfHERE. 128 @ General MIDI 7 > R -y h&EN—hyar -y TDUZXKTT,
General MIDI 13, H75 % 5588 0 Al 2 FE R T 5 7212 3% 5H S 1172 MIDL B OREHED B T & v
b T9, General MIDI O%EgR1, FIU AU BEBICT R TOHEZHML, N—Hy 3 >D/N—
M TIEIHICMIDI OF v >RV 10 MEAINE T, DR & 16 DY 2 REFRFIHEAETE,
Dia< EH 24 FDORY 7+ Z—MH[EETT,

ZOfTERIE. ROHEIN SR INTNET,
e [GeneralMIDIYW >R -twh] (391 X—2)

e [General MIDI /S—H1wv 3> -<vT] (396 R—2)

General MIDI YOk -y b

007-2275-010aJP

(Fv >V 10 ZBRSTXTOF ¥ > %))
702 No. #2884

1 Acoustic Grand Piano
Bright Acoustic Piano
Electric Grand Piano
Honky-tonk Piano
Electric Piano 1

Electric Piano 2

Harpsichord

® NN o O bk W N

Clavi

391



f18% C: General MIDI Y > K - tw hENX—hviar v T

9 Celesta

10 Glockenspiel

11 Music Box

12 Vibraphone

13 Marimba

14 Xylophone

15 Tubular Bells

16 Dulcimer

17 Drawbar Organ

18 Percussive Organ

19 Rock Organ

20 Church Organ

21 Reed Organ

22 Accordion

23 Harmonica

24 Tango Accordion

25 Acoustic Guitar (nylon)
26 Acoustic Guitar (steel)
27 Electric Guitar (jazz)
28 Electric Guitar (clean)
29 Electric Guitar (muted)
30 Overdriven Guitar

31 Distortion Guitar

32 Guitar harmonics

33 Acoustic Bass34 Electric Bass (finger)
35 Electric Bass (pick)
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General MIDI Y7 > K - v k

007-2275-010aJP

36
37
38
39
40
41
42
43
44
45
46
47
48
49
50
51
52
53
54
55
56
57
58
59
60
61

Fretless Bass
Slap Bass 1

Slap Bass 2
Synth Bass 1
Synth Bass 2
Violin

Viola

Cello
Contrabass
Tremolo Strings
Pizzicato Strings
Orchestral Harp
Timpani

String Ensemble 1
String Ensemble 2
SynthStrings 1
SynthStrings 2
Choir Aahs
Voice Oohs
Synth Voice
Orchestra Hit
Trumpet
Trombone

Tuba

Muted Trumpet

French Horn
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f18% C: General MIDI Y > K - tw hENX—hviar v T

394

62
63
64
65
66
67
68
69
70
71
72
73
74
75
76
77
78
79
80
81
82
83
84
85
86
87

Brass Section
SynthBrass 1
SynthBrass 2
Soprano Sax
Alto Sax

Tenor Sax
Baritone Sax
Oboe

English Horn
Bassoon
Clarinet

Piccolo

Flute

Recorder

Pan Flute
Blown Bottle
Shakuhachi
Whistle

Ocarina

Lead 1 (square)
Lead 2 (sawtooth)
Lead 3 (calliope)
Lead 4 (chiff)
Lead 5 (charang)
Lead 6 (voice)
Lead 7 (fifths)
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General MIDI Y7 > K - v k
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88
89
90
91
92
93
94
95
96
97
98
99
100
101
102
103
104
105
106
107
108
109
110
111
112
113

Lead 8 (bass + lead)
Pad 1 (new age)
Pad 2 (warm)
Pad 3 (polysynth)
Pad 4 (choir)

Pad 5 (bowed)
Pad 6 (metallic)
Pad 7 (halo)

Pad 8 (sweep)

FX 1 (rain)

FX 2 (soundtrack)
FX 3 (crystal)

FX 4 (atmosphere)
EX'5 (brightness)
FX 6 (goblins)

FX 7 (echoes)

FX 8 (sci-fi)

Sitar

Banjo

Shamisen

Koto

Kalimba

Bag pipe

Fiddle

Shanai

Tinkle Bell
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f18% C: General MIDI Y > K - tw hENX—hviar v T

General MIDI/N\—Hh vy -

396

114
115
116
117
118
119
120
121
122
123
124
125
126
127
128

(F ¥ >3 10)
/ — bk No.

35

36

37

38

39

40

Agogo

Steel Drums
Woodblock
Taiko Drum
Melodic Tom
Synth Drum
Reverse Cymbal
Guitar Fret Noise
Breath Noise
Seashore

Bird Tweet
Telephone Ring
Helicopter
Applause

Gunshot

Ry

[NV RV
Acoustic Bass Drum
Bass Drum 1
Side Stick
Acoustic Snare
Hand Clap

Electric Snare
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General MIDI )N\—h v a> - Ry

007-2275-010aJP

41
42
43
44
45
46
47
48
49
50
51
52
53
54
55
56
57
58
59
60
61
62
63
64
65
66

Low Floor Tom
Closed Hi-Hat
High Floor Tom
Pedal Hi-Hat
Low Tom

Open Hi-Hat
Low Mid Tom
Hi Mid Tom
Crash Cymbal 1
High Tom

Ride Cymbal 1
Chinese Cymbal
Ride Bell
Tambourine
Splash Cymbal
Cowbell

Crash Cymbal 2
Vibraslap

Ride Cymbeal 2
Hi Bongo

Low Bongo
Mute Hi Conga
Open Hi Conga
Low Conga
High Timbale

Low Timbale

397



f18% C: General MIDI Y > K - tw hENX—hviar v T

398

67
68
69
70
71
72
73
74
75
76
77
78
79
80
81

High Agogo
Low Agogo
Cabasa
Maracas

Short Whistle
Long Whistle
Short Guiro
Long Guiro
Claves

Hi Wood Block
Low Wood Block
Mute Cuica
Open Cuica
Mute Triangle

Open Triangle
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&8

AFv 3N

4 DDA =N —ZFAEHET SO0 4 DOF v D RI)IAEREFF DO —F 1 4. F#i. HAl
%S, B ORI —BAITT A, ZOMOMED R 51 £ 9. Quadraphonic 4 —F 1 F
EBIFINET,

AIFF
Audio Interchange File Format ®li§, SGI 7 —2 X7 —3 3 > HOREES —F 1 B,

AIFF-C

Audio Interchange File Format with Compression O, SGI 7 —27 27— 3 > H OFEHEF —
71 A,

AVI
Audio Video Interleaved D&, Microsoft #:D L —E— + 7 7 A JLEK,

B-Y
B () YAFRXY Ob2F2R), BYEBBRETYFOY - A2R—%> k- EFFT—T DRk
BRICHEHENET,

CCIR

Comite Consultatif International des Radio-Communications (FEREHFAREBMEZESR) O
&, EREEDELENZERE LT, EBES AR U =B,

CCIR-601
CCIR #1556 601 Ho TPFIN T LEDI>O—F 1 257 - NTA—FRBEREL TVET,

399



FGE

400

CinePak

QuickTime B L AVI (Microsoft Windows #5727 kw7« E54) HIZIES N7z codeco
HEFR D codec ENZIEAFRAYT, CinePak TIL> d— RE N L —E—DIEMICERIANN S K
T, FEAERE DRI IEH I EE T 9. Ak CinePak 13, CD-ROM 7 5 O & @R 3 K UFF
AZENE L THEINL—E—TEMREIHN T,

codec
L—E—DEMBLUORHEZITOIV I T LT,

General MIDI

FL72 B A IR D B HAVE 2 MR T 2 72D ICBIFRE S /= MIDI B OFEHEY 7 & » b, General MIDI
E“i?«fwﬁéﬂb}%Uﬁﬁ RTEL. MIDI F % > %)V 10 ZEIZ/N—Hvar -

N—NMNZHEHLET, INS5DOREI—EITPa<ED 16 HEN LOFTEHETE, D&

H24 FORY 7 4 Z—/Va[HET T,

Hi-8mm
Sony #:ABHFE L 72 8mm $E S K. I2KRDP Y MEHE S- EF A EFTEZMNT LT,

JPEG

Joint Photographic Experts Group 72355 U 7z [EfE#it%. H—D JPEG [Effif A—2 %2 1 DD
T 7 AIRIFS 2720 DBEE T 7 A VBRI JFIF EMHENE T, JPEG (3 ki i B
FEE NI lossy FEMIA XTI A, A—E—IZHBMATEEXT. /2 & AL, QuickTime, SGI Movie,
OMFI &7 7 A VXD L—E—1E, JPEG EfiETF - 7—F 2 RETEET, VI hUx
TIZ LB JPEG EfEZETTD & DY A XD 1/2 ~1/100 IZJEME SN E T, @H, k7L —LA
OfRE T 0t X TOEMEIC JPEG A L7z%. BlOH KX (MPEG7/RE) TI SIZEMZEITS T
BRI LA —E— - 77 A IVEERL 9, JPEG 3. MEOXLIICT> M I X MvE< WO
FoEDELEAA—TYEDD, BEEOL D ITHBEENE S, ERLIZARHOA A—JIEL T
WE9d,

lossless
DT —H I HDTXNTOERERET D, ETFEZEA A-VDEMHAF— L,

lossy
TEDT—HFIZHDIEHRZE 100% TERIIIRELRN, EFFEZEA A= DEMAF— Lo
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MIDI

Musical Instrument Digital Interface Dlig, 1> 21— & S KRB TAEL / HEVHAR
BTELLDITERLINZTOYINEERION— R = 7K,

MIDI F+ > RJb
F—4 DEZEFERIC MIDI BB NED TS 16 BEH OEE DR MIDI 57— 4% OREFITHE
BF v x)EE. MIDIF—% « A R —LANOE@EICE > THRESINET,

MIDI a» bkA-5
MIDI 5 —% Z2EETHN—RI 7 EHEV I T 7,

MIDI F/81 R

MIDI 57 —#% NDJ& £7213 MIDI 7 —% O 4Rz 17 5 %, MIDI 7 /N1 2 O —#iy7apl & L
T. MIDI @ IN. OUT. THRU 72 EDR— b ZFDF—R—FPL RIT LNy RPFETF5NET,

MDIA 4927 x—R

Silicon Graphics D> 7 b =7 MIDI Y —)V DEHIZHB W T MIDI 1 >4 7 = — X1, MIDI
VI Mz T INBREETOIEOOEEERLET. VI AT — 3 2ONML T A TRt
BREER ENMIDL A > 7 2 —RITHZD LT,

MDIA &7 x—R - THTH
a2 a—F &, BEOCI I AMTRED MIDI FNA APHEBEETESLDICTTEHN—R
LT TN R

MPEG
Motion Pictures Expert Group MBI ¥ U 7z JEHi Bk, CD-ROM %> World Wide Web O —4 1
STRTUTINICH - EB KL HHINTNET, —#%IC MPEG-1 Tid. 7tD 7 7 1 )L % 1/100
DF—5 « B ZIZJEML £ lossy [EMi ST & W T, JPEG * MVCI £ D b @EWEMHIC
720 E9, MPEG 3. —EEMLZETFZMEDMBL THAET LRI BRETAHMIZEL T
WEJ,

MVC1

MVC1 (Motion Video Compressor 1) i3. Silicon Graphics #:4 H QI EME Y )L TV XL TT,
—fIZ MVC1 Tid, 57—% - Y1 XN 1/5 [TEMENET, o—E—Z#LAAT— - BIVE
WAEA T2 32 T2 b OEWBE TR AARICR 255075 D £T, MVCL IZEE
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FGE

402

Flossy VIV XALT, HEMiED JPEG EZEm<HV EFH A, MVC1 OFHIE. VI boxY
DHDFHAEERENHERENZ & TY,

MvC2

MVC2 (Motion Video Compressor 2) i&. 1 A—Y DFE DR Tld MVC1 EIEF% OJEMiH
#MTT. MVC2 Tid, MVC1 &0 BEMHBENE LD LT, EMEESE< D ET, —KIC
MVC2 TiE, 7t 7 71V &K 1/20 DY A ZIEML £9. 5islRDT—FBNDR N9,
R, BAEEEIIMVCL L0 BH LD ET,

NTSC
AT—FTLVEDKKD1DTHD, A, HE FEHRZIRT1IDODOEFICIZ>O—-RLESY
1227 ALK BKROKRE HERORT I THRHASNTHWET, NTSCld., 20T AT
LR L 7 EEME(L B National Television Systems Committee Ol Td. NTSC /D 7
=413 1 7L —LH720 % 2625 ROKEEEREFFD2 DD T 1 —)L KMSRLD., &5 525
AOKFEEEREFALET, £71—IVROUTL v a - L—M360Hz (EREIZIT 59.94
Hz) T9,

PAL

NI—=TLVEDEKD1DTHD, BRAYTHIEINLESIIIER. AFUX, 752X
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